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Preface

Welcome to the Universal Routing 8.1 Business Process User s Guide. This
guide contains step-by-step instructions for creating business processes, which
direct the handling of multimedia interactions through various processing
objects including interaction queues, views that extract interactions from
queues, and routing strategies that contain more specialized processing objects.

This document is valid only for the 8.1 release of this product.

Note: For versions of this document created for other releases of this
product, visit the Genesys Technical Support website, or request the
Documentation Library DVD, which you can order by e-mail from
Genesys Order Management at ordermanegenesys Lab.com.

This preface contains the following sections:

«  About Universal Routing, page 14

+ Intended Audience, page 16

«  Making Comments on This Document, page 17
+  Contacting Genesys Technical Support, page 17
+ Document Change History, page 17

For information about related resources and about the conventions that are
used in this document, see the supplementary material starting on page 457.
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About Universal Routing

About Universal Routing

CIM Platform

14

Genesys Universal Routing enables intelligent distribution of interactions
throughout the enterprise, whether you have a single-tenant or a multi-tenant
environment. Universal Routing can direct interactions from a wide variety of
platforms, such as toll-free carrier switches, premise PBXs or ACDs, IVRs, IP
PBXs, e-mail servers, web servers, and workflow servers. It can handle
pure-voice, multimedia, and blended environments, enabling routing of each
media type based on appropriate criteria. Routing strategies and business
processes automate interaction routing to the most appropriate agent/resource
based on factors such as the type of inquiry, the value of the customer, and the
media channel.

Universal Routing is a part of the Genesys Customer Interaction Management
(CIM) Platform that provides the core interaction management functionality.

Universal Routing, on its own, provides voice-routing capabilities. When
combined with Genesys eServices (called Multimedia in 8.0.0 and earlier), you
can also route various types of non-voice media. Universal Routing and
Genesys eServices work together to enable you to seamlessly route both voice
and non-voice interactions.

CIM Components

Genesys CIM is the collection of core servers that enable the rest of your
Genesys environment to process the thousands of interactions representing the
needs of your customers. The CIM Platform consists of the following Genesys
products:

* Management Framework

e Interaction Management, which in turn consists of:
+ Universal Routing
+ Interaction Workflow
+ Knowledge Management
+ Content Analysis
+ Universal Contact History
* Reporting
Figure 1 on page 15 depicts CIM graphically.
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Figure 1: Customer Interaction Management Platform

eServices

The CIM Platform can handle various media channels. Genesys eServices
(formerly Multimedia) in Figure 1 encompasses those Genesys components
that work together to manage interactions whose media is something other than
traditional telephonic voice (for example, e-mail or chat).
eServices includes some parts of the Genesys Customer Interaction
Management (CIM) Platform, plus certain of the media channels that run on
top of the Platform:
*  From the CIM Platform, all of Interaction Management except for
Universal Routing:
+ Interaction Workflow—Centralized handling of interactions
irrespective of media type
+ Knowledge Management—Creation and maintenance of standard
responses and screening rules
+ Content Analysis—Optional enhancement to Knowledge Management,
applying natural language processing technology to categorize
interactions
+ Universal Contact History—Storage of data on contacts and on
interactions (linked as threads)

*  From the media channels, at least one of the following:
+ Genesys E-mail
+ Genesys Chat (formerly, Genesys Web Media)

Business Process—User’s Guide 15
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Intended Audience

+ Genesys SMS (Short Message Service)
+ Genesys MMS (Multimedia Messaging Service)
+  Genesys Web Callback

+ Genesys 3rd Party Media—Ability to add customized support for other
media (fax, for example)

+  Optionally, Web Collaboration—Ability for agents and customers to
co-browse (simultaneously navigate) shared web pages. This is an
option that you can add to either Genesys Chat or Inbound Voice.

See Figure 2.
Media Channels ;— ?oth_ers Genesys Genesys Genesys Genesys Genesys
Inbound | Network | | E-mail Chat 3™ Party
| Voice Voice Media
Interaction Manageinent
Content Analysis
£ Interaction Workflow Universal Contact History
QO
L':Q — eServices (Multimedia) —
S Reporting
o

Framework

Figure 2: eServices in Relation to the CIM Platform and Media Channels

Any functioning solution (platform plus channels) that includes any part of the
Interaction Management sector requires Universal Routing

Intended Audience

This guide is primarily intended for contact center staff responsible for creating
business processes. It assumes that you have a basic understanding of:

16

Computer-telephony integration concepts, processes, terminology, and
applications.

Network design and operation.
Familiarity with your own network configurations.
The Genesys CIM platform.

Ideally, you also have experience designing routing strategies using Interaction
Routing Designer (IRD).

Universal Routing 8.1 @



Preface Making Comments on This Document

Making Comments on This Document

If you especially like or dislike anything about this document, feel free to
e-mail your comments to Techpubs.webadminegenesyslab.com.

You can comment on what you regard as specific errors or omissions, and on
the accuracy, organization, subject matter, or completeness of this document.
Please limit your comments to the scope of this document only and to the way
in which the information is presented. Contact your Genesys Account
Representative or Genesys Technical Support if you have suggestions about
the product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or
distribute your comments in any way it believes appropriate, without incurring
any obligation to you.

Contacting Genesys Technical Support

If you have purchased support directly from Genesys, please contact Genesys
Technical Support.

Before contacting technical support, please refer to the Genesys Care Program
Guide for complete contact information and procedures.

Document Change History

This section lists topics that are new or that have changed significantly since
the first release of this document.

Release 8.1.3

e Chapter 1, “Business Process Overview” on page 21:
+ The Hide Activity feature was added. See “Strategy Object” on
page 30 for additional details.
*  Chapter 10, “Creating Business Process Objects” on page 247:

+ “Distribution of Load Between Multiple Interactions Servers” on
page 315 section was added.

Release 8.1.1

* Chapter 11, “Planning a Business Process” on page 195:

+ In the section, “IRD Limitations” on page 219, a bullet item has been
added to describe a new limitation and a sentence has been added to
the Note on page 215, referring to this new limitation.
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Preface Document Change History

* Appendix, “Business Process Samples” on page 369:

+ A new section, “How To: Conduct a Survey by Using Email” on
page 425 has been added to describe the Email or Chat Survey
Business Process.
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Part

Introduction to Business
Processes

Part One of the Universal Routing 8.1 Business Process User s Guide presents
an overview of business processes. It also gives a high level description of
Genesys interaction processing. The information in Part One is divided into the

following chapters:
* Chapter 1, “Business Process Overview,” on page 21.

* Chapter 2, “Interaction Processing,” on page 47.
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Chapter

Business Process Overview

This chapter gives a high-level overview of a business process. It covers the
following topics:

+  Business Process Definition, page 21

+  Conceptual Diagrams, page 24

- Sample Business Process, page 25

«  Business Process Objects, page 27

«  Processing Flow, page 42

+  Visual Comparison, page 44

Business Process Definition

A business process directs customer interactions that arrive at the contact
center through various processing objects. It defines what happens to customer
interactions from the point of arrival to the point of completion. You can create
one large business process or a number of smaller business processes
connected via queues. A group of business processes comprise an interaction
workflow.

Interaction Workflow

An interaction workflow implements the procedures used by agents,
supervisors, quality assurance, and other personnel in your company to
accomplish business objectives related to incoming interactions. This
workflow can be broken down into various segments. IRD enables you to
represent such segments as individual business processes.

A business process is a logically-organized series of steps that, working
together, handle a task or some aspect of a task and that therefore contributes to
your overall workflow processing. Think of business processes as containers
for performing general tasks, such as moving interactions in and out of queues
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and submitting interactions to routing strategies. You can transfer interactions
or tasks from one business process to another.

Processing by Media Type

The types of processing applied to interactions varies based on the media type
and the contact center’s business logic. In most cases, the goal is to generate an
appropriate response for the customer.

* In the case of an e-mail interaction, an appropriate response might be an
e-mail answering the customer’s questions.

* In the case of a chat interaction, an appropriate response might be mailing
product brochures to the customer.

* In the case of a fax interaction, an appropriate response might be an e-mail
stating the requested materials had been received, and so on.

E-mail Server Example

Assume an e-mail interaction from a customer arrives at the contact center,
either via the enterprise mail server or, if the customer sends an e-mail from a
web site by filling out a web form, the interaction arrives via the Web API
Server.

The media server (E-mail Server in this example) stores the body of the
interaction in the Universal Contact Server database, and then sends
operational data on the interaction to Interaction Server.

Interaction Server parks the interaction’s operational data in its cache and starts
processing the data according to the first business process in the interaction
workflow.

In general, a business process works as follows:

* E-mail Server directs Interaction Server to place the interaction into an
inbound queue. Figure 3 shows an example inbound queue defined in an
example E-mail Server Application object):
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Business Process Definition

abe contact-identification
EE default-domain

El_b-; defaul-from-address
b E default-inbound-gueue

"MT221.9.247

3% E-Mailserver [techpubs4:3010] Properki El
General | Tenants | Server Info | Start Info
Connections Options | Annes I Security I D ependency

%= email-processing j I | |:| x | E | @ 3 @
Marme 'alue -
Enter tewt here S| Enter tewt here S
‘-:'E attachrnent-rngt "LEAWE"

‘ﬁ; autobot-agent-login-name

E_b-; autowar-detect-penod "00:10:00"

abe autawar-mas-reply-count "R |
‘-:'E autowar-zcan-all-threads-of-co... "FALSE"

‘ﬁ; boc-address e

E_b-; check-email-address "TRUE"

"IDEMTIFY-AMD-CREA...

78T echpubzlnbound"!

El_b-; enable-autowar-detect "FALSE"
Eg; enable-estract-uuencoded-file "FALSE"
El_b-; enable-inbound-processzor "TRUE" -
1] | »
|D | ] I Cancel Apply | Help |

Figure 3: E-mail Server Default Inbound Queue

Note: If you are planning to use a single Interaction Server as a
Multi-Tenant application, you can configure as many inbound
queues as you need for directing media server interactions into
queues via the endpoints:<tenant_DBID) section in the E-mail
Server Application object. For more information about endpoints,

see page 41.

* The interaction is then taken out of the queue and submitted to a strategy
that uses various processing objects (see “Routing Design Toolbar” on
page 123 for a summary of available processing objects).

* A strategy performs the processing specified and eventually routes the
interaction to a target, but not necessarily the final target. For example, an
e-mail interaction may be placed in an agent queue for construction of a

response.

Business Process—User’s Guide
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The target processes the interaction and places it into another queue where
another strategy may process it. For example, a strategy may send an
agent’s draft e-mail response to a queue for Quality Assurance checking.

The cycle of going from queue to strategy to queue continues until

processing is stopped or the interaction reaches some final (usually
outbound) queue.

Conceptual Diagrams

Figure 27 shows a conceptual diagram of an inbound e-mail business process
that ends in outbound Quality Assurance (QA) review.
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Web Support =

—
Business Process GENESYS]
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Use Mode ksientify :
| = o, Clagall) Send Auto- Cusi Priority
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on Content Email B.-q.;aq
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Eond Autoe Prricarity Chisgruner
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ulbaund
E Reviaw
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Figure 4: Business Process Conceptual Diagram: Inbound E-mails

Figure 5 continues the conceptual diagram by showing a conceptual diagram
of the business process used for outbound QA review.
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Figure 5: Business Process Conceptual Diagram: Outbound QA Review

Sample Business Process

Note: For information about the interface that is used to create business
processes, see Chapter 3, “Business Process Interface,” on page 57.

An actual business process in IRD’s Interaction Design window resembles a
diagram. Figure 6 shows an example business process that forwards incoming
chat interactions to agents and processes chat transcripts.
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Sample Business Process

,"' default @I Chat inbound view
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- @ I Chat request branscripk send wiew

Chat request transcripk send queus

Chat send trarscript email queus

Figure 6: Example Business Process

Objects of several types, together with their properties, define a business

process:

* The primary objects are Queue (rounded squares in Figure 6), View (single
small circles in Figure 6), and Strategy (rounded rectangles in Figure 6)

objects.

* A business process can also contain a Media Server object that has
attached Endpoints (Chat Server in Figure 6).

* Some objects appear because they are specified as targets in strategies:
output queues, agents, agent groups, workbins, and servers (such as Chat
Transcript in Figure 6). Also see “Strategy-Linked Nodes” on page 34.

* A Stop node appears if a strategy contains a Stop object, which notifies
Interaction Server that processing for a particular interaction has stopped.

26
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* Lines from queues to routing strategies represent Submitter processes
(75tpin in Figure 6).

* Lines flowing out from routing strategies point to targets (smaller nodes,
such as the line connecting to Chat distribution in Figure 6).

Business Process Objects

This section discusses the various objects that can appear in a business process.

Queue Object

A Queue object represents a logical parking place (persistent queue) for an
interaction during its lifetime at the contact center. Figure 7 shows a Queue
object, named Inbound emai ls.

\ @ I 'Inhnund B-mails . .

Inbound e-mails Inbound e—Fha_;iI

Figure 7: Queue Object

Double-clicking a Queue object opens a properties dialog box (see Figure 8).

The 'Queuel’ Interaction (Queue Properties k|

Eeneral | Used In |

Script Mame II] ueuel

Drescription I

¥ Enabled

[ Default

Figure 8: Queue Properties Dialog Box
Select the Default check box to make this the default queue for this Business

Process. A default queue is marked with a bright-green square in the Object
Browser ().
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View Object

28

Setting a queue as default means that when you configure a new Media Server
object for this Business Process, it automatically uses the selected queue.

Note: In this example, the display name (Inbound-e-mails) and the
Configuration Manager Script object name (Inbound e-mails1) are
slightly different. Figure 143 on page 159 shows an example
Configuration Manager Scripts folder for Script objects.

A Queue object has special ports for outgoing connections. Such ports
represent View objects. The same queue can be used in more than one business
process—for example to connect one business process to another thereby
creating an interaction workflow.

A Queue object may display an up arrow in the lower left area of its icon (see
Figure 9).

)

Inbound e-mail
postprocessing

Figure 9: Queue Object with Up Arrow

The up arrow indicates that the queue is “owned” by (originated in) a different
business process. You can find the business process that owns the queue by
right-clicking the queue and selecting Locate from the menu. The queue is
then highlighted in the object browser under the business process that owns the
queue.

For information about adding Queue objects, see page 258.

View objects pull interactions from queues and submit them to strategies.
Placing an interaction into a queue defines the subsequent actions that are
applied to the interaction through queue-processing rules, which consist of one
or more View objects. Figure 10 shows tan example View object (which
appears as a small circle) attached to a Queue object.

@ I %Iﬂbuund e-mails . o

Figure 10: View Objects Attached to Queue Object
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Right-clicking a View object in the object browser and selecting Properties
opens a properties dialog box. You can also open the properties dialog box by
right-clicking the associated Queue object and selecting Properties of and the
name of the View object.

The example in Figure 11 shows a condition for pulling interactions in the
Condition tab.

The ‘BP_Linel_Daemon' Interaction Dueue Yiew k|

General  Condition I Order I Schedulingl Pararmeterized I:Dnl:liticnnsl Cal 4 | *I

time_in_queue() > 4320 |

Figure 11: View Properties Dialog Box

A View object defines one or more of the following:

* The name for the View object in the Configuration Manager Scripts
folder (see page 271).

* The conditions for interaction selection including parameterized
conditions, such as those used by Agent Desktop (see pages 272 and 282).

* The order of interaction selection (see page 274).

e The time interval that Interaction Server uses to check for interactions
(page 275).

* The schedule for submitting interactions to strategies (see page 275).
* Database hints (see page 283).
*  The number of interactions of different segments (see page 284).

In addition, you can use Configuration Manager to limit the number of
interactions based on interaction properties, such as Customer Segment (see
page 287).

For information about adding View objects, see page 267.
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Strategy Object

Note: All objects used in a strategy are hidden if the Strategy object
represents a shortcut. To view the objects used in such strategy, you
have to first locate the business process that owns the strategy by
right-clicking the strategy, and then selecting Locate. Then open the
strategy in that business process.

A Strategy object represents a routing strategy, which performs specific
processing operations (for examples, see Figure 28 on page 44 or Figure 114
on page 132). Stated another way, a strategy is a set of instructions that
Universal Routing Server follows in deciding how to handle an interaction.
Figure 12 shows a Strategy object named Inbound e-mail preprocessing st.

Inbound e-mai
@ I Inbound e-rmails = postprocessing

Inbound e-mails Inbound e—-r';ha_uil

preprucessing"ﬁ; A., @ I

Collaboration
reply e-mails

Figure 12: Strategy Object

* Activated strategies that are loaded on a virtual routing point are marked

with a small green arrow (see Inbound e-mail preprocessing st in
Figure 12).

* The same strategy can be used in more than one business process. You can
tell this has occurred if a Strategy object displays an up arrow in the lower
left area of it icon (see Figure 13).

2

=

Terminate
Interaction
st

Figure 13: Strategy Object with Up Arrow

The up arrow indicates that the strategy is “owned” by (originated in) a
different business process.
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You can find the business process that owns the strategy by right-clicking the
strategy and selecting Locate from the menu. The strategy is then highlighted
in the object browser under the business process that owns the strategy.

Double-clicking a Strategy object opens a properties dialog box with the name
of the Configuration Manager Script object (see Figure 14), its description,
and the path where the graphical portion (.rbn file) is stored (see page 172).

The "Agent_Redirect’ Simple Routing Properties

General | Limitations | Strategy Loading | Used In |

Scripk Mame I Agent_Redirect

De=scripkion I

Path I Z:\Program Files\yaC T Interackion Routing Designerlagent

V' Hide ackivity

Figure 14: Strategy Properties Dialog Box

* To examine the strategy detail and flow, you can open the strategy for
viewing (see Figure 260 on page 305).

* For information about creating Strategy objects, see page 323.

* Ifthe Hide activity check box is selected, no activity related to the strategy
is reported by Interaction server.

When the Hide Activity checkbox is checked, it stores a value of true for the
hide-activity option in the default section on the Annex tab of a strategy
configuration object. Or as a value of false if the Hide Activity checkbox is
unchecked. See Figure 15 for details.
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%z Agent_Redirect {2155) [W2K350L2K5-0Al.us.int.genes... [E4

General Annex | Se-:urit_l,ll Dependenc_l,ll

% default jI|Dx|E|@ Tp-
Mame “* "Walue

Enter text here S| Enter test . |5F
EE hide-activity "trug"

El k. I Cancel Apply Help

Figure 15: hide-activity Option

Certain activities defined in Business Processes and handled by Interaction
Server are intended to periodically check interactions and modify their
properties.

For instance, an interaction can be pulled from a queue, pushed to a specific
strategy, which changes the interaction’s properties, and returned back into the
same queue. This activity is reported by the following sequence of events, and
can happen multiple times until finally the interaction is either moved to
another queue or routed to an agent:

* EventTakenFromQueue (interaction leaving a queue)

* EventPartyAdded (strategy added as a party)

* EventPropertyChanged (one or more changes, if any)

* EventPartyRemoved (strategy party removed)

* EventPlacedInQueue (interaction returned back to the same queue)

If a customer is not interested in reporting these interim changes, all
corresponding reporting events can be eliminated in order to not waste network
bandwidth and reporting engine CPU.
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The Interaction Server reads the value of the strategy hide-activity option
when it reads the configuration of a corresponding Business Process, and does
not report the activity associated with this strategy if the option’s value is set to
true.

Workbin Object

A workbin is an object that holds interactions for later processing. Figure 16
shows the properties dialog box for a workbin.

The "Workbin for Original Agent® Interaction ¥o k|

General |Elr|:|er | Usedin| Queue |

Script Mame IWnrkbin for Qriginal Agent

Description I
Diwrier
% fgent = Agent Group ¥ Enabled
" Place " Place Group

Figure 16: Workbin Properties Dialog Box

* In Genesys Agent Desktop, agents can use workbins to store interactions
that they have started working on and wish to continue working on at a
later time. For more information, see the Genesys Desktop 7.6 Deployment
Guide.

* Interactions can be distributed to workbins by Universal Routing Server
when executing a strategy that uses the Workbin object (see “Workbin
Strategy-Linked Node” on page 37).

*  Workbins may be used in a business process for escalation functionality
(see page 298). Multiple workbins may be associated with the same
interaction queue.

A workbin is similar to a queue in that it holds interactions. A workbin differs
from a queue in that, when configured with IRD’s Workbin routing object, a
workbin can be associated with a particular Agent/Agent Group/Place/Place
6roup. In this case, its major function is to hold interactions for that
agent/place/group to process. Agents can view the entire content of a workbin
and pull interactions from it in any order. Agents can also pull interactions
from queues, but only in the order defined by the queue.

Note: For more information on configuring workbins, refer to “Adding
Workbins” on page 292.
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Outgoing connections automatically appearing from a Strategy object that
represent objects specified inside the strategy are called strategy-linked nodes.
For example, assume a strategy in a business processes contains the following:

* A Queue Interaction object (see Table 11 on page 207)
* A Workbin object (see Table 11 on page 207)

* A Route Interaction object using a variable for the name of the routing
target (see Table 11 on page 207)

* A predefined queue called Stop_Processing

Figure 17 shows the resulting strategy-linked nodes.
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FESiE
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\
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Stop

Figure 17: Strategy-Linked Nodes

The next section discusses the various types of strategy-linked nodes.

Queue Strategy-Linked Node

If the Strategy object uses a Multimedia object (see Table 8 on page 201) or a
Routing object (see Table 11 on page 207) that names an interaction queue, a
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queue node with the same name automatically appears in the business process
(see E-mails for QA review in Figure 18).

=)

E-mails
for Q4
review

s

—=—3)

Figure 18: Queue Node Linked to Strategy Object

You can easily tell when a queue node is a strategy-linked node because it
flows out of the right side of a strategy and is directly connected to the strategy
(see Figure 18).

Server Strategy-Linked Node

If the Strategy object uses a Multimedia object (see Table 8 on page 201) that
names a server performing an action or operation, a server node with the same
name appears in the business process. Figure 19 shows two example server
nodes (Email:InteractionAutoResponse and Email::InteractionACK).
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Figure 19: Server Node Linked to Strategy Object

Stop Strategy-Linked Node

If the Strategy object uses a Stop Interaction object (see Table 8 on page 201),
a Stop node appears in the business process (see Figure 19). This node
specifies the end point for processing of an interaction in a strategy.

Target Strategy-Linked Node

If the Strategy object uses a Route Interaction object (see Table 8 on page 201)
that specifies a Person, Agent Group, or Skill (see page 241) as a routing
target, a node with the same name appears in the business process. Figure 20
shows an example Agent Group target node (Email QA Review group).
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Figure 20: Person Node Linked to Strategy Object

Workbin Strategy-Linked Node

If the Strategy object routes an interaction using the Workbin object (see
Table 8 on page 201), a workbin node appears in the business process (see

Figure 21).
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Place ™, warkbin
interaction for
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Figure 21: Workbin Strategy-Linked Node

In the case of a workbin strategy-linked node, the Workbin object in the

strategy specifies a target type: Agent, Agent Group, Place, or Place Group.
The selected target type appears under Owner in the Workbin Properties dialog
box (see Figure 16 on page 33).

The same workbin can be used in more than one business process. A workbin
strategy-linked node may display an up arrow in the lower left area of it icon

(see Figure 22).
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Workbindgent]

Figure 22: Workbin Object Owned by a Different Business Process

The up arrow indicates that the workbin is “owned” by a different business
process.

You can find the business process that owns (originated) the workbin by
right-clicking the workbin and selecting Locate from the menu. The workbin
is highlighted in the object browser (see Figure 36 on page 61) under the
business process that owns the workbin.

e Views extract interactions from workbins.

* For information about creating Workbin objects, see page 292.

Note: The WorkfLlow Settings tab in the Options dialog box (see Figure 75
on page 90) affects the visibility of strategy-linked nodes.

New and Existing Interactions

To distinguish existing interactions from new ones, the lines connecting an
object that creates a new interaction and the destination for the new interaction
are red instead of black.

* Ifa strategy places an existing interaction in a queue, IRD inserts a Queue
strategy-linked node and uses a black connection between the strategy and
the queue.

» Ifa strategy stops interaction processing, IRD inserts a Stop
strategy-linked node and uses a black connection to the strategy.

» Ifastrategy calls a 3rd-party server that creates a new interaction and
places it into a queue, IRD inserts the server strategy-linked node and
connects it to both the strategy (black connection) and the queue (red
connection). See Figure 19 on page 36.

» If a strategy routes the interaction to an agent, IRD inserts an agent
strategy-linked node and connects it to the strategy using a black
connection.

» If the agent is supposed to stop interaction processing, IRD inserts a Stop
strategy-linked node and connects it with the agent node using a black
connection.

* Ifthe agent is supposed to place an interaction in a queue, IRD connects
the agent strategy-linked node to the queue using a black connection.
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Submitters

» Ifthe agent is supposed to create new interaction and place it in a queue,
IRD connects the agent strategy-linked node to the queue using a red
connection.

When you connect a View object (see Figure 10 on page 28) to a Strategy
object, this action defines a Submitter, which fetches interactions through a
corresponding view and submits them to the strategy.

Figure 23 shows a Submitter connecting the Inbound e-mails Queue object

with the Inbound e-mail processing st Strategy object.

Inbound e-rmai

@I Inbound e-rails \ nﬁEﬂ I postprocessing

Inbound e-mails Inbound e- rna|l

preprocessing st A.. @ I

Collaboration
reply e-mails

Figure 23: Submitter Object

For information about creating Submitter objects, see page 303.

Media Server Object

At some point, you will need to direct customer interactions into the workflow.
The only way to get customer interactions into a workflow (for further
processing by other business processes) is to use a Media Server object. The
location where the Media Server object is used will frequently be the first
business process in the workflow, but the exact location depends on how you
design your workflow.

Background

The Genesys Multimedia software components include five media servers,
E-mail Server, Chat Server, SMS Server, iWD Capture Points, and Third Party
Servers, which process e-mail, chat, SMS/MMS interactions, and iWD tasks
respectively. Your enterprise’s media servers appear as Media Server objects in
aMedia Servers folder in the Interaction Design window (see Figure 49 on
page 70 for an example).
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* E-mail Server interfaces with the enterprise mail server and the Genesys
Web API Server, bringing in new e-mail interactions from customers and
sending out replies or other outbound messages.

* Chat Server works with Web API Server to open, conduct, and close chat
interactions between agents and customers.

* SMS Server receives and handles SMS and MMS messages sent from a
mobile client.

* 1WD Capture Points capture iWD tasks from various source systems.

* Third Party Servers are used to represent servers for which there is no
corresponding Application type in Configuration Server.

For more information on the media servers, start with the eServices
(Multimedia) 8.0 Deployment Guide.

Figure 24 shows example chat and e-mail Media Server objects used in a
business process.

| | default
)
ﬁ
E-MailServer
@I Fotnin
75TechpubsInbound
3 ult
. |
ChatServer

Figure 24: Media Servers and Endpoints

In this particular example, both media servers direct interactions into the same
queue (75TechpubsInbound) for sorting. You may want to set up different
queues for different media types.

To view a Media Server’s properties, right-click it in the object browser Media
Servers folder and select Properties. Figure 25 shows an example dialog box.
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The 'ChatServer’ Chat Server Properties E I

eneral |

M ame IEhatS Erver

Type IEhat Server

Part [4800 Multimedia7 =]

Belongz To The Following Solutions:

Figure 25: Media Server Properties Dialog Box

For information about using Media Server objects, see page 252.

Endpoint Object

In Figure 24, note the small circles attached to each media server. Each small
circle is an Endpoint object. An endpoint can be used to connect a media server
with a queue in a business process.

To view an endpoint’s properties, right-click it in the Media Servers folder of
the object browser and select Properties. Figure 26 shows an example dialog

box.
The "default’ Endpoint Properties B I
General |

M arme Idefault

Fefers Ta I.f-‘-.EE Simple Chat EP::Chat inbound queue

Fallowe The Reference

Figure 26: Endpoint Properties Dialog Box

If the endpoint is connected to another object, the Refers To field names the
business process and object.

To find the object in the business process to which the endpoint connects, click
the Follow the Reference button. IRD highlights the object in the business
process.
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Processing Flow

For information about creating endpoints in the Interaction Design window,
see “Adding Endpoints” on page 254.

Processing Flow

Figure 27 shows a flow diagram using objects discussed in “Business Process

Objects” on page 27.
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> 15.
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»| Outbound | o4 ToEmail Server
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Figure 27: Business Process Conceptual Diagram
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The processing flow for the diagram is the following:
1. The Inbound E-mails queue accepts all inbound e-mails.

2. The By Date view is attached to the Inbound E-mails queue. The view
specifies interaction selection by date received (assumed from the view
name).

3. A submitter process pulls interactions from the Inbound E-mails queue
(through the By Date view) and submits them to the Analyze & Autoreply
strategy.

4. The Analyze & Autoreply strategy analyzes the e-mail based on its
content and defines each e-mail’s special attributes such as To whom. The
strategy also generates an autoreply e-mail and places it in the Outbound
E-mails queue.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22,

The Analyzed Queue. The above strategy places e-mails in the Analyzed
queue.

The Customer Support view, attached to the Analyzed queue, specifies
interaction selection based on the To whonm attribute. It selects only those
interactions that have the attribute value equal to Customer support.

The Sales view, attached to the Analyzed queue, specifies interaction
selection based on the To whom attribute. It selects only those interactions
that have the attribute value equal to Sales.

The submitter pulls interactions from the Analyzed queue (through the
Customer Support view) and submits them to the Customer Support
Agents strategy.

The submitter pulls interactions from the Analyzed queue (through the
Sales view) and submits them to the Sales Agents strategy.

The Customer Support Agents strategy distributes interactions to agents
skilled in customer support.

The Sales Agents strategy distributes interactions to agents with the sales
skill.

Customer Support Agents process interactions and create replies.
Inbound e-mail processing stops here. The reply interactions are placed
into the Outbound E-mails queue.

Sales Agents process interactions and create replies. Inbound e-mail
processing stops here.

The For Approval queue. The reply interactions are placed in the For
Approval queue.

The By Date view, attached to the For Approval queue, specifies
interaction selection by date received.

The submitter pulls interactions from the For Approval queue (through the
By Date view) and submits them to the Managers strategy.

The Managers Strategy distributes interactions to the manager’s
supervisors.

The Managers (Supervisors) processes interactions by reading and
approving agent replies.

The Outbound E-mails queue. Managers place interactions into the
Outbound E-mails queue.

The By Date view, attached to the Outbound E-mails queue, specifies
interaction selection by date placed in queue.

The submitter pulls interactions from the Outbound E-mails queue
(through the By Date view) and submits them to the E-mail Server
strategy.

The E-mail Server strategy submits interactions to the E-mail Server.
Instructs E-mail Server to send outbound e-mails.
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23. The E-mail Server. Receives interactions from the E-mail Server strategy
and sends outbound e-mails.

Visual Comparison

So that you can visually compare a strategy and a business process, this section
shows both.

Figure 28 shows the Inbound e-mail preprocessing st strategy in the Routing
Design window.

i . . .
¥ Routing Design - Inbound e-mail preprocess ;|E|_>J

|| Eile Edit Yiew Tnals Help
IEEERE IR YAy 5|
Bacseo@gmD |H |Ea JJ%

Inbound e-mail has subtype
'InboundCollabarationReply

Inbound e-mail does not hawve
subtype 'MDR' ar
'InboundCallaborationReply' == look
for'onbound processing failure' flag

Email has'inbound
processing failed' status

.............. Email does not hawve
-------------- 'inbound processing failed
""""""" status == postprocessing

Figure 28: Example Strategy

44 Universal Routing 8.1 @



Chapter 1: Business Process Overview

Visual Comparison

The strategy in Figure 28 uses the Generic Segmentation, Queue Interaction,
and Multi-Assign objects that are described in Table 8 on page 201, as well as
the Route Interaction object that is described in Table 11 on page 207.

Figure 29 shows the same strategy in the workflow viewer portion of the
Interaction Design window.
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Figure 29: Example Business Process
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Chapter

Interaction Processing

This chapter familiarizes you with Genesys interaction processing as it relates
to business processes. It covers the following topics:

Genesys Queues, page 47

Interaction Workflow Control, page 48
Interaction Flow, page 51

Genesys E-mail, page 51

URS/Interaction Server Communication, page 53

Genesys Queues

The Genesys software maintains both interaction queues and virtual queues:

A queue in a business process executed by Interaction Server is called an
interaction queue in this document. You might also call this type of queue
a persistent queue. Business process developers define interaction queues
(Queue objects) and objects that extract interactions from queues (View
objects) in the Interaction Design window (see Figure 36 on page 61).
The definition of an interaction queue is stored as a Script object in the
Configuration Database (see Figure 143 on page 159).

All interactions submitted to URS are placed in virtual queues. A virtual
queue is not a physical queue, but instead a logical queue to which all
interactions are queued if the specified target in the routing strategy is not
available.

Just as a business process keeps all of its interactions in interaction queues,
Universal Routing Server (URS) keeps all of its interactions in virtual queues
(the Connections list in the URS Application object can have many different
T-Servers). URS communicates with Interaction Server about non-voice
interactions, and with voice T-Server about voice interactions.
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Note: If a target is unavailable, interactions sent to URS by Interaction
Server are returned to Interaction Server.

* In addition to interaction and virtual queues, there are also ACDQueue
routing target objects. However, the term queue, as used in this guide,
refers to an interaction queue.

Note: Genesys supplies business processes and strategies that use
interaction queues, as detailed in “Using the Samples” on
page 197.

Interaction Workflow Control

48

An interaction workflow refers to a group of business processes that are
connected via queues (see page 21 if you need a review). An interaction
workflow can also be designed as a single large business process similar to the
Genesys-supplied Default BP sample business process that is described on
page 387.

The Genesys components shown in Figure 30 handle workflow control for
non-voice interactions.

URS, IRD
(with
IxDesign)

)

To media interface

Interaction Server
-

Interaction
Server/cache

Classification Server To agent

To data storage

Knowledge Manager

b G ab ab &b &> &
<+ Training Server | D MM component

-
] § Optional MM component
-

-
@ Other Genesys componen

(Knowledge Management>

Figure 30: Workflow Control Components

Note: Not shown in Figure 30 are other required Genesys Management
Framework components, such as Configuration Server and the
Management Layer.
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The workflow control software components are as follows:

Interaction Server

Interaction Server is the central interchange for multimedia (non-voice)
interaction flow.

* Itreceives interaction operational data from the media interface.

» It stores the operational data in a cache (a database) while receiving and
transmitting information about the interaction. This cache also contains
queues through which the interaction passes as part of its processing.

» It works in concert with the routing components to route interactions
according to business processes and routing strategies.

For more information on Interaction Server, see the eServices (Multimedia) 8.0
Deployment Guide.

Interaction Routing Designer

Through its Interaction Design window, IRD creates and traces business
processes, which plot an overall path for interactions (see Figure 6 on

page 26). Business processes, executed by Interaction Server, map a route for
the interaction between contact center objects—principally, queues and routing
strategies. When executing business processes, Interaction Server
communicates with Universal Routing Server (URS), which is the server that
executes the routing strategies that are contained in business processes.

Note: Genesys recommends using only one IRD application per desktop.

For more information on IRD, see Universal Routing 8.1 Reference Manual.

For information about creating routing strategies, see page 323.

Universal Routing Server

Universal Routing Server (URS) executes routing strategies, which trigger
specialized processing tasks, such as sending automatic responses to customers
and screening of incoming interactions for certain words. URS also applies
segmentation logic to the flow; and requests delivery of the interaction to an
agent or other target. For more information on all the specialized processing
tasks handled by strategies, see “IRD Objects Used in Business Processes” on
page 201.

For more information on URS, see Universal Routing 8.1 Reference Manual.
Also see Universal Routing 8.1 Deployment Guide.
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Stat Server

Stat Server accumulates data about routing targets: Agents, Agent Groups,
Places (desks), and other contact center objects; converts the data into
statistically useful information; and passes these calculations to other software
applications. In particular, it provides agent capacity information to IRD and
URS, which refers to the number and types of interactions an agent can accept
(see “Agent Capacity Rules” on page 164).

For more information on Stat Server, see Framework 8.1 Stat Server User's
Guide. Also see Genesys 8.0 Resource Capacity Planning Guide.

Knowledge Manager

Knowledge Manager (see Figure 160 on page 177) is the user interface
component of Genesys Knowledge Management, which also includes:

* Classification Server, which applies Screening Rules when triggered to do
so by a routing strategy. Screening Rules are basic pattern-matching
queries performed on e-mail contents. The results of these queries can then
be used in routing strategy logic.

* Training Server, which trains the system to recognize Categories. It is
active only in the Content Analyzer option (see below).

You use Knowledge Manager to:

* Manage the library of Standard Responses, which is a collection of
ready-made responses to common inquiries and topics.

* Manage Screening Rules.
* Manage Categories, which are used to organize Standard Responses.

For more information on Knowledge Manager, see the eServices (Multimedia)
8.0 Users Guide.

Content Analyzer
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Genesys Content Analyzer is an optional enhancement to Knowledge
Management, requiring a separate license. It uses natural language processing
technology to analyze incoming interactions for assignment to the Categories
of the Standard Response Category system. The algorithms for content
analysis are built up and refined by Training Server as it processes collections
of pre-classified interactions. Setting up and scheduling these training sessions
is another function of Knowledge Manager. The content analysis algorithms
like Screening Rules, are applied by Classification Server when triggered by
routing strategies, and are stored in the Universal Contact Server database.

For more information on Content Analyzer, see the eServices (Multimedia) 8.0
User’s Guide.
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Interaction Flow

To summarize interaction flow:

* At the highest level, the flow is controlled by business processes as
executed by Interaction Server.

* Each business process contains queues and routing strategies.
* Routing strategies may bring in other applications/components to apply
specialized processing tasks to the interaction—for example:
+ Send an acknowledgement or an automatic reply
+ Apply a Screening Rule
+ Apply content analysis (with Content Analyzer option only)
+ Forward or Redirect

For a complete list of specialized processing tasks, see “IRD Objects Used in
Business Processes” on page 201.

Genesys E-mail

This section presents architecture that is specific to Genesys E-mail. Figure 31
shows the main components.

| [ POPISMTP
mail server

E-mnail
client

Imteraction

E-mail Sarvar
Sarvar

Genesys
Desktop

|
|
|
Web || (" vyan AR
cliant 1 Sarver
| Chat
Sarvar
Knowladge
Contact
Serer

Each Ganasys component alsa
connecls to tha Configuration
Sarvar for configuralion data.

Figure 31: E-mail for Multimedia Components
Figure 31 simplifies the workflow control components by showing Knowledge

Management and Routing as single objects. E-mail interaction processing
generally proceeds as follows:
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1. In addition to replies from external resources (see “External Service” on
page 210), e-mail interactions arrive at E-mail Server in the following
ways:

a. If the customer sends ordinary e-mail, the interaction arrives via the
enterprise mail server.

b. If the customer fills out a web form, the interaction arrives via the Web
API Server.

2. E-mail Server sends operational data on the interaction to Interaction
Server and simultaneously stores the body of the interaction in the
Universal Contact Server (UCS) database.

3. Interaction Server parks the interaction’s operational data in its cache and
starts processing it according to a business process.

4. What happens next depends on the business process and the routing

strategies that it contains. The system may

+ Apply a Screening Rule.

+ Assign one or more Categories to the interaction (if Content Analyzer
is present).

+ Generate an automatic response.

+ Route the interaction to an agent’s desktop, possibly also sending an
automatic acknowledgement to the customer.

A supervisor may intervene at various points as long as the interaction’s
operational data remains in the Interaction Server’s cache.

5. The agent receives the interaction. With the Content Analyzer option, the
interaction may arrive with a Category assignment and associated
suggested response. Otherwise, the agent may search manually for a
Category with a suggested response.

6. The agent may then:
+ Simply reply to the interaction.
+ Transfer it to another agent.
+ Produce a collaborative response by consulting with other agents.

7. When the reply is finally released by the agent or agents (typically to an
Outbound queue in the Interaction Server cache), it may optionally be
routed to a senior agent or supervisor for QA review. The reviewer decides

whether to let the reply continue through the outbound part of the business
process, return it to the agent for revision, or take other action.
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URS/Interaction Server Communication

URS and Interaction Server communicate by using T-Server message protocol
where all messages from URS to Interaction Server starts with Request and all
messages from Interaction Server to URS start with Event. The basic message
set is shown in Table 1.

Table 1: Basic URS/Interaction Server Communication Protocol

Name Direction Comment

EventRouteRequest | from Interaction Server | Ask URS to find appropriate target (Place, Agent, ...)

to URS for given interaction

RequestRouteCall from URS to Interaction | Provide Interaction Server with target information for
Server a given interaction

EventRouteUsed from Interaction Server | Report to URS about successful processing or
to URS command to cancel strategy execution for this

interaction (ReferencelD = 0)

Interaction Server executes business processes and, in doing so, communicates
with URS using a subset of T-Server protocol:

RequestUpdateUserData, RequestAttachUserData, RequestDeletePair,
RequestDistributeEvent for EventQueued, EventDiverted,
EventPartyAdded, EventPartyRemoved, and EventAbandoned are supported.

The message types that are shown in Table 2 for third party servers (such as
Universal Contact Server and E-mail Server) are also supported.

Table 2: URS/Interaction Server Request and Event Messages

Name or Request/Event Direction Comment
Request3rdServer From URS to Send to Interaction Server request for
Interaction Server third-party server operation
Event3rdServerResponse From Interaction Server | Returns results of third-party server
to URS operation
Event3rdServerFault From Interaction Server | Supply error information about
to URS third-party server operation failure

You can use these messages in the log file when you are diagnosing
strategy/routing problems. For more information, see the eServices
(Multimedia) 8.0 Open Media Interaction Models Reference Manual. 1t has
examples of basic scenarios that involve messaging between Interaction Server
and other components, including URS.
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Part

User Interfaces

Part Two of the Universal Routing 8.1 Business Process User s Guide
familiarizes you with the various Genesys user interfaces involved with
creating business processes.

The information in Part Two is divided into the following chapters:

*  Chapter 3, “Business Process Interface” beginning on page 57, describes
the features and functions of the interface used for business process design
and configuration.

» Chapter 4, “Strategy Interface” beginning on page 103, describes the
features and functions of the interface used for routing strategy design and
configuration.

* Chapter 5, “Configuration Layer Interface” beginning on page 155,
describes the features and functions of the interface used to define Genesys
Configuration Layer objects.

* Chapter 6, “Knowledge Manager Interface” beginning on page 175,
describes the interface used to define Standard Responses, classification
Categories, and other elements required by certain IRD objects.
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Chapter

Business Process Interface

This chapter introduces the interface that is used to create business processes.
Find step-by-step instructions for creating a business process on page 247.

This chapter covers the following topics:

Opening IRD, page 57

Accessing Interaction Design, page 60
Object Browser, page 62

Workflow Viewer, page 70

Viewers, page 71

File Menu, page 73

Edit Menu, page 78

View Menu, page 80

Business Process Menu, page 82
Tools Menu, page 83

Help Menu, page 93

Shortcut Menus, page 93

Interaction Design Shortcut Bar, page 100

Note: Prior to 7.1, business processes were created outside of IRD in a

standalone application that was called Interaction Workflow Designer.

Opening IRD

The information in this section assumes that you have already installed IRD as
described in the Universal Routing 8.1 Deployment Guide.
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Procedure:
Logging into Interaction Routing Designer

Purpose: To access the interfaces that are used for creating strategies as well
as the interfaces that are used for creating business processes.

Start of procedure

1. Click the desktop shortcut if a shortcut is present (see Figure 32).

55

RoUtingDesi =

Figure 32: Interaction Routing Designer Desktop Icon

As an alternative, click the Start button on your computer desktop and
select Programs > Genesys Solutions > Routing > Interaction Routing
Designer » Start Interaction Routing Designer.

2. Respond to any security-related screens that your company may have
configured to appear before the Interaction Routing Designer login
dialog box.

3. Complete the Interaction Routing Designer login dialog box. Figure 33
shows dialog box with example entries after clicking Detai Ls<<.

;:s Interaction Routing Des = |I:I|£|

@ YWelcome to Interaction Boubing Designer

Uzer name: Idefault

Ilzer pazsword: I

OE. | Carcel
Application; IIHD
Huost narne: ItEChDUhS4 j

Part: |3n1 0 |

Figure 33: Interaction Routing Designer Login Dialog Box

The first time the login dialog box opens, all fields are empty. The next
time you log in, IRD “remembers” previous entries for the following
fields: User name, Application, Host name, and Port.
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4. Use the information in Table 3 to complete the login dialog box shown in
Figure 33.

Table 3: IRD Login Dialog Box

Field Description

User name: Name of Person object that is defined in Configuration
Manager (see Figure 144 on page 160). See “Setting
Permissions” on page 173.

User password: | Password of Person object in Configuration Manager.

Application: Enter the name of an IRD Application that is defined in

Configuration Manager (see Figure 141 on page 157).
Host name: Name of machine where Configuration Server is running.
Port: Port number used by Configuration Server.

5. Click 0K, the Strategies list pane opens. Figure 34 shows an example.
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Figure 34: Strategies List Pane

End of procedure
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Accessing Interaction Design

You create/edit business processes in the Interaction Design window, which
opens from the IRD main window.

Procedure:
Opening the Interaction Design window

Start of procedure

1. Loginto IRD as described on page 58.

2. Click the Interaction Design bar (see Figure 34 on page 59). If bar does
not appear, see page 100.

3. Click the Business processes icon to bring up Business Process list pane

(see Figure 35).
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Figure 35: Business Process List Pane
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Accessing Interaction Design

At this point, you can create a new business process (see page 247) or edit an
existing one. Edit an existing business processes as follows:

4. Double-click a business process to open it in the Interaction Design
window as shown in Figure 36.
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Figure 36: Interaction Design Window

End of procedure

Note: Through the use of queues, you can connect multiple business
processes to create an interaction workflow (see page 199).

The Interaction Design window has three areas:
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* An object browser (dockable) on the left displays queues, views, routing
strategies, strategy-linked nodes, media servers, and endpoints in a tree
style.

* A workflow viewer (static) on the right displays the selected business
process.

* A log viewer (dockable) at the bottom of the window displays a running
list of status and event messages.

The next section discusses each area.

Object Browser

By default, each business process has the following folders: Queues, Workbins,
Strategies, and Subroutines.

When a business process is expanded, the object browser (see Figure 36 on
page 61) displays its configuration objects in a tree structure. Assume that you
expand the folders in an example business process that uses queues, workbins,
and strategies, but not subroutines. The object browser appears as shown in
Figure 37.
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Figure 37: Object Browser

Small Yellow Triangle
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Once you use an object in a business process, the browser marks it with a small
yellow triangle. For example, in Figure 37 under Queues, see E-mails failed
QA. The yellow triangle is helpful when working with a large business process
when you cannot see all objects at once and you are unsure whether a
particular object has been dropped in the viewer.

* Ifyou see the yellow triangle, the object has been dropped in the viewer.
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* Ifyou delete a previously dropped object from the business process, the
triangle disappears.

Independent Objects Folder

The Independent Objects folder holds objects that do not belong to any
business process. Figure 38 shows an example Independent Objects folder
expanded.

-- Step 4. Outbound sending
423 Independent Objects

- l2ly desktop-collaboration-email-workbin
-2l desktop-draft-workbin

-2l desktop-failed-email-workbin
-2l desktop-pending-external-email-workbin
----- £3 Emaillnbound

----- &9 EmailOutbound

----- £% QueueforDrafts

+-p8] sendaBC_2

--[o@] str_10_Telephone_Company
--[oF] str_7_1 Cable Provider
EEI-- str_classify

-[oF] str_databaze |ookup

-0 str_using_IVR_data
str_using_subroutines

- [oF] strategy3

-] strategyworkBinTest

-] sub_IVR_target

(+-[o8] Updated_3881

- [o8] Vaoice_5551

- [o] Voice_3831

Figure 38: Independent Objects in Object Browser

In order for a strategy of any media (voice and non-voice) to appear in the
Independent Objects folder, two requirements must be met:

* The strategy must be created without using queues and workbins that
belong to a particular business process.

* The strategy must be created outside of the Interaction Design window.
“Created outside” means that in the IRD main window, under Routing
Design, you clicked Strategies, selected New from the File menu, and
created a strategy in the Routing Design window.

Note: Inthe Interaction Design window, you can only create a strategy
under a particular business process, even if you are not using queues
and workbins that belong to a business process.

Business Process—User’s Guide 63



Chapter 3: Business Process Interface

Object Browser

Using drag and drop functionality, you can move objects between the
corresponding subfolders of different business processes, as well as between
the Independent 0bjects folder and appropriate subfolders of business

Processes.

Once a strategy belongs to a business process, it no longer appears in the

Independent Objects folder.

Useful Views Folder

The Interaction Design window object browser includes a folder that is
called Useful Views (see Figure 49 on page 70). It contains the Global View
and the Deployment View. To bring up either view, open the desired business
process. Then right-click either Global or Deployment View in the object
browser and select Show The View from the shortcut menu.

Deployment View

Figure 39 shows the beginning of an example Deployment View.

|-
techpubsd
ZhatServer
B - gk
LIR._Serwer 750 Stat_Serwer_ 750 g
e e i) - 4
Genesys_Integratinn_set:{r'ié'r-._.;:‘._ED E-MailServer
... | tplabhostz

id

Cu:unﬁguratiu:-n_Senrer_?;

Figure 39: Deployment View Example
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In this example, there are two hosts, techpubs4 and tplabhost2. This
simplified view, showing only hosts and certain Applications within the
business process, was created by filtering ApplLications in the Show
Applications tab of the Deployment View Filter dialog box (see Figure 47 on

page 68).
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Deployment View shows how various objects in your Configuration
Environment are deployed and interact. As shown in Figure 39 on page 64,
they are grouped by host. You can print the Deployment View.

Viewing Deployment View Properties

To view the properties for any Application in the Deployment View:, right-click
it and click Properties on the shortcut menu. The resulting properties dialog
box is read-only. Figure 40 shows an example.

The ‘InteractionServer’ Interaction Server Prope |

eneral |

Mame IlnteractiDnS el

Type Ilnteractinn Server

Port |442c| 7 _Solution =]

Belohgz To The Following Solutions:

[

Figure 40: Deployment View, Example Properties for Application

* ForanApplication object (see Figure 39 on page 64), the dialog box gives
the name of the Application, its type, its port number, and the Solutions to
which the Application belongs. Figure 41 shows some example
Application nodes that you can right-click to bring up a properties dialog
box.

8-

Genesys_DesEt’qﬁ"_‘?Eﬂ]

Figure 41: Application Object Examples

* ForaSwitch object, it gives the switch name and type. Figure 42 shows an
example Switch node that you can right-click to bring up a properties
dialog box.

=

Multirnediaz

Figure 42: Switch Object Example
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For a Database Access Point, it gives the name of the DAP, its type, its port
number, and the Solutions to which it belongs. Figure 43 shows an example
Database Access Point node that you can right-click to bring up a properties
dialog box.

Figure 43: Database Access Point Example

* For aHost object, it gives the host name, IP address, and operating
system.Figure 44 shows an example Host node (mkatten) that you can
right-click to bring up a properties dialog box.

.

MILFED

Figure 44: Host Object Example

You can also see the settings for the Deployment View as a whole by
right-clicking Dep loyment View in the object browser tree and selecting
Properties from the shortcut menu (see Figure 45).

The "‘Deployment ¥iew" Properkties A

General |

Current Filker

Show applications from all solutions ;I
Show all application types
Show applications that do not belong o any salution.

[
Define |

Figure 45: Deployment View Properties Dialog Box
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Changing Deployment View Settings

You might want to change settings. For example, you might want to view only
Applications from certain Solutions, only certain types of Applications, or to
reduce complexity by not showing unconnected Applications.

To change Deployment View settings:

1. Click right-click Deployment View in the object browser and select
Properties from the shortcut menu. This brings up the Deployment View
Properties dialog box (see Figure 45 on page 66).

2. Click Define to bring up the dialog box for changing settings (see
Figure 46).

Deployment Yiew Filter X|

-

v Solutions | S how &pplications I

Fabdbd_Solution

¥ Show Applications That Do Mot Belong To Any Solution
¥ Show Mon Connected Applications &nd Switches

k. I Cancel

Figure 46: Deployment View Filter Dialog Box

e The Show Solutions tab lists all the Solutions that are configured in your
Configuration Environment.

* The Show Applications tab lists all the Application types that are
configured there. Figure 47 shows an example.
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Deployment Yiew Filter x|

Chat Server Outbound Cantact Server
Clazzification Server Solution Control Server
Co-Browsing Server Stat Server

Configuration Server T-Server

Contact Server Third Party Server

CFD Server Training Server

D atabaze Access Point niversal Bouting Server
DB Server YWeb APl Server

E-tail Server "W'Fhd Builder

Genesns Generc Server "WER D ata Aggregatar
Genesys Integration Server  WER Server
Interaction Server WM Wb

M ezzage Server

¥ Show spplications That Do Mat Belong Ta Any Solution
W Show Mon Conrected Applications And Switches

F. I Cancel

Figure 47: Deployment View Filter Dialog Box

Default Settings

The default settings are to show all Applications, including those that do not
belong to a Solution, and to show Applications that are not connected to any
other object (see Figure 45 on page 66).

* Ifyouclear the Show Applications That Do Not Belong to Any Solution
check box, only Applications that belong to the Solutions you select are
shown in Dep Lloyment View.

* Ifyou clear the Show Non-Connected Applications check box, only
applications that are connected to another Application or a Switch appear
in Deployment View.

Global View

The second view available in the Useful Views folder (see Figure 49 on
page 70) is Global View.

Global View enables you to see all of the business processes you have created,
the media servers you are using, and the relationships between them. Figure 48
shows an example.
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E’];jﬁﬁi___

Step IJ"

Y
componentt, e B{E
for 2
: EI{E Forwardip

__.-"'Etep 23",
e

inbound
e-rnails

EJ .................................... el E-EE ..

Shep 1. ™. Step 2.2, Step 2.1,
Pre-routing Inbound Processing
collabor ation by agents
reply

——t
S_Egp 3.4
S oA

{ renview

Step 2.1,
MR,
handling

InFarrmation
o

L Producte - _ﬂjf‘ ﬂJ

Cales
-
'Suppnrt Hiow b Huioa o
. apply place the
ErnailSerwerJawa_750 escalation inberaction
procedurs inta the
workbin

Figure 48: Global View Example

These relationships involve exchanges of interactions. Global View shows the
big picture of how interactions are created and handled through the entire
workflow sequence. There can be two arrows from one business process to
another in the Global View, a red one and a black one. The black one means the
business process is passing an existing interaction to the receiving business
process. The red one means it is also passing a new interaction.You can open
any business process in the Global View by double-clicking it.
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Media Servers Folder

By default, the Genesys Multimedia (see page 39) media servers appear as
Media Server objects in a Media Servers folder (see Figure 49).

iH Interaction Design - How to: get credit card number from the e-mai - 10| x|
File Edit Wiew BusinessProcess Tools Help

e BB 0= 2

How ko: handle Fax interactions :I
Howy ko identify conkack and create interaction in LCS
Howy ko place the interaction inko the workhin

How ko: screen mulkiple rules and use screening switct
Skep 0, Common components

Sktep 1. Pre-routing

Step 2.1, MDR. handling

Step 2.2, Inbound collaboration reply

Step 2.3 Mew inbound e-mails

Step 3.1, Processing by agents

Skep 3.2, QA review

Step 3.3, Forwarding @ Submit For credit card numbe
Step 5.4, Redirecting =

Step 4, Quthound sending
[0 Useful Views Inbound e-rnail queus
-423) Media Servers

@ ChatServer\

@ E-MailZerver

@ Emailserverlava_TED

|:| Independent Chjects -

1| | ﬂ; o | _’lll
=

= -
= Configquration Loaded - 0 erroris), 1 warhing(s). =
hd
H [ 4] »[# ] Log £ Corfiguration Updates  #, Search Resulks || 1 I I _bl
For Help, press F1 FLIN | o

Figure 49: Media Servers Folder

For more information, see “Media Server Object” on page 39. Also see “Using
Media Server Objects” on page 252.

Workflow Viewer

The workflow viewer (see Figure 36 on page 61) displays the business process
as a directed graph.
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*  You can drag objects from the object browser and drop them into the
viewer.

*  You specify the interaction flow by connecting the objects.
*  You can reposition the elements as you wish.

*  You can have IRD arrange elements in the viewer by choosing Business
Process > Arrange Objects.

Viewers
The bottom of the Interaction Design window contains the following three
tabs:
* Log
* Configuration Updates

e Search Results

Log Tab

The Log tab displays messages and warnings about business process
configuration (see Figure 50).

| Configuration Loading -
| Submitter 'Submit to Process ABC' ignored: does not reference walid ob
Submnitter 'Submit to Send ABC' ignored: does not reference walid objec
Strategy 'Inbound FPreprocessing' references unexisting Workbin 'EPF_f1
-

Hameszpace information for gqususe 'Agentl' has been updated.

| 4[4[ » [# ] Log A Confgurasion Updates b, Search Resuits / | KN | ¥
For Help, press F1 [ y
Figure 50: Log Viewer

[+

The Log tab contains a running log of events that reflect actions that you have
taken. The following are more examples:

—————————————————————— Configuration Saving ----------====—-—-——--
Error: Queue2 conflicts with existing Data Collection

Configuration Saving Abandoned - 1 error(s), @ warning(s).

Another example:

—————————————————————— Configuration Loading --------=-=====-----
Warning: View 'Outbound ABC1' was assigned to business process 'ABC
Simple BP'

Warning: View 'Inbound ABC1' was assigned to business process 'ABC
Simple BP'

Configuration Loaded - 0 error(s), 2 warning(s).
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Configuration Updates Tab

The Configuration Updates tab displays the status of changes to the
configuration. For example:

—————————————————————————— Connected ------—--------—--—-—-———-
5/24/2004 2:34:47 PM: Queue 'Queuel’ has been deleted from
configuration server

Note: Interaction Design does not automatically reset values that are
modified in Configuration Manager for Queue, View and Workbin
objects. When the option values for these objects are changed in
Configuration Manager, Interaction Design displays the following
message in the Configuration Updates tab:

Interaction <object_name' has been changed. If you want to
accept these changes, refresh workflow.

In order to save changes that are made in Configuration Manage, you
must select Lose the changes and reload configuration in the
Refresh Options dialog box.

Search Results Tab

The Search Results tab displays the result of using Find from the Edit menu
(see page 79). Figure 51 shows the Search Results tab after using Find.

Default
Default
Default
Default
Default
Default
Default
4

BF:
BE:
BF:
BE:
BF:
BE:
BF:

Dueuse 'E-mail failure analvy=is' (E-mail failure analy=is)
Dueue 'Inbound e—mail failure' (Inbound e-mail failure) ]
Dueue 'Collaboration reply failure' (Collaboration reply failw
Dueue 'Termination failure' (Termination failurel)

Dusue 'Preprocessing failure' (Preprocessing failure)
Dueue 'Fedirect e—mail failure' (Redirect e—mail failure)
Dusue 'Forward e—mail failure' (Forward e—mail failure)

| .

[ » [P/ Loo b Condgursson Updsies , Search Results /

Figure 51: Search Results Tab

Viewer Context Menus
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To clear, hide/unhide or dock the viewers (Log, Configuration Updates, and
Search Results), right-click to bring up a context menu in which you can
select Hide (see Figure 52).
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=| [Jarn::Lng I Hame=space informat I!.Dn for gueus ' de&ktup—failgd—emai l—wurkhin;l

H| Wazrning Copy. formation for gueuse 'desktop-pending—exzternsl-smns
Configu: clear — [ erroris). 17 warningi(=). TI
|4 k| v Allow Docking Updates A\ Search Resuls f | KNI

For Help, press F - T 4

Figure 52: Viewer Context Menu

To redisplay, select Log from the View menu.

The menu bar (see Figure 36 on page 61) contains File, Edit, View, Business
Process, Tools, and Help menus.

File Menu

The File menu contains the commands and keyboard shortcuts that are shown
in Figure 53.

File
Refresh F5
Save Chrl+5

Impaort...
Export...

Brint. .. Chrl+F
Frint: Preview
Print Setup...

Close

Figure 53: File Menu

Refresh Select to reload the Tenant's configuration information from
the Configuration Database. If you made changes and did not
save them, you will see the dialog box that is shown in
Figure 54.
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W arningl

Current configuration has been changed.
You heed to choose how ta refresh it

¥ Save it and then refresh

" Load only new objects

{~ Lose the changes and reload configuration

] I Cancel

Figure 54: Refresh Dialog Box

Warning! If you select the Lose the changes and reload configuration
radio button, a refresh occurs, but you lose any unsaved work.

Save Select to save everything (not just the current business process)
in the Configuration Server database.

Warning! The workflow viewer shows the current configuration as it exists in
a temporary buffer. To make the current editing session changes
permanent, you must use the Save command from the Fi Lle menu. If
you exit without saving your edits, you lose them.

Export Select to open the Export dialog box. Figure 55 shows an
example completed dialog box.
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Export x|

Chooze Buzinezs Proceszes to export

Buzinezz Processes ﬂ
How to: apply escalation procedure

Howe to: attach classification categories and use attach categories obje
How to: attach classification categones and use mult-zcreen object
How to: get credit card number from the e-mail

How to: handle fax interactions

Howe to: identify contact and create interaction in JCS

How to: place the interaction into the warkbin

How to: gcreen multiple ules and use screening switch

Step 0. Comman components

Step 1. Pre-routing

Step 2.1. MDR handling =
1| ' |

Shart Comments

ISths difference between manual and automatic attachment of categorie

Inta The File:
ID:'\.M_I,I DocumentshUR7_NEWAST.2_DocshCategones.w

] LCancel

Figure 55: Export Dialog Box

For more information, see “Exporting a business process” on page 307.

Import Select to open the Configuration Import Wizard. (see
Figure 56).
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Configuration Import Wizard x|

Chooze File
Chooze file to impart configuration from E'EE

File

|| Browsze. .

YWhere to put strategy BEM files

[T Into Databaze  [|Mwmkattenal_KattenhGenesys_ S oftwarehGCT I\ nteractio Browse...

Log [only if you need i)

I Browsze. .

N1l

Back I et I Cancel

Figure 56: Configuration Import Wizard

Use to import a business process that was saved using the Export command
For more information, see “Importing a business process” on page 310.

Printing a Business Process

Print, Print Preview, Print Setup

Using these Windows-standard menu selections from the File menu, you can
print and print-preview the business process view seen in the Interaction
Design window.

Note: To enable Print and Print Preview, first select any object in the
business process.

Procedure:

Printing large business processes

Purpose: To print a business process that is too large to fit on one page.
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Start of procedure

1. First try Zoom Out from the View menu before printing.

If the business processes still does not fit on a single sheet of paper, you
can print each area of the business process on a separate sheet of paper and
then place the sheets together. For example, assume that you want to print
the Default BP business process that is shown in Figure 340 on page 388.

2. Select any object in the business process.
3. SelectPrint Preview from the File menu.

The resulting dialog box contains a page for each area of the business
process. In the example in Figure 57, the first print preview shows pages 1
and 2.

I Interactson Design - Default B9 =] =]

[CEWE ] tieiPage | oo | GraPage | Zomin | o] Qe |

Pasjei 1-2 =l

Figure 57: Print Preview of a Business Process (Pages 1 and 2)

3. Move the scroll bar on the right to view pages 2 and 3 (see Figure 58).
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Figure 58: Print Preview of a Business Process (Pages 2 and 3)

4.

Continue moving the scroll bar (or click Next Page in the Print Preview
dialog box). You will see that this particular business process encompasses
eight pages.

Use Zoom In inthe Print Preview dialog box to get an enlarged view. This
option only prints the current page.

Click Print inthe Print Preview dialog box that is shown in Figure 57 on
page 77.

Place the printed pages together to view the entire business process.

If necessary, use Namespace Relative (see Figure 73 on page 89) in the

Options dialog box to show the manually-edited name of an object, instead
of the object’s Script name in the Configuration Database.

End of procedure

The strategy interface has a similar functionality.

Edit Menu

Note: You cannot create a copy of a business process or save a business

process under another name.

The Edit menu contains the commands and keyboard shortcuts that are shown
in Figure 59.

78
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Edit Menu

Interaction Design - How to: attach classificaktion
Filz | Edit Miew Business Process Tools Help
Jq:' Inda Cerl+2 p@ |§| ?
A Bedo Gkl E
— ';IEI ..... -
w End ChhF [——‘ il
H - _ Freprooezdng
" BB SII'I'IFI|E! EP Kallure
[+-{sig| ABC Simple Chat BP

Figure 59: Edit Menu

Note: Menu wording can change depending on the action that is selected.

Undo Switch to Business Process <action>

Redo <action>

This menu item starts out as Undo. Depending on the type of
edit you made, this wording changes.

It changes to Undo Creating after you select New <object> from
the Business Process menu, but before you edit the item name.
Select this option to remove the new item from the object
browser so you can start over.

After you delete an object in the workflow viewer, the wording
changes to Undo Hide. Selecting this command puts the deleted
item back in the viewer.

After you disconnect an object in the workflow viewer, the
wording changes to Undo Hide. Selecting this option restores the
deleted connection.

Select Redo Updating after using Undo Updating to return to the
current edit.

Warning! After selecting any of the preceding commands, save the business
process. After you select an Undo or Redo command, the object
browser shows the edit, which exists only in a temporary buffer. To
make the change permanent, you must save the business process.

Find

Business Process—User’s Guide

Brings up the Find dialog box (see Figure 60).
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View Menu

Find

X

Emwmm

v Match Case
¥ Substring Search

In Element's
V' Mamespace Belative Mames

¥ Configuration Dbject Mames

Wwharkflov Elements
v Shategies
¥ Queues

WV iews
W wiorkbing

] I Cancel

Figure 60: Find Dialog Box

For more information on using Find, see “Search Results Tab”

on page 72.

View Menu

The View menu contains the commands and keyboard shortcuts that are shown
in Figure 61.
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Wi

v Ohject Browser
Properties

v Log

v Toolbar
v obatus Bar

aarid
Page Lavout

Zoorm In +
Zoam Ok =
Zoom Morrmal

Figure 61: View Menu

Object Browser

Properties

Log

Select to hide the object browser and enlarge the workflow
viewer area. Reselect to redisplay the object browser.

Select an object in the object browser and select Properties to

open the properties dialog box for the selected object.

Select to hide the log viewer from view. Reselect to redisplay

the log viewer.
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Toolbar

View Menu

Select to hide the toolbar from view (see Figure 62).

| B A aaE & 2

Figure 62: Toolbar

Status Bar

Grid

Page Layout

Reselect to redisplay the toolbar.

Select to hide the bottom status bar from view. Reselect to
redisplay this bar.

Select to remove the grid lines in the workflow viewer and set
a white background. Reselect to redisplay the grid.

Select to display a page indicator line in the workflow viewer.
That line indicates how the workflow viewer display will be
divided between pages when you print it.(see Figure 63).

% Interaction Design - ABC Simple Chat BP =]
File Edit Wiew Business Process Tools Help
¢ B HeHE S| ?

| x

75TechPubsTenant =
ABC Simple BP
ABC Simple Chat BP

Hiows Eos
Step 0. Common compo
Step 1. Pre-routing

Step 2.1, NDR handling

2l

bound
gy

Default BP E
How to: apply escalation

How to: attach classific: L
How to: attach classific: by -
How to: get credit card —1 - ke
Hiow ko handle Fas inte ript
How to: identify contacl ai
How to: place the inter:

screen multiple

4

page layout 4

indicator Iine\
Eﬂ @ Send chat transcript e-mail wiew

Chat . _ J
Send chat transcripk e-mail queoe

Transcripk

Stop

—

Figure 63: Page Layout Indicator

Zoom In

Zoom Out
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Select to magnify the objects in the workflow viewer.

Select to return to the previous magnification. Useful when

printing.
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Zoom Normal

Business Process Menu

Select after using Zoom In more than once to immediately return
objects to normal viewing size.

Business Process Menu

The Business Process menu (when you click inside the object browser)
contains the selections and keyboard shortcuts that are shown in Figure 64.

82

[ew Queues
[t Wiew

Mew Workbin
Add Endpint

Business Process  Tools  Help

Mew Business Process

Mews Strateqy

Delete

Del

Arrange Objects

Figure 64: Business Process Menu

Note: If the selections appear inactive, click inside the object viewer.

New Business Process

New Queue

New View

New Strategy

New Workbin

Add Endpoint

Select to add a new business process. IRD assigns a temporary
name, which you can change (see Figure 196 on page 249).

Select to define a new Queue object. IRD assigns a temporary
name, which you can change (see Figure 205 on page 258).

Select to define a new View object (see Figure 219 on

page 269). Enabled only when a queue is selected in the
workflow viewer or the object browser. IRD assigns the new
view a temporary name, which you can change (see Figure 219
on page 269), and attaches the new view to the selected queue.

Select to define a new routing strategy. See “Strategy
Placeholder Option” on page 299.

Select to define a new Workbin object. IRD assigns a
temporary name, which you can change (see Figure 244 on
page 294).

Select to define a new Endpoint object (see Figure 24 on
page 40). Enabled only when a media server is selected in the
object browser.
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Disconnect And/Or Hide Del

Select to hide/delete the selected object. Confirmation dialog
box does not pop up. Select the action from the Edit menu if
you change your mind.

Arrange Objects

Select to organize and align the business processes in the
workflow viewer. For more information, see “Arranging
Options Tab” on page 91.

Tools Menu

The Tools menu contains the commands and keyboard shortcuts that are shown
in Figure 65.

Tools

Activate Strategy(ies)...
Deactivate Strategylies..
Edit/Miew Strategy...

Options. ..

Figure 65: Tools Menu

Activate Strategy(ies)

Use to load a strategy on a virtual routing point using the
Strategy Activation Wizard (see Figure 66).

Strategy Activation Wizard El

Choosze Interaction Server

Choosze an Interaction Serverz], which will submit interactions to the strategy. E'[E

Interaction Server | Switch |
| nteractions erver kultimedia

™ Do not show this dialog if there is only one server available [choose it automatizally)

Figure 66: Strategy Activation Wizard
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File Edit “iew Tools Help

The Wizard provides a convenient way to create a virtual routing point on the
Switch object for the purpose of loading/activating a multimedia routing
strategy (see Figure 67). To distinguish the virtual routing points automatically
created for multimedia strategies through the Wizard, their names will combine
the prefix asl and the name of the strategy: asl_ <strategy_name). asl stands
for active strategy loading.

;tt Interaction Routing Designer 8.0.000.10 - Server localhost on port 2020

I i = ||mt:rﬂl]1

DT e

=] =l .
Inkteraction Design LDa dl ng

Routing Design

R outing Server | Strateg/Schedule |

Monikaring

Loading

Group Loading

Ewvent Log

az|_Chat inboun... | Chat inbound strategy
az|_Ewpired Caon... | Expired Conference Callbacks
az|_Ewpired Tra... | Ewpired Tranzsfer Callbacks
az|_MMS Inbou... | MMS Inbound Processing

----- az|_Outbound r... | Outbound notification email zend...
az|_Preprocesszi.. | Preprocessing

az|_Procesz AB... | Procesz ABC

az|_Reschedule... | Rezcheduled by Agent
az|_Rezchedule... | Rezcheduled by Custamer
az|_5M5 Inbow... | SMS Inbound

az|_5MS Outbo.. | SM5 Outbound

----- az|_Stop By Ag.. | Stop By Agent

az|_Stop By Cuz... | Stop By Custorer

----- i) Chat request tra... | Chat request tranzcript zend stra...

SErver

SkatServer
InteractionServer

al

ExpartImpart

& Ennnectinnsl & Configuration & Manitoring I

Figure 67: Strategies Loaded on Virtual Routing Points in Loading View
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The Wizard requires that the Interaction Server specify a Switch connection
(see Figure 320 on page 362). If such a connection does not exist, the Wizard
displays a message to this effect.

* For more information, see “Activating Strategies” on page 361.

This section continues with the next item on the Tools menu (see Figure 65 on
page 83).

Deactivate Strategy (ies)
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Tools Menu

Select an activated routing strategy in the object browser to
enable this option. Opens the Deactivate Strategies dialog
box, where you can follow through with strategy deactivation,
unloading it from the routing point, or cancel the procedure
(see Figure 68).

Deactivate Strategies El

Strateqy name

Switch | WRP | riverzal Routing Server |

Inbound e-mail prepr W tultimedia az_Inbound e-mail prepr... UR_Server_TED

Deactivate I Unload Cancel

Figure 68: Deactivate Strategy Dialog Box

Note: You must deactivate a routing strategy before you can access it for

Business Process—User’s Guide

editing or viewing. The icon in front of the strategy in the browser
contains a green triangle that indicates a loaded strategy (see
Figure 69).
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=-£5 Strategies
-- Chat inbound strategy
- Chat request tr.an.scnpt Sénbloaded strategies
[#-{o Chiat send transcript email s
(1] Subroutines -

+1-Joi8| Default BP

+1-0| JoeTest

+1-8i5| post-transition

+1-85| Step 0. Common companents

—:I Step 1. Pre-routing

=55 Queues

----- @ Inbound e-mail failure

i @ Inbound e-mails

(=5 Strategies 4 unloaded strategy

Inbound e-mail preprocessing

------ [C7 Subroutines

Figure 69: Loaded and Unloaded Strategies in Object Browser

Edit/View Strategy...

Tools Menu

Select a routing strategy in the object browser to enable this
Tools menu option. Opens the selected strategy for editing.

If the strategy is already loaded, the menu item is Deactivate

Strategy (ies), which automatically removes the

corresponding virtual routing point along and unloads the

strategy.

Options Select to open the Options dialog box. (see Figure 70).

options x|

I .ﬁ.ppearancel Wwhorkflow S ettings I Arranging I:Iptiu:unsl

¥ FEix Referential Integrity Ermars dutomatically [on load)

[ Remove Unused S ubmitters From Configuration [on save]

Figure 70: Options Dialog Box, Configuration Tab

dialog box.

Configuration Tab

86

Fix Referential Integrity Errors Automatically (on load)

The following options are available from the Configuration tab of the Options
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Remove Unused

Appearance Tab

Tools Menu

Enable this option to allow IRD to assign configuration objects
(such as Queue, View, Submitter, and Strategy objects) to the
same business process, when it judges, during its initial
loading, that referential integrity has been changed.

Disable (clear) this option to forbid the automatic corrections
described above. During loading, IRD notifies you of possible
problems and you must respond manually. Choose if you want
to preserve intentional changes.

Submitters from Confiquration (on save)

If you make changes outside IRD (for example, in
Configuration Manager) a Submitter (see Figure 23 on

page 39) in IRD may become disconnected—and invisible to
the user. When you bring up the business process, you will see
a "Submitter" is ignored... message in the log viewer if this
has happened.

Enable this option to allow IRD to automatically remove
Submitter objects that are invisible and disconnected.
Notification of an automatic removal appears in the log viewer.

Disable this option to prevent this automatic removal of
Submitters.

This section discusses the Appearance tab in the Options dialog box (see

Figure 71).

Business Process—User’s Guide
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Tools Menu

options x|

Configuration

| Whorkflow Settings I Arranging Optiohz I

— Labelz
{* Mamespace Felative
{~ Real Configuration Mames
{~ Buoth
— Fonts
Elements | Tahoma, 8 Change... |
Ezitz | Tahoma, & ﬂl
Log |Courier MNew, 10 Change. .. |

[~ Accurate Printing

] LCancel

Figure 71: Options Dialog Box, Appearance Tab

Labels

The on/off buttons in front of Namespace Relative, Real
Configuration Names, and Both allow objects to have one name
in the Interaction Design window, but a different name in the
Configuration Database, a feature which can be very useful
when you are designing complicated business processes.

For technical background information on this feature, see
“Workflow Object Names” on page 171.

Real Configuration Names

88

Select to have the browser or viewer show the object’s Script
name. Assume that you define a queue that is named Inbound
e-mails1, a view named Inbound e-mails2, save the definitions
as Script objects in the Configuration Database, and then
select the Real Configuration Names button as shown in
Figure 71 on page 88. The objects appear with their
Configuration Database Script names as shown in Figure 72.

Universal Routing 8.1 @



Chapter 3: Business Process Interface Tools Menu

@ I Inbound e-ﬂmai.lsi"

Inbound

z-mailsl

Figure 72: Real Configuration Names

Namespace Relative

Select to have the Interaction Design window show the result
of manually editing a queue, view, or workbin name in the
browser or viewer after the initial save as a Script object in the
Configuration Database.

Assume that you edit the names that are shown in Figure 72
and use the same name (Inbound e-mai Ls) for both the queue
and its view (which Configuration Server does not allow for
Script objects). If you select the Namespace Relative button as
shown in Figure 71 on page 88, the objects appear as shown in

Figure 73.
@ I Inbound =-mails
-
Inbound
e-mails

Figure 73: Namespace Relative

Both Select to show both the decorative and internal Script name
(with the internal name in parentheses).

If you select Both in Figure 71 on page 88, the objects appear
as shown in Figure 74.

@ Inbound e-mails (Inbound e-mails2y
r — : 3

Inbound

z-mails
{(Inbound
z-mails]

Figure 74: Both (Namespace Relative and Real Configuration Names)
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Accurate Printing

When you are printing a business process that contains
overlapping objects, use this option (see Figure 71 on page 88)
to ensure that all object detail prints and tiny white spaces do
not occur.

Workflow Settings Tab

This section discusses the third tab in the Options dialog box, Workf Low
Settings (see Figure 75).

options x|

Caonfiguration | Appearance | workflow Settings I &rranging I:Iptin:-nsl

— Show Strategy Elements
v Targets

v Servers

v Stops

¥ Edges To Subroutines

Figure 75: Options Dialog Box, Workflow Settings Tab

Targets

Enable to have the business process show routing strategy
targets as strategy-linked nodes (see “Strategy-Linked Nodes”
on page 34 and Figure 20 on page 37).

Servers

Enable to have the business process show routing strategy
actions (such as those performed by servers) as strategy-linked
nodes (see “Strategy-Linked Nodes” on page 34 and Figure 19
on page 36).

Stops
Enable to have the business process show routing strategy Stop
Interaction objects as strategy-linked nodes (see
“Strategy-Linked Nodes” on page 34).
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Edges To Subroutines

Enable to remove lines showing connections from strategies to
subroutines. Doing so reduces the complexity of the layout,
making it easier to interpret.

Arranging Options Tab

When you select Arrange from the Business Process menu, IRD uses an
algorithm that arranges nodes in the workflow viewer based on what you enter
in the Arranging Options tab (see Figure 76).

options x|

En:nnfiguraticnnl .-’-‘-.ppearan-:el Wwiarkflow Settings | Aranging Options |

Accounting For Labels
Horizontal [+

Yerltical [+

Spacing Between Banks [pixels]: |54
Spacing Inzide B ank [pixels]: |4Ei

Figure 76: Options Dialog Box, Arranging Options Tab

The fields in the Arranging Options tab (see Figure 76 on page 91) are
summarized below.

Accounting for Labels

IRD places labels above nodes (type) and below nodes (name)
nodes as well as on the right of nodes (for names of views) .
The end result of the arranging algorithm produces compact
picture, but some labels may overlap. You can fix this by
checking the Horizontal and Vertical fields in the Arranging
Options tab.

Horizontal By checking the Horizontal checkbox, you are instructing IRD
to account for horizontal dimension of labels in its arranging
algorithm. In this case, IRD includes the horizontal positions of
labels into the node size calculation, which spreads the nodes
out more horizontally.

Vertical By checking Vertical checkbox, you are instructing IRD to
account for the vertical dimension of labels in its arranging
algorithm. In this case, IRD includes the vertical positions of
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labels into the node size calculation, which spreads the nodes
out more vertically.

Notes: Each rectangular node has a height and width. The default node sizes
are 48x48 (for queue nodes), 64x48 (for strategy and media server
nodes), and 32x32 (for stop, server and agent nodes). If you don’t
check either of the Accounting for Labels checkboxes, IRD defaults
to these sizes.

If the Horizontal and Vertical boxes are both checked, the size of
almost every node will be different (because labels usually have bigger
dimensions than nodes). This spreads out the nodes and produces a
nice looking picture, but of much bigger size.

Spacing Between Ranks (pixels)

Use this field to specify the separation of nodes in adjacent
ranks. Allows you to adjust the spacing of nodes by setting the
number of pixels between one column of nodes and the column
of nodes beside it. Enter any number between 16 and 160.

For a definition of rank, see “Arranging Algorithm” below.
Spacing Inside Rank (pixels)

Use to specify the separation of nodes inside a rank. Allows
you to adjust the spacing of nodes by setting the number of
pixels between nodes in a single column. Enter any number
between 16 and 96.

Arranging Algorithm
When arranging nodes, the arranging algorithm:

*  First assigns ranking numbers. Rank number assignment depends on the
relationship between nodes or, more specifically, it depends on edges
between the nodes.

If two nodes are connected at an edge, the source of the edge will have a
lesser rank than the destination edge. For example, assume:

You have nodes A, B, C and D.

The edge of A is connected to the edge of B.

The edge of A is also connected to the edge of C.
The edge of B is connected to the edge of D.

In this case, the algorithm assigns a ranking of 0 for A, 1 for B and C, and
2 for D.

» After assigning rank numbers, the algorithm arrange nodes in ranks
(levels) in order to minimize edge crossing. Sometimes changing nodes in
a rank will lower edge crossing between nodes in adjacent ranks.
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* Finally, after the relative positions between nodes is calculated (when it is
known which node is left, which node is right, which node is above and
below, and so on), the algorithm gives exact positions to nodes. In this step
it uses the size of nodes and the specified amount of space between nodes
of adjacent ranks and between adjacent nodes in same rank.

Help Menu

The He lp menu contains the commands and keyboard shortcuts that are shown
in Figure 77.

Help
Help Topics

about IRD..,

Figure 77: Help Menu

Help Topics
Displays the Universal Routing 8.1 Interaction Routing
Designer Help.

About IRD

Displays a dialog box containing the Genesys logo, the
software title, version number, copyright notice, and warning.

Shortcut Menus

Figure 78 shows an example shortcut menu when you right-click a business
process in the object browser (not in the currently open business process).
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iE Interaction Design - ABC Simple Chat BP -0 x|
File Edit Yiew Business Process Tools Help
¢ |HH@E | ?
:;I_ZI Y
-- 76_Basic -
+]-{Big ABC Simple BP
SR SHIABC SimplathabRn
Eﬁ QueLes Properties
% Chs Mew Business Process
% Che
£ Che  Activate Strategies
-] Workbir  Deactivate Strategies Chat Server
=19 Strateg _
=Bl che Rename &l l default - @ I Chat ir
FH-eg Che pelete Del
[+-{24g Che ChatServer Chat inbound ¢

BP_Sample,

Hide

Defaul: BP

Haow to: apply escalation procedure
Haowe bo: attach classification cakegaories and
Haow b attach classification cakegories

| || — .

Configuration Loaded - 0 errori(s), 3 warningi(s). -

[ 4T ] Log / Configuration Updates A Search Results / || 1 | | Ll

Figure 78: Browser Shortcut Menu
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The content of the shortcut menus vary, depending on which object you select
in the tree.

Business Process Shortcut Menu

If you select a business process (see Figure 78 on page 94), the shortcut menu
lists:

* Properties (opens the properties dialog box).
* NewBusiness Process (see page 247).

* Open the Process appears if you right-click a business process other than
the one that is currently selected. Use to switch to another business
process. This menu item is not listed when you right-click the active
business process.

* Activate Strategies (see page 83).
* Deactivate Strategies (see page 84).
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Rename highlights the selected object. Click inside the highlighted text and
type the new name.

Delete removes the selected object after a confirmation message.

Allow Docking allows you to reposition the object browser or the log viewer
elements—select the element’s double line in its header and drag. You can
dock an element at different places inside the window, or you can allow it
to float as a separate window.

+ Right-click inside the object browser to display a drop-down menu and
select ALLow Docking to enable (check) or disable (uncheck) this
feature.

+  When Allow Docking is disabled, the element is always a separate
“floating” window.

+  When Allow Docking is enabled (the default setting), you can dock the
element at various locations or create a separate window.

Hide removes the object browser from view. Select 0Object Browser from
the View menu to redisplay the object browser.

Media Servers Shortcut Menu

If you select an item under the Media Servers folder, the shortcut menu lists:

Properties (see the various properties dialog boxes discussed in “Business
Process Objects” on page 27). Reads Properties of if you select it in the
workflow viewer and there are several branches.

Locate (highlights the object in the workflow viewer).
Add Endpoint (see “Adding Endpoints” on page 254).
Allow Docking (see above description).

Hide (see above description).

Queue Object Shortcut Menu

If you select an item under the Queues folder, the shortcut menu lists:

Properties (see the various properties dialog boxes discussed in “Business
Process Objects” on page 27. Reads Properties of if you select it in the
workflow viewer and there are several branches.

Locate (highlights the object in the workflow viewer).
New View lets you create a new view (see page 267).

Rename highlights the selected object. Click inside the highlighted text and
type the new name.

Delete removes the selected object.
Allow Docking (see above description).

Hide (see above description).
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Strategy Object Shortcut Menu

If you select an item under the Strategies folder, the shortcut menu lists:

Properties (see the various properties dialog boxes discussed in “Business
Process Objects” on page 27).

Locate (highlights the object in the workflow viewer).
Edit/View Strategy (see page 86).

Activate Strategy (see page 83).

Deactivate Strategy (see page 84).

Rename highlights the selected object. Click inside the highlighted text and
type the new name.

Delete removes the selected object.

Allow Docking. See description under “Business Process Shortcut Menu”
on page 94.

Hide removes the object browser from view. Select 0Object Browser from
the View menu to redisplay the object browser.

View Object Shortcut Menu

If you select a view under Queue object, the shortcut menu lists:

Properties (see the various properties dialog boxes discussed in “Business
Process Objects” on page 27).

Locate (highlights the object in the workflow viewer).

Rename highlights the selected object. Click inside the highlighted text and
type the new name.

Delete removes the selected object.

Allow Docking. See description under “Business Process Shortcut Menu”
on page 94.

Hide removes the object browser from view. Select 0bject Browser from
the View menu to redisplay the object browser.

Workbin Object Shortcut Menu

If you select an item under the Workbins folder, the shortcut menu lists:

Properties (see the various properties dialog boxes discussed in “Business
Process Objects” on page 27).

Locate (highlights the object in the workflow viewer).

New View. Select to create rules for extracting interactions from workbins as
described in “Adding Workbins” on page 292.

Rename highlights the selected object. Click inside the highlighted text and
type the new name.
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Delete removes the selected object.

Allow Docking. See description under “Business Process Shortcut Menu”
on page 94.

Hide removes the object browser from view. Select 0Object Browser from
the View menu to redisplay the object browser.

Workflow Viewer Shortcut Menus

The menu items that are listed depend on whether an object is selected.

Object Not Selected

If you right-click inside the workflow viewer without selecting an object, the
shortcut menu lists:

New has branches for adding a new queue, workbin, or strategy.
6rid (hides/shows workflow viewer grid lines).

Page Layout (hides/shows workflow viewer page break indicator).
Zoom In (magnifies icons in workflow viewer).

Zoom Out (moves workflow viewer display away from icons).

Zoom Normal (sets workflow viewer to normal zoom).

Object Selected

If you right-click an object inside the workflow viewer, the shortcut menu lists:

Properties of if a Queue or Media Server object is selected. There are
Queve and View branches.

Reads Properties if a Strategy object is selected.

Reads Add Endpoint if a Media Server object is selected.

Locate (highlights the object in the Workflow Viewer).

Edit/View Strategy if a Strategy object is selected.

Activate or Deactivate Strategy if a Strategy object is selected.
New View if a Queue or View object is selected.

Disconnect and/or Hide if a Queue object is selected.

6rid (hides/shows workflow viewer grid lines).

Page Layout (hides/shows workflow viewer page break indicator).
Zoom In (magnifies icons in workflow viewer).

Zoom Out (moves workflow viewer display away from icons).
Zoom Normal (sets workflow viewer to normal zoom).

Bring Forward changes the position (brings forward) of the selected object
relative to the others in the stack. Use for overlapping objects.
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* Send Back changes the position (sends back) of the selected object relative
to the others in the stack. Use for overlapping objects.

* Label/Group for any group of objects or object selected. See “Grouping
and Labels” section below.

Grouping and Labels

You can create a group of objects within a business process and then label it.
This enables you to mark out a set of objects that have something in common.
Figure 79 shows an example.

INITIAL PROCESSING

@ I Lnbound view - "‘EJ 'EJ

ﬁ
E-rnail Skap

Inbound queus Process ABC distribution

Figure 79: Labeled Group of Objects

Procedure:
Grouping objects within a business process

Purpose: To group together a set of objects within a business process either for
visual purposes or to apply the same set of properties to the group.

Start of procedure

1. Select the objects to group by clicking each one as you hold down the
[Ctrl] key. Or hold down the mouse button and select the entire group with
the mouse cursor so they all appear highlighted.

2. Right-click any of the selected objects and select Labe L/Group from the
shortcut menu. The Group Properties dialog box opens (see Figure 80).
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Shortcut Menus

Group Properties

Label

ki

W Has Baorder '&En

* Left
W Muliine =

r
™ Subgraph Bt

* Top
" Bottom

]

Cancel

Figure 80: Group Properties Dialog Box

3. Type the label text into the Label text box.

4. Optionally, you can also perform other operations:

+  You can have the group set off by a border by selecting Has Border.
This check box is selected by default.

+ If you want the text to wrap, select Multi Line. This check box is

selected by default.

+ To have the group actually handled and arranged as a unit, select the
Subgraph check box. When you select Subgraph, Has Border is also

selected automatically.

+ ToAlign, select the radio buttons that set the label where you want it.
You can select either Left or Center and either Top or Bottom. Top and

Left are selected by default.

5. When through in the dialog box, click 0K. The new group, with its label,

appears in the workflow viewer.

* To remove an object from a group, right-click the object and select Remove
from Group from the shortcut menu. To remove a group, you must remove

all the objects from the group.

* To change the properties of a group, right-click the group label and select

Properties from the shortcut menu.

* To add an object to a group, create a new group that includes all the objects

you want grouped.

End of procedure

Business Process—User’s Guide
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Note: You cannot put an object into more than one group. You cannot create
nested groups (where one group contains another group).

Viewer Context Menus

The Log, Configuration Update, and Search Result tabs in the lower portion of
the Interaction Design window also bring up context menus. See Figure 52 on
page 73.

Interaction Design Shortcut Bar
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When IRD starts up, it checks for an eServices (formerly, Multimedia) solution
that was installed by the Multimedia Configuration Wizard. If one is not found,
the main IRD window or the window that is shown in Figure 35 on page 60
does not display an Interaction Design shortcut bar and you cannot open the
Interaction Design window (shown in Figure 36).

Use the following workaround if Multimedia components were manually
configured in the Configuration Database without using the Wizard or if the
Interaction Design shortcut bar does not display.

Procedure:
Displaying the Interaction Design shortcut bar

Start of procedure

1. Loginto IRD as described on page 57.

2. Click to Tools menu and select Routing Design Options.
3. Click the Views tab in the IRD Options dialog box.

4. Uncheck the Default check box.
5

Verify that the following are checked:
e Interaction Design
* Business Processes

6. Click 0K to save your changes.

End of procedure
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Summary

The intent of this chapter is to introduce the business process interface. For
step-by-step instructions on using the interface, see “Creating Business Process
Objects” on page 247.
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Chapter

Strategy Interface

This chapter describes the interface for creating routing strategies that are
contained within business processes. Find step-by-step instructions for creating
routing strategies on page 323.

This chapter includes the following sections:

«  Shortcut Bars in IRD Main Window, page 104

« IRD Menus, page 106

- Reusable Objects, page 115

« Strategy-Building Objects, page 122

«  Routing Design Toolbar, page 123

«  Using the Strategy-Building Objects, page 129

«  Properties Dialog Boxes, page 132

- Building Logical Expressions, page 135

«  Comment Object, page 139

«  Other Design View Operations, page 140

«  Routing Design Options, page 142

« Database Wizard, page 147

«  Defining Variables, page 150

« IRD Security, page 152

Note: The information in this section assumes that you have already installed
IRD, as described in the Universal Routing 8.1 Deployment Guide.

Start IRD, as described on page 58. After you complete the login fields, click
OK, the Strategies list pane opens (see Figure 34 on page 59).

The remainder of this chapter discusses strategy interface elements, both in the
IRD main window and in the Routing Design window.

Business Process—User’s Guide 103



Chapter 4: Strategy Interface Shortcut Bars in IRD Main Window

Shortcut

Bars in IRD Main Window

Note the shortcut bars in Figure 34 on page 59. The shortcut bars access the
various views and objects of IRD.

* Clicking the Interaction Design shortcut bar in Figure 34 on page 59
displays a Business Processes icon on the left. Clicking this icon brings
up the Business Process list pane (see Figure 35 on page 60).

*  Clicking the Routing Design shortcut bar and then a reusable object icon
on the left displays that object’s list pane. For examples, see Figure 91 on
page 116 and Figure 92 on page 116.

* Clicking Event Log followed by Event Viewer brings up Event Log view
where you can see the history of your actions in IRD (see Figure 81).

File Edit Wiew Tools Help

;:.t Interaction Routing Designer 7.6.001.07 - Server techpubs4 on port 3010

ExporkiImport

= = |[sIP76
O I =
ok )
Interaction Cesign
Routing Design Type Date Ti.. | IDv | Source Comment
Monitoring i) Irfor.. | 05417406 08.. | 4. | Routing Desi... | Delete
L) Irfor.. | 05/17/06 08.. 0 | Routing Desi.. | DeleteFile
Ewent Lag B - - -
J) Infor... [08A7A06 03.. |0 | Boutng Des.. | CopyFile
;j) Infor... [05A7A06 08.. |0 | Roubng Desi... | Compiling
;j) Infor.. (0547406 03.. |0 | Boutng Desi.. | CopyFile
;j) Infor... [05A7A06 03.. | 4. | Boulng Desi... | Update
Li) Infor.. | 05A17/06 03 |0 | Routing Desi.. | DeleteFile
Infor.. [08A7A06 03.. |0 | Routng Desi.. | MoveFile
0 | FAouting I... | DeleteFi

Fiouting

Delete file C:\Program Files\GCTI Inkerackion Rooting Designer {4Yimpoartskr
172sortmediaZ.rbn

Dietails I

Figure 81: Event Log
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For log location, see Working Directory (Figure 133 on page 145).
* Clicking Monitoring displays the Loading and Group Loading icons.

Clicking Loading brings up Loading view. Here you can view routing
points (including virtual routing points) and the names of strategies loaded
on those routing points (see Figure 67 on page 84).
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Clicking 6roup Loading brings up a view for loading the same strategy on
multiple DNs.

e  Clicking Export/Import brings up Solution export and Solution import
icons.

Clicking Solution export brings up a view that allows you to export a
group of strategies or subroutines. Figure 82 shows the shortcut menu for
putting an object on a export list.

-

Interaction Cresign SDlLItIDn Expurt 4
R.outing Design M arme ~ | Type Des.. | Add | Add all uzed | Mark uz.. | Selectfor.. | R..
Manitoring ; e ] TAMM_S.
Eventlog | [ . Strateqy W nativel”.rbn)
Export/Impart | [ 7 i Strateqgy

- B Refresh
Solution expart B
— Export
B Wiew expork log
{ |
Solution import B Clear results
B Clear all
= add the object to expart list l
[ Mark used objeck in expark list are' 7a_GCETnteraction Routing
L Add all used objects to export lisk

Select format I

Figure 82: Solution Export View

Note: Strategies and subroutines can be exported using any one of four
formats: archive (*.zcf), native (*.rbn), open (*.xml), and text
(*.kvl) format. All other objects are exported in text (*.kvLt)
format.

You can also use this view to export only objects (routing rules, business
rules, interaction data, statistics, macros, and so on) without the strategies
that use them.

Clicking Solution import brings up a view for importing the results of an
export operation. For detailed information on using these views, refer to
the Universal Routing 8.1 Interaction Routing Designer Help.
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IRD Menus

IRD Menus

File Menu
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Note: The menus below are available in IRD when not working in the
Interaction Design window (see Figure 36 on page 61).

The following menus are available in the IRD main window: Fi Le, Edit, View,
Tools, and He Lp. The current view controls what menu items and enabled and
disabled. The enabled menu items that are shown in Figure 83 are those that
are available when you click the Strategy Design shortcut followed by the
Strategies icon, which displays the Strategies list pane (see Figure 34 on
page 59).

The File menu contains the commands and keyboard shortcuts that are shown
in Figure 83.

File Edit View Tools Help

Mew... Ctrl-+Hd
Open Ctrl+0
Close (S ir( -
SaWE B epfo
Save AS...
[Mesaribe
Backup

Emp
Expaort To File Ctrl+E
Impaort From File Ctrl+I

=

1=

2l
0
m

1

Change password

Exit

Figure 83: File Menu

The File menu includes the following commands:

New

Creates a new object based on the current view.

Note: In order to enable New, you must first select a folder for the reusable

object on the list pane.
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Open

Close

Save

IRD Menus

Opens the selected object. If you select Open when a strategy is
selected, the Routing Design window opens. When other types
of objects are selected (subroutine, routing rule, business rule,

attribute, interaction data), the corresponding dialog box opens.

Enabled when in the Routing Design window. Closes only the
Routing Design window.

If you are creating a new strategy in the Routing Design
window, selecting Save from the File menu opens the Save
dialog box (see Figure 84).

save x|
Storage Location I Config. Layer Locatian |

— Strateqy Mame

— REM File Path

IE:"'.F'ngram FilezhGCT M nteraction Routing Desi _I

™| Stare to database

] I Cancel Help |

Figure 84: Save Dialog Box

Here you can specify the .rbn file save location (see
“Graphical Portion of a Strategy” on page 172). The Script
object save location is the Scripts folder you specify in the list
pane in order to enable New from the File menu.

Note: If you are editing an existing strategy and select Save from the File
menu, the save action occurs, but the Save dialog does not appear.

Save As

Describe

Business Process—User’s Guide

Enabled in Routing Design window. Opens the Save As dialog
box where you have the option of changing the name and/or
storage location for the .rbn file and Script object in the
Scripts folder of Configuration Manager.

Enabled in Routing Design window. Opens the Describe
dialog box where you can add or change the description of a
strategy or subroutine or the input/output parameters of a
subroutine (see Figure 85).
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B

Hame :

ItestE

Dreszcription

Cancel |

Figure 85: Describe Dialog Box

Backup

Restore

Enabled in the Routing Design window. Backs up the current
strategy by creating a version.

Enabled in the Routing Design window. Restores one of the
backup versions of a strategy. You can select which version to
restore.

Restore from temp

Export to File

Enabled in the Routing Design window. Restores a strategy
saved by IRD when the Autosave timer feature is activated (see
Figure 133 on page 145).

Exports a strategy that you have selected in the Strategies list
pane. For another person to view a strategy you have created,
they must have access to both the Script file and the .rbn file
(see “Graphical Portion of a Strategy” on page 172). For more
information, see the section on automatically packaging a
strategy in Universal Routing 8.1 Reference Manual.

Import From File

Imports a strategy file and creates a Script object for a
strategy and its subroutines (if any), business rules, routing
rules, attributes, interaction data, statistics, list objects, and
macros in the Configuration Layer for the strategy. For more
information, see the section on importing a strategy file in
Universal Routing 8.1 Reference Manual.

Print, Print Preview, Page Setup

Using these Windows-standard menu selections, you can print
and print-preview the strategy view seen in the Routing Design
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window. You can print to a PDF file if you have the appropriate
print driver installed.

When printed, some strategies may not fit on a single sheet of paper. In this
case, you can print each area of the strategy on a separate sheet of paper, and
then place the sheets together. For example, assume that you want to print the
Classify customer inquiry att-ct strategy thatis shown in Figure 357 on
page 414.

Procedure:
Printing large strategies

Start of procedure

1. Open the strategy.

2. SelectPrint Preview from the File menu. The resulting dialog box
contains a page for each area of the strategy. The print preview example in
Figure 86 shows the strategy on two pages.

Design - Classify customer inquiry att-ck

Hiext Fage I Frew Fame | One Page | Zoom |n Zomn Hut Cloze

Figure 86: Print Preview of a Strategy (Pages 1 and 2)

3. If'the strategy exceeds two pages, move the scroll bar (or click Next Page
in the Print Preview dialog box) to view the remaining pages.
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Note: Use Zoom In inthe Print Preview dialog box to get an enlarged
view. This option only prints the current page. Use Zoom Out to fit
more on a page.

4. Click Print inthe Print Preview dialog box that is shown in Figure 86 on
page 109.

Note: To avoid printing blank pages, in the Print dialog box, specify the
To and From pages .

5. Place the printed pages together to view the entire strategy. In the Print
dialog box, specify the to and from pages.

6. To get a better idea of interaction flow before printing, use Comment
objects (see page 139) or manipulate 6raph Settings in the Routing
Design Options dialog box (see Figure 127 on page 142).

End of procedure

This section now continues with the next item on the File menu, Change
Password.

Change Password

Brings up a dialog box that allows you to change your
password, which is used to gain access to GUI applications.

Exit Exits IRD if used in the IRD main window. Closes the opened
strategy if used in the Routing Design window. If there are any
unsaved changes in the current strategy, a confirmation dialog
box prompts you to save those changes.

The Edit menu contains the commands and keyboard shortcuts that are shown
in Figure 87.

Edit View Tools Help

This menu includes the following commands:

Undo Reverses the last action. This command is not available for all
actions.
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Redo Repeats the last action. This command is not available for all
actions.
Cut Removes selected objects from the Routing Design window
and moves the objects to the clipboard.
Copy In the Routing Design window, copies selected objects to the

clipboard. This action cannot be undone. You can also copy an
object using a context menu. Note: Copying in the Strategies

list pane cannot be done from the Edit menu.

Paste Creates copies of objects currently in the clipboard.

View Menu

The View menu contains the commands and keyboard shortcuts that are shown

in Figure 88.

Mormal

Zhech Integrity

IT Toolbar
IT Skakus Bar

Split
CbE i

IT Shortcut Bar

Business praocesses
IT Strategies
Subroukines
Routing Rules
Business Rules
Attributes
Interaction Data
Skatistic Data
Schedules
List Ohjects
Macros
Loading
Group Loading
Yiew Log

Solution expork

IT Page Bounds

|v Grid
IT Snap to Grid
IT Angle Snap

Zoom Percent

Zoorm Custom...

Zoom to Fit

Figure 88: View Menu

Note: The View menu appears as one long vertical column, not two columns
as shown in Figure 88. The second group of menu items appears when

the view menu is open from IRD’s Interaction Design window.

Business Process—User’s Guide
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Normal

IRD Menus

When this command is selected, the Check Integrity tool (see
page 354) is de-activated. This is the default setting. The
Normal command functions with the Check Integrity
command to de-activate/activate the Check Integrity tool.

Check Integrity

Toolbar
Status Bar
Split

Output Window

Shortcut Bar
Strategies

Subroutines

Routing Rules

Business Rules

Attributes

When this command is selected, the Check Integrity tool is
activated (see page 354. When activated, all strategies and
objects in IRD are checked with the exception of objects used
in the object browser of the Interaction Design window (see
page 62). As IRD performs the check, no other operation can
be performed. The progress bar indicates the progress of the
integrity checking.

Displays/hides the toolbar.
Displays/hides the status bar.

Splits the active window with a horizontal divider.

When a strategy is open, displays the an output area that
contains the Find in Strategy and Errors in Strategy tabs.
These tabs appear automatically when compiling or checking
integrity.

Displays/hides the shortcut bars (see page 104).

Displays the Strategies list pane (see Figure 34 on page 59).
The Strategies list may also be displayed by selecting the
Strategies icon on the shortcut bar.

Displays the Subroutines (see page 117) list. The Subroutines
list may also be displayed by selecting the Subroutines icon on
the shortcut bar.

Displays the Routing Rules (see page 117) list. The Routing
Rules list may also be displayed by selecting the Routing Rules
icon on the shortcut bar.

Displays the Business Rules (see page 119) list. The Business
Rules list may also be displayed by selecting the Business
Rules icon on the shortcut bar.

Displays the Attributes (see page 118) list. The Attributes
view may also be displayed by selecting the Attributes icon
on the shortcut bar.

Interaction Data

Displays the Interaction Data (see page 119) list. The
Interaction Data Llist may also be displayed by selecting the
Interaction Data icon on the shortcut bar.
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Statistic Data

Schedules

List Objects

Macros

Loading

Group Loading

View Log

IRD Menus

Displays the Statistics (see page 120) list. The Statistics
list may also be displayed by selecting the Statistics icon on
the shortcut bar.

Displays the Schedules (see page 120) list. The Schedules List
may also be displayed by selecting the Schedules icon on the
shortcut bar.

Displays the List 0bjects (see page 121) list. The list may
also be displayed by selecting the List 0bjects icon on the
shortcut bar.

Displays the Macros (see page 121) list. The Macros list may
also be displayed by selecting the Macros icon on the shortcut
bar.

Displays the Loading view (see Figure 67 on page 84). The
Loading view may also be displayed by selecting the Loading
icon on the shortcut bar.

Displays the 6roup Loading (see page 104) view. The Group
Loading view may also be displayed by selecting the Group
Loading icon on the shortcut bar.

Displays the Event Log view that is shown in Figure 81 on
page 104.

Solution export

Displays the Solution export view that is shown in Figure 82
on page 105.

Solution import

Displays the Solution import view that is described on
page 105.

Routing Design Window Menu Items

The following View menu items are only active in the Routing Design window
(see Figure 98 on page 122):

Page Bounds

Grid
Snap to Grid
Angle Snap

Zoom Normal
Zoom Percent

Zoom Custom

Business Process—User’s Guide

Shows the page boundaries.

Displays a grid in the Routing Design window.
Snaps objects to the grid.

Snaps objects on an angle.

Displays the window at 100% zoom.

Zooms the window to a predefined percentage.

Zooms the window to a custom percentage. The allowable
range of integers for entry into the Magnificationz field is 5 to
1500. However, if you need to bring magnification down to
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Tools Menu
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Zoom to Fit

IRD Menus

5%, Genesys recommends you turn off the 6rid menu item.
This prevents a negative impact on IRD performance.

Zooms Routing Design to fit in the window.

The Tools menu contains the commands and keyboard shortcuts that are
shown in Figure §9.

Tools

Cuskornize

Zampile

Zhange Tenank Chrl+T

Riouting Design Options

Load Strateqy

Release Strateqy

Figure 89: Tools Menu

This menu includes the following commands:

Change Tenant

Customize

Opens the Tenant menu. The tenant can be changed anywhere
except in the Routing Design window.

Opens the Toolbars dialog box. Toolbars can be enabled or
disabled except for the menu toolbar.

Routing Design Options

Compi Le

Load Strategy

Opens the Options dialog box (see*“Routing Design Options”
on page 142). The Options command is accessible in the IRD
main window.

Compiles the strategy, displaying progress in the Status Bar
and error messages as message boxes. This command is only
active in the Routing Design window. See page 353 for more
information.

Opens the Select Strategy dialog box. Allows you to load a
voice strategy to the selected routing points (see Figure 67 on
page 84). Use the Strategy Activation Wizard (see Figure 66 on
page 83) for loading multimedia routing strategies on virtual
routing points. This command is only active in the Loading
view (see page 104).

Release Strategy

Releases a strategy from the selected route points. This
command is only active in the Loading view.
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Help Menu

See “Help Menu” on page 93.

Reusable Objects

With IRD, you can define the following reusable objects and data, which any
strategy can then use:

» Strategies * Interaction Data
* Subroutines » Statistics

* Routing Rules * Schedules

* Business Rules » List Objects

* Attributes * Macros

Note: The GUI elements that you can work with are affected by settings in
the View tab of the Options dialog box (see Figure 135 on page 147).

For more detailed information than presented here on reusable objects, see
Universal Routing 8.1 Reference Manual or Universal Routing 8.1 Interaction
Routing Designer Help. Figure 90 shows the buttons for reusable objects in the
left pane of the IRD main window (not all buttons shown).

0O I = &k Buttons for Reusable Objects
=] = -
Inkeraction Design I Stra tegl €S
Routing Design [ Mame ~ | Description Ready Loaded | Access | Trace |;

uﬂ 724 cknowledgement ® RHD %

uﬂ T 2emallprocessing " " RHD

uﬂ F2ProcessOM b b RAHD

uﬂ 7 2zendernail b b RAHD

g 725 PYnice % % RHD

od 72sortmedia X RHD %
: g M — ey
T8 oice " " RHD
Chat inbound strat. . " " RHD
Chat request tranz... " " RHD
Chat zend tranzcrp. .. " " RHD
Clazzify customer i.. | Preliminan customer i | » " RHD
Clazzify customer i... " " RHD
E-mail dizgtribution £... | Distributes interaction... | « " RHD 1
E-mail dizgtribution £... | Distributes interaction... | « " RHD
Forward e-mail pro... | Forwards interactions . | " RHD
Forward e-mail pro... | Forwards interactions . | " RHD

uﬂ Identify Contact ar... b b RAHD

Eﬁu linbonind collaboesb Stratenn that ororess | " " EHM

Figure 90: Reusable Object Buttons (Not All Shown)
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Clicking a button for a reusable object brings up a list of those objects. For
example, clicking Subroutines brings up the Subroutines list (see Figure 91).

"5'| Subroutines o

E

Inkerackion Design

= | Dezcription

Rauting Design

e Checks if an emar happened during...

"
uﬁ New Subrouting b RHD
nﬂ Terminate Interaction | Terminates subzequent interaction ... | » RHD
nﬂ Terminate Interaction st | Terminates subsequent interachion ... | » RHD

|7
Created 5032004 3:15:00 PM by defaulk
S ubroutines Updated 9/7/2005 3:21:00 PM by defaulk

Output parameters:
IMTEGER, LOCAL _result

zedin:
Solution; Redirect e-mail processing
ol T s L S S N

Figure 91: Subroutines List

Similarly, clicking Statistics shows the Statistics list (see Figure 92).

=] =] 9@ |
Interaction Cesign | S tatl 5 tl c 5 i
Routing Design k ame i i
e Callh aiting Fredefi.. | Currenti... | DMAction RHD
i I EN St T e Predefi... | Expected... | DMAction RHD
Interaction O ata Pozitionlnueue Predefi... | Currenth... | DMaction RHD
RStatCallzindusue Predefi.. | CurrentM... | DMAction RHD
AP RStatCallsinTransiti... | Predefi.. | CurentM... | DMNAcon RHD
2 RStatCost Predefi... | Currenth... | DMAchion RHD
Statistics RStatE spectedLBE ... | Predefi.. | LoadBala.. | DMéction FHD
RAStatEspectedLoa... | Predefi.. | LoadBala... | DMachon RHD
“E,;-:; RStatlBEW/TLAS Predefi.. | LoadBala.. | DMaction RHD
= F5tatLoadB alance Predefi... | LoadBala.. | DMAction RHD
Statbgentloading Predefi... | Currenth... | DMAction RHD
StathgentLoading... | Predefi.. | CurentM.. | DMAction RHD
StatdgentDccupancy | Predefi.. | RelativeT... | AgentSt... RHD i
Stathgentedevailable | Predefi.. | CurentM... | AgentSt... RHD
StathgentzBusy Fredefi.. | CurrentM... | AgentSt... RHD
Statdgentzinueue... | Predefi.. | Currenti... | DMAction RHD
Statdgentzinueus... | Predefi.. | CurrentM... | DMACtion RHD
-ﬁ StatdgentsT otal Predefi.. | CurrentM... | AgentSt... RHD ﬂ
Manitoring |
Ewent Lag =
Export/Inpork —— I

Figure 92: Statistics List
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Strategies

Subroutines

Summary information about each reusable object is presented in the following
section. The information includes whether the reusable object applies to
non-voice interactions. Detailed information can be found in Universal
Routing 8.1 Reference Manual and Interaction Routing Designer 8.1 Help.

A strategy is a set of decisions and instructions that tell Universal Routing
Server how to handle and where to direct interactions under different
circumstances (see Figure 28 on page 44).

*  You load a voice routing strategy in IRD Monitoring view by clicking the
Monitoring shortcut (see Figure 90 on page 115) followed by the Loading
or Group Loading shortcut (not shown). In the case of Loading view, you
select the switch and routing point, right-click, select Load Strategy from
the menu, and select a strategy from a dialog box.

*  You load non-voice (multimedia) strategies on virtual routing points (see
Figure 67 on page 84) by using the Strategy Activation Wizard (see
Figure 322 on page 363).

A subroutine (previously called a substrategy) is a strategy called from within
a strategy using the Call Strategy object (see Table 13 on page 209) or another
subroutine. Like a strategy, a subroutine provides instructions to URS on how
to route an interaction. A subroutine can contain any of the IRD objects,
routing rules, or functions, including another subroutine.

* Subroutine names appear in the Subroutines list, instead of in the
Strategies list. You get to this list by clicking the Subroutines icon that is
shown in Figure 90 on page 115.

*  When in IRD’s Interaction Design window, the object browser (see
Figure 36 on page 61) lists any subroutines associated with strategies in a
Subroutines folder.

For more information on subroutines, including the dialog boxes that are used
for subroutine input and output parameters, see Universal Routing 8.1
Reference Manual. The “Business Process Samples” on page 369 include
sample subroutines.

Routing Rules

Used only by voice routing strategies in 7.6, routing rules specify the method
of target selection. Figure 93 shows an example routing rule.
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Attributes
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Load balancing propetties il

General |
Rule's Mame : I Mew Fule |
Fouting Rule |
LoadB alance

LoadE alances

— Detailz

According bo this distibution rule interactions wil be &
distributed between following ACOHueus -

BE0T onthe 7B G3 2

BE0Z2 on the 7A_G3_2

The goal iz to have all agentz in these queues evenly

loaded. ;I
[k, I Cancel | Help |

Figure 93: Example Routing Rule

Many voice Routing objects (see “Buttons for Routing Objects” on page 125)
use routing rules in their properties. These include: Force, Load Balancing,
Percentage. Service Level, Statistics, Switch to Strategy, and Workforce.

The Route Interaction object that is discussed on page 126 does not use routing
rules. Other objects that do not use routing rules are the Default object and the
Routing Selection object (see page 125).

Used mostly by voice routing strategies, attributes are pieces of call or
customer data and all possible values. In order to use each piece of data for
strategy decisions, you must first define each piece of data in IRD as an
attribute. You can then use the attributes to create business rules. Figure 94
shows some example attributes.
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Zlxd :
e || Attributes =

Mame = | Value Description Acoess

att_account_type account ype
"""" val_existing InteractionD ata['account_type'] = '1*
"""" wal_new InteractionD ata[ account_type'] = "2
E-E] att_language cuztomer langu... | RHD
"""" val_englizh InteractionD ata['language] = "1"
"""" val_spanizh InteractionD ataf'language’] = 2

lbrovtines

Figure 94: Example Attributes

Do not confuse attribute reusable objects that you define in IRD with
Configuration Manager Business Attributes that are used by non-voice
routing strategies (see page 161).

Business Rules

Used mostly by voice routing strategies, business rules are created from the
attributes just discussed. Business rules and their attributes enable you to create
logical expressions for segmentation. Figure 95 shows some example business

rules.
T -
el Business Rules 27)
Fing Design Marne = | Yalue Deszcription | Details Aocess I
= Transactions RHD
I_':_I---@_I:ur_e:-:isting_english FHD
----- att_account_type wal_existing InteractionD at. .
b E att_language wal_english |nteractionD at. .

=+ br_existing_spanizh RHO
att_account_type wal_exizting InteractionD at...

wval_spanizh InkeractionD at. ..

Ll

Figure 95: Example Business Rules

The advantage of using them is that they allow you to reuse the same business
decision multiple times in the same strategy and in many different strategies.
See Universal Routing 8.1 Strategy Samples for more information.

Interaction Data

Used by both voice and non-voice routing strategies, interaction data defines
attached data keys used in a strategy (see Figure 96).
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Interaction Cesign

il -4

Raouting Design

Subroutines

Dl mabivem Bllas

Figure 96: Example Interaction Attributes

Statistics

Schedules

120

Reusable Objects

Interaction Data

----- 3¢ account_type .

----- @ language zhring IR attaches customer... | 1.2 1 RHL
----- @ language_na... | string lahguage az zet by DH... | Englis... Englizh | RHD
----- Lger_account | string account number attac... RHO

You define interaction data in order to allow strategies to gather attached data.
You can use interaction data in the following Miscellaneous objects discussed
ahead (see page 126): Assign, If, and Function.

You can define a custom statistic for use in within a strategy or subroutine. Or
you can use or edit one of IRD’s predefined statistics (see Figure 92 on

page 116). For more information, see the chapter on routing statistics in the
Universal Routing 8.1 Reference Manual.

When creating routing strategies that will be called by business processes,
there is one particular predefined statistic that business process designers may
find useful: StatAgentLoadingMedia.

The StatAgentLoadingMedia statistic works like StatAgentLoading with one
difference: StatAgentLoadingMedia returns data about the current media (not
the whole agent). For example, assume Stat Server reports for some agent
vector state:

* voice - one busy agent, one available agent
* e-mail - three busy agents, two available agents
In this case, StatAgentLoading will return four available agents.

StatAgentLoadingMedia, if executed for call with media type of voice, will
return 1; if executed for call with media type of e-mail, will return 3.

For information about calculating the minimum or maximum value of this
statistic, see the E-mail object description in Universal Routing 8.1 Routing
Reference Manual.

Used mostly for voice routing strategies, a schedule instructs Universal
Routing Server when to load/release a specific voice routing strategy
automatically, including the switch and DN to use. You can specify times for
loading and releasing schedules using seconds, minutes, hours, dates, months,
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List Objects

years, and days. After saving, the schedule definition is stored in Configuration
Manager as a Script object of type Schedule. See the Universal Routing 8.1
Interaction Routing Designer Help for more information.

Used mostly for voice routing strategies, a list object contains strings of any
nature (for example, DNIS or ANI strings), which can be used in strategies and
are included in integrity checking. Figure 97 shows an example.

List Objects x|
Fropeties I CME Location |
em x|
M ame IEusinessList Ibem |
. gample of buzineszs li
Drescription M arme stﬂ
— Items W
Ttem Key Yalue
1 VIS 1 Agentaroup VIS4
o (P z BorrowCond sdata[VQ_WISA.Q, Stakc
3 DISCOVER 3 BorrowTargets VISA SKILL=0
2 B 4 LendiCondition sdata[VQ_WISA.Q, SkakC
5 LendTargets VISA SKILL<S
& WirkualQueue WO YISA

Figure 97: Example List Object

Macros

May be used to create lists of toll-free numbers. Rather than reference each
individual 800 number in a strategy, you can logically group numbers together
and name the group. Then, when you need to add/edit numbers, the strategy
does not need changing; you just add to/edit the list object. See the Universal
Routing 8.1 Interaction Routing Designer Help for step-by-step instructions.
For examples of list object use, see the chapter on Share Agent by Service
Level Agreement Routing in the Universal Routing 8.0 Routing Application
Configuration Guide.

A macro is a Miscellaneous object (see page 126) that allows you to combine
several objects and expressions in one re-usable block. This block works as a
user-defined function. IRD supplies the following predefined macros: Delimit
TargetList, ComplexSample, MakeAgentNotReady, RedirectCall,

RedirectCal LMakeNotReady, and SimpleSamp Le. For more information, see
Universal Routing 8.1 Reference Manual.
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Strategy-Building Objects

Besides the reusable objects just discussed, IRD also provides
strategy-building objects. Icons for each object category appear on the objects
toolbar in the Routing Design window when you create or edit a strategy or
subroutine. Figure 98 shows the Routing Design window with only the starting
Entry object, which appears when you start a new strategy.

B8 Routing Design - Sample *

J_ File Edit Wiew Tools Help

I EEIR LN [
Loons for BaeeoBmDed = | e | |
categories  |\[ " T ]

Figure 98: Routing Design Window with Entry Object

When you click an icon in the toolbar that represents an object category,
buttons for all objects that belong to that category drop into view. For example,
if you click the third icon (Segmentation) in Figure 98, buttons for all
Segmentation objects drop into view (see Figure 99).

;:.t Routing Design - Sample *

. File Edit Wiew Tools Help
Segmentation Icon —
\__ﬁ9§§|ééﬁ|%ﬂs|ﬂ| |
$|© § & O eo h =] e | || e
Buttor]for -
Segmentation | =2 E|©| B G|@[@| @l | i
Object - w

Buttons for
Segmentation
Objects

Figure 99: Dropdown Buttons for Segmentation Objects
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Routing Design Toolbar

Figure 100 shows the Routing Design window toolbar for each
strategy-building object category.

;:.ﬁ- Routing Design - Sample *

JJ Filz= Edit “iew Tools Help

|EEE & & e | S 6 ]
@3 © & 65 e ok |[E= ] e | |
| Ay SR A R | ANEMEAN
Treatments~ / / / Outbound \\ SMS
Database Multimedia Workflow and Resource Management
Segmentation Miscellaneous
Routing

Figure 100: Strategy Building Object Categories

Note: When you are working in the Routing Design window (see Figure 114
on page 132), the strategy-building objects toolbar is dockable. It can
be removed from its current position and be placed anywhere within
the Routing Design window.

Object Buttons Associated with Toolbar Icons

Clicking an icon on the toolbar drops down a button bar for placing objects in
your strategy. The next section describes the object buttons associated with
each object category. The object buttons are listed in toolbar order.

Buttons for Treatment Objects

Treatment objects apply to voice interactions. Figure 101 shows the buttons
that come into view when you click the Treatments icon in Figure 100.

B e | 2|t | | 27| | R 20 oo . R B [ ey

Figure 101: Buttons for Treatment Objects

Treatment objects specify an action that is to be performed with the current
interaction, such as playing music for the caller.

The Treatment objects from left to right are the following: Collect digits, Play
announcement, Play announcement and collect digits, Play application, Record
user announcement, Verify digits, Busy, Fast busy, Cancel call, Delete user

Business Process—User’s Guide 123



Chapter 4: Strategy Interface Routing Design Toolbar

124

announcement, IVR, Music, Ringback, Set default destination, Silence, Text to
speech, Text to speech and collect digits, Pause, RAN (Play recorded
announcement). See the section on treatment objects in the Universal Routing
8.1 Reference Manual for more information.

Button for Data & Services

Figure 102 shows the buttons that come into view when you click the Data and
Services icon in Figure 100 on page 123.

5]

B|Ei|@||

Figure 102: Buttons Under Data & Services

* Clicking the first button in Figure 102 and placing the object in your
strategy opens the Database Wizard used for database lookups.

* The second button, External Service, enables you to exchange data with
third party (non-Genesys) process servers that use the Genesys Interaction
SDK or any other server/application that complies with Interaction Server
communication protocol.

e The third button, Web Service, enables you to interact with Web-based
applications outside of Genesys applications.

Note: For more information on the above strategy-building objects, as well as
the strategy-building objects summarized in the pages ahead, see “IRD
Objects Used in Business Processes” on page 201.

Buttons for Segmentation Objects

Clicking the third button on the objects toolbar in Figure 100 on page 123
reveals additional buttons for various types of Segmentation objects (see
Figure 103).

2
od e (o) [ 63 [ [ S

Figure 103: Buttons for Segmentation Objects

Segmentation objects separate incoming interactions and put them on different
paths based on criteria that you select. The buttons from left to right are the
following:

* Generic (dialog box brings up Expression Bui Lder that is shown in
Figure 119 on page 136)
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Date
Time
Day of the Week

ANI (originating phone)
DNIS (number dialed)

Business

Classify (Classification Switch)

Screen

Routing Design Toolbar

Note: The ANI and DNIS objects are intended for voice interactions. The
Classify and Screen Segmentation objects are intended for multimedia

Buttons for Routing Objects

interactions.

Clicking the fourth button on the objects toolbar (see Figure 100 on page 123)
reveals additional buttons for various types of Routing objects (see
Figure 104).

@

(53] % | |5 = | =3 Gh 2 | & & &

Figure 104: Buttons for Routing Objects

Routing objects specify a routing action that is to be performed with the
current interaction, such as connecting a customer to a specific agent group.

The buttons from left to right are the following:

Service Level
Load Balancing
Percentage
Statistics

Switch to Strategy
Default

Force

Selection
Workforce

Route Interaction
Workbin

Queue Interaction
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Note: The Route Interaction, Queue Interaction, and Workbin objects are
intended for routing strategies that are called by business processes.
The remaining objects apply to voice routing strategies.

Buttons for Miscellaneous Objects

Clicking the fifth button on the objects toolbar (see Figure 100 on page 123)
reveals additional buttons for various types of Miscellaneous operations (see
Figure 105).

E |
S BeElEE R E )

Figure 105: Buttons for Miscellaneous Objects

Miscellaneous objects are used for flow control or for performing operations,
such as executing a function or directing interactions that are based on an If
statement. The buttons from left to right are the following:

* Entry (IRD automatically places it as the first object in a strategy)

« Exit
o If
* Assign

* Function

* Macro

*  Error Segmentation
* Call Subroutine

*  Multi-Assign

e Multi-Attach

e Multi-Function

Buttons for Multimedia Objects

Clicking the sixth button on the objects toolbar (see Figure 100 on page 123)
reveals additional buttons for Multimedia objects (see Figure 106).

-1
o | | 3
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Figure 106: Buttons for Multimedia Objects
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The buttons from left to right are the following:
* Stop Interaction

* Acknowledgement

* Autoresponse

* Chat Transcript

* Send E-mail

* Redirect E-mail

¢ Forward E-mail

* Reply from External Resource
* Screen

*  Multi-Screen

* C(lassify

* Attach Categories

*  Create Interaction

e Create E-mail Out

* Create Notification

¢ Create SMS

* Identify Contact

* Update Contact

* Render Message Content
* Find Interaction

* Update Interaction

* Update UCS Record

* Submit New Interaction
* Distribute Custom Event

See Table 8 on page 201 for summary information on these objects.

Buttons for Outbound Obijects

Clicking the seventh button (Outbound) on the objects toolbar reveals
additional buttons to support the Genesys Outbound product including
proactive interaction routing (see Figure 107).

[
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Figure 107: Buttons for Outbound Objects
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The buttons from left to right are the following:
* Add Record

* Do Not Call

* Processed

¢ Update Record

* Reschedule Record

Note: The Outbound objects are designed to be used in strategies that are
configured for proactive routing functionality, which are Open Media
interactions that are processed with the outbound_preview media type.
For more information, see the Genesys 7.6 Proactive Routing Solution
Guide.

Buttons for Workflow and Resource Management
Objects

Clicking the eighth button (Workflow and Resource Management) on the
objects toolbar reveals additional strategy-building objects that enable you to
control certain settings for strategies, Places, and Agents (see Figure 108).

L
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Figure 108: Buttons for Workflow and Resource Management Objects

The buttons from left to right are the following:
¢ Set Multimedia Strategy State

* Set Agent DND State

* Set Agent Media State

* Force Logout

See Table 9 on page 206 for summary information on these objects.

Buttons for SMS Objects

Clicking the ninth button (SMS Objects) on the objects toolbar reveals buttons
used for creating and sending SMS messages (see Figure 109).

i
s

Figure 109: Buttons for SMS Objects
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The buttons from left to right are the following:
¢ Create SMS Out
* Send SMS Out

See Table 10 on page 207 for summary information on these objects.

Using the Strategy-Building Objects

This section explains how you define interaction processing in a strategy by
using strategy-building objects.

Procedure:
Placing an object in a strategy, configuring its
properties, and connecting it to another object

Purpose: To define an interaction processing step within a strategy.

Start of procedure

Using the Generic Segmentation strategy-building object as an example:

1. Click the icon for Segmentation objects to drop down the button toolbar
(see Figure 103 on page 124).

2. Click the button for the Generic Segmentation object on the toolbar (first
button in Figure 99 on page 122).

3. Click inside the Routing Design window (see Figure 98 on page 122) to
place the object inside the strategy.

4. Connect the Entry object to the Generic Segmentation object by
connecting (drawing a line from) the bottom port of Entry object to the left
input port of the Generic Segmentation object.

5. Double-click the Segmentation object in the Routing Design window to
open its dialog box (see Figure 110).
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Generic segmentation properties il

General | New Entry Button

7 K

Segment Expression
1

KI i
oK | Cancel | Hep |

Figure 110: Generic Segmentation Properties Dialog Box: Starting

6. Assign properties in the dialog box. For this object, properties are
expressions created in Expression Bui Lder. To keep things simple, details
on Expression Builder are not included here (but are included in
“Segmenting Interactions” on page 328). Assume, after creating
expressions, that the dialog box appears as shown in Figure 111.

Generic segmentation properties il

General |
ZH K
Segment Expression
1 Bu=zinez=Data[InteractionSubtype] = ‘Inbo
2 Buszinez=Data[InteractionSubtype] = Inbo

Figure 111: Generic Segmentation Properties Dialog Box: Completed

7. Click 0K to close the Generic Segmentation Properties dialog box.

End of procedure
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Next Steps

* The next step is to define the strategy-building object that is to be used
when each expression in Figure 111 is true. For example, you might want
the Generic Segmentation object to send interactions to two different
queues. In this case, you would place two Queue Interaction objects in the
strategy as described on page 337.

*  After this is done, connect the green output ports of the Generic
Segmentation object to the input ports of the Queue objects. At this point,
the strategy would appear as shown in Figure 112.

Figure 112: Example Strategy with Four Objects

Directing Strategy Flow

Typically, a choice-point is represented graphically in a strategy by an object
with one yellow entry port (left side), one red error port (bottom), and one or
more green exit ports (right side).

Note: You can customize port locations and connector shapes in the Routing
Design window by right-clicking an object and selecting Port location
from the context menu. This brings up a dialog box for changing the
location of the input, output, and error (default) ports. For more
information see the Setting Options book in Universal Routing 8.1
Interaction Routing Design Help.

Look again at the Generic Segmentation object Figure 112. This particular
instance has a yellow input port, a red error port, and two green exit ports (see
Figure 113).

green exit ports

red error port

Figure 113: Generic Segmentation Object Ports
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The Generic Segmentation object routes based on the true/false value of
expressions in its properties dialog box (see Figure 111 on page 130). It uses

the ports as follows:

» If'the expression is true, the interaction goes out the
port to the next object.

applicable green side

* Ifthe expression is false (or none of the expressions are true), the
interaction goes out the red bottom port to the next object as described

below.

Figure 114 shows the example strategy after creating objects for the red error

port and connecting them.

PF_flag=InteractionData[GEM . © © . 000010000000

B N [ 'Step L. Pre-routing Inbound E-I:
— " EPE walue '=""& EPF walue!="-1" == - :

Figure 114: Inbound E-mail Preprocessing Strategy

As you can see from Figure 114, a strategy is made up of objects and the

connections between objects. All strategies have an Entry object. The other
objects you choose define the actions that IRD performs, and the connections
that you make between objects define the sequence in which each object is
executed. IRD selects only one connection to follow after handling an object.
For detailed instructions on creating strategies, see “Creating Strategies” on
page 323.

Properties Dialog Boxes

132

When a strategy-building object is in the Routing Design window,
double-clicking the object opens its properties dialog box. Here you can assign
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values to the object’s parameters. The content of the properties dialog box
varies based on the object. Different examples are presented below. Figure 115
shows an example completed properties dialog box for the Route Interaction
object.

Selection properties

Eenerall Busy  Targst Selection |

X|

Agent Group
Zampaign Group
Destinakion Label
Place

Place Group

— Statistics
= Min -
M ame IStaLﬁ.gentaﬁ.vallahle -
' Max
— T argets
i P o4 ¥ Clear Target Timneout j Sec
Type Mame StatServer
1 [Agent Group E-mail D& review g iStak_Server_7a0
2 -
ACDOueue
Agenk

Queue Group

it Rouking Paink

I [skil

e Yariable

Suiitch |

[ urmber I

o]

Cancel

Help

Figure 115: Example Route Interaction Properties Dialog Box

The selectable parameters in properties dialog boxes are object-specific. For
example:

When you use the Route Interaction object that is shown in Figure 115, the
parameters in the Target Selection tab are the routing targets that are

shown in the drop-down menu.

In contrast, when you use the Workbin routing object (see page 292),
targets are limited to Agent, Agent Group, Variable, or SkiLL.

The parameters of some Segmentation objects are logical expressions (see
“Building Logical Expressions” on page 135). Figure 116 shows the
Assign Properties dialog box in which the expression is assigned to a

variable.

Business Process—User’s Guide

133



Chapter 4: Strategy Interface Properties Dialog Boxes

Assign properties x|

General |
— Bxpression

mp_str_skill_level F UDatalga_review_skill_flag] |

Deta Type Mame

Interaction Data | |TangetObjectSelected ;I Add |

Business Attributes Target Selected

All Functions Time )
Calllnfo TimeDifference Verify |
Configuration Qptions Timelndone
Data Manipulation Time Stamp + | - | ! | ® |
Date/Time Translate
List Manipulation | _Zi Variables |

Parameter Value
Key

Retum value type: STRING. This function retrieves the User Data information collected «
from the incoming call, when the caller responds to either the IVR orto an agent. This
user data information is stored on Genesys T-Server throughout the lifetime of the ﬂ

[ ok | cancd | Hp |

Figure 116: Example Assign Properties Dialog Box

Note: See page 150 for information about defining and assigning
variables.

* The properties dialog box for the Function object includes the function
name, parameters and values. Figure 117 shows an example.
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Function properties x|

General |
— Bxpression
I j F |pdate[ga_review_flag, 0] ﬂ
Deta Type Mame
Timelndone - Add
Callnfo Timeout _I — |
Configuration Qptions TimeStamp Verify |
Data Manipulation Translate
Date/Time TRoute
Force Data
List Manipulation I1DatalNT =
Mizcellaneous ;I ;l Variables |
Parameter Value
Key
Value
Retum value type: WOID. This function updates interaction user data. ﬂ

=
[ ok | cancd | Hp |

Figure 117: Example Function Properties Dialog Box

In summary, parameters entered in properties dialog boxes are object-specific
and vary with each object.

Note: Almost every IRD object opens its own properties dialog box. The
exceptions are: Entry, Exit, Default Route, and Treatment Cancel Call,
and a few Function objects.

Building Logical Expressions

The properties of several IRD objects are defined as logical expressions. When
creating a logical expression, you use Expression Builder.
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For example, if you are using the Generic Segmentation object, click the down
arrow that appears when you click under Expression in the object’s properties
dialog box (see Figure 118).

Generic segmentation properties E[

General |

7 K

Segment Expression
1

Figure 118: Generic Segmentation Object Down Arrow

Clicking the arrow that is shown in Figure 118 brings up the Expression
Bui lder. Figure 119 shows the Expression Bui Lder after construction of an

expression.
General |
— Bxpression
BusinessData[Interaction Subtype] = InBoundMDR] ﬂ
— Data
Type Mame Qperator Value
Interaction Data =] [ACDa ﬂ P |incoundNOR
Business Attibutes ActiveServerMame I=
m e — . EPF flag
AN > EPE vl
Calllnfo AngwerCall »= _vale
Corfiguration Options Bearer_apabili 4
Data Manipulation =
Date/Time BusinessDatalMT -
List Manipulation j P I"' | »
Parameter Value | Add I
Key ' i .
Veiy |
a0 [ oR |
Varables |

Figure 119: Expression Builder Dialog Box

Miscellaneous Objects and Logical Expressions

Under the Miscellaneous icon (see Figure 105 on page 126), the If, Assign, and
certain Function objects (see Figure 140 on page 152) all use logical
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expressions. The area for constructing the expression in these objects is the
same as Figure 119 on page 136. Figure 120 shows an example completed If
Expression Properties dialog box.

If expression properties

General I
— Bxpression
_skill_level == min_skill_lzvel N
— Data
Type MName Operator Value
1
Business Attrbutes FromIVRIATA I= T
All Functions GEM_Failure b SKIlIEVE -
Callinfo language = >
Corfiguration Options 4
Data Manipulation = default_level
Diate,/Time mln_sk!ll_lewn.fflel
i i i ga_review_flag
Hﬁhfl?_n_”::l{lamn j ga review skill T
rdd |
Veiy |
ano | oR |
Wariables |

T

Figure 120: If Expression Properties Dialog Box

When placed in a strategy, the true/false value of the expression causes
interactions to take different paths.

* Ifthe expression is true, the interaction goes out the applicable green port
to one object.

» Ifthe expression is false, the interaction goes out the applicable red port to
another object.

Routing Objects and Logical Expressions.

Under the Routing icon (see Figure 104 on page 125), the target Selection and
Route Interaction objects use logical expressions in the form of a skill
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expression. These two objects use the Skill Expressions dialog box, which
opens when you select Ski Ll as a target type and click the arrow under Name.
Figure 121 shows an example Route Interaction Properties dialog box with
a skill expression.

Route Interaction properties El
Interaction Queye  Target Selection |
— Statistice
= Min
i M ame IStatﬁ.gentaﬁ.vailable j
i bax
— Targets
i et ¥ Clear Target Timenutl TI Sec
Type Name StatServer
N |
foent A
Agent Sroup Skill expression properties
Place
|Place Group General |
Skill ;
— Expression
Bondz =6 &% Spanish > & ;I
—Wirtual Queue
™ Use Virtual Queue j
Aliag Data
Guwitch Type MHame O perator Walue
[Skil D= | [ g
Mumtser Statiztic Mewdcoounts _I I=
W arighbles 5 atiskrit B
| Spanish  EEPR
| al Stocks <
T amil L=
Telugu
Tierthandling -
Add |
R

Figure 121: Skill Expression Properties Dialog Box

138

Functions for use in the Function object (see Figure 105 on page 126) that
support skill expressions include CreateSkilLlGroup and Multiskill.

For more information on functions and creating valid expressions, see the
Universal Routing 8.1 Reference Manual.
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Comment Object

Use a Comment object to annotate a strategy. You can insert a comment by
right-clicking anywhere in the strategy and selecting Insert Comments (see
Figure 122).

Figure 122: Insert Comments from Context Menu

A text box appears in the Routing Design window, which you can edit (see
Figure 123).

0

on_

Figure 123: Comments Text Box
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Other Design View Operations

You can perform other operations in the Routing Design window: close
strategy, save strategy, backup, restore from previous version, cut, copy, paste,
print, find, replace, and search. Use the toolbar that is shown in Figure 124.

. Routing Design - Sample *

J File Edit Miew Tools Help
pEse|ppr &ma
ABY ¢ §EB RN \

Close Strategyi/ Cut Copy Peaste Print\ Search
Save Strategy Find and Replace
Backup

Restore From Previous Version

Figure 124: Toolbar: Other Strategy Operations

Procedure:

Searching for text strings

The Search button allows you to search for text strings used in a strategy
including objects, rules, functions, and so on. You can only search one strategy

at a time. Within a strategy, you can limit the search to multiple selected
objects.

Start of procedure

1. Open the strategy from the Strategies list pane.

2. Click the Search button in the toolbar (see Figure 124). The Find dialog
box opens.

3. Type the name of the object into the Find what field. This feature is case
sensitive so type the name exactly as it appears in the strategy. If you only
want to search for an exact match, sclect the Match whole word only
option.

Assume you type empl_id. The Find dialog box appears as shown in Figure
125.
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Find

Fird what: |em|:|l_i|:l | Firud riow

e
[ Match whole ward only

™| Selection Drly

Figure 125: Find Dialog Box

4. Click Find now. The Find in Strategy output window appears below the
Routing Design window and highlights the occurrences of the text string
(see Figure 126).

Searching for empl_id ...

Debug[4927794946,0,0] =1 -» CED[] OOAlways->5SetinPersistentQueues[",",'__STOP__ ' "]SetOutPersistentQueues[","”
Debug[491464974,0,0] =1 & empl_jd 1=" -> Goto[25137324]

Debug[820633569,0,0] =1 -> Assign[empl_id_flag,'GD_OriginalAgentEmployesld]Assign[empl_id, UDatalempl_id_flag]]2
3 occurrence(s) have been found.

| - 0

Find in strategy l Errors in strategy I

| For Heln oress Fi [ [ hog[ | [ A
Figure 126: Objects Highlighted that Contain Text String

5. Double-click the line in the Find in strategy tab that begins with Debug.
The object containing the search item is highlighted in the strategy.

6. Double-click the object to open its properties dialog box and view the text
string.
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7. Move through the list of string occurrences that appear in the list by using
the Enter or Arrow keys on your keypad or the F3 function key. The object
that contains the text string is highlighted as you move through the list.

End of procedure

Routing Design Options

The annotations that are shown in Figure 126 on page 141 are not user-entered
comments. The annotations appear in the Routing Design window when you
select Routing Design Options from the Tools menu and set the Graph
Settings tab as shown in Figure 127:

Routing Design Options El

Graph Settings | Storage Settings | Default font | Yiews |

[ iShow Properties On Do

[+ Shaow Conditionz On Graph
[~ Shaw Manitar Label: On Graph

¥ Show Description of Objects On Graph

™ Round angle connections

] I Cancel Help

Figure 127: Graph Settings Tab

Note: The Routing Design Options dialog box applies to the Routing Design
window (see Figure 98 on page 122). IRD does not use it for the
Interaction Design window (see Figure 36 on page 61), which has its
own options dialog box (see Figure 70 on page 86).

Use the Graph Settings tab to more clearly document interaction flow. For
example, assume you wish to review the flow of Chat inbound strategy
discussed in “ABC Simple Chat BP” on page 379.

When you do not check any options in the Graph Settings tab that is shown in
the Routing Design Options dialog box (see Figure 127 above), only the
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manually inserted comment objects (see page 139) appear. Figure 128 shows
Chat inbound strategy with only the comment objects.

Check if
interaction

esp-default-nickname
will be used for

is online

empty Mickname

Offline chat interaction {which could
happen when agent desktop failures
to complete interaction processing)
i to be routed also - e.q. for post
processing

Figure 128: Chat Inbound Strategy with Only Comment Objects

Figure 129 shows the strategy after checking Show Conditions on Graph.

. Check if esp-default-nickname
P

. . .| interaction e will be used for o

E>I IS DnllnE ......... Empt:'l'l NlenamE .................

Offline chat interaction fwhich could
happen when agent desktop failures
to complete interaction processing)
is to be routed also - e.g. for post
processing

Figure 129: Show Conditions on Graph Checked

Figure 130 shows the strategy after checking only Show Monitor Labels on
Graph in the Routing Design Options dialog box.
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Check if
interaction

esp-default-nickname
will be used far

Offline chat interaction (which could
happen when agent desktop failures
to complete interaction processing)
iz to be routed also - e.g. for post
processing

Figure 130: Show Monitor Labels on Graph Checked

Figure 131 shows the strategy after checking Show Description of objects on
Graph.

Check if
interaction
is online

esp-default-nickname
will be used for

application name=TData[Bubmitte dBy'] |:

SHE ..........

| S—

processing

Offline chat interaction (which could
happen when agent desktop failures
to complete interaction processing)
i= to be routed also - e.g. for post

Figure 131: Show Description of Objects Checked

Figure 132 shows the strategy with only Round Angle Connections checked in
the in the Routing Design Options dialog box.

144
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Check if
interaction
is online

esp-default-nickname
will be used for
empty Mickname

Offline chat interaction (which could
happen when agent desktop failures
to complete interaction processing)
iz to be routed also - e.g. for post

processing

Figure 132: Round Angle Connections Checked

This section now returns to the second tab in the Routing Design Options
dialog box. Figure 133 shows the Storage Settings tab.

Routing Design Options El

Graph Settings  Storage Settings | Default fu:untl Wiews I

—Working directony
C:AProgram Files\GLCT M nteraction Routing Desi J

— Autosave timer
v Autozave

[T Compatible strategy saving mode

o]

Figure 133: Storage Settings Tab

Cancel Help
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Working directory

Autosave timer

Keep the default or browse for a new one. This directory
contains log and importstr folders. It can also contain the
following files: import.log (after importing), export. Log
(after exporting), copyas. Log (after save as), and save. Log
(after saving). Temporary strategy/subroutine files reside in the
importstr subdirectory. See the Universal Routing 8.1
Interaction Routing Designer Help if you want more
information on the temporary files in the importstr directory.

Use to automatically save a currently active and open strategy
or subroutine at the indicated interval while the strategy is
being edited. If IRD shuts down or freezes, you can restore the
last edited version of the strategy that was autosaved.

Compatible strategy saving mode

Normally you will leave unchecked (the default). Select only if
you will you want to save a strategy created with IRD 7.6 in

compatible mode so that it can be opened with an older version
of IRD (prior to 7.5). When unchecked, IRD saves the strategy

in a memory-efficient format.

Note: You can also specify a default storage location by Tenant. For details,
see the Universal Routing 8.1 Interaction Routing Designer Help.

Use the Default Font tab to specify the strategy comments font (see
Figure 134).

=
Graph SEttingsl Storage Settings  Default font I\-’iews I
B Snap ITC -]
T Stencil ﬁgllidc
B Syfaen Bold ltalic
H Symboal
H Tahoma
T TechSchool
T TechSchoolCondensed ~Sample
T TechSchoolf stended
T Tempus Sans ITC AaBhCeDd
Times Mew Foman j
[T Undeline T Stike-Out Text Color: | NN |-

Figure 134: Default Font Tab
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Note: If you have a strategy currently open, you must close and re-open the
strategy in order for the change to take effect.

Use the Views tab to specify the IRD GUI elements to display (see
Figure 135).

Routing Design Options El

Graph Settingsl Starage Settingsl Diefault font  Wiews I

=1 [#] Interaction Design -
.. [#] Buziness processes
= [#] Routing Design
- [#] Strategies
- [#] Subroutines
- [#] Rauting Rules
- [#] Busingss Rules
- [w] Asttributes
- [#] Interaction Data
- [w] Statistics
- [#] Schedules hd

ak. I Cancel | Help |

Figure 135: Views Tab

Note: New settings take effect upon IRD application restart.

Database Wizard

Database-driven routing means that an interaction is routed based on
information retrieved from a database. You can build a strategy that instructs
URS to:

* Query a database for any information, including customer name and
language, but also for account level, ID of the last agent who handled the
customer, and so on.

*  Attach this information to the interaction.
* Route the interaction to the appropriate agent.

You use the Database Wizard object (see Figure 102 on page 124) for this
purpose. Figure 136 shows an example voice strategy that uses the Database
Wizard object.
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SELECT samplecustomer. Tier FROM ; —-% @ ;‘L
samplecustomer WHERE : 5

samplecustomer AccountNumber=CustID | | - - - - - - - ...

l T1e.rhand]n1g =0& T1erhand]mg <=3

var_ tler- Flatinum’

uar_her- "Gold

var_tier = "Silver |- - -

Default

Figure 136: Example Database Lookup Strategy

This strategy routes based on the customer’s revenue potential (Customer
Tier). Customers are ranked by importance based on their account number.
Based on its three possible values (PLlatinum, Gold, and Si Lver), the interaction
is routed to an agent with a corresponding skill range.

Figure 137 shows the Database Wizard dialog box that opens when you place
the Database Wizard object in a strategy.
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F

{* Database server

™ Custom server

4

f",-l.-\.l—md‘ Co-DiAD 70

— Select server
I [T Use varables
DB Access Foint | DB Server -
Database_Access_Point_710 L
Routing_DAP routing_dbserver
bnDAP-701

routing_dbserver _Ij
| »

" Procedurs

™ Query

— Select the type of data access expression

< Back Mext = Cancel Help

Figure 137: Database Wizard Starting Dialog Box

Note: To see all the Database Wizard dialog boxes, refer to Universal

Routing 8.0 Strategy Samples. Also see Universal Routing 8.1
Reference Manual.

Summaries of each Database Wizard dialog box are presented below.

After click Next as shown in Figure 137, the next Database Wizard object
dialog box retrieves from the table samp Lecustomer the value of the field
Tier for the record where the field AccountNumber equals the number
contained in the interaction.

The next Database Wizard dialog box constructs the WHERE clause (see
Figure 138).
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F
— Where Expression
lecustomer. Account Mumber=Cust D
— First Operand —Relationy —Second Operand
Tableftable access) o= i~ Tablef.a {* Vanable Edit var |
|| 5| o
Field =05 M
: = =l
I j =
pdd | Delete | Cearal | AND orR | Verify |
— SQL statement
SELECT samplecustomer. Tier FROM samplecustomer WHERE
samplecustomer.Accourt Mumber=Cust D
< Back Next > Cancel | Hep |

Figure 138: Database Wizard, Where Expression

* The next Database Wizard dialog box allows you to specify a sort order.

* The next Database Wizard dialog box gives the option of assigning the
output to a variable or attaching it to the interaction.

* Ifyou elect to assign the output to a variable, the final Database Wizard
dialog box lets you assign the output value to a variable.

Defining Variables

Certain objects allow you to assign values to variables:

150

*  Under the Miscellaneous icon (see Figure 105 on page 126), the Assign,
Function, and Multi-Assign objects assign values to variables.

*  Under the Database icon (see Figure 102 on page 124), the Database

object.
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Defining Variables

Variable List Dialog Box

Use the Variable List dialog box to define variables and to move definitions
of variables used in one strategy to another strategy. Figure 139 shows the
Variable List dialog box with several variables defined.

x

i -

Variable Type Scope
default_level INTEGER LOCAL
_=kill_level INTEGER LOCAL
min_zkill_level INTEGER LOCAL
qa_review _flag STRING LOCAL
qa_review _zkill_flag STRING LOCAL
tmp_=tr_=kil_level STRING LOCAL

Cancel |

Figure 139: Variable List Dialog Box

Bring up the Variable List dialog box as follows:

When working with a strategy, click the Variables button on the
toolbar to bring up this dialog box.

In the Database Wizard object (see Figure 137 on page 149), when you
assign the output or key-value pairs to one or more variables, a dialog box
opens. Here you click the Edit Variables button to bring up the Variable
List dialog box.

In the Generic Segmentation object, click the down arrow in the
Expression column to bring up the Expression BuiLder (see Figure 119 on
page 136). In the Expression Bui Lder, click the Variables button.

Under the Miscellaneous icon (see Figure 105 on page 126), in the
properties dialog box for the If, Assign, or Function objects, click the
Variables button to bring up the Variable List dialog box. The
Multi-Assign object lets you assign multiple variables at once using its
own dialog box.

Using the Function object as an example, Figure 140 on page 152, shows the
output of the Rand function (described in Universal Routing 8.1 Reference
Manual) assigned to the variable min_skill_level.
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IRD Security

General |

Function properties

— Bxpression

min_skill_level F

Rand[101}-1

Deta Type Mame
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Configuration Options PegValue Verify |
Data Manipulation PositioninGueue
Date/Time Print =l
Force Pricrity
List Manipulation Priarity Tunin
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Parameter Value
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specified interval.

Retum value type: INTEGER. This function retum random number in bounds from 1to ﬂ

"I

Figure 140: Function Object Properties Dialog Box

For more information, see “Defining Variables” on page 341. Also see the
section on variables in the Universal Routing 8.1 Reference Manual.

IRD Security

Starting with 7.6, IRD implements an inactivity timeout, which is fully
described in the Genesys 8.0 Security Deployment Guide. This feature requires
re-authentication (logging in again) after a period of user inactivity. The
default period of inactivity is 0 (zero) minutes. To change the default in the
IRD Application object, configure a value for the inactivity-timeout option

152

as described in the Universal Routing 8.1 Reference Manual.

Note: IRD interprets the absence of the inactivity-timeout option or the
setting of its value to 0 (zero) as disabling the feature of application
locking as a result of user inactivity.
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Important Information

* Upon expiration of the value set for the inactivity-timeout option, all
opened IRD windows are hidden (minimized). You are presented with a
re-login dialog box that, for authentication purposes, asks only for a user
password in order to resume the Application session. All other fields are
grayed out since the connection of the IRD Application to Configuration
Server remains active the entire time until re-login.

If you want to end the Application session by pressing Cancel button, on
the re-login dialog box you will be warned that you are about to exit the
Application. To exit the Application, press the Yes button on the Do you
want to close the application? warning message. To return to the
re-login dialog box, press the No button.

* Ifthe administrator changes a user’s password in Configuration Manager at
any time during an IRD session before that user is presented with the
re-login dialog box, the previous password will be required in order to
resume the suspended session.

* In a case where the user changes a password in IRD before the expiration
of the value set for the inactivity-timeout option, then only a new
password will be accepted in the re-login dialog box in order to continue
working with the Application.

* The Interaction Design window (see Figure 36 on page 61) behaves
differently than the Routing Design window in the case where you want to
end the Application session while you have unsaved changes. Unlike
Routing Design, when you press the Yes button in order to close the
Application, Interaction Design provides a message giving the possibility
to save modifications made to a business process prior exiting.

IRD Access Permissions

Make sure that the Person object (see Figure 144 on page 160) for each user
that will access IRD is assigned the required Access Group for IRD. Starting
with 7.6, the Environment and Tenant objects have an option that defines the
access permissions for a new Person object. The default is for a new Person
object to have no access permissions unless you specify assign them in the
Security tab of the Person properties dialog box.

Configuration Manager displays a warning message if you attempt to save a
new Person object without assigning an Access 6roup. Any user without an
assigned Access Group can open IRD, but can only view the IRD GUI. For
more information on configuring Application level security, see the Genesys
8.0 Security Deployment Guide.
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Summary

The intent of this chapter is simply to introduce the strategy creation interface.
You will use it to create the routing strategies that are discussed in “Creating
Strategies” on page 323.
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Chapter

Configuration Layer
Interface

This chapter describes the interface that is used to create Configuration
Manager objects used in strategies. For step-by-step instructions on creating
these objects, see “Creating Configuration Manager Objects” on page 237.

This chapter includes the following sections:

About Configuration Manager, page 155
Environment Folder and Tenants, page 156
Resources Folder, page 158

Scripts Folder, page 159

Business Attributes, page 161

Workflow Object Names, page 171
Graphical Portion of a Strategy, page 172
Setting Permissions, page 173

About Configuration Manager

Configuration Manager is the Genesys software application that enables you to
manipulate your contact center's configuration data and set user permissions
for solution functions and data. Configuration Manager is one of the three
mandatory components of the Configuration Layer:

Configuration Database, which stores all configuration data. DB Server—a
Services Layer component—serves as an access point to the Configuration
Database.

Configuration Server, which:

Provides centralized access to the Configuration Database, based on
permissions that you can set for any user to any configuration object.
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Environment Folder and Tenants

Maintains the common logical integrity of configuration data and notifies
applications of changes made to the data.

As an optional feature, provides support for a geographically distributed
environment.

Configuration Manager.

Note: For information about logging into Configuration Manager, see

page 237

Required Objects

Assuming that you have objects required by Framework and Universal
Routing already configured, additional objects that you might need to define in
Configuration Manager include:

Persons. In addition to an agent, at various points in a business process,
you will want to route an interaction to a supervisor, manager, or QA
member. Before you can select that target in a Strategy object, the target
must first be defined as a Person object in Configuration Manager.

Skills (for assignment to Person objects)

Agent Groups (collections of Person objects)
Places and Place Groups (desks)

Business Attributes (see Figure 146 on page 162).

Table Access (instructions that tie together formats, database access
points, and tables when accessing information in a non-SQL database)

Email Accounts (external e-mail addresses)

Capacity Rules (see “Agent Capacity Rules” on page 164)

Environment Folder and Tenants

Figure 141 shows an example Configuration Manager interface. The right pane
shows the Environment folder; the left pane shows Tenants.

156

Tenants are businesses whose customer interactions are enabled or
enhanced through services offered by a third party, typically a
telecommunications service provider.

From a functional standpoint, each Tenant in a Multi-Tenant environment
is a contact center (single or multi-site) completely equipped to process
customer interactions.

The example in Figure 141 includes three Tenant objects (including
Environment).
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Configuration Manager - default default {default}), Server techpubs4 ¥. 7.6 J

Eile Edit Wew Tools Help
JI_}CDnFiguratiDn j| ?| }é @ ED x D - Ev

P
Wl Folders LContents of ‘WConfiguration’
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) Access Groups Enter text here i
() Action Codes {&Envimnment
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(= Alarm Conditions 4 TechPubs75
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I Applications
[ Business &ttributes
1 Calling Lisks
1 Campaigns
1 DM Groups
1 Fields
[ Filkers
) Formats
) Hosts

) vRs
) Objective Tables

) Persons
" Place Groups
(" Places
T Scheduled Tasks
1 Scripts
i Skills
[ Solutions
o) Statiskical Days
o1 Statistical Tables
I Switches
o1 Switching Offices
) Table Access
) Time Zones

Figure 141: Environment Folder Expanded

The object presentation in Configuration Manager depends on the type of
Genesys configuration environment, which can be:

1. Enterprise (also referred to as Single-Tenant) or
2. Multi-Tenant.

Note: The type of Genesys configuration environment depends on the
operation mode of Configuration Server. You set this mode by
applying either Enterprise or Multi-Tenant installation scripts when
you create the Configuration Database as described in the Framework
8.1 Deployment Guide.
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This guide assumes objects in the Environment folder—including Universal

Resources Folder

Routing Server (see page 49), E-mail Server (see page 51), and Interaction
Server (see page 49) Applications —have already been configured.

Resources Folder

Figure 142 shows folders for resources for a Tenant in a Multi-Tenant

environment.

File Edit Wew Tools Help

Configuration Manager - default default {default}), Server techpubs: ¥. 7.6
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" Configuration
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=
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=) Business &ttributes
1 Calling Lists
) Campaigns
1 DM Groups
) Fields
) Filkers
[ Formats
) IvRs
) Objective Tables
1 Persons
" Place Groups
) Places
1 Scripks
i Skills
=) Statiskical Days
o1 Statistical Tables
I Switches
o Table Access
) Time Zones
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1 Treatments
[ “oice Prompks

Mame

Enter kext here i
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[ Transactions
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Figure 142: Resources Folder, Tenant Selected

Note: A Single-Tenant environment places resources in a folder called

Resources.
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Scripts Folder

When you create a new business process, Queue, View, or Strategy object, the
associated Script file is stored in the Scripts folder in the Configuration
Database (see Figure 143).

Configuration Manager - default default {default}, Server 172.21.27.97 v. 7.6.000.04 on port 5050
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—:' Bu5fness. Attributes ﬁ hat inbound queue Inkerackion Queue
—,I E::Lniiui: ﬁgchat inbound skrategy Simple Rouking
:: Ol Gl:tl*cn?ps ﬁ Chat inbound wvigw Inkeraction Quele
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=) Filters ﬁ hat request transcript send gueoe/Chat re... Interaction Queus
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71 Multimedia?é ﬁchat send transcript email queue Inkeraction Queue
[ Objective Tables ﬁ hat send transcript email queue/Chat send... Interaction Queus
1 Persons ﬁ hat send transcript email quewe/Chat send... Inkeraction Submitts
1 Flace Groups ﬁg[hat send transcript email strakegy Simple Rouking
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196 ahjeck(s) (@ | | oM line

Figure 143: Scripts Folder

Warning! Do not use Configuration Manager to create these Script objects
manually. To ensure internal integrity, use only IRD to create these
objects.
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Viewing Object Properties

box (see Figure 144).

1. Expand the Persons folder to find a Person object.

Scripts Folder

To view an object’s properties, double-click its icon in the right pane. For
example:

2. Double-click a Person object in the right pane to open a properties dialog

Configuration Manager - default default {default}), Server techpubsd ¥. 7.6

i
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Figure 144: Agent Properties Dialog Box, General Tab
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3. Click the Agent Info tab to see any Skills or Capacity Rules that are
assigned to the agent (see Figure 145).

2. 4001 4001 {4001} [techpubs4:3010] Prope EI
General Agent Info I Hanksl .-i'-.nnez-:l SEcurit_l,II Dependenc_l,ll
Default Place: |1 4001 = =
Capacity Rule: Iﬁ Default_EIne_media_allu:uws_mnj ,.&
LCost contract: Iﬁ [Maorne] j _)‘1
Site: Ii' [None] j 4
— Skills
Skil | Level |«
Bonds 10 | |
E Currency 9
Englizh a8
& Engle ° -
addSkil | Ediskil | DeleteSkil |
~ Login D=
Agent Login | Switch | YWiap-up Time |
&b 40m 75 G631 0
sgdiD | EdtiD | Deteld |
El ] I Cancel | Al | Help |

Figure 145: Agent Properties Dialog Box, Agent Info Tab

Note: Sece the Note on page page 72 about updating properties for View,
Queue, and Workbin objects.

Business Attributes

Business Attributes are interaction attributes that are used in different ways
within Genesys. Figure 146 shows the content of the Business Attributes
folder.
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Business Attributes

Configuration Manager - default default {default), Server techpubs4 ¥. 7.6.000.06 on port 3010
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Figure 146: Business Attributes Folder

162

When designing strategies for business processes, you can use the attributes in
the Business Attributes folder (see as follows:

* The If object (see Figure 120 on page 137) and Assign object (see
Figure 116 on page 134) give the option of selecting Business Attributes

when constructing an expression.

*  When using the Function or Multi-Function objects, certain functions use
Business Attributes including Attach, Business Data, Update, and
UpdateBusinessData.

* The Generic Segmentation object (see page 129) lets you select Business
Attributes when constructing an expression.
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Business Attributes

General |
— Expression
BusinessData[CustomerSegment] = ‘gold] ;I
—Data
Type Mame Walue
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Figure 147: Generic Segmentation Object Using Business Attributes

Note: In the above example, the function uses a Business Attribute called
Customer Segment, which can be used to categorize a customer based
on their revenue potential. For example, in the credit card business,
customers are categorized according to their maximum spending limit.
This is indicated by whether the customer has a Platinum (high), Gold
(medium) or Bronze (low) credit card.

* The Multi-Attach Miscellaneous object (Table 8 on page 201) gives the
option of attaching Business Attributes to interactions.

* The Forward and Redirect objects require you to select an E-mai L Account.
* The Classify object requires you to select e-mail Categories.

* The Screen and Multi-Screen objects require you to select Screening Rules
(see page 233).
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Media Type Business Attribute

A frequently used Business Attribute isMedia Type. Figure 148 shows the
Business Attributes and Media Type folders expanded.
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Figure 148: Media Types in Business Attributes Folder

Agent Capacity Rules

Note the agent capacity rule that is assigned to the agent in Figure 145 on
page 161. A capacity rule (which can be assigned at the Tenant (default),
Person (agent), or Place level) defines an agent’s ability to handle
simultaneous interactions of different media types.
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Business Attributes

URS is required to use agent capacity information when routing non-voice
interactions such as those handled by business processes. After defining a
complete set of available agents (taking agent capacity rules into consideration
if configured), URS applies the routing selection criteria specified in the
strategy objects.

Capacity rules reside in the Genesys Configuration Database as Script
objects. By default, the Multimedia Wizard puts capacity rules in a Scripts
folder under the Solutions folder for the Tenant.

Creating a New Capacity Rule

To create a new capacity rule in Configuration Manager, you must have the
Resource Capacity Planning Wizard installed (available on the Real-Time
Metric Engine CD). You can then right-click the Scripts folder and select
Wizard > New > Capacity Rule from the context menu (see Figure 149).

= [ 75MM_Salution
1 75MM_Solution-App

-

[ Arcess Gt gty

ﬁhDBFauII:_One_media_allnws_mu:ure_than_u:une_inter. o
ﬁDeFauIt_‘-.-'u:uice_interactinns_always_allnwed

, ﬁdeskl:u:up-u:u:ullaburatinn-email-queue

ﬁ desktop-collaboration-email-view

[ Action Co

=) Agent Gre [2] Refresh

ﬁ desktop-callaboration-ermail-warkbin

[ Business

[ Calling Lis
[ Campaign
[ DM Group

Cuk

Copy
Faste

ﬁ desktop-draft-queue

ﬁ deskiop-dr aft-view

ﬁ deskiop-draft-workbin

ﬁ desktop-failed-email-queus
ﬁ desktop-Failed-email-view

[ Fields

=) Fiters () Disabls
) Formats 3¢
) I¥Rs

Delete

ﬁ desktop-Failed-email-workhbin
ﬁ desktop-pending-external-email-queus
ﬁ desktop-pending-external-email-view

1 Objective E Properties

ﬁ desktop-pending-external-email-workbin

[ Persons

[ Place Gro Manage Cpkions

FH HH

) Places
[ Scripks
[ Skills
[ Statistical Days
[ Statistical Tables
[ Switches

[ Table Access
[ Time Zones

Wizard

q =] Corfigurs
2 Delete
@ Alarm Deteckion

€3 Alarm Reaction

@ Capacity Rule

) Folder

Caparity Rule
Caparity Rule
Inkeraction Queue
Inkeraction Queue Yig
Inkeraction Wwork Bin
Inkeraction Queue
Inkeraction Queue Yis
Inkeraction ‘Wark, Bin
Inkeraction Queus
Inkeraction Queue Yig
Inkeraction Work Bin
Inkeraction Queue
Inkeraction Queue Yig
Inkeraction Work Bin

Figure 149: Capacity Rule in Scripts Folder Under Solutions

This action brings up the Resource Capacity Planning Wizard (see Figure 150).
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Resource Capacity Wizard x|

Welcome to the
Resource Capaaty Wizard

This wizard helps you configure a Capacity Rule for your contact
center.

A Capacity Rule is a logical expression describing the maximum
possible number of interactions for all applicable media type
combinations that a contact center resource can simultaneoushy
handle.

To continue, click Mext.

¢ Back Finizh Cancel

Figure 150: Creating a New Capacity Rule

At this point, you can create a new capacity rule from scratch or edit an
existing rule.

Note: For more information about creating agent capacity rules, see the

Genesys 8.0 Resource Capacity Planning Guide.

Media Types Available During Agent Login
The Agent Desktop login (Connection) dialog box uses agent capacity rules to

define the media types that the agent can receive. Figure 151 shows an
example agent capacity rule that includes numerous media types.
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Business Attributes
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Figure 151: Example Agent Capacity Rule

Assume that the capacity rule that is shown in Figure 151 is associated with an
agent who is logging in (see Figure 145 on page 161). You can configure the

Agent Desktop Connection dialog box to list:

* All of the media types that are shown in Figure 151.

*  Only certain media types if you edit the multimedia option that is
associated with the Agent Desktop Application object as described later.

Figure 152 shows the Connection dialog box with only a subset of media types

shown.
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Connection

Uzer Mame : 6002
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Figure 152: Dialog Box for Logging In

In order to receive interactions of a specific media type, the agent must check
that media type in the Connection dialog box.

Figure 152 does not list all the media types shown in the capacity rule in
Figure 151 on page 167. This is because you can limit the media types shown
in the Connection dialog box via the media option in the ion Agent Desktop
Application object.

Procedure:
Limiting media types during login

Purpose: To limit the media types that an agent can check in the Connection
dialog box to a subset of the media types associated with the capacity rule.
Start of procedure

1. Open Configuration Manager.
2. Select the Tenant if applicable.
3. Open the Applications folder.
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Business Attributes

4. Open the Agent Desktop Application object (see Figure 153).

¥ Genesys_Desktop_750 [techpubs4:3010] El
Connections | Ophions I Annes I Security I Dependency
General | Tenants I Server Info I Start [nfo
[
I‘I
Mame: |Genesys_Desktop 750 j
Figure 153: Agent Desktop Application Object
5. Click the Options tab (see Figure 154).
¥ Genesys_Desktop_750 [techpubs4:3010] |
General I Tenants I Server Info I Start Info
Connectionz Opticrs I Annex I SecLrity I Dependency
Sectiong j I | D x | E‘ | K D* £
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Enter text here S| Enter test here i
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% co-browse

Figure 154: Agent Desktop Application Object, Options Tab

6. Select the multimedia section and click the icon to edit the section/option

(see Figure 155).
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General I
Connections

Tenants I Server Info I

Optionz

Start Info
I Aniney I SecLrty I Depende

T:ﬁ chat-tref-quels

% multimedia j I | |:| X. | E-‘b =
Mame W alue -
Enter text here 5| Enter text here K
Eﬂ chat-default-quels "78T echpubs nbovund'

‘-:‘E chat-routing-bazed-trsf "agent, queue"’

X

Figure 155: Icon to Edit Section/Option

7.

In the resulting dialog box specify the media types to be shown in the login

dialog box. Figure 156 shows an example completed dialog box that
includes only some of the media types shown in Figure 152 on page 168.
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Option M ame:
[medd

Cption % alue:;

L+
abc

Iemail,n:hat,wu:urkitem,v-:uip,videu:u,cuutbnundpreview

o]

Cancel |

Edit Option X|

Figure 156: Edit Option Dialog Box

Business Attributes

8. Click oK. The media types appear as option values (see Figure 157).

leneral I
Connechionz

Tenantz I

Options

¥ Genesys_Desktop_750 [techpubs4:3010 ﬂ

Start Infa

Server Info I
| Annex I Security I Dependency

% multimedia

2 DX B ® >

Mame

Yalue ﬂ

Enter tewt .. |5

Enter text here

E_b-; email-follow. ..
E_b-; email-follow. ..
'f:g; email-forma...
'-EM, email-never...
Eﬂ, email-never...
‘-:‘M, email-outb....
'f:ﬂ, email-pendi...
E_b-; email-guate. ..

E_b-; email-guate. ..
'f:g; email-reply-...
'-EM, email-routin....
Eﬂ, email-trzf-g. ..

"Fuar!

"On <dater, <perzonals <from: wrote:"
"Fu"

"“fou do not reed to reply ko the message vo.
"Pleaze dizregard message:"

78T echpubz0utbound"

4800

1

"On <dater, <contacts wrote:"

"Fe"

"agent,quaus"

-

“email,chat warkitem, '-.-'n:ni|:|_.'-.-'i|:|Eu:|_.|:u.Jtl:u:ul.Jr'u:Ipr ;

o o]

Cancel Smply Help

Figure 157: Media Option After Adding outboundpreview

End of procedure
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Notes: To ensure proper handling of workflow post-processing features, you
may also wish to set the following option in the Agent Desktop
Application object, outbound section:

preview-park-queue
Values: _STOP__ (default), or any valid Interaction Queue name

For more information, see the section on handling Outbound and
Callback interactions in the Genesys Desktop 7.6 Deployment Guide.

Workflow Object Names

IRD stores business process information as a set of objects in the
Configuration Database where each object corresponds to a business process,
queue, workbin, view, submitter or strategy. Each object is stored as type
Script.

All scripts in the Configuration Database share the same namespace. All
Scripts must have unique names, which means a particular name can be used
only once.

The Interaction Design window avoids this limitation by allowing business
processes to be presented in a way where two different queues may have
equally named views or two different business processes may have equally
named queues or workbins.

This is accomplished by IRD using an auxiliary name (Namespace Relative,
Figure 73 on page 89) for each Script object (which is also a Script object
property). This allows you to reuse names across configurations with IRD
controlling the uniqueness of the auxiliary names in their namespaces.

Note: IRD does not allow you to have equally named views that belong to the
same queue, nor it does not allow having equally named queues that
belongs to the same business process. The only object that must have a
unique name in the whole configuration is a strategy/subroutine.

By default, IRD presents a business process in a way where only Namespace
Relative names are displayed for queues, views and workbins. However, IRD
can present a business process where each element shows its real name in the
Configuration Database or even both. See page 88 for information about the
Real Configuration Names, Namespace Relative, and Both options.

* The Namespace Relative option presents only auxiliary names.

* TheReal Configuration Names option presents names of corresponding
Script objects.

* The Both option shows both names. In this case, if an object has an
auxiliary name different from its real name in the Configuration Database,
the real name will be shown in brackets.
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Graphical Portion of a Strategy

172

The script portion of a strategy and the graphical portion (.rbn file) may be
stored in different locations. For example, while the script file is always stored
in the Configuration Database, the graphical portion (which takes up more
space) may be stored:

* In the Configuration Database in the ird_strategies table if an
initialization script supplied by Genesys created the table.

*  On auser’s local drive.

e On anetwork drive.

Note: If you do not have access to the .rbn file, you will not able to view a
strategy in the Routing Design window.

To view the path pointing to the graphical portion of a strategy:
1. Double-click the strategy in the Scripts folder,

2. In the resulting properties dialog box, select the Annex tab. (If the tab does
not appear, select View > Options from the Configuration Manager menu
and select Show annex tab in object properties.)

3. Select the strategy section.
4. Double-click the path option (see Figure 158).

%: Route e-mail to original agent strat2 [te x|

General Annex |Secunty| Dependenwl

Iiﬁstmteg'_.r jﬁllj ><-|E|'-';"” ':P

F

Mame Value
Entertesd... |5F| Entertest hen
T:Mb*_.'tecnde <Binary Value, Size = 0>

'ﬁgdescriptinn "Makes an attempt to deliver failed interaction t...

1]
o
=1

'-En_h.; location "file"
ab path “mkatten \All_Katten'Genesys_Software™GCT ..

‘-:'ngt'_.rpe "Custom™

Figure 158: Strategy RBN File Path
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Business Attributes that Cannot Be Changed

Warning! Some Business Attributes should never be changed. See the
chapter on interaction properties in the eServices (Multimedia) 8.0
Users Guide for more information.

* For more examples of Business Attribute usage, see the section on e-mail
routing strategies in Universal Routing 8.1 Strategy Samples.

* For information about creating Business Attributes, see page 243.

Setting Permissions

Set permissions by right-clicking an object in Configuration Manager,
selecting Properties, clicking the Security tab and then the Permissions
button to bring up a dialog box. You can then assign types of access to types of
users. Figure 159 shows an example.

Object: Script "4BC Simple Chat BEF*
§ Environmenttdefault Full Contrao
§ TechPubs75\admin_gad Full Contral
ﬁ EnvironmentsS uper Administrators Full Cantral
ﬁ TechPubsz7 S Adminiztrators Special Access(Rx]
ﬁ TechPubz75]sers Special Acoceszs(Rix]
Type of Access: ISpeciaI Aocezs j
] I Cancel | Add... | Remove | Help |
P

Figure 159: Example Object Permission Dialog Box for Agent Group
When you log into IRD, you are granted permissions for objects based on your

group membership and object permissions. An Access tab appears in the list
pane for each IRD object (see Figure 34 on page 59).
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Table 4 describes the types of access.

Table 4: Access Control Types

Access control | Appears in IRD List pane as

type (R=Read, H=Change, D=Delete)
No Access Object does not display

Read R

Change RHD

Full Access RHD

Special Access Depends on the selected option(s): Full Access: RHD; Read:
R; Create: R; Change: RH; Execute: R; Delete: RD Read
Permissions: R; Change Permissions: R; Read and Execute:
R

Note: If you do not have access to the folder where the graphical portion of a
strategy is stored, you will not able to view a strategy in the Routing
Design window. For more information, see “Graphical Portion of a
Strategy” on page 172.

Default of No Access for New Users

Summary

174

Starting with 7.6, the Environment and Tenant objects have an option that
defines the access permissions for a new Person object created in
Configuration Manager. The default is for a new Person object to have no
access permissions unless you specify assign them in the Members of tab of the
Person Properties dialog box. As a result, in order to use IRD 7.6, each
Person object must have one or more Access Groups assigned. Any user does
not have an assigned Access Group can open IRD, but can only view the IRD
GUI. For more information, see the Genesys 8.0 Security Deployment Guide.

The intent of this chapter is simply to introduce the Configuration Manager
interface. You will create Configuration Manager objects later in “Creating
Configuration Manager Objects” on page 237.
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Chapter

Knowledge Manager
Interface

This chapter describes the interface used to create interaction classification
Categories, Screening Rules, Standard Responses, as well as the Field Codes
and Custom Variables that may be used in Standard Responses. For
information about creating these objects, see “Creating Knowledge Manager
Objects” on page 223.

This chapter includes these sections:

- About Knowledge Manager, page 175

«  Categories Tab, page 178

« Field Codes Tab, page 183

«  Screening Tab, page 185

+  Training, Training Schedules, Models, and FAQ Tabs, page 188

About Knowledge Manager

At some point in a business process, you may want to screen an interaction for
certain words or word patterns, analyze an interactions content and assign
Categories, or send a Standard Response. Before you can perform these
functions in a strategy, you must define certain objects in Knowledge Manager
(see Table 5 on page 176).
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Table 5: Knowledge Manager Objects Used for Routing

Knowledge Manager Routing Strategy Object That Uses:

Object

Classification Classify object to automatically classify an interaction with a Category code
Categories based on its content (see Figure 162 on page 180). Once a Category code is

assigned, other types of processing can occur based on the Category code,
such as automatically generating a Standard Response.

Attach Categories object to manually attach classification Categories to an
interaction (see Figure 163 on page 181).

Classification Segmentation object (see Figure 164 on page 181) to cause
interactions to take different paths in the strategy based on an assigned
classification Category.

Multi-Screen object to return Categories associated with Screening rules.

Standard Responses
(which may include
Field Codes and
Custom Variables)

Acknowledgement, Autoresponse, Chat Transcript, Forward E-mail, Redirect
E-mail, Create E-mail Out, Create Notification, and Create SMS objects.

Screening Rules

Screen and Multi-Screen objects for screening interactions for certain words
or word patterns. Once a Screening Rule match occur, you can configure other
types of processing to occur.

Note: The primary difference between screening and classification is that the
result of screening is a Screening Rule name and the value of true or false; the
result of classification (you must have the Content Analyzer option installed)
is a Category Code, which can be associated with a Standard Response or
used for other purposes such as segmentation. For more information, see the
chapter on IRD objects in the Universal Routing 8.1 Reference Manual.

176

After creating these objects in Knowledge Manager and saving the definitions
in the Universal Contact Server Database, the object names carry over to the
Configuration Database.

* The Knowledge Manager objects are then viewable in Configuration
Manager (see Figure 148 on page 164 for an example).

* The Knowledge Manager objects are also selectable in the Strategy objects
that use them (see Figure 365 on page 421 for an example).

Note: For information about logging into Knowledge Manager, see page 223.

Figure 160 shows an example Knowledge Manager with a Category expanded.
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j Knowledge Manager-Content Analyzer: ConfigSeryer Hosk techpubs4; F ;|g|_>=
File Edit ‘iew Tools Help
| (& B X @ ||English - |||TechPut:ns?5 - I
Category Tree Eubcategories of Category books
1 [TechPubsTa] Category Mame | Crer I Dste Modified | Usze in Clazsifica...
Auto Response ﬁ cookery clefault TI2G06 Yes
e Bobs_Books fiiction default 7 I2EG Yes
(= e periodicals  default 7 I2EG Yes
cookery self-help default 7 I2EG Yes
fiction
periodicals Subcategories pane
zelf-help
i3 DsL Service ftached Stahdard Responzes of Category books
i3 rmusic Standa...l Status IDescrip...l Ackno... | Autare. . | Sugges...l Fao I
BDhS—BDDkS_—‘JUI? hook re... [&pproved [generic .. | Active Mo Yes Active I;
Chat Transcript Mok Dick |Anoroved [This res... ING es Active Mo (=
copyofBobs_Books
) . . ftached Rules of Category books
Financial service
Forwarding Matme Rule Body | Addrezses To Match
LanguageDetection? est_rule FegExFind"test") |n:ust-:umer_suppu:ur‘t,tech...
LanguageDetectiond,
Category tree pane Standard Responses pane

- Catedoties | Field Cu:udesl Screeningl Trainingl Training Schedulel Mndelsl F.-E'-.Ql

Figure 160: Knowledge Manager Panes

The Knowledge Manager interface contains the following tabs.
* (ategories

* Field Codes

* Screening

* Training

* Training Schedule

* Models

* FAQ

Note: The first three tabs are relevant to all users of Knowledge Manager
while the remaining tabs are relevant only to users of Genesys Content
Analyzer if that option is installed (see page 50).

Table 6 summarizes each tab.
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Table 6: Knowledge Manager Tabs

Relevance Tab Description

General Categories tab Displays and gives access to Category trees and their
associated Standard Responses. Provides access to the
Standard Response Editor.

Field Codes tab Displays the set of Field Codes and provides access to the
Field Code Editor.
Screening tab Displays the set of Screening rules and provides access to

the Screening Rules Editor.

Genesys Content | Training tab Displays the set of training objects and provides access to
Analyzer only the Mail Editor.

Training Schedule | Displays start time, status, and other information about

tab training objects.

Models tab Displays information about models.

FAQ tab A FAQ object takes Standard Responses and recasts them as

answers to frequently asked questions.

Categories Tab

Note: For more information on Categories than presented here, see the
eServices (Multimedia) 8.0 User's Guide.

Refer back to Figure 160 on page 177 to view the Categories tab with folders
expanded.

Category Codes and Standard Responses

Category trees are integral to the classification functionality of Genesys
Content Analyzer.

* Category trees are a means of organizing and gaining access to the library
of Standard Responses. Each Standard Response must be associated with
one category. One Category can have zero or many Standard Responses
associated with it.

* Content Analyzer can classify an incoming e-mail in terms of the Category
tree.
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You use Knowledge Manager to create Category trees and to create and edit
the associated Standard Responses, as well as the Field Codes that Standard
Responses can contain.

Once Categories are defined in Knowledge Manager and saved in the
Universal Contact Server Database, the object names carry over to the
Configuration Database and are viewable in Configuration Manager (see
Figure 161 and compare it to Figure 160 on page 177).

Configuration Manager - default default {default}), Server techpubs4 ¥. 7.6
File Edit Wwiew Tools Help

b = G
JI_,?EDbs_EiDDks | j| ?|d%|h D|X|:-|' El' 7
1Ll Folders Contents of YConfigurationdEnvironmentBusiness AtiributesiCategory
3 Alarm Conditions ;I Display Marne Default Descripkion
) Application Templates Erter bext here 7| Enter te... |§F] Enter text here
1 Applications Cimusic
= [ Business attributes DAL Service
rfg Business Result Cyhooks

4 Case ID
= h’g Zakegary Structure
= [y Attribute Values
[ Aubo Response
_} EI|:||:|5_EI|:||:||-=:5
) Bobs_Books_July
[ Chat Transcript
) copyofBobs_Books
[ Financial service
[ Forwarding
1 Langquageletectionz
1 Langquageletectionsd
Contact Attributes
hﬁg Zuskomer Segrment

Figure 161: Classification Category Codes

Once the Categories are contained in the Configuration Database, the codes are
viewable in various IRD object properties dialog boxes.

Category Codes in Classify Object and Attach
Categories Objects

The IRD Classify object properties box displays classification Categories that
were originally defined in Knowledge Manager (see Figure 162).
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Classify properties il

General | Fresult |

Clazsification 1 72_ClassificationServer j
Foot tobs Books j

Confidence i) =i 4

— Get clazsified data from
IJzer data key if zpecified:

! =~

Othensize from the variable if specified:

! [

Otheraize from JCS databaze

—Iv &l tree

Categaries:

-] cooker -
-] fiction

-] zelf-help
-] periodicalz
E- ] rusic

- [Jrock

-] izzzandbluss
- [ warld L
- ] classical =

FIncl Canimn
— Subcategones using

= Ho £ Direct |

] I Cancel | Help |

Figure 162: Classification Categories in Classify Object

IRD’s Attach Categories object is similar to the Classify object, but you use it
to manually (instead of automatically) attach classification Categories to an
interaction. Once this is done, one possible use would be to create a strategy
where an If object creates an expression based on the attached Categories. You
could then have interactions take different paths in the strategy based on those
Categories.

Figure 163 shows an example completed Attach Categories Properties
dialog box with Categories selected that were originally defined in Knowledge
Manager.
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Attach categories properties
General |
s g o Root Mame: |Bobs_Books j
Category | % |
1 books.cookery 75
2z books. fiction 75
3 |books.zeli-help 3 7=

1P I i

Ll-l

Categories Tab

Figure 163: Classification Categories in Attach Categories Object

Category Codes in Classification Segmentation Object

You can segment interactions to take different paths in a strategy based on
Categories returned from the Multi-Screen or Classify object. Figure 164
shows an example completed Classify Segmentation Properties dialog box.

General |

Classify segmentation properties

-

Classify by variable

i Root Mame: IEDbs_BDDks

Segment Expression

1

books.cookery

s

books. fiction

i

x|

Carc

Help

Figure 164: Classification Categories in Classify Segmentation Object
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Categories Tab

Category Codes in Acknowledgement and

Autoresponse Objects

The Acknowledgement and Autoresponse objects allow you to select Standard
Responses, which are previously defined in Knowledge Manager. Figure 165
shows an example Acknowledgement receipt properties dialog box where

Standard Responses are selected.

Acknowledgement receipt properties

General |F|:|rmat| Hesultl

" Operation mode

* Email " Dpen Media " B.x Compatible

Email zerver I Emailserverlava_750

[

Cutput queue:
" Get standard response from UserData

IStep 3.1, Proceszing by agents.E -mail

”F Select standard responze or categony

E-mail ackrnowledge receipt

[ Include ariginal message into reply

— Field codes

i P

Key ¥alue

X

| ] I Cancel

Help

Figure 165: Acknowledgement Object With Standard Response

Universal Routing 8.1 @



Chapter 6: Knowledge Manager Interface Field Codes Tab

Field Codes Tab

Note: For more information than presented here, see the section on Field
Codes in the eServices (Multimedia) 8.0 User’s Guide.

Figure 166 shows the Knowledge Manager Field Codes tab.

Knowledge Manager-Content Analyzer: ConfigSeryer Host techpubsd;
Fil= Edit Yiew Tools Help

N % X (2] ||English - I ||Ten:hPubs?5 - |

Field Codes
Matme I Descrigtion | Eiody

contact phone_CORMFOS0205102517 Contact PrimaryPhoneMurmber
subject _COMNFOS0205102517 subject of interaction Irteraction. Subject
agentsig COMFOS0205102517 Agent. Signature
contact name and title_COMFOS020... Contact Title+" "+Contact FullMame
contact phone Contact PrimaryPhoneMurnber
subject subject of interaction Irteraction. Subject
agentsig Agent. Signature
contact name and title Contact Title+" "+Contact Fulllame
Customer name Cortact Firsthame+" "+Cortact Lasth
ShisText =M= Text, contains the text of the SM= 1. Interaction AttachedDatal"SM=Text™)
Customer name_CONFOS1 606161004 Contact Firsthame+" "+Contact Lasth
Orig=h=number Criginal SM= number, contains the arigin... Interaction. AttachedDatar " Orig ShShy
DestShsMumber Destination k= number, contains the 5. Interaction. AttachedDatal"Dest =S
ShSText COMFOS31 06155105 SMS Text, containg the text of the SMS 1. Interaction. AttachedData" SMEText™)
Customer name_COMFOS3106155105 Contact Firsthame+" "+Contact Lasth
Orig=MERumber  COMFOS31 061551 ... Original SMS number, contains the origin... Interaction. AttachedData " OrigSh=RY
DestShMSMumber COMFOS3106155... Destination SMS number, contains the S, Interaction. AttachedData"DestSMER
SMSText COMFOS3T106155105_C0... SMZ Text, cortaing the text of the SMS 1. Interaction. AttachedData" =M= Text")
DestSMSMumber _COMFO91306153... Destination SMS number, contains the S, Interaction AttachedDatal"DestSMEN

Categoties  Field Codes I Screeningl Trainingl Training Schedulel Mu:udelsl F.&.QI

Figure 166: Knowledge Manager Field Codes Tab
The main use of Field Codes is to particularize Standard Responses.

Figure 167 shows a Standard Response that uses the Field Codes
Contact.Title and Contact.FullName.
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Dear =§ Contact Title+" "+ Contact FullMame §=,

hank you faryour request thatwe carry =magazine_names=.
IInfortunately wwe have anly limited shelf space and must carry only periodicals that hawve
above a minimum customer interest.

Sinceraly,
=F Agent.Signature §=

Figure 167: Field Codes in Standard Response

For example, you can use the Field Code <$Contact.FulLName $> in a response
beginning Dear <{$Contact.FullName $>, which you send to dozens of
recipients. In each message, <$Contact.FullName $) is replaced by the full
name of the addressee of the message (the contact) as listed in the Universal
Contact Server database. Figure 168 shows an example completed Edit Field
Code dialog box for a Field Code.

i

Marne: Iu:u:urltact name and title_COMFOS02051 0231 T-'|

Description: I

~Field code variables

System: Anent Signature b In=ert

Clstom: v Insert

Create custom variable

Text: lcartact Title+" "+Cortact FullMarme

Check

Ok Cancel

Figure 168: Knowledge Manager Edit Field Codes Dialog Box
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Field Codes in Autoresponse Object

Once you define Field Codes in Knowledge Manager, the names carry over to
Configuration Manager and are selectable in the IRD Acknowledgement and

Autoresponse Properties dialog boxes by clicking the down arrow (see Figure
169).

Send automated response properkies El

General | F-:urmatl Hesultl

Operation mode
’7 = Email " Open Media " E.x Compatible

Email zerver I Email5erver)ava_750 j

Dutput queue: IStep 3.1, Processzing by agents.E-mail
™ Get standard rezponze from UserData
% Select standard response or category

Iu:u:u:ukl:u:u:uk in shock,

™ Include original message into reply
[T Do nat thread

— Field codes

7H K

Key }/ Yalue

0k I Cancel Help

Figure 169: Autoresponse Object, Displaying Field Codes

Screening Tab

Note: For more information than presented here, see the section on Screening
rules in the eServices (Multimedia) 8.0 User s Guide.
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Screening Tab

Figure 170 shows the Knowledge Manager Screening tab with example

entries.

Categoriss I Figld Codes

=TT
Fil= Edit “iew Tools Help
| % X K] ||English - | ||TechF'ubs?5 - |
Screening Rules
farme I Fule Body | Addresses To Match I Attached Categories I Order |

ridertified transacti... Find("transaction” true) .. Etrors in transactions: 2. 10
Eﬁ Credit card number RegEx<Find"d{d - Tulid}... 10
Eﬁ Wirong transaction &... Find("transaction” truel .. Errors in transactions: 7 ... 10
m Tech suppart [ Fircli "problem true 7| ... 400
m Warranty problem Find "swarranty" true 38 300
Mtest_rule RegExFind"test™ customer_support tech_... | books: 87%; books:87%; 10
m Auto Response &vai... Find("customer support”,.... 200
m Gualty prove Finc("durnb" true || Find... 10
m nidertified transacti... Find("tranzaction” true ... 10
m Credit card number ... RegExFind(™d{4 - Tul{d}:... 10
m Wirang transaction a... Find"transaction” true) ... 10
m Tech suppart_COMNF ... [ Find( "problem true 7| ... 400
m Warranty problem_C.. Findl "warranty” true 18 300
m Auto Responze &vai... Find("customer suppart”,... 200
m Gualty prove_CONF ... Find("dumb” true) || Find... 10

SCreening I Trainingl Training Schedulel Mudelsl F.&GI

Figure 170: Knowledge Manager Screening Tab
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When triggered by a Screen object in a routing strategy, Classification Server
uses Screening Rules to scan an interaction and try to match either an
originating address, a regular expression, or both. Figure 171 shows an
example completed Edit Screening Rule dialog box.
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Edit Screening Rule

Marme: IWru:ung tranzaction amourt

[¥ Enahled Order: |1IZI

—Use these addresses

customer _support
ech_support

wearranty _suppart A

[ Exact address match

% AnD " CoR
~Use pattern

Chooze and add regular expressions and operators between therm:

[Fincics Rd Al | |aa ﬂ Al |

“rind("transactin:nn",truej &8 Find("atmourt" true) && ( Find("wrong" true) || Find("differert"” true) || Find("doesn't match",;

Search for pattetn in message's ¥ Subject v Body ¥ Header

I Merge sources checked above

—iCategories
Add Root categary | Category | Relevancy
Financial zervice |Err|:|rs in transactions |T5
Delete

Test against whole database

~Test messages

Subject
Al newy e

Celete

Test rule

Figure 171: Knowledge Manager Screening Tab
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Note that a Screening Rule is associated with a Category and a Category is
associated with a Standard Response (see Figure 160 on page 177). Once you
define Screening Rules in Knowledge Manager, they carry over to the Genesys

Configuration Database and become selectable in the IRD Screen object (see
Figure 172).

Screen properties il

General | Fresult |

Clazzification I

Language: I Englizh

L L Lo

Screening rule:

Auto Responze Available
Credit card number
Cluality prove

Tech support
Unidentified transaction
' arranty problem

Ywrong tranzaction amont

] I Cancel Help

Figure 172: Screen Object Showing Available Screening Rules

After an interaction is screened, you can use the Screen Segmentation object to
have interactions take different paths in a strategy based on screening results
(see Figure 375 on page 431).

Training, Training Schedules, Models, and
FAQ Tabs

The last four tabs are relevant only to users of Genesys Content Analyzer and

are not shown. For details, see eServices (Multimedia) 8.0 Knowledge
Manager Help.
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Summary

The intent of this chapter is simply to introduce the Knowledge Manager
interface. You will use Knowledge Manager later as described in “Creating
Knowledge Manager Objects” on page 223.
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Part

Creating a Business
Process

Part Three of this Universal Routing 8.1 Business Process User s Guide
provides information that you will need to create a business process, including
information for the planning and preparation stage.

The information in Part Three is divided into the following chapters:

Chapter 7, “Planning a Business Process” on page 195.

Chapter 8, “Creating Knowledge Manager Objects” on page 223.
Chapter 9, “Creating Configuration Manager Objects” on page 237.
Chapter 10, “Creating Business Process Objects” on page 247.
Chapter 11, “Creating Strategies” on page 323.

Chapter 12, “Using a Business Process” on page 361.

Summary of Entire Process

This section summarizes the entire process of creating a business process. It
includes the planning stage and creating the objects that must exist prior to
creating the business process in IRD’s Interaction Design window.

Table 7 summarizes the steps that are required.
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Summary of Entire Process

Table 7: High Level Steps to Create/Load a Business Process

Objective

Related sections and procedures

1.

Determine the interaction life
cycle at your contact center.

Review a simple interaction life cycle: See “Basic Interaction
Life Cycle” on page 195.

Review a more complex interaction life cycle: See “Using the
Samples” on page 197.

. Determine the IRD objects to be

used in strategies to perform the
various processing required at
each stage of interaction
processing.

Review the functionality associated with IRD objects commonly
used in business processes. See “IRD Objects Used in Business
Processes” on page 201.

. For each interaction processing

stage, assign a name to the
required business processes.

Use the supplied worksheet in the section “Naming the Required
Business Processes” on page 212.

Name the queues that will
connect the strategies contained
within each business process
and/or connect one business
process to another business
process.

Use the supplied worksheet in the section “Naming the Required
Queues” on page 213 to name the required queues.

Determine the selection criteria
for extracting interactions from
queues.

See “Determining View Criteria” on page 215.

Name the views that will extract
interactions from queues.

Use the supplied worksheet in the section “View Information
Worksheet” on page 216.

Review limitations.

See “Configuration Manager Limitations” on page 219 and “IRD
Limitations” on page 219.

Create Knowledge Manager
objects, such as Categories,
Standard Responses, Field Codes,
and Screening Rules.

To create some of the objects that will be used in IRD objects
contained in strategies, see “Creating Knowledge Manager
Objects” on page 223.

Procedures:

* “Creating a New Category” on page 227.

* “Creating a Standard Response” on page 229.
*  “Creating a Field Code” on page 231.

* “Creating a Screening Rule” on page 234.
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Summary of Entire Process

Table 7: High Level Steps to Create/Load a Business Process (Continued)

Objective

Related sections and procedures

9. Create Configuration Manager
objects, such as Skills, Persons,
Agent Groups, Places, Place

Groups, and Business Attributes.

To create some of the objects that will be used in IRD objects
contained in strategies, see “Creating Configuration Manager
Objects” on page 237.

Procedures:

+ “Defining Skill objects that can be assigned to agents” on
page 239.

* “Defining Person objects” on page 241.

* “Defining Agent Groups, Places, and Place Groups” on
page 243.

* “Defining Business Attributes” on page 243.

10.Create the business process
“container” that will contain the
queues, strategies, views and
other objects that perform
interaction processing.

Use the following procedures:

*  “Defining a Business Process Script object” on page 248
* “Adding endpoints” on page 254

*  “Adding a Queue object” on page 258

*  “Adding a View to a Queue object” on page 268

¢ “Completing the View object Condition tab” on page 272
¢ “Completing the View object Order tab” on page 274

o “Completing the Parameterized Conditions tab” on
page 282

* “Adding a Workbin object to a business process” on
page 293

*  “Creating strategy placeholders” on page 300
¢ “Creating a Submitter object” on page 304

11.Create routing strategies for use
inside business processes.

See “Creating Strategies” on page 323 for a list of procedures.

12. Activate the strategies inside
business processes.

See “Activating Strategies” on page 361.
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Chapter

Planning a Business
Process

This chapter provides instructions for planning a business process. It covers the
following topics:

Basic Interaction Life Cycle, page 195

Using the Samples, page 197

Defining the Required Functionality, page 200

IRD Objects Used in Business Processes, page 201
Naming the Required Business Processes, page 212
Naming the Required Queues, page 213
Determining View Criteria, page 215

View Information Worksheet, page 216

Order of Configuration, page 217

Limitations, page 219

Basic Interaction Life Cycle

When you are planning a business process, start by considering the basic
stages in interaction life-cycle processing. You can then design a business
process that encompasses all stages, just one stage, or multiple stages. This
section presents four basic stages in interaction life-cycle processing, which
are especially applicable to e-mail processing. The stages are the following:

1.
2.
3.
4.

Pre-Route
Route-to-Agent
Review
Pre-Send

Each stage is summarized below.

Business Process—User’s Guide

195



Chapter 7: Planning a Business Process Basic Interaction Life Cycle

Pre-Routing Stage

The main activities in the pre-routing stage can include, but are not limited to:

Determining whether an interaction has already been processed by
Genesys. This can be accomplished via the absence or presence of an
Interaction Subtype (see “Step 1. Pre-Routing” on page 391).

If Content Analyzer is installed, sending interactions to Classification
Server for assignment of one or more Category codes previously defined in
Knowledge Manager (see Figure 162 on page 180). Once a Category code
is assigned to an interaction, you can configure other types of processing to
occur based on the Category code.

Screening interactions for certain words or patterns of words (see “Step
2.3. New Inbound E-mails” on page 396). Once a Screening Rule match
occurs, you can configure other types of processing based on the true/false
value.

Sending an acknowledgement and/or automatic Standard Response to the
customer originating the interaction (see “Step 2.3. New Inbound E-mails”
on page 396).

Determining the agent that previously handled the interaction (see “Step
2.1. NDR Handling” on page 393).

Route-to-Target Stage

Review Stage

196

This may or may not be an agent target. For example, the interaction may be:

Sent to a queue for submittal to other routing strategies and further
processing (see “Step 2.3. New Inbound E-mails” on page 396).

Sent to a queue for failed interactions (see “Step 2.2. Inbound
Collaboration Reply” on page 394).

Forwarded outside the contact center to an expert with the expectation of
getting a response back (see “Step 3.3. Forwarding” on page 403).

Redirected to another agent without the expectation of getting a response
back (see “Step 3.4. Redirecting” on page 405).

Routed to an agent target for construction of a response (see “Step 3.1.
Processing By Agents” on page 399).

The reviewer could be a manager, supervisor, or QA Person (see “Defining
Persons” on page 241). You may want to have two different types of
quality-assurance review:

1. A supervisor review that checks the skills of the agent who constructed the

response (see “Step 3.2. QA Review” on page 401).
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2. An analysis that performs a “sanity check;” for example, to prevent
sending out a bank account password in an interaction or to screen
interactions for inappropriate language.

Pre-Send Stage

The cycle of going from queue to routing strategy to queue can continue until
the interaction reaches some final outbound queue (see “Step 4. Outbound
Sending” on page 407). The pre-send stage performs last-minute quality
checking and allows for attaching additional information to interactions when
needed.Another approach to defining the interaction life cycle is to study the
Genesys-supplied business process samples.

Using the Samples

When you install the Genesys Multimedia software, you have the option of
installing a component called Interaction Workflow Samples (see Figure 173).
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File Edit ‘iew Business Process Tools Help

|e» BB |leaaE| & 2
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» attach classification categories and use multi-scrg
: get credit card number from the e-mail s
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» identify contact and create inkeraction in UCS
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Figure 173: Interaction Workflow Samples
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Using the Samples

The Workflow Samples component (samples) includes various business
processes and associated queues, views, submitters, workbins, and routing
strategies. The samples show how interaction processing can be contained in
one large business process or broken down into smaller business processes
connected with queues.

Samples Functionality

Note: For a description of each sample, see “Business Process Samples” on
page 369.

The Default BP business process shown in Figure 173 demonstrates “real
world” workflow complexity. In order to help you understand Default BP, a
group of samples isolate its functional areas. For each functional area of
Default BP, such as pre-routing, the samples supply a corresponding
step-numbered business process (see Figure 173 on page 197). For example,
Figure 174 shows the pre-routing area in Default BP.

@ I 'Allabnratinn reply e-rnails
o
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@ I _ Inbound e-rnail postprocessing
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Inbound e-mail
postprocessing

@ I GLnbound e-rnails
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o |
Inbnunc'[.__...

preprocessing .
E-rnails to route ta original
agent
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E-rnails to route ta original agent
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Figure 174: Pre-routing Area in Default BP
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The pre-routing area in Default BP in Figure 174 corresponds to the Step 1.
Pre-routing business process shown in Figure 175 on page 199.
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Using the Samples
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Figure 175: Step 1. Pre-Routing Business Process

Connecting Business Processes Via Queues

As can be seen in Figure 175, Step 1. Pre-routing directly outputs to four

queues:

1. Collaboration reply e-mails. Input queue for Step 2.2. Inbound
Collaboration Reply.

2. E-mails to route to original agent. Input queue for Step 2.1. NDR

Handling.

3. Inbound e-mail failure.

4. Inbound e-mail postprocessing. Input queue for Step 2.3. New Inbound

E-mails.
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Queues can connect business processes in this manner to create an interaction
workflow. You can find the business process that “owns” (originated) a queue
by right-clicking the queue and selecting Locate from the menu. The queue is
highlighted in the object browser under the business process that owns the
queue. If the queue originated in a different business process, it displays an up
arrow (see Figure 9 on page 28).

Step-Numbered Business Processes

The step-numbered business processes demonstrate how to construct the
functional areas of Default BP. To help you estimate the queues and strategies
you will need if you wish to emulate the samples, Table 30 on page 389 shows
the elements in each step-numbered business process. It also points you to the
corresponding IRD objects used to implement the functional area.

Defining the Required Functionality

200

To isolate the interaction processing functionality that is required at your
contact center, you can start by using the samples to these questions:

1. What functionality from the first column in Table 30 on page 389 is
applicable to your site? The middle column in Table 30 on page 389 shows
the IRD objects you could use. The third column shows the queues you
would need to define if emulating the samples.

2. Is there any special interaction processing functionality that is required at
your contact center that is not covered by the first column in Table 30 on
page 389 or by the overall samples functionality (see “Samples
Functionality” on page 371).

3. Can the Web Service (see Table 14 on page 210) or External Service object
(see Table 8 on page 201) be used to supply this functionality?

4. Does this special interaction functionality require its own business process
or will it be part of another business process?

5. What queues and strategies are required to implement this special
functionality?

6. What are your contact center’s special conditions for extracting
interactions from queues? See “Interaction Attributes” on page 216.

After listing the interaction processing functionality that is required at your
site, decide whether you should:

* Create one large business process as demonstrated by Default BP (see
page 387).

* Build a number of smaller business processes and connect them via queues
as demonstrated by the step-numbered samples (see page 389).
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IRD Objects Used in Business Processes

This section highlights the strategy-building objects that are specifically
intended for routing strategies that are called by business processes.

Multimedia Objects

Table 8 on page 201 summarizes the Multimedia strategy-building objects (see
Figure 106 on page 126) in alphabetical order.

Note: IRD Multimedia objects (business processes, single queues, and
workbins) are renamed in release 8.1.1. IRD keeps a record of the
interaction design objects usage (business process, queues, workbins)
in strategies, and tracks interaction design object name changes. This
enables IRD to make the adjustment the object properties inside
strategies on-the-fly to correctly refer to the renamed interaction
design object. Previously, users had to adjust the name changes
manually.

Table 8: Multimedia Objects Used in Business Processes

Name Purpose Strategy-linked
nodes (page 34)
Acknowledgement | Generates an acknowledgement e-mail using text from When Operation
your Standard Response Library explaining that the Mode is E-mail or
customer’s e-mail has been received and will be answered. | Open Media,
You can send an Acknowledgement in reply to an generates server and
incoming interaction in any medium. queue nodes in a

The Acknowledgment object has two methods for getting | Pusiness process.

text for the acknowledgement e-mail.

The first method automatically selects Standard Response
text based upon the Category specified in interaction User
Data placed there as a result of using the Classification
Request object.

The second method lets you preset a Standard Response.
If you select this option, you are presented with a tree of
Categories and associated Standard Responses.
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IRD Objects Used in Business Processes

Table 8: Multimedia Objects Used in Business Processes (Continued)

Name

Purpose

Strategy-linked
nodes (page 34)

Attach Categories

Lets you manually emulate the results of the Classify
object’s request to Classification Server to attach one or
more classification Categories to an interaction.

Use when creating a strategy in which screening results
determine what Categories to attach to an interaction with
the Attach Categories object.

Use when creating a strategy in which an If object creates
an expression based on Categories manually attached to
interaction with Attach Categories object. URS analysis
(true/false) of the expression determines interaction path
in strategy.

You can also segment interactions based on Categories
using the Classify Segmentation object and/or use
Categories to select a Standard Response.

Autoresponse Generates (but does not send) an automatic response When Operation
message using text from your Standard Response Library. | Mode is E-mail or
You can send an Autoresponse in reply to an incoming Open Media,
interaction in any medium. generates server and
The Autoresponse object has two methods for gettinga | 4U€U€ nodes in a
Standard Response. business process.

1. The first method automatically selects a Standard
Response based upon the Category specified in interaction
User Data placed there as a result of using the
Classification Request object.

2. The second method lets you preset a Standard
Response. If you select this option, you are presented with
a tree of Categories and associated Standard Responses.

Chat Transcript Generates (but does not send) an e-mail, using text from | Generates server and
your Standard Response Library, with the customer's chat | queue nodes in a
transcript attached. (Use the Send E-Mail object to send | business process.
it.) Does not generate any strategy-linked nodes in a
business process.
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IRD Objects Used in Business Processes

Table 8: Multimedia Objects Used in Business Processes (Continued)

Name

Purpose

Strategy-linked
nodes (page 34)

Classify (note: there
is also a Classify
Segmentation
object)

Requests Classification Server to assign one or more
Categories to text-based interactions. The Categories can
then be used to select a Standard Response, as well as for
routing or reporting.

The input parameters include the minimum relevancy each
Category must have in order for Classification Server to
consider an interaction as belonging to that Category
(threshold). Parameters also specify whether to analyze
only for the Parent Categories set up in Configuration
Manger or both parent and child Categories.

Create E-mail Out

Creates an outbound e-mail interaction. This outbound
e-mail is sent via an E-mail Server that has been

specifically configured to handle Open Media interactions.

Use the Send E-Mail object to send this message after it
has been created.

Generates server and
queue nodes in a
business process.

Create Interaction

Has URS request that an interaction record be created in
the Universal Contact Server database for a customer
contact. This object applies to all interaction types other
than voice, chat, or e-mail. The UCS Database can store
three types of interaction content simultaneously: Text,
Structured Text, and Binary Data. When interaction
content is expected to be large, Genesys recommends
using the Create Interaction object as early as possible in a
strategy.

Create Notification

Creates an informational e-mail to a customer. The e-mail
may contain the information that is requested by the
customer or may direct the customer to a URS on which
the information is located.

The outbound e-mail is sent via an E-mail Server that has
been specifically configured to handle Open Media
interactions.

Generates server and
queue nodes in a
business process.

Create SMS

Use to create a new outbound message in a format that is
to be sent by a specifically configured E-mail Server to
SMS-ready targets, such as cell phones, via an E-mail to
SMS gateway.

Use the Send E-Mail object to send the SMS message
after you have created it.

Generates server and
queue nodes in a
business process.

Distribute Custom
Event

Delivers special events to reporting clients.
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Table 8: Multimedia Objects Used in Business Processes (Continued)

Name

Purpose

Strategy-linked
nodes (page 34)

Find Interaction

Queries Interaction Server for all or a number of
interactions that correspond to specific conditions and
listed in a specific order.

Forward E-mail

Use when sending an incoming message to an external
address (see E-mail Accounts on page 246) with the
expectation of getting a response back. Supports agent
collaboration. The resource can be another agent such as
an “expert” or an e-mail server. The Forward E-Mail
object is a request to E-mail Server for method Forward to
create the forwarded e-mail. Use the Send E-Mail object
to send the forwarded e-mail that is waiting in a queue.

Generates server and
queue nodes in a
business process.

Identify Contact

Use to locate one or more contacts in the Universal
Contact Server (UCS) database with attributes that match
data attached to the interaction. If you choose to match
one unique contact, if UCS locates it, it returns all stored
data concerning that contact.You can also choose to have
UCS create a new contact if no existing contact matches
the attached data.This object requires you to specify a
Contact Server.

MultiScreen

See Screen object. The difference between the two objects
is that MultiScreen can use multiple Screening Rules,
supplies additional return options, and does not require a
conditional test to determine whether a match occurred.

Redirect E-mail

Used when sending an incoming message to an external
address (see E-mail Accounts on page 246) without
expecting a response or the need for any further
processing. The Redirect E-Mail object is a request to
E-mail Server for method Redirect to create the redirected
e-mail. Use the Send E-Mail object to send the redirected
e-mail that is waiting in a queue.

Generates server and
queue nodes in a
business process.

Reply from External
Resource

Takes an External Resource Reply inbound e-mail as input
(such as one generated as a result of using the Forward
object), extracts the external resource reply text from it,
creates a Customer Reply outbound e-mail, and submits
the e-mail to Interaction Server.

Generates server and
queue nodes in a
business process.

Render Message Creates message content by using text from either a
Content message box of the strategy object, strategy variable, User
Data or Standard Response.
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Table 8: Multimedia Objects Used in Business Processes (Continued)

Name Purpose Strategy-linked
nodes (page 34)

Screen Requests Classification Server to screen text-based
interactions for certain words or patterns of words using
rules set up in Knowledge Manager.

You can choose to return Screening Rule identifiers
(associated with Categories in Knowledge Manager) or
Categories (associated with Standard Responses in
Knowledge Manager), matched pairs, or all of the above.

Requires that you name the Classification Server used for
screening as well as a language and a Screening Rule.

Send E-mail Sends an e-mail that is waiting in an interaction queue to a
customer or another agent. This can be the final e-mail
response or an e-mail generated with the
Acknowledgement, Autoresponse, ChatTranscript,
Forward, or Redirect object.

Stop Interaction Sends a stop interaction request to Interaction Server. Generates a stop node
Optionally, notifies Universal Contact Server that in a business process.
interaction processing in this particular routing strategy is
finished. Requires a Reason Code.

Submit New Creates a new interaction in Interaction Server.
Interaction
Update Contact Updates information for an existing contact in the

Universal Contact Server (UCS) Database based on data
associated with the interaction.

Update Interaction | Updates properties of the interaction in the Interaction
Server database that are not currently processed in the
strategy by URS.

Update UCS Record | Updates properties of the interaction in the Universal
Contact Server database that are not currently processed in
the strategy by URS.

Routing objects Certain Routing objects also generate queue, person, and
stop nodes. See Table 11 on page 207 for more
information.
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Workforce and Resource Management

Table 9 describes Workforce and Resource Management objects (see
Figure 108 on page 128) that can be used in strategies that are called by
business processes.

Table 9: Workforce and Resource Management Objects Used in Business Processes

Name

Purpose

Force Logout

Use the Force Logout object to log out a Place or an Agent from all media that are
controlled by Interaction Server. When this is done, the reported agent state (agent
capacity vector) will not contain any media that are supported by Interaction Server.

Strategy State

Set Agent Use the Set Agent DND State object to turn the Agent DND status on or off. If this is

DND State set to off, all of the agent’s media that are controlled by Interaction Server will be
reported as not accepting any interactions. If it is set to on, reported media status will be
based on agent capacity rules.

Set Agent Use the Set Agent Media State object to change the state of the specified media to

Media State which the agent is logged on (if it is controlled by Interaction Server). If the media are
set to Not Ready, it will be reported as not accepting any interactions. If the media are
set to Ready, the status of the media will be reported based on agent capacity rules.

Set Use the Set Multimedia Strategy State object as an additional method for managing

Multimedia workflows. Strategies can by activated or deactivated by an interaction that has specific

properties.
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SMS

IRD Objects Used in Business Processes

Table 10 describes Workforce and Resource Management objects (see
Figure 109 on page 128) that can be used in strategies that are called by

business processes.

Table 10: SMS Objects Used in Business Processes

Name Purpose Strategy-linked
nodes (page 34)
Create Use the Create SMS Out object to instruct SMS Server to create a Generates a queue
SMS Out | new SMS interaction that will be handled by using ESP technology. | node in a business
Note: Do not confuse this object with the Create SMS object on the | PTOCCSS.
Multimedia toolbar. The Multimedia Create SMS object creates a
specially-configured e-mail-type message that is sent by the E-Mail
Server. The Create SMS Out object uses ESP technology to create an
SMS message that is sent by SMS Server.
Send SMS | Use the Send SMS Out object to send an SMS message that is created
Out by using the Create SMS Out object.

Routing Objects

Table 11 describes Routing objects (see Figure 104 on page 125) that can be

used in strategies that are called by business processes.

Table 11: Routing Objects Used in Business Processes

Name Purpose Strategy-linked nodes
Route Interaction Routes a non-voice interaction to a specified | Generates a queue node in a
target type: Agent, AgentGroup, Place, business process. If Agent is
PlaceGroup, Skill (see Figure 121 on specified as a target, generates a
page 138)—or to a target that is contained in | person node in a business
a variable (see “Defining Variables” on process.
page 150).
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Table 11: Routing Objects Used in Business Processes (Continued)

Name Purpose Strategy-linked nodes
Workbin Use to place an interaction in a temporary Generates a workbin node in a
storage area that is called a Workbin, which | business process. If a Person
is associated with one of the following: object (agent) is specified as a
Agent, AgentGroup, Place, or PlaceGroup target, generates a person node.

If the Stop Processing(_ queue
is selected, generates a stop
node.

Queue Interaction Generates a message from URS to Interaction | Generates a queue node in a
Server to place the interaction into a queue business process.

see page 47). Queues that are defined in the
Interaction Design window (see page 258)
are listed for selection.

The remaining Routing objects on the toolbar are intended for voice routing
strategies.

Segmentation Objects

Table 12 describes the Segmentation strategy-building objects that you will
frequently use in routing strategies that are called by business processes.

Table 12: Segmentation Objects Used in Business Processes

Name Purpose

Generic Segments interactions to take different paths in the strategy based on the
true/false value of an expression created in Expression Builder (see
Figure 119 on page 136). Expressions can be created using Interaction
Data (see page 119), Business Attributes (see page 161), or Functions
(see page 331). For an example, see “Segmenting Interactions” on

page 328.

Screen Segments interactions to take different paths in the strategy (see
Figure 364 on page 420) based on analyzing whether a Screening Rule
match occurred.

Classify Segments based on classification Categories (see Figure 164 on
page 181).

Miscellaneous Objects

Any of the objects accessed from the Miscellaneous icon (see Figure 100 on
page 123) can be used in routing strategies that are called by business
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processes. However, if you study the samples, as described in “Business
Process Samples” on page 369, you will note frequent use of the
Miscellaneous objects listed in Table 13.

Table 13: Miscellaneous Objects Used in Business Processes

Name Purpose

Assign and Multi-Assign The Assign object (see Figure 116 on page 134) gives a value to a
variable, which has been predefined in the Variable List dialog box (see
Figure 139 on page 151). For an example, see page 341. The variable can
then be used as a parameter of almost any object. For example, the
Function object allows you to assign the function return to a variable.

Function When you open the properties dialog box for the Function object, you
select one of the functions detailed in Universal Routing 8.1 Reference
Manual. 1f applicable, you can use the Expression box (see Figure 140
on page 152) in the Function object to create an expression, which
assigns the output to a variable.

If The properties dialog box lets you create an If expression (see

Figure 120 on page 137). You can create expressions using Interaction
Data (see page 119), Business Attributes (see page 161), or Functions
(see page 331).

Error Segmentation The Error Segmentation object processes error codes generated by
functions and objects. Connecting an object to the Error Segmentation
object overrides standard behavior for a particular error. This enables
further processing of errors and presents interactions from going to the
default destination.

Call Subroutine The Call Subroutine object lets you all a subroutine from within a
strategy or subroutine. When URS encounters this object in a strategy,
control of the interaction is passed to the subroutine. Values can be
passed between a strategy and a subroutine through input and output
parameters

Note: For detailed information about using these and other strategy-building
objects, see the section on IRD objects the Universal Routing 8.1
Reference Manual.

Data & Services

Table 14 describes Data & Services objects (see Figure 102 on page 124) that
can be used in strategies that are called by business processes.
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Table 14: Data & Services Objects Used in Business Processes

Name

Purpose

External Service

Use to exchange data with third party (non-Genesys) servers that
use the Genesys Interaction SDK or any other server or application
that complies with Genesys Interaction Server (GIS) communication
protocol.

Note: To use this object, you must already have created the
third-party server or application in Configuration Manager. Before
completing the object properties dialog box, you must already know
the names of the services, methods, and signatures (requested
input/output parameters) provided by the external service.

Web Service

Use to interact with Web-based applications (Web Services) outside
of Genesys applications. You specify request parameters, what type
of data that you expect to be returned, and what to do with the
returned data. This object can be used in both voice and non-voice
routing strategies.

Outbound

Note: The Outbound objects are designed to be used in strategies that are
configured for proactive routing functionality, which are Open Media
interactions that are processed with the outbound_preview media type.

Any of the objects that is accessed from the Outbound toolbar (see Figure 100
on page 123) can be used in routing strategies that are called by business
processes. For more information about these objects and example strategies,
see the Genesys 7.6 Proactive Routing Solution Guide.
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Table 15: Outbound Objects

Name

Purpose

Add Record

Use the Add Record object to automate building of Calling Lists by adding a new
record to a specified Outbound List, such as a Calling List. For example, use to develop
a Calling List, such as one to follow up on inbound calls that were abandoned during
traffic peaks. You can then configure a routing strategy to detect abandoned calls and
add records to the Calling List with the parameters of the incoming interactions. The
Calling List can subsequently be used by an Outbound Campaign that dials out these
customers during off peak hours and has the agent apologize and follow up.

Do Not Call

Use to add a phone number or e-mail address to a specified Do Not Call List and mark
the corresponding record as Do Not Call.

Use the Do Not Call and Processed (page 92) objects to finalize Outbound record
processing. You cannot use other Outbound objects to process records with the same
Record Handle after using Processed or DoNotCall in a strategy flow.

The Do Not Call object prevents a record from being dialed by any Campaign. If a
record is marked as Do Not Call, Outbound Contact Manager rejects all subsequent
requests for the record.

When URS executes this object in a strategy, it sends (via Interaction Server) a
DoNotCall request to OCS. Using the GSW_RECORD_ HANDLE provided, OCS:

» Identifies the record and updates the record type as NoCall.

* Enters the phone number and e-mail address or customer ID of this record in the
gsw_donotcall list (table).

If you require more information about Do Not Call Lists in general, see the section on
submitting Do Not Call requests in the Qutbound Contact 8.0 Reference Manual.

Processed

Use to finalize Outbound record processing. You cannot use other Outbound objects to
process records with the same Record Handle after using Processed or DoNotCall in a
strategy flow.

In the Outbound Contact 7.6 product, when an agent finishes processing a Calling List
record, Genesys Desktop sends a RecordProcessed event to indicate that the record is
processed and Outbound Contact Server updates the record accordingly.

Use the Processed object in a strategy to have URS request that Outbound Contact
Server finish processing a record created as a result of a customer call that was
previously:

* Initiated from a Calling List
* Automatically dialed by the Genesys Outbound Contact product
* Routed to an agent when the potential customer answered

When URS executes this object in a strategy, it results in an External Service Request to
Outbound Contact Server.
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Table 15: Outbound Objects (Continued)

Name

Purpose

Reschedule

Use to reschedule a customer call on a Calling List. A record is typically rescheduled
during a call when a customer requests a callback at a certain time. As described in the
section on scheduling and rescheduling records in the Outbound Contact 8.0 Reference
Manual, Outbound Contact supports two methods for rescheduling records:

» Using RecordReschedule to reschedule a call.

* Using ScheduledRecordReschedule when a rescheduled call cannot be completed
and must be set for another time.

The Reschedule object emulates the first method. URS sends Outbound Contact Server
(through Interaction Server) a RecordReschedule message and receives a
RecordRescheduleAcknowledge in return.

Update Record

Use to update a Calling List record that you specify via a RecordHandle parameter. The
resulting UpdateCallCompletionStats request updates Genesys modifiable mandatory
fields and custom fields in a record to Outbound Contact Server. In Predictive Dialing
mode, this request can be used to overwrite the call result detected by call progress
detection when needed. Or you can overwrite a call result answer with the call result
wrong party.

When URS executes this object in a strategy, it results in an External Service Request to
Outbound Contact Server.

Naming the Required Business Processes

When you have determined the interaction processing functionality that is
required at your site by identifying the IRD objects that you will use, ask
whether a single business process can implement all the functionality (such as
the Default BP sample in Appendix A on page 387). If you require more than
one business process, use Table 16 to name the functionality, the required
business process, the next business process(es) in the flow, and the connecting
queue(s).

Table 16: Required Business Processes and Connecting Queues

Functionality

Business process | Connecting business | Connecting
process(es) queue(s)
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Table 16: Required Business Processes and Connecting Queues (Continued)

Functionality Business process | Connecting business | Connecting
process(es) queue(s)

Naming the Required Queues

Many of the Multimedia objects that are listed in Table 8 on page 201, as well
as the Routing objects listed that are in Table 11 on page 207, require you to
specify an output queue. Table 17 lists the objects that require output queues
and contains columns for your queue names.
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Table 17: IRD Objects and Required Queues

IRD objects How queue is used Name of your Originating
specifying queues queue business

process
Acknowledgement Output queue in which E-mail

Server should place the
acknowledgement e-mail that will be
sent to the customer.

Autoresponse Output queue in which E-mail
Server should place the autoresponse
e-mail that will be sent to the
customer.

Chat Transcript Output queue in which E-mail
Server should place the e-mail with
the attached chat transcript that will
be sent to the customer.

Create E-mail Out Output queue in which E-mail
Server will find the e-mail.

Create Notification Output queue in which E-mail
Server will find the e-mail.

Create SMS Interaction queue in which E-mail
Server will find the messages.

Create SMS Out Output queue for outbound SMS.

Forward E-mail Output queue in which E-mail
Server should place the e-mail that is
to be forwarded.

Queue Interaction Output queue for the e-mail. Could
be one read by agents, a queue for
failed interactions, used for routing
interactions from one business
process to another, and so on.

Redirect E-mail Output queue in which E-mail
Server should place the e-mail that is
to be redirected.

Reply from External | Output queue for outbound e-mails
Resource that contain final replies that are to
be sent to customers.
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Table 17: IRD Objects and Required Queues (Continued)

Determining View Criteria

IRD objects
specifying queues

How queue is used

Name of your
queue

Originating
business
process

Route Interaction

The Interaction Queue tab is
optional. It gives the option of
specifying:

A queue for the existing interaction.
For example, after the agent

constructs a response, the interaction
might need to be checked by QA.

A queue for a new interaction if a
new interaction is created.

Workbin

The Interaction Queue tab is
optional. It gives the option of
specifying:

A queue for the existing interaction.
For example, after the agent

constructs a response, the interaction
might need to be checked by QA.

A queue for a new interaction if a
new interaction is created.

See “Adding Workbins” on
page 292.

Note: IRD predefines a Stop_processing (_STOP_) queue, which is not

actually a queue, but a notification to Interaction Server that processing
has stopped for a particular interaction if it reaches this point. For more
information on this topic, see “IRD Limitations” on page 219.

Determining View Criteria

Views (see Figure 10 on page 28) extract interactions from queues or

workbins. Part of the planning process includes determining whether all
interactions should be extracted or a subset of interactions based selection

criteria (see “Adding a View” on page 267).

You enter the selection criteria in the View properties dialog box (see

Figure 221 on page 270). It has two tabs, Condition (see Figure 222 on
page 273) and Order (see Figure 224 on page 274), where you specify column
names and values (interaction attributes).
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Interaction Attributes

Translations

When you are creating a View object, you can create an expression that
comprises:

* An interaction attribute (field) name from the interactions table
* An equal sign if required

* For string data, the attribute value in single quotes (not necessary for
integers)

For an example, see Figure 222 on page 273.

Note: Sce the eServices (Multimedia) 8.0 Users Guide for details on the
interactions table, including column names and descriptions.

Some attribute values will be contained in the original e-mail. E-mail Server
may assign other values. Routing strategy objects, such as the Database object
or Classify object, may assign yet other values.

The attributes that you use to create the expression will be those in the
interactions table as well as any custom attributes that you define in the
interactions table (see custom_1s through custom_3n).

Translations, when they are used in the Conditions tab (see Figure 222 on
page 273), provide database manipulation tools that are independent of the
underlying database—including functions, attributes, and customizable
property names for use in view and snapshot definitions.

Translations are optional. Interaction Server will accept either customized
property names or actual database field and construct names. For more
information, see the chapter on Interaction Properties in the eServices
(Multimedia) 8.0 User s Guide.

View Information Worksheet

Use Table 18 to record view information.

Table 18: View Objects Configuration Data

View name Associated queue or | Conditions (if any) | Order by
workbin information (if any)
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Table 18: View Objects Configuration Data (Continued)

View name Associated queue or | Conditions (if any) | Order by
workbin information (if any)

Order of Configuration

Certain objects must be defined in Knowledge Manager in order to be
viewable in Configuration Manager. Similarly, certain objects must exist in the
Configuration Database before the objects are selectable in IRD Strategy
objects. Because of this dependency, Genesys recommends that you configure
objects in the following order:

1. Start with Knowledge Manager (see “Knowledge Manager Interface” on
page 175).
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Define any required classification Categories, Standard Responses,
Screening Rules, Field Codes, and Custom Variables (see “Creating
Knowledge Manager Objects” on page 223).

Once these are saved in the Universal Contact Server Database, the object
definitions carry over to Configuration Database and are accessible to the
strategy-building objects that use them.

2. Next, use Configuration Manager (see “Configuration Layer Interface” on
page 155).

Define any required media server, Skill, Person, Agent Group, Place, Place
Group, and certain Business Attribute objects (see “Creating
Configuration Manager Objects” on page 237).

Once these are saved in the Configuration Database, the objects are
selectable in the IRD objects that use them.

3. Ifnot already defined, use the Interaction Design window to define
endpoints (see Figure 24 on page 40) for the media server Application
objects.

4. Use the Interaction Design window (see Figure 36 on page 61) to define
Business Process objects, including queues, views, and strategy
placeholders (see “Creating Business Process Objects” on page 247).

Once definitions are saved in the Configuration Database, the names are
selectable in the strategy-building objects that use them.

Notes: The properties dialog box for most of the IRD Multimedia objects
requires an interaction output queue. Before any interaction queue
can be listed for selection in one of the Multimedia objects, you
must first associate the queue with a business process in the
Interaction Design window.

The properties dialog box for the Workbin object requires you to
select a workbin name. In order for a workbin name to display for
selection in the Workbin object, you must the associate Workbin
object with a business processes in the Interaction Design
window.

5. Use the Routing Design window (see Figure 98 on page 122) to create the
required routing strategies (see “Creating Strategies” on page 323).

6. Edit your business processes by pulling in existing Strategy objects and
connecting them to queues with Submitter objects (see “Adding a Strategy
to a Business Process” on page 356).

If you proceed in this sequence, you will be able to select the applicable queue
or other object.
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Limitations

When you are developing a strategy or a business process, familiarize yourself
with the following limitations pertaining to Configuration Manager and IRD:

Warning! If you do not observe these limitations, your interactions might be

routed to an incorrect destination, URS might unexpectedly shut
down, or a requested operation might not be performed.

Configuration Manager Limitations

IRD Limitations

While the Configuration Layer supports the full character set for use in
object names, using certain characters can cause problems in the behavior
of other Genesys applications.

The objects affected by this limitation that are used in Universal Routing
include Tenant, Field, Format, Script (strategies and subroutines), Table
Access, Tenant, and Transaction (routing rules, interaction data, attributes,
business rules, and custom statistics).

The maximum length of any Configuration Server object name is 256
bytes (a limitation that is automatically enforced by Configuration Server).

When you are configuring Employee IDs, Login IDs, Place names, DN
numbers, and Switch names that will be used to define routing targets, the
maximum length is 63 bytes.

When a URS name is added to the name of a T-Server that is connecting
through a Load Distribution Server, the sum of the bytes cannot exceed
126 bytes.

When you are defining agent states on the Annex or Options tab of a URS
Application object (for example when preparing to use the UseAgentState
function), the maximum number of user-defined agent states is 32.

The names of skills, if they are used in a skill expression, cannot exceed
126 bytes.

The priority of an interaction cannot exceed 1,000,000,000.

When you are creating or modifying strategies in IRD:

Certain symbols, listed in Figure 176, should not be used in object names.
The names of all IRD reusable objects and data (strategies, routing rules,
schedules, and so on) as well as Interaction Design window configuration
objects (business processes, queues, and so on) are limited to alphanumeric
characters and cannot begin with a space, an underscore, or a hyphen.
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220

Interaction Routing Designer El

Please note that although some IRD objects allow you to enter names
containing special characters, Genesys strongly recommends not using
them.

Do not use symbols: @Ot =[1]:;, ™ <= o,

Figure 176: Invalid Symbols and Characters

IRD allows you to use only one special character, an underscore, in the
middle of a strategy name. You may also use an underscore in any reusable
object name, as well as in the name of a service, method, method
parameter, or the name of any strategy object that results in executing an
external or internal service or procedure.

The underscore is the only character that you can safely use in the middle
of the name of a strategy or other reusable object, service, method, or
method parameter name of any strategy object that results in executing an
external or internal service or procedure.

Warning! Using commas and square brackets as data separators can make
IRD incorrectly interpret the entered values if those symbols
are used in Treatment, Data and Services, Multimedia, and
Outbound objects.

When you are specifying busy treatment parameters, do not include pipes

“|97 [T 1)

and colons “:” in values.

Skill expressions (see Figure 121 on page 138) that are used by the
Selection, Service Level, and Route Interaction Routing objects cannot
exceed 100 elements (skill names, numbers, comparisons, and logical
operands). That is, a skill expression should have no more than 25
constructions, such as English > 1. It is especially important to observe
this limitation in the case of Service Level routing rules, which use skills
internally—that is, every skill criterion used in a Service Level routing rule
generates 1-3 constructions in the form <Skill> > <Number).

The maximum size of an overall skill expression (as text) is 10239 bytes.

The maximum length of a string using the format
placenameestatservername.AP agentnameestatservername.A for any
routing target is 253 bytes.

The maximum length of a request to Custom Server or DB Server through
XData (used for 5.x strategies) is 10239 bytes.

When creating a key-value list that uses a string format (such as
aaa:5/gggg:123]...), the maximum key length is 1000 bytes and the
maximum length of one key-value pair is 4096 bytes.
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*  When you are using the Database Wizard object to query a database, the
maximum size of a SQL statement created by the DB Wizard is 1010
bytes.

*  When you are using the IRD statistical adjustment functions, the name of
an object plus the name of the statistic cannot exceed 250 bytes.

* The name of any single target (including a skill group) cannot exceed 256
bytes.

* Integer variables can have a maximum value of approximately four billion,
with a range of -2 billion to +2 billion. If a value number exceeds the
maximum capacity of an integer variable, the number wraps back around.
If the number gets larger than largest allowed number, the integer variable
wraps to a negative number. If the value number gets smaller than the
smallest allowed number (around negative two billion), the integer variable
wraps back into being positive. In any case, the returned number will be an
error.

* The name of a strategy created in IRD can incorporate only 194 characters.
If you create the Simple Routing script object (or rename an existing one)
in Configuration Manager with the 254-byte name length, such an object
will be displayed in the IRD Strategies list, but its .rbn file is not
accessible for any kind of operation.

*  When you specify a _STOP_ queue for an Existing Interaction in the Route
Interaction object's Interaction Queue tab, it places a Stop strategy-linked
node in the Workflow Viewer. This Stop strategy-linked node looks the
same as if you explicitly placed a Stop object in the strategy. However, the
behavior is different. A _STOP_ queue is just a hint to the desktop and the
other is an actual stop.
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Chapter

Creating Knowledge
Manager Objects

This chapter provides step-by-step instructions for creating Knowledge
Manager objects that are used by routing strategies (see Table 5 on page 176).
The information in this chapter covers the following topics:

+  Opening Knowledge Manager, page 223

« Categories and Standard Responses, page 225
«  Creating Field Codes, page 230

«  Creating Screening Rules, page 233

For background information, see “Knowledge Manager Interface” on
page 175.

Opening Knowledge Manager

The information in this section assumes that you have already installed the
Multimedia software components and Knowledge Manager, as described in the
eServices (Multimedia) 8.0 Deployment Guide.

Procedure:
Logging into Knowledge Manager

Start of procedure

1. Click the desktop shortcut if one exists.

As an alternative, use the Start button on your computer desktop and
select Programs > Genesys Solutions » Multi Channel Routing 8.0)
Knowledge Manager » Start Knowledge Manager.
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224

Either action brings up the Knowledge Manager login dialog box that is
shown in Figure 177.

T

@ Welcome to Knowledge Manager

Uzer name: I

=er passward: I

(0], Cancel | Detailz == |

Application: I

Host: I ;I
Part: I ;I

Figure 177: Knowledge Manager Login Dialog Box

2. Use the information in Table 19 to complete the Knowledge Manager login
dialog box.

Table 19: Knowledge Manager Login Dialog Box

Field Description

User name: Name of the Person object that is defined in Configuration
Manager.

User password: | Password of the Person object that is defined in
Configuration Manager.

Application: Use default to have the Application object (see

Figure 141 on page 157) selected automatically or enter the
name of a Knowledge Manager Application object defined
in the Configuration Manager. This Application object is
associated Contact Server Application object, which is
associated with a UCS Database Access Point.

Host name: Name of the computer on which Configuration Server is
located.
Port: Port number that is used by Configuration Server.
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3. Click oK. The Knowledge Manager interface opens.

End of procedure

After you complete the login fields and click 0K, Knowledge Manager opens
with the Categories tab selected. Figure 178 shows a Categories tab with
various top level (root) classification Categories.

Knowledge Manager-Content Analyzer: Configseryer Host techpubs4; Po J
File= Edit “iew Tools Help

|E % I:D X EI ||Eﬂ§||i3h v|||Te':hF'L,|t:usi-'5 vl

Categary Tree hu:u:t Categories for the Tenant [TechPubsTa]
Y[ TechPubs7s] Category Mame | Owner |  DateMadified | Use in Classif]
i3 Auto Responss Auto Regponze  defaut FI2E0E Yes
Bobs_Books Bobs_Books  |default 728006 Yes
Boks_Books_July Eohs_Books_J... defaut 7I2EG Yes
that Transcript Chat Transcript  default 7I2EG Yes
copyofBiobs_Books copyofBobs_B... default £ 7105 Yes
Financial service Firancial service [defautt TI2G06 Ve
Forwarding Forswarding defaut TI2G06 Ve
Languagebetection? LanguageDete . [defautt 5431 /06 e
Languagebetection. LanguaneDete . [defautt 511606 Yes

- Categories I Field Cndesl Screeningl Trainingl Training Schedulel Mudelsl F.&.GI

Figure 178: Knowledge Manager, Categories Tab

Categories and Standard Responses

When creating a new Category in Knowledge Manager, you must understand
the concept of a root Category. Then you can decide whether you need to
define a new root Category or whether you can place the new Category under
an existing root.Note the expanded Category tree in Figure 179.
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Categories and Standard Responses

Yigw —Tools

Help

New Category

[] knowledge Manager-Content Analyzer: ConfigServer Host techpubsd4; Pork 3t
Fil=  Edit

| s B X @ |[enaien ~ || frechpups?s -]

=— |

==

==

==

—

—

—

Category Tree
F Y[ TechPubsT:

I=

hn:n:t Categoties far the Tenant [TechPubs?S]

—ﬁ cookery
3 fiction
—ﬁ periodicals
—ﬁ zelf-help
—

DEL Service

—ﬁ clazsical

—ﬁ rock
—ﬁ |l
Bobs_Books_Jly
Chat Tranzcript
copyofBobs_Books
Financial zervice
Farwearding
LanguageDetection?

Root|@ategories

Category Mame | Civyrer | Date Modified | U=e in Claszsifi

Auto Response  default TI2G06 Yes
Bobz_Books default TI2G06 Yes
Bobs_Books_J... default TI2G06 Yes
Chat Tranzcript  default Tr2ane Yes
copyofBobs_B... default M 706 Yes
Financial zervice default FI2506 Yes
Farwarding default FI2506 ==
LanguageDete... default 5431106 ==
LanguageDete... default S BIE ==

Subcategories Pane

=]

Standard Response Pane

- Categaries I Field Cndesl Screeningl Trainingl Training Schedulel Mu:udelsl F.&.QI

Figure 179: Example Knowledge Manager Root Categories
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The example root Categories in Figure 179 are:

Bobs_Books
Bobs_Books_July
Chat Transcript
copyofBobs_Books
Financial service
Forwarding

LanguageDetection2.
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Procedure:
Creating a New Category

Purpose: To define a Category for the Category tree that is discussed on
page 178. You can then use the Classify strategy-building object (see

page 203) to request Classification Server to assign one or more classification
Categories to an interaction, which can then be used to automatically select a
Standard Response for customers.

Start of procedure

1. Decide whether you need to define a new root Category or a Subcategory.

+ For a new root Category, select Resources, which is the topmost node
in the Category tree.

+ For a new Subcategory, select an existing root Category or a lower
level Category.
2. Do one of the following to start creating a new Category:
+ Select New from the File menu.
+  Click the icon for a new Category on the toolbar (first icon).
+ Put the cursor in the Category tree or subcategories pane, right-click,
and select New Category from the shortcut menu.

The dialog box for creating a new Category opens. Figure 180 shows the
New Root Category dialog box.

New Rook cateqgory El

@ Rook cateqaory namme:
[

i I Cancel |

Figure 180: New Root Category Dialog Box

Figure 181 shows the dialog box when Resources is not selected.
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New category

Cateqgory name ||

Uze in classification ¥

F & attribute

()4 Cancel

Figure 181: New Category Dialog Box

3. Enter the Category name.

Note: Names of Knowledge Manager objects can use only alphanumeric
characters (A—Z, a—z, 0-9), hyphen (-), underscore (_), and space.

4. Ifyou are using the New Category dialog box that is shown in Figure 181,
the Use in Classification check box is selected by default. Clear it if you
want Genesys Content Analyzer to omit this Category.

Note: Not all categories may have Standard Responses attached. For
example, some categories in a deep tree may exist only for the
purpose of organizational structure. You may only be interested in
viewing only the terminal categories that have Standard Responses
attached. Other reasons include preventing a higher level Category
from getting too high a relevancy and thereby shielding the lower
ones from agents. In summary, this field gives you the ability to
fine tune your Category structure.

5. Click OK.

End of procedure

See the eServices (Multimedia) 8.0 Knowledge Manager Help for information
about FAQs, operating on a Subcategory, searching Standard Responses
associated with a Category, and deleting a Category.
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Procedure:
Creating a Standard Response

Purpose: To create a prewritten response that can be used by agents when
responding to interactions such as e-mail interactions. Can also be used to
automatically respond to a customer inquiry without agent intervention
(Autoresponse object).

Start of procedure

1. On the Category tree pane in Figure 179 on page 226, select the Category
that should be associated with the Standard Response.

2. On the Standard Responses pane in Figure 179 on page 226, right-click
and select New Standard Response.The New Standard Response dialog box
displays, as shown in Figure 182.

[i]Mew Standard Response

Marme: |

Description: ‘

Subject: ‘

Plain text part: Inzert Field Code Check Spelling Check Field Codes

Ok | Cancel

Figure 182: New Standard Response
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Note: The title of the Standard Response editor dialog box is New
Standard Response if you are creating a Standard Response and
Edit Standard Response if you are editing an existing Standard
Response. The contents are otherwise identical.

Note the General tab in Figure 182 on page 229. To complete the General
tab:

Enter a name (required) and description (optional) for the Standard
Response. Remember that the name can only use alphanumeric characters
(A—Z, a—z, 0-9), hyphen, underscore, and space.

Enter a subject for the Standard Response. What you enter here appears as
the Subject line in an e-mail (acknowledgement or autoresponse) generated
from this Standard Response.

Enter text for the plain text version of the Standard Response, using the
Insert Field Code button to insert Field Codes. If you have not yet
created Field Codes, you can continue creating the Standard Response,
then return to it and insert Field Codes after you have created them.

Use the relevant buttons to check spelling and Field Codes. Checking Field
Codes shows you the result of applying (rendering) the Field Codes in this
Standard Response. The values that are rendered are taken from a
collection of generic properties that exists for this purpose.

End of procedure

For information about the remaining elements in the General tab, as well as the
Additional, Attachments, and History tabs, see the eServices (Multimedia) 8.0
User's Guide.

Note: When E-mail Server uses the Standard Response to create an e-mail (as

when generating an acknowledgment, for example), it creates a
multipart e-mail that includes both plain text and HTML versions.
Then the settings of the e-mail client that receives the e-mail determine
the version that is displayed. For more information, see the eServices
(Multimedia) 8.0 User s Guide.

Creating Field Codes

230

The IRD Acknowledgement and Autoresponse objects allow you to specify
Standard Responses, which can contain Field Codes (see Figure 165 on

page 182 and Figure 169 on page 185). The Knowledge Manager Field Codes
tab shows the name, description, and body of all Field Codes currently in the
Universal Contact Server Database. Figure 183 shows an example tab.
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Creating Field Codes

Knowledge Manager-Content Analyzer: ConfigSeryer Host techpub

4

File Edit ‘“iew Tools Help
|*D o B X (2] ||Er'|glish "’”ITechPubs?S -|
Field Codes
Marme | Description Body
Iﬁ'] contact phone_CONFOS0205102517 Cantact PrimaryPhoneMumber
Iﬁ'] subject_COMFOS020510251 7 zubject of interaction Intersction. Subject

=] agertsig_ COMFOS0205102517

Iﬁ'] contact natme and title COMNFOS020...
@ cartact phone

=] subject

Iﬁ'] agentsig

Iﬁ'] contact name and title

Iﬁ'] Customer name

1= SMSText

E] Customer name_COMFOS1 606161004
t=l] CrigSMSHumber

=] DestSMShumber

=] SMEText_COMFOS3106155105

Iﬁ'] Customer name_COMFOS3106155105

zubject of interaction

Destination Sk= number, contains the S

Iﬁ'] DestShSMumber _ COMNFOE3106155... Destination SMS number, contains the = ...

ShS Text, cortains the text of the SMS 1.
Criginal SMS number, containz the origin. .
=S Text, contains the text of the SMS 1.
Iﬁ'] Orig=h=hNumber _COMNFOS31 061551 .. Original SM= number, cortains the origin. .

=] ShSText _COMFOS3106155105_CO .. |SMS Tewxt, contains the text of the SMS ..

Agent. Signature

Contact. Title+" "+Corntact . Fullbatme
Contact PrimaryPhoneMurmber
Irteraction. Subject

Acent. Signature

Cortact. Title+" "+Contact FullMame
Cortact FirstMame+" "+Contact Lasths
Interaction. AttachedData" SMSText")
Cortact FirstMame+" "+Contact Lasthls
Interaction. AttachedDatal" Crig=hShu
Interaction AttachedDatal " DestSh SR
Interaction. AttachedDatal" SMSText")
Contact Firsthlame+" "+Cortact Lasthlg
Interaction. AttachedDatal" Orig=hShu
Irteraction. AttachedDatal" Dest =SSk
Interaction. AttachedDatal" SMSText")

Irterasction. AttachedData" Dest S S

Iﬁ'] DestSMSMumber _COMFO91306153... Destination SMS number, contains the S

Categaries  Field Codes I Screeningl Trainingl Training Schedulel Mndelsl F.&@I

| |

Figure 183: Knowledge Manager Field Codes Tab

Procedure:
Creating a Field Code

Purpose: To create a Field Code to customize a Standard Response—usually
for a particular customer.

Start of procedure

1.
2.

Click the Field Codes tab in the Knowledge Manager main window.

Click the icon on the toolbar for a new Field Code (the first icon, as shown
in Figure 183). This brings up the New Field Code dialog box (see
Figure 184).
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New Field Code x|

T ||

Description: I

~Field code variables

Systerm: Agent . Sionature v In=ert
Custorm: gl | In=ert

Create custom variable

Text:

Check

Ok Cancel

Figure 184: New Field Code Dialog Box

Note: Figure 168 on page 184 shows a completed dialog box.

As an alternative method, on the Field Codes tab of Knowledge Manager,
right-click and select New Field Code. The New Field Code dialog box,
shown in Figure 184, opens.

The Text field shows the Field Code as you create and edit it.

3. Enter a name and description for the Field Code. Name is the only required
field in this dialog box.
Enter the Field Code variables section, which includes two fields:
* System. Click the down arrow to display a list of all system variables.

* Custom. Click the down arrow to display a list of all custom variables
that you have created.
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4. To create a new Field Code, click Create custom variable.The New Custom
Variable dialog box opens (see Figure 185).

E

Marne: ||

Description: I

Type: IS‘tring LI

Default value: I

Custam variahle list; Add Remave |

Ok |

Figure 185: New Custom Variable

5. For information about creating Custom Variables, see the eServices
(Multimedia) 8.0 User s Guide. Also see that guide for information about
the following:

* Inserting Field Codes into a Standard Response.
* Editing an Existing Field Code.

6. Click OK.

End of procedure

Creating Screening Rules

Note: To review the difference between screening and classification, see
Table 5 on page 176.
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Creating Screening Rules

When constructing a routing strategy that screens e-mails for certain words or
word patterns, you use the Screen or Multi-Screen IRD object. Each of these
objects requires Screening Rules, which must be set up in Knowledge Manager
in order to be selectable from the object dropdown menus.

Figure 186 shows the Screening tab of Knowledge Manager filled in with
sample Screening Rules.

Knowledge Manager-Content Analyzer: ConfigServer Hosk techpuk

File= Edit ‘“iew Tools

Help

|ﬂ * & X (2) ||English v”lTechPuhs?a vI

=10l x|

Screening Rules

Matme | Fule Body | Addreszes To Match I Attached Categaoties | Order I
Uridertified transacti... Find("transaction" truel ... Errors in transactions: 2. 10

w Credit card number RegExFind"w{4 - Tvl{4}... 10
m Wirong transaction a... Find"ransaction' truel .. Errors in transactions: 7 ... 10
m Tech support [ Find( "problem true 71| ... 400
m Warranty problem Find( "wwarranty"” true 1& ... 300
mtest_rule RegExFind("test"] customer _support tech_... | books:579%; books: 87 %, 10
w Auto Respanzse &vai... Find("customer suppart”, ... 200
m Gality prove Find("durmb" true) || Find... 10
m Uridertified transacti... Find("transaction” true) .. 10
m Credit card number ... RegExFind™d{d - Jul{d}.. 10
m Wirang transaction a... Find("transaction' true) .. 10
Ef.‘ﬂ Tech suppart_COMF ... [ Find( "problem” truae 7] ... 400
Ef.‘ﬂ Wiarranty probletm_C... Findl "warranty” true 15 300
w Auto Response &vai... Find("customer support”,... 200
w Guality prove_CONF . Find("durmb" trued || Find... 10

Categories I Figld Codes

Soreening I Trainingl Trainirg Schedulel Mndelsl F.-E'-.Ql

Figure 186: Knowledge Manager Screening Tab
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Procedure:

Creating a Screening Rule

Purpose:

To create or edit a Screening Rule that can be used in the Screen or

MultiScreen IRD strategy object to filter interactions for specific words or

word patterns.
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Start of procedure

1. Go to the Screening tab in the Knowledge Manager main window (see
Figure 186 on page 234).

2. Do one of the following:
a. Select New from the File menu.
b. Right-click anywhere on the Screening tab and select New.

¢. Select an existing Screening Rule and double-click or select Edit from
the File menu.

The Screening Rule dialog box opens, as shown in Figure 187.

New Screening Rule x|

Mame: I

[~ Enabled Order: IlD

Use these addresses

custormer_support
tech_support

warranty_support
Add

[ Exact address match

f* AMND " CR
~Use pattern

Choose and add regular expressions and operators between them:

[Findc™ =l Add | Im 4|Add

Search for pattern in message's [~ subject I~ Body I~ Header

[~ Merge sources checked above

riCategoties

add Root cateqory I Cakeqory Relevancy I

Delete |

Figure 187: New Screening Rule Dialog Box

Note: In the case of Steps 2a or 2b, its title is New Screening Rule; in the case
of Step 2c, its title is Edit Screening Rule.

3. Complete this dialog box using the detailed instructions on creating a
Screening Rule found in the eServices (Multimedia) 8.0 User s Guide.

End of procedure
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Notes: To obtain all available screening functionality, Genesys recommends
that you use the MultiScreen object instead of the Screen object. Use
the Screen object for backward compatibility only (for example, for 7.0
backward compatibility).

When you first start creating routing strategies, you might want to use
the Screen object instead of the Classify object if your site’s
classification Categories are not yet defined or if your site has not
purchased the Content Analysis option required by the Classify IRD
object.
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Chapter

Creating Configuration
Manager Objects

This chapter provides step-by-step instructions for creating Configuration
Manager objects that are used by IRD’s strategy-building objects. It contains
the following sections:

+  Opening Configuration Manager, page 237

« Defining Skills, page 239

«  Defining Persons, page 241

«  Defining Agent Groups, Places, and Place Groups, page 243

- Defining Business Attributes, page 243

For background information, see “Configuration Layer Interface” on page 155.

Opening Configuration Manager

The information in this section assumes you have already set up the Genesys
Configuration Layer as described in Framework 8.1 Deployment Guide.

Procedure:
Logging into Configuration Manager

Start of procedure

1. Click the desktop shortcut if one appears (see Figure 188).

i

Figure 188: Configuration Manager Desktop Icon
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Opening Configuration Manager

As an alternative, use the Start button and select Programs > Genesys

Solutions > Framework > Configuration Manager.

2. Respond to any security-related screens that your company may have
configured to appear before the Configuration Manager login dialog box.
The Configuration Manager login dialog box appears as shown in

Figure 189.
Configuration Manager =10 x|

%? “Welcome to the Configuration M anager

Uzer name: I

|lzer passward: I

K. I Cancel Detailz < |

Application; I

Host narme: I j
Fuort: || j

Figure 189: Configuration Manager Login Dialog Box

3. Use the information in Table 20 to complete the Configuration Manager

login dialog box:

Table 20: Configuration Manager Login Dialog

Box

Field Description

User name: Name of the Person object that is defined in Configuration

Manager.

User password: | Password of the Person object that is defined in

Configuration Manager.

Application: Use default to have the Application object selected
automatically or enter the name of an Configuration

Manager Application object.

Host name: Name of computer on which Configuration Server is
located.
Port: Port number that is used by Configuration Server. By

default, this value is 2020.
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4. Click oK. Configuration Manager opens (see “Environment Folder and
Tenants™ on page 156).

5. If working in a Multi-Tenant environment, select a Tenant object (one of
the tenants is named Environment).

End of procedure

Note: All figures in this chapter are based on a Multi-Tenant environment.

Defining Skills

If you plan to route based on agent skills or skill levels, you must first create
SkiLl objects and then assign those Ski Ll objects to agents (Persons).

Procedure:
Defining Skill objects that can be assigned to agents

Start of procedure
1. Log in to Configuration Manager, as described on page 237.
2. Expand the Resources folder.

3. Right-click the Skills folder and select New > Skill. The New Ski Ll
Properties dialog box opens (see Figure 190).
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* new skill [techpubs3:6010] Properties X|

General | Arnes |

b=

Name: |EHI j

I¥ State Enabled

Figure 190: Skill Properties Dialog Box

4. Type the Skill name. Examples: Emai L, Chat, English, Spanish, New
Accounts, Existing Accounts.

5. Leave State Enabled checked.
6. The Annex tab is not required (if it does not display, select View > Options.

Note: Annex is an additional data structure Genesys uses to quickly
introduce additional information properties for any object. Annex
describes such properties as simple text options arranged in
sections, where each section typically relates to the product that
uses this set of properties. You can find information about when and
how to add and change information in Annexes in the configuration
sections of application-specific manuals.

7. Click 0K in the properties dialog box.

8. Continue defining Skills in this manner.
End of procedure

Note: In addition to assigning Skills to agent Persons as described below,
you can also route based on the value of a skill expression (see
Figure 121 on page 138).
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Defining Persons

Once you have defined Ski Lls, you can assign them to Persons, such as agents,
QA, managers, and supervisors. You can then route interactions to Persons
that have specific Skills and Skill Levels.

Procedure:
Defining Person objects

Purpose: To represent agents that can be routed to in the Configuration
Database.

Start of procedure

1. Log into Configuration Manager as described on page 237.

2. Under Resources, right-click the Persons folder and select New > Person.
The New Person Properties dialog box opens (see Figure 191).

2 New Person () [techpubs4:3010] Properk il

General |.-i'-.gent Infa | Rarks | &nnex |

Tenant: I,-;‘&I TechPubsz75 j il

Employee 10 I

E-Mait | |
— Internal Authentication

Uszer Mame: I j

Enter Paszword: I

Be-enter Passwiord: I

— Extermnal Authentication
External User |0 I j

[¥ State Enabled ¥ |z Agent

EI | 2k, I Cancel | Apply | Help |

Figure 191: New Persons Dialog Box, General Tab
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3. Complete the General tab. If you need help, click the Configuration
Manager Help menu and select Help Topics.

4. Click the Agent Info tab. Figure 192 on page 242 shows the dialog box
filled in with sample data.

2 4001 4001 {4001} [techpubs4:3010] Prop El
General Agdent Info I Ranks | Annex | Security | Dependency |
Default Place: Il@ 4001 j 4
Capacity Rule: Iﬁ. Default_l:lne_media_alluws_m-:uj
Lozt contract: IE [More] j j
Site: {5 [None] | %
— Skills
Skil | Leval |
Bonds 10 (I
E Currency |
Englizh 3
8 Enale ° -l
AddSkil | EdtSkil | DeleteSkil |
— Login D=
Agent Lagin | Switch | YWwrap-up T ime |
&b a0 75 G731 0
sgdiD | EdtiD | Deteld |
EI ak. I Cancel | Lol | Help |

Figure 192: Person Dialog Box, Agent Info Tab

5. Complete the Agent Info tab. Click the Add Ski Ll button to add a
previously defined agent skill. If you need help, click the Configuration
Manager Help menu and select Help Topics.

Note: If applicable, you can assign a Capacity Rule to the agent, which
defines the agent’s ability to handle multiple interactions. For more
information, see “Agent Capacity Rules” on page 164.

6. Click the Security tab.

7. Click the Permissions button in the Security tab and assign permissions
(see “Setting Permissions” on page 173). Figure 193 shows the dialog box
filled in with sample data.
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Object Permission

Object: Pergon "4001 4007 [4007]"

Accezz

@ STSTEM Special Ao

§ Environmenthdefault Full Control

§ TechPubs754admin_gad Full Cantral
&5 Envionment\Super Adminiztrators Full Cantrol
ﬁ TechPubs/BAdminiztrators Special Accezs(Rx]
ﬁ TechPubsrohU sers Special Acceszs(Rx]

Type of Access: |Speu:ial Arccess j

| 0k I Cancel | Add... | Eemwel Help |

Figure 193: Object Permissions Dialog Box

2

8. When you are finished defining permissions, click 0K to save in the Object
Permission dialog box.

9. Click 0K in the New Person properties dialog box.

End of procedure

Defining Agent Groups, Places, and Place
Groups

Once you have defined Persons, define Agent Groups and assign Persons to
each group. You only need to do this if you plan to route to agent groups. After
completing the previous sections, you now understand how to create new
objects in Configuration Manager:

1. Log into Configuration Manager as described on page 237.

2. Under Resources, right-click the object and select New <ob/ect_name> to
open the properties dialog box.

3. Complete the properties dialog box.

4. Click 0K to save your entries.

Defining Business Attributes

The Resources folder contains a Business Attributes folder. Figure 146 on
page 162 shows the folder expanded.
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As described in the chapter on interaction properties in the eServices
(Multimedia) 8.0 User s Guide, the origin of Business Attributes varies:

Some Business Attributes are predefined by Genesys and can be
expanded.

Other Business Attributes are customer-defined in Configuration
Manager.

Other Business Attributes are initially defined in Knowledge Manager
and then carried over to Configuration Manager.

Business Attributes from Knowledge Manager

If you followed the “Order of Configuration” on page 217:

Names of Screening Rules, defined in Knowledge Manager, will also have
carried over from the Universal Contact Server database.

Names of classification Categories, defined in Knowledge Manager, will
have carried over from the Universal Contact Server database. The names
will be viewable in the Category Structure folder along with the name of
the associated Standard Responses (see Figure 194).

= [ Bobs_Books
= = books
[ cookery
[y Fiction
[ periodical—
) self-help
1 D3l Service
] music
1 books]
1 Chat Transcript

]| Falders Contents of YConfigurationiTechPubs73Business AttributesiCateqory Structy
1 Action Codes ;I Display Mame Default = Cescription
[ Agenk Groups Enter text hare 5| Enter te... 5F| Enter text here
= B'-'S""ES_S Attributes @ book response False genetic response For book query
@i Business Result (@ Moby Dick False This response is for erudite writer
& Case [ [_Jpetiodicals
= & Cateqory Structure .
. . [_self-help
B [ Attribuke Values - Fickion
[ Aukto Response _I
[jcookery

Figure 194: Classification Categories and Standard Responses

Other Business Attributes that Might Need to Be Defined

244

You may still need to use Configuration Manager to define the following
Business Attributes:

Service Type and Customer Segment, which are used in the MultiAttach
object (see Figure 195).
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General |

Multi Attach properties x|

— Business Aftributes

" Attach

" Update {* Business Attributes

{” Reguested Skills

Attribute

Value

1 |ServiceType

2  |CustomerSegment

3 |ServiceObjective

| QK I Cancel Help

Figure 195: Multi-Attach Object Properties Dialog Box

The above three attributes are described in the chapter on IRD objects,
MultiAttach object section, in the Universal Routing 8.1 Reference
Manual.

Note: ServiceObjective is defined outside of the Business Attributes
folder under Objective Tables.

Disposition Code. Currently not used by any IRD object, but contained in
the Interactions table.

Language. The primary motivation for creating is the necessity to use this
Business Attribute in conjunction with some particular Tenant in
Knowledge Manager. All objects in Knowledge Manager, including
classification Categories and Screening Rules, can only be created under
specific combination of Language and Tenant. The following IRD objects
use the Language Business Attribute: Screen, Multi-Screen, and Screen
Segmentation. For more information about this attribute, see the chapter on
interaction properties in the eServices (Multimedia) 8.0 User s Guide.

PIN. Currently not used by any IRD object, but you might want to include
in interactions.
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Reason Code and Stop Processing Reason, when you are using the IRD
Stop object that is described in Table 8 on page 201. For more information
about Reason Codes, see the Stop Interaction object description in the
chapter on IRD objects of this guide.

As described in the Universal Routing 8.1 Reference Manual, E-mail
Accounts specifies an external e-mail address that is required when you are
using the following IRD objects: Acknowledgement, Autoresponse, Chat
Transcript, Create Notification, Create SMS, Forward E-mail, Redirect
E-mail, Reply From External Resource, and Send E-mail. See Table 8 on
page 201.

For additional information about E-mai Ll Accounts, see the chapter on

preparing your environment for Genesys Desktop in the Genesys Desktop
7.6 Deployment Guide. Also see description for the E-mail Server option
convert-idn-to-unicode in eServices (Multimedia) 8.0 Reference Guide.

Media Type. When you are implementing the Genesys Open Media
concept, another Business Attribute that you might want to create is a
custom Media Type that will be added to the Genesys predefined set of
Media Types. A service that is performed by some third party server that is
associated with a custom Media Type could be used in the External Service
object that is described in Table 8 on page 201.

Contact Attributes. See the topic on matching contact attributes in the
eServices (Multimedia) 8.0 Users Guide. Also see the chapter on contact
identification and creation in that guide.
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1 0 Creating Business Process
Objects

This chapter provides step-by-step instructions for starting a new business
process, including adding Queue, View, and Workbin objects, and Strategy
object placeholders.

This chapter includes the following sections:

+ Distribution of Load Between Multiple Interactions Servers,
page 315Simple Versus Complex, page 247

+ Defining the Business Process Object, page 248
« Using Media Server Objects, page 252

+ Adding Endpoints, page 254

+ Adding a Queue, page 258

« Adding a Synthetic Queue, page 262

« Adding a View, page 267

« Adding Workbins, page 292

+  Strategy Placeholder Option, page 299

« Adding a Submitter, page 303

«  About Connector Lines, page 305

«  Exporting and Importing a Business Process, page 306

- Distribution of Load Between Multiple Interactions Servers,
page 315Simple Versus Complex

Note: Sece “Order of Configuration” on page 217.

The chapter “Planning a Business Process” on page 195 discusses two types of
business processes:

1. A complex business process that encompasses many different functional
areas, such as the Genesys-supplied Default_BP (see Figure 174 on
page 198).
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2.

Smaller, less complex business processes, each of which encompass a
single functional area, such as the Genesys-supplied step-numbered

business processes (see Figure 175 on page 199).

This guide assumes that, as a new user, you will create smaller, less complex
business processes and connect them via queues. This chapter assumes that
you want to create something similar to the Step 1. Pre-Routing business
process that is shown in Figure 175 on page 199.

Defining the Business Process Object

Note: When you run IRD on a clean configuration, it automatically creates a

default Business Process object for you, which you can rename or use
to create other Business Process objects. The instructions and figures in
this section assume that you do not have a clean computer, but that you
have loaded the samples as described in “Using the Samples” on

page 197.

Procedure:
Defining a Business Process Script object

Purpose: To define the Business Process Script object in Configuration Layer.

Start of procedure

1. Log in as described in “Opening IRD” on page 57.

2. Click the Interaction Design shortcut bar on the left.

3. Click the Business Process icon. Existing business processes are listed for
selection as shown in Figure 35 on page 60.

4. If a folder is already selected, from the File menu, click New. You can also
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right-click any folder on the list pane and select New; The New dialog box
opens. A temporary name for the business process appears in the browser
as shown in Figure 196.
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Defining the Business Process Object

File Edit

& Interaction Design - BusinessProcess1

Wigws Business Process  Tools  Help

=101

e B HE aaE & 2

i

72Techpubs
ABC Simple BP
ABC Simple Chat BP

BusinessProcess1

----- (27 Workbins
=45 Strategies

------ (£ Subroutines

[#-{og| Default BP
[+-{8i5| Haw kot apply escalation pro__

108 How b abbach classification

.

lu

Figure 196: New Business Process with Temporary Name

5. Select (slowly double-click) temporary name and replace it, supplying the
name that is to be used for the Script object (see Figure 143 on page 159).

Assume that you enter Preprocessing. Because the browser lists business
processes in alphabetical order, it now appears as shown in Figure 197.

File Edit

ﬁﬂ Interaction Design - Preprocessing

Yiew Business Process  Tools Help

=10] >

|e= 2=

QoE|E ?

I

i) Queues
(L Warkbins

Ea Strategies

Step 1. Pre-routing
Step 2.1, NDR handling

Step 3.2, QA review
Skep 3.3, Forwarding

EI iElPreprocessing -

Step 0. Common component:

Step 2.2, Inbound collabarat
atep 2.3 Mew inbound e-mail
akep 3.1, Processing by age

s

Figure 197: Business Process Renamed

Note: If you change your mind at any point, click the Edit menu and select
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Undo Creating or Undo Updating.
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6. Right-click the business process and select Properties from the shortcut
menu. The Business Process Properties dialog box opens (see
Figure 198).

The 'Default’ Business Process Properties k|

General |

Seript M ame ID efault

Drescription I

[ Default

Figure 198: Business Process Dialog Box

7. In this dialog box, describe the business process.

8. A Business Process can be the default Business Process for the Tenant by
selecting the Default check box. The configuration of the default Queue
and default Business Process simplifies Media Server configuration, and
enables interactions to be submitted without having to specify the initial
interaction queue. Only one Business Process within a Tenant can be set as
default.

Note: Sce the eServices documentation to develop a Media Server object
that takes advantage of the default Business Process and default
Queue configuration.

9. After completing the dialog box, click its upper-right corner. The new
Business Process object remains selected in the viewer.
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10. Select Save from the File menu. This creates a new Script object in the
Configuration Database of type Business Process (see Figure 143 on
page 159). You can still change the name in the Interaction Design
window as shown in Figure 73 on page 9.

End of procedure

Notes: To switch to another business process, save the changes in the current
business process, and double-click the business process you want to
switch to.

Unlike the Routing Design window, the Interaction Design window
does not allow you to save a business process within a tree of
customized folders/subfolders, which is then viewable on an IRD list
pane. You may save a business process only in the predefined default
Scripts folder (see Figure 35 on page 60).

Warning! Do not use Configuration Manager to manually create business
process and the other Script objects described in this guide. To
ensure database integrity, use only IRD to create these objects.

Procedure:
Deleting a previously saved business process

Warning! If you do not want to delete the strategies that are associated with a
business process, move them to the Independent Objects folder
(see Figure 38 on page 63) before you delete the business process.

If you have not yet saved the business process, you can delete it by exiting the
Interaction Design window and clicking no to the prompt indicating that the
configuration has been changed.

Start of procedure

1. To delete a business process, right-click it in the object browser.

2. Select Delete from the shortcut menu. If the business process was
previously saved, the message shown in Figure 199 appears.
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Interaction Routing Designer x|

0

Deleting Business Process object will also delete all objects, that belong to it, induding strategies' REM files,
Do you wish to continue?

Figure 199: Delete Confirmation Message

3. Click Yes. See page 172 if you need to review strategy *.rbn files.

End of procedure

Procedure:
Switching to another business process

Start of procedure

Later on, if you wish to switch to a different business process, you can
double-click that business process or use the shortcut menu:

1. Select the business process in the object browser,
2. Right-click to open a shortcut menu.

3. Select Open the Process from the menu. The business process is
highlighted in the object browser.

End of procedure

Using Media Server Objects

252

For background information about Media Server objects, see page 39.

The eServices software components include five media servers—E-mail
Server, Chat Server, SMS Server, iWD Capture Points, which process e-mail,
chat, SMS/MMS interactions, and iWD tasks respectively—and Third Party
Servers. For more information about these servers, start with the eServices
(Multimedia) 8.0 Deployment Guide.

E-mail Server (see page 52) Chat Server, and iWD Capture Point Application
objects and their endpoints that are already defined in your Configuration
Environment are listed in the object browser of the Interaction Design
window. Figure 200 shows an example Media Servers folder.
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e8| Skep 3.3, Forwarding
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Figure 200: Media Servers and Endpoints in Object Browser

In the example in Figure 200, there are three Media Server objects:
ChatServer, E-MailServer and EmailServerdava_760. Note the arrow-shaped
objects under each media server. These are Endpoint objects (see page 41 if
you need a review).

Placing a Media Server Object

To get interactions of a particular media type into a business process, you have
the option of placing a Media Server object, and then connecting some or all of
its endpoints to queues. After you do this, you can continue processing the
media server’s interactions in the current business process and in subsequent
business processes. Follow these steps:

1. First determine whether the Media Server object has already been placed in
the workflow via a previously configured business process.
+ Ifyes, continue with “Adding Endpoints”.
+ Ifno, continue with step 2.
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2. To place a Media Server object in this particular business process, drag the
Media Server object from the object browser and drop it into the workflow
viewer.

Adding Endpoints

254

You may or may not need to configure additional endpoints for your media
server in order to get interactions into the proper queue. To determine this,
review the information in “Media Server Object” on page 39 and “Endpoint
Object” on page 41.

Note: You can add endpoints before or after you drag a Media Server object
into a business process. Endpoints added to a Media Server in the
object browser automatically appear in the workflow viewer.

Procedure:
Adding endpoints

Purpose: To connect a media server and its interactions with a queue in a
business process.

Start of procedure

1. Select Add Endpoint by using one of the following methods:

+  From the shortcut menu that appears when you open the Media Servers
folder in the object browser and right-click a media server.

+  From the shortcut menu that appears when you right-click a media
server in the workflow viewer (if a media server has already been
placed there).

+ From the Business Process menu, when you select a media server in
the object browser or workflow viewer.

The new Endpoint object appears in the object browser with a temporary
name, which you can edit (see Figure 201).
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Figure 201: Object Browser After Selecting Add Endpoint

If the media server is already in the workflow viewer, the new endpoint
with its temporary name appears there as a port on the right side of the
media server (see Figure 202).
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Figure 202: Workflow Viewer After Selecting Add Endpoint
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Adding Endpoints

2. Select (slowly double-click) the temporary name to edit it. You have the
option of supplying a more descriptive name. Assume you name it
ProductB. IRD moves the endpoint down to maintain alphabetical order.

3. Save the business process as it exists so far.

4. Define the queue to be connected to the endpoint (see “Adding a Queue”

on page 258). Assume you name it ProductB.

5. Connect the endpoint(s) to the queue(s). Figure 203 shows the endpoint
connected to a queue.

Wiewy  Business Process
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Help
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[#-{8i8| 75TechPubsTenant -
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o BusinessProcess1
o8| BusinessProcess2
o8| Default BP
- How to; apply escalation
-] Queues
EI a Warkbins
- @k Supervisars workbin
: I -y Workbin For Original
=3 Strategies
@ Move overdue inters
------ fe[27] Subroutines

E§|-- How ko aktach classification
E§|-- How ko aktach classification -
| | 4

1

InFnrmatlnn

Sales

Suppu:urt

EmailServerJava, TR0

TS

ProductB

x|
=

|

Configuration 3aved - 0 errori(s),

O warningi(s) .

HI 4' IIHI'-. Lnuul_:“‘f.l Configuration Updates }'\ Search Results f
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Faor Help, press F1
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Figure 203: Media Server Endpoint Connected to Queue
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Note: If an endpoint is used in another business process, IRD allows you to
draw the connector. In the business process where the endpoint was
previously used, IRD outlines the endpoint in red and no longer shows

connector. This ensures a single endpoint is only connected to a single
queue.
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Adding Endpoints

6. Save the business process, as it exists so far.

End of procedure

The endpoint appears in the endpoints:<endpoints::DBID) section in the media
server Application object. Figure 204 shows an example for a Multi-Tenant

Application object.

¥ EmailserverJava_760 [techpubs4:3010] Properties x|
Bninex I Security I D ependency |
General | Tenants I Server Info | Start Info I Conrections Optiars
k- T A 13
=¥ e dpointz: 101 j I | I:l x | E | B o 5
Mame "Yalue
Enter text here S| Enter tewt here i
fzﬁ, Information "B nbound"™!

s Froduct B
[

abe S ales
'El_br, Support

jia]

] I Cancel Spplp Help l
T

Figure 204: E-mail Server, Example Endpoints Section

Note:

Business Process—User’s Guide

If you are planning to use a single Interaction Server as a Multi-Tenant
Application, you can configure as many inbound queues as you need
for directing media server interactions into queues by creating
Endpoint objects in the Interaction Design window, which writes to
the endpoints:<tenant_DBID) section in the media server Application

object.
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Adding a Queue

For background information about Queue objects, see page 27. For
information about connector lines, see page 305.

The next step is to define a Queue object. For information about the initial
inbound queue, see Figure 3 on page 23.

Procedure:
Adding a Queue object

Purpose: Associating a Queue object with a business process.

The following instructions assume that you are continuing from the previous
section.

Start of procedure

1. Click the Business Process menu.

2. Select New Queue. A new Queue object appears in the object browser with a
temporary name (see Figure 205).

Interaction Design - Preprocessing = |EI|

File Edit Yiew BusinessProcess Tools Help
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=l
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-- Step 1. Pre-routing
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-- Step 2.2, Inbound collaboral TB_E-MailServer —
{8 Step 2.3 Mew inbound e-mai
-- Step 3.1, Processing by age
-- Step 3.2, QA review
ol Step 3.3, Forwarding

Information
ProductB

L
Sales

=

Support

Figure 205: New Queue with Temporary Name

3. Select (slowly double-click) the temporary name and replace it with the
name to be used for the Script object (see Figure 143 on page 159).
Figure 206 shows the queue as it appears in the Object Browser after it has
been renamed.
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Adding a Queue
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Figure 206: New Queue Renamed

4. Drag the Queue object to the viewer and drop it there (see Figure 207).
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Figure 207: Queue in Workflow Viewer

5. Right-click the Queue object in the right pane and select Properties of
and then select the queue name. The Queue Properties dialog box opens

(see Figure 208).
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The ‘ProductB® Queue Properties k|

General | zed InI

Script Mame IF'ru:u:qu:tE

Description I

¥ Enabled

Figure 208: Queue Properties Dialog Box, General Tab

Note: You can also enable/disable Queue objects the same as any other object
in Configuration Manager.

The Used In tab names the business process in which the queue is used.

The 'ProductB’ Queue Properties k|

Gereral Uzedin |

Freprocezszing

Figure 209: Queue Properties Dialog Box, Used In Tab

6. Use the information in Table 21 to complete the General tab of the Queue
Properties dialog box:
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Table 21: Queue Properties Dialog Box

Field Description

Script Name Reflects the name that is entered in the object browser. When
you save, the definition will be saved as a Script of type
Interaction Queue in the Configuration Database (see

Figure 143 on page 159).

Description Describe the queue.

Enabled After activating strategies as described on page 361, open the
Queue Properties dialog box and select the Enabled check box

to specify the queue state as ready to accept interactions. The
default is checked (enabled).

7. If this queue will receive media server interactions via an Endpoint object,
connect the Endpoint object to the Queue object (see Figure 210).

Interaction Design - Preprocessing = |I:I|_>
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o] Step 3.3, Forwarding
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Figure 210: Media Server Endpoint Connected to Queue

lw

Support

8. Select Save from the File menu.

End of procedure

Later, when creating routing strategies, the queue will be selectable in the
properties dialog box for all IRD objects that let you select queues, such as
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Queue Interaction. You will find it under the associated business process (see
Figure 211).

(ueue Interaction properties El
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]

] I Cancel | Help |

Figure 211: Queues Available for Selection

Note: Bec sure that you define separate interaction queues and workbins for
each Open Media type.

Adding a Synthetic Queue

A synthetic queue is a queue that is composed of multiple interaction queues.
Creating a synthetic queue simplifies workflow configuration by enabling you
to specify interaction processing by multiple queues in a single step.

Three types of synthetic queues can be created:

+ Business Process Queue—represents interactions located in any
queue that belongs to the same Business Process as the Business
Process queue. A Business Process Queue can be used to define
processing for all interactions of a given Business Process.
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+ Synthetic Queue—represents interactions located in any queue that is
listed in the Synthetic Queue configuration. A Synthetic Queue can be
used to define processing for all interactions in a specific group of
Interaction Queues.

+ Tenant Queue—represents interactions located in any queue that
belongs to the same tenant as the Tenant Queue. A Tenant Queue can
be used to define processing for all interactions that belong to a tenant.

Procedure:
Adding a Synthetic Queue object

Purpose: To associate a Synthetic Queue object with a business process.

The following instructions assume that you are continuing from the previous
section.

Start of procedure

1. Click the Business Process menu.
2. Select New Synthetic Queue.

3. Inthe Type drop-down list, select the synthetic queue #ype for this
synthetic queue (Business Process, Synthetic, or Tenant, as described
above), then click 0K.

4. A new Queue object appears in the object browser with a temporary name
(see Figure 212).

| BH Interaction Design - Default BP

| Fil= Edit Miew Business Process Tools Help

o> |H Eos0E|Z|?

izl =l
=-{id| ABC Simple BP -
-5 Queuss
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% Cutbound queus
ﬁ Cele

b2 Workbins
-5 Strategies

-- Process ABC
- Send ABC

------ ([ Subroutines
& ABC Simple Chat BP
@i ABC Simple MMS

#-{e8 ABC Simple SMS Paging

Figure 212: New Synthetic Queue with Temporary Name
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Adding a Synthetic Queue

5. Select (slowly double-click) the temporary name and replace it with the
name to be used for the Script object (see Figure 143 on page 159).
Figure 213 shows the synthetic queue as it appears in the Object Browser

after it has been renamed.
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Figure 213: New Synthetic Queue Renamed

6. Drag the Synthetic Queue object to the viewer and drop it there (see Figure

214).
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Figure 214: Synthetic Queue in Workflow Viewer
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7. Right-click the Synthetic Queue object in the right pane and select
Properties. The Interaction Queue Properties dialog box opens (see
Figure 215, Figure 216, and Figure 217).

The "ProductB’ Interaction Queue Properties E |

General | Llseu:llnl E!ueuesl

Script Hame IF'ru:u:qu:tB

Dezcription I

Type ISynthetic

¥ Enabled

Figure 215: Synthetic Queue Properties Dialog Box, General Tab

The 'ProductB’ Interaction Queue Properties E I

General Usedln | E!ueuesl

&BC Simple BP

Figure 216: Synthetic Queue Properties Dialog Box, Used In Tab
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Figure 217: Synthetic Queue Properties Dialog Box, Queues Tab

8. Use the information in Table 22 to set values in the Interaction Queue
Properties Dialog box.

Table 22: Synthetic Queue Properties Dialog Box

Tab Field Description

General (All Script Name (Read-only) Displays the name that you assigned to the
Synthetic synthetic queue in the Object Browser. When you save, the
Queue Types) definition will be saved as a Script of type Interaction Queue in

the Configuration Database (see Figure 143 on page 159).

Description Describe the synthetic queue.

Enabled After activating strategies as described on page 361, open the
Queue Properties dialog box and select the Enabled check box
to specify the synthetic queue state as ready to accept
interactions. The default is checked (enabled).

Used In (All This read-only tab lists the Business Processes in which this

Synthetic synthetic queue has been placed.

Queue Types)

Queues Select the interaction queues to be included in this synthetic

(“Synthetic” queue from the tree on this tab. The interaction queues are

Type Only) listed under the Business Processes in which they were initially
configured.

9. If this queue will receive media server interactions via an Endpoint object,
connect the Endpoint object to the Queue object (see Figure 210 on
page 261 for an example).
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10. Select Save from the Fi le menu.

End of procedure

Later, when creating routing strategies, the queue will be selectable in the
properties dialog box for all IRD objects that let you select queues, such as
Queue Interaction. You will find it under the associated business process (see
Figure 211 on page 262).

Adding a View

For background information about View objects, see page 28. For information
about connector lines, see page 305. A View object allows you to define one or
more of the following:

* The name for the View object in the Configuration Manager Scripts
folder (see page 271)

* The conditions for interaction selection including parameterized
conditions, such as those that are used by Agent Desktop (see pages 272
and 282)

*  The order of interaction selection (see page 274)

e The time interval that Interaction Server uses to check for interactions
(page 275)

*  The schedule for submitting interactions to strategies (see page 275).
* Database hints (see page 283)
*  The number of interactions of different segments (see page 284)

In addition, you can use Configuration Manager to limit the number of
interactions based on interaction properties, such as Customer Segment (see
page 287).

You can set other values in the Interaction Server Application object, as

described in the chapter on configuration options in the eServices (Multimedia)
8.0 Reference Manual.

Same Queue, Multiple Views

You can define multiple View objects for a single queue or workbin. The
examples that follow use queues. For an example of a view attached to a
workbin, see “How To: Apply Escalation Procedure” on page 411.

Example #1
You must define multiple views for a queue if you want to deliver interactions

from one queue to different routing strategies. For example, if you have E-mail
Server submit all e-mails into one queue, but you have two separate
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strategies—one for normal e-mail and another for nondeliverable e-mail—you
must define two views.

Example #2

You might want to define multiple views for a queue for priority escalation:

*  You could use one view to pull interactions for standard processing by a
routing strategy that delivers interactions to agents.

*  You could use a second view to select interactions for special processing
by a routing strategy that changes interaction priority and then returns the
interaction to the same queue.

Warning! If you configure multiple views for the same queue and the view-
selection conditions overlap, more that one view could potentially
select the same interaction. When configuring views, be sure
conditions do not overlap. Also, make sure that conditions process
all the interactions in the queue.

Procedure:
Adding a View to a Queue object

Purpose: Views enable you to extract interactions from queues, either all
interactions or interactions that are based on specific selection criteria.

Note: This section describes attaching a view to a queue. The instructions
also apply to attaching a view to a workbin.

Start of procedure

The following instructions assume that you are continuing from the previous
section.

1. Select the queue to which you want to attach the view, either in the object
browser or in the workflow viewer.

2. Right-click and select New View from the shortcut menu that opens (see
Figure 218). You can also select New View from the Business Process
menu.
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Figure 218: New View From Context Menu

After you select New View, the object browser and viewer show a new view
with a temporary name (see Figure 219).
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Figure 219: New View with Temporary Name
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3. Select (slowly double-click) the temporary name and replace it with the
name to be used for the Script object.

Assume that you rename it ProdBView1

Adding a View

4. Double-click the small circle that represents the new view (see

Figure 220).
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Figure 220: New View Attached to Queue Object

The View Properties dialog box opens (see Figure 221).

Description I

The ‘ProdBYiewl’ Yiew Properties

2]

General |Eu:unu:|itiu:un| Crder I 5cheduling| Farameterized Eu:unditiu:unsl Cal 4 | *l

Script Mame IF'ru:u:IEI‘»-"iew‘I

¥ Enabled

Check Interval [zec) I

Figure 221: View Properties Dialog Box, General Tab

Note: You can also enable/disable View objects the same as any other object
in Configuration Manager.

End of procedure
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General Tab

Next Steps
* Complete the General tab (optional step).

This section contains procedures for completing each tab in the View
Properties dialog box.

Procedure:
Completing the View object General tab

Purpose: To describe the view and to specify the frequency for checking the
queue if the default will not be used.

Start of procedure

1. Click the General tab in the View Properties dialog box.

2. Use Table 23 to complete the General tab of the dialog box shown in
Figure 221.

Table 23: View Properties Dialog Box, General Tab

Field Description

Script Name Reflects the name that is entered in the object browser. When you save, the
definition will be saved as a Script of type Interaction Queue View in the
Configuration Database (see Figure 143 on page 159).

Description Enter a description for the view.
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Table 23: View Properties Dialog Box, General Tab (Continued)

Field

Description

Enabled

After activating strategies as described on page 361, open the Queue
Properties dialog box and select the Enab led check box to specify the view as
ready to extract interactions. The default is checked (enabled).

Check Interval (sec)

Enter the number of seconds to specify the frequency (time interval) that
Interaction Server will use to check the queue and, if necessary, adjust the
number of interactions that can be submitted to the strategy based on options in
the Scheduling tab (Figure 225 on page 275). Acceptable values are 0~300
seconds. You might want to use this field for high-value interactions or
time-sensitive conditions, such as when checking should be performed more
frequently.

This field creates or updates option freeze-interval for the view. It overrides
option default-view-freeze-interval (in the settings section of Interaction
Server options) for the view. The freeze-interval defines how long Interaction
Server suspends database checking for a view if no interactions were selected.
If option freeze-interval is not present for a particular view, the value of
default-view-freeze-interval is used. If option default-view-freeze-interval is
not specified, Interaction Server uses the default of 300 seconds.

Condition Tab

This section describes the tab on which you specify the condition for extracting
interactions from queues.

272

3. When you have finished completing the General tab, select Save from the

File menu.

End of procedure

Next Steps

Complete the Condition tab (optional step).

Procedure:
Completing the View object Condition tab

Start of procedure

Click the Condition tab in the View Properties dialog box.

2. Use Table 24 to complete the Condition tab that is shown in the following

figures.
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Table 24: View Properties Dialog Box, Condition Tab

Adding a View

Field

Description

Condition

Here you have the option of creating an expression. Figure 222 shows an
example from another business process.

The ‘BP Linel Daemon' Interaction Oueue ¥Yie

Gereral  Condition I Order I Schedulingl Farametenzed C

customer_zegment="gold AND service_type="sales]

Figure 222: Extracting Based on Customer Segment

Another example from another business process:

The ‘BP_Linel_Daemon' Interaction Ouegue Yie

General Condition I Crder I 5|:heu:|uling| Farameternized C

time_in_gueue(] > 4320

Figure 223: Extracting Based on Time in Queue

As an alternative to the Condition tab, the Segmentation tab (see
page 285) uses a more complex approach that involves specifying limits
and submitting equal numbers of interactions.

The expression defines the conditions for interaction selection. You can
specify one or more expressions, which can be comprised of:

« An interaction attribute name from the interactions table. eServices

(Multimedia) 8.0 User s Guide lists and describes the interaction
attributes that you can use when building an expression.

+ A relational operator, such as an equal sign or a greater than sign.
+ The attribute value in single quotes.

The expression is used for interaction selection as if you were constructing

a SQL SELECT statement and specifying a WHERE clause.

For a comparison of the Condition tab with the Parameterized Condition

tab, see page 282.

When you have finished completing the Condition tab, select Save from

the File menu.

End of procedure
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Next Steps
* Complete the Order tab (optional step).

Order Tab

This section describes how to specify the order of interaction selection.

Procedure:
Completing the View object Order tab

Start of procedure

1. Click the order tab in the View Properties dialog box.
2. Use Table 25 to complete the Order tab that is shown in Figure 224.

Table 25: View Properties Dialog Box, Order Tab

Field Description

Order Here you have the option of defining the order for pulling interactions from
the queue when using this view.

order:= [property order[,order]]property order:= property name [asc|desc]

Example using an attribute found in the interactions table.

The "WorkbinAgentA® Interaction York Bin Prop

Eenerall Order Uszedln I Dueuel

How to: apply escalation procedure

Figure 224: Order Tab

For more information interaction attributes that can be used on the Order tab,
see the section on System Properties in the chapter on Interaction Properties in
the eServices (Multimedia) 8.0 User's Guide.

3. When you have finished completing the Order tab, select Save from the
File menu.

End of procedure

Next Steps
* Complete the Scheduling tab (optional step).
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Scheduling Tab

This section describes how to schedule submitting interactions to a routing
strategy. You might want to do this for various reasons, such as scheduling of a
customer callback or to escalate overdue interactions.

Procedure:
Completing the View object Scheduling tab

Start of procedure

1. Click the Scheduling tab in the View Properties dialog box (see Figure
225).

The ‘BP Linel Daemon’ Interaction Queue ¥Yie £

Generall Condition | Order ~ Scheduling | Parameterized Eu:unditi-:unsl Cal 4 I ’I

&+ |gnore 5 cheduling

" Scheduled Orly

" Scheduled &nd Unscheduled
" Unzcheduled Only

Figure 225: Scheduling Tab

2. Use Table 26 to complete the Scheduling tab.

Table 26: View Properties Dialog Box, Scheduling Tab

Field Description

Scheduling The Scheduling tab shown in Figure 225 on page 275 lets you specify the
scheduling condition that Interaction Server should use, based upon the
scheduled time contained in interactions (see “Setting the Scheduled At
Property” on page 276).Background: The interaction scheduling functionality
uses a database field called scheduled at, which is mapped to an interaction
property called ScheduledAt. For information about this field, see the chapter
on interaction properties in the eServices (Multimedia) 8.0 User s Guide.

Ignore Scheduling Default. Select if there is no scheduled processing. Even if the value of
ScheduledAt is set for some interactions, Interaction Server ignores it.
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Table 26: View Properties Dialog Box, Scheduling Tab (Continued)

Field

Description

Scheduled Only

Select to process only interactions that are scheduled (ScheduledAt is set) as
per the value of the scheduled time. If selected, Interaction Server uses the
following condition: (_current_time() >= scheduled at) and the following
order: scheduled at, received_at, id.

This condition and the conditions that follow are stored in the Scripts folder of
Configuration Manager, Interaction Queue View object, Annex tab.

Scheduled and
Unscheduled

Select to process scheduled interactions at scheduled times (ScheduledAt is
set) and after that, process unscheduled interactions. In this case, scheduled
interactions are delayed until the scheduled time, and all others are processed
immediately afterwards. If selected, Interaction Server uses the following
condition: ((scheduled at is NULL) OR (_current time() >= scheduled at))
and the following order: scheduled at, received_at, id.

Unscheduled Only

Select to process only interactions that are unscheduled (‘ScheduledAt’ is not
set). Interaction Server uses the following condition: (scheduled at is NULL)

276

3. When you have finished completing the Scheduling tab, select Save from
the File menu.

End of procedure

Next Steps

* Complete the Parameterized Conditions tab (optional step) as described
on page 282.

Setting the ScheduledAt Property

There are several methods for setting the scheduled time:

1. Setting scheduled time directly. You can directly set the value of the
ScheduledAt property using:

RequestChangeProperties, RequestUpdateUserData,
RequestAttachUserData, or RequestDeletePair from URS. For information
about these message types, start with the Multimedia 7.5 Interaction
Models Reference Manual.

Note: This method is more likely to be used by custom applications that
use the RequestChangeProperties API (Open Media Platform
SDK).
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2. Setting processing delay relative to the current time. You can configure
a routing strategy to set the special interaction property ScheduleDelay to
the number of seconds to schedule processing at timestamp current time +
ScheduleDelay.

Note: This property is not stored in the database and is not maintained as
an interaction property in the Interaction Server protocol. Instead,
the ScheduledAt property is calculated as current time +
ScheduleDelay and is stored at the time when the interaction is
placed in queue (current time is a timestamp of
RequestChangeProperty).

This method is particularly useful to schedule processing of interaction in
strategy. Property 'ScheduleDelay' is not visible to reporting (it is not
propagated in any reporting events). Instead it appears that property
ScheduledAt is changing.

3. Setting processing delay relative to a fixed timestamp. Sometimes it is
useful to schedule processing delay for a specific timespan relative to a
well known timestamp such as ReceivedAt, SubmittedAt, MovedToQueueAt,
PlacedInQueueAt, DeliveredAt, SubmittedToRouterAt, or possibly any other
timestamp not related to interactions.

To accomplish this, Interaction Server can interpret another special
interaction property, ScheduleBase. In this case, the ScheduledAt timestamp
is calculated as ScheduleBase + ScheduleDelay. The ScheduleBase must be
in the standard date format of Interaction Server protocol YYYY-MM-DD
HH:MM: SS. If the property is not present in the update request (when
ScheduleDe lay is present), then it is considered as a current time, which
leads to the scenario described above in setting processing delay relative to
current time.

This schema of scheduling allows URS (via the strategy) to schedule
processing using a calculated delay in seconds and a fixed (existing)
timestamp. For example, it is easy to schedule processing for two hours
after interaction submission by simultaneously updating ScheduleBase to
SubmittedAt and ScheduleDelay to 7,200. Setting ScheduleBase to
SubmittedAt does not require any date manipulation in the URS strategy; it
is simply a substitution of an existing value.

Sample Strategy to Set the Scheduled Time

IRD’s Function object contains several Date and Time functions that you can
use when setting the scheduled time: GetUTC, UTCAdd, UTCFromString, and
UTCToString. For information about these functions, as well as the Attach and
Update functions that you may also use when setting the scheduled time in
interactions, see the chapter on functions in the Universal Routing 8.1
Reference Manual. Figure 226 shows a sample strategy, which uses these
functions.
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=10 %]

# Routing Design - Scheduling_UTC_FromString *
| Eile Edit “ew Tools Help

s@ss sme an Al ] [areane
"ﬁ@®@@EDHkl@@H%%fE“ﬁﬂu| """
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ERERERE]

For Help, press F1

Figure 226: Strategy for Setting Scheduled Time and Placing in Queue

Strategy Flow

1. The UData function specified in object 1 in Figure 226 retrieves the value
from the ReceivedAt attribute. It points to the time when the interaction

was received (see Figure 227).
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Figure 227: Retrieving Time

2.
the time string from the R

Interaction Received

eceivedAt attribute (presented in

YYYY-MM-DDTHH:MM:SSZ UTC format) and returns it as the number of

seconds (see Figure 228).

The UTCFromString function in object 2 in Figure 226 on page 278 takes

General |

;?.w- Function properties

¥

— Exprezsion

T CFrom_Sting

F

T CFromString[Feceived_at]

—Data

Type

Calllnfo

Configuration Options
Drata b anipulation
Drate/Time

Force

Lizt b anipulation
Mizcelansous

| e EPSPR Ry

=

Mame
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Add
IlzeCustomagentT ppe

=

zeCustorDMN T vpe

UszeCustomPlaceT ype Yerify
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zeMediaT ype

T Cadd
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Figure 228: Returning Number of Seconds

3. The UTCAJd function in object 3 increments the time string supplied by
the UTCFromString function by 120 seconds (see Figure 229).
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Adding a View
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Figure 229: Incrementing Time

4. The UTCToString function in object 4 in Figure 226 on page 278 takes the
updated UTC time in seconds (supplied by the UTCFromString function)
and converts it back into YYYY-MM-DDTHH:MM:SSZ UTC format (see

Figure 230).

General |

;?.ﬁ Function properkties

— Expreszion
UTC TaSting

F

UTCTaStingUTC_Add]

—Data
Tupe M ame
zeCustomdgent T vpe :I &dd |

Calllnfao IlzeCustomDMT ype

Configuration Qptions IlzeCustomPlaceT ype erit |

[ ata Manipulation zeDMNTvpe B

D ate/Tirme lzeMediaType

Force ITCAdd

Lizt M anipulation IITCFromStrin

Miceloreous | |ITEICH ~| | Vaishes |
Figure 230: Convert Back to UTC Format

5. In object 5, the time in the ScheduledAt attribute in the interaction is
updated by the time (in YYYY-MM-DDTHH:MM:SSZ format) supplied by the
UTCToString function (see Figure 231).
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Figure 231: Update ScheduledAt Attribute

6. In object 6, the interaction takes its place in queue. From there (see
Figure 232), it will be executed by the time set in the ScheduledAt
attribute.

;?.ﬁ Queue Interaction properkties El

General |

— Interaction queve

Figure 232: Interaction Placed in Queue

Cancelling Scheduling

To cancel scheduling, you must configure a strategy to delete the property
ScheduledAt using attribute attr_deleted prop of RequestChangeProperties
or by using RequestDe LetePair. Setting the value of this property to an empty
string will also lead to deletion of this property.

When property attr_deleted prop is deleted, the corresponding field
(scheduled_at) is set to NULL and property ScheduledAt is no longer present in
the interaction data (not visible in Events).

Note: The Script file for the View object reflects what you select in the

Scheduling tab. To preserve database integrity, do not change this field
in the Script object; use only the Scheduling tab.
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Parameterized Conditions Tab

282

The Parameterized Conditions tab lists the interaction attributes that can be
used in pull requests from clients of Interaction Server (for example, from
Agent Desktop). Each pull request can use any listed attribute, a combination
of listed attributes, or none. If an attribute is not listed on this tab, then client
applications cannot use it. For details on pull requests, see the “RequestPull”
section in the chapter on Interaction Management Protocol in the Multimedia
7.5 Open Media Interaction Models Reference Manual.

For example, if the Parameterized Conditions tab lists the from_address
attribute, then a pull request from a client can include a condition such as
from_address=joe_customeremyisp.com. This would retrieve all interactions
from a particular contact.

The Condition tab and the Parameterized Conditions tab both make use of
interaction attributes (see the chapter on Interaction Properties in the eServices
(Multimedia) 8.0 User's Guide). The difference between them is:

* The Condition tab states a condition that applies to all pull requests.

* The Parameterized Conditions tab only lists attributes that can be used as
parameters in a pull request, but it is up to the client whether or not to use
these attributes.

You can:

» Select the attribute from a drop-down list of interaction attributes. This list
includes most of the attributes in the interactions table. the exceptions
are abandoned_at, destinations, moved_to_queue_at, scheduled_at,
server_id, and snapshot_place_id.

* Enter the name of a custom property that you have created in
Configuration Manager. Creating custom properties is described in the
“Interaction Properties” section of the chapter on Interaction Properties in
the eServices (Multimedia) 8.0 User's Guide.

Procedure:
Completing the Parameterized Conditions tab

Start of procedure

1. Click the Parameterized Conditions tab in the View Properties dialog
box. This tab is used by Genesys Supervisor Desktop interface. See the
Genesys Desktop 7.6 Supervisor Help for more information about this
interface.

2. There are two ways to add an attribute:

* Click Add and manually type the attribute name in the text box (where
Figure 233 shows NewCondition).
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*  Click the down arrow opposite NewCondition and double-click an
attribute name from the interactions table (described in the eServices
(Multimedia) 8.0 User s Guide). Figure 233 shows the tab after
clicking Add and selecting NewCondition.

The 'BP_Linel Daemon’ Interaction Dueue ¥iew P =]

Generall Eu:unu:liti-:unl Order I Scheduling Parameterized Conditions I Cial 4 | *I

Add Edt | Bemove |

MewConditior j

agent_group_id -
agent_id =
caze_id

category

contact_id
cuztomer_zegment T

Figure 233: Parameterized Conditions Tab

3. You can add multiple attributes.

4. To change an attribute, select the attribute, click Edit and then select the
attribute to substitute.

5. To remove an attribute, select it and click Remove.

6. When finished completing the Parameterized Conditions tab, select Save
from the Fi le menu.

End of procedure

Next Steps

* Complete the Database Hints tab (optional step).

Database Hints Tab

The View Properties dialog box has Database Hints tab, which is applicable
to an Oracle database.

The 'Process" Interaction Queue Yiew Properties |

Schedulingl Parameterized Conditions ~ ['atabase Hints I Segmentatinnl 1 I *I

=

Figure 234: Database Hints Tab
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Oracle allows special tags in SQL queries that cause queries to execute in a
way that optimizes performance. These tags are called Hints. For example, you
might want Oracle to use a certain index to reorder data during query
execution. You can apply a Hint, which will cause Oracle to use a specific
index. One Hint that Oracle provides is the following:

/*+ index (interactions interactions_default_view_idx) */.

You could enter this Hint in the Database Hints tab of the View object.

Procedure:
Completing the View object Database Hints tab

Purpose: To accommodate Oracle Database users.

Start of procedure

1. Click the Database Hints tab in the dialog box.

2. Use the information given above under Purpose to apply an Oracle
Database Hint.

3. Save your entry.
End of procedure

Next Steps

* Complete the Segmentation tab (optional step).

Segmentation Tab

284

Use the Segmentation tab on the View Properties dialog box to submit an
equal number of interactions of different segments and to limit the total
number of interactions that can be submitted to a strategy.

Use Case

Assume the following:

* You have a simple business process: a queue, the queue’s view, a strategy,
and a submitter that submits interactions from the queue to the strategy
through the view.

* There are two groups of agents equal in number. One group is trained to
handle only customers of the gold Customer Segment (see note on
page 163) and another group is trained to handle only customers of the
bronze Customer Segment.
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* The strategy directs interactions to the corresponding group of agents
based on the value of the customer_segment property of an interaction
(assume the value could be either gold or bronze).

* Next, start placing interactions into the queue, five interactions from
bronze customers, then four interaction from gold customers, then again
five interactions from bronze customers, three from gold, and so on.

If the strategy has a limit (see “Total Limit” on page 287) of five interactions
that may be submitted into it, when the limit is reached, the strategy will be full
of interactions from bronze customers, but will have no interactions from gold
customers. As a result, interactions from gold customers will be waiting back
in the queue and free agents, who are able to handle them, will also be waiting.
Because the interactions are not yet in the strategy, the strategy is unable to
route the interactions.

To avoid such a scenario, you could add the customer_segment value to the
Segmentation tab of the View Properties dialog box. After that, Interaction
Server will fetch all interactions from the queue, grouping by the
customer_segment property. It will find two distinct values of the property:
gold and bronze. Interaction Server will then divide strategy limit by two (the
number of distinct values) and limit the submission of each group of
interactions to the strategy by the calculated value. As a result, Interaction
Server submits an equal number of interactions from each group.

Procedure:
Completing the View object Segmentation tab

Start of procedure

1. Click the Segmentation tab in the View Properties dialog box (see Figure
235).

The 'BP Linel Daemon' Interaction Dueue ¥ie k|

Schedulingl Parameterized Ennditiunsl Database Hints ~ Segmentation | 1 I "I

sod | Edt | Bemove |
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Check |nterval [zec) I Total Lirnit I

Figure 235: Segmentation Tab

2. Use Table 27 to complete the Segmentation tab (optional step).
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Table 27: View Properties Dialog Box, Segmentation Tab

Field Description
Segmentation For background information about this tab, see “Use Case” on page 284.
Add Figure 235 on page 285 shows the Segmentation tab after clicking Add. There

are two ways to add an attribute in this dialog box:

* Click Add and manually type the attribute name in the text box (where
Figure 233 shows NewSegment).

* Click the down arrow opposite NewSegment and double-click an attribute
name from the interactions table (described in the eServices
(Multimedia) 8.0 User's Guide).

Figure 236 shows the Segmentation tab after adding several segments and
clicking Add.

The 'BP Linel Daemon' Interaction Oueue ¥iew £

Schedulingl Parameterized Eunditiunsl Database Hints ~ Segmentation I 1 I *I

tdd | Edt | Bemove |
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Figure 236: Segmentation Tab After Specifying Segments

Option segment-by (see Figure 237) reflects the added segments.

If the routing strategy connected to the view uses the Generic Segmentation
object (see “Segmenting Interactions” on page 328), the segments you specify
in the Scheduling tab should match those segments.

Edit To change an attribute, select the attribute, click Edit. You can then manually
type the name of another attribute or select the segment to edit from the
drop-down menu.

Remove To remove an attribute, select it and click Remove.
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Table 27: View Properties Dialog Box, Segmentation Tab (Continued)

Field

Description

Check Interval (sec)

Enter the number of seconds that Interaction Server should use for checking
the queue connected to this view. This interval controls how often Interaction
Server checks the main queue and adjusts the number of interactions that will
be submitted to the strategy according to the Total Limit field. Option
segment-check-interval (see Figure 237) reflects the number of seconds.

Total Limit

Enter the total number of interactions that can be submitted to the strategy
connected to the View object. This option allows you to override the
maximum number of interactions that can be submitted to the strategy
according to the specified segments. Option segment-total-Limit (see
Figure 237) reflects Total Limit.

Notes: If segments are not configured but Total Limit is configured, then
Interaction Server calculates a dynamic value. It divides Total Limit
by the number of actual types present in the main queue and uses the
result to limit the number of each interaction type in the cache queue.

When some segments are specified, Interaction Server adheres to Total
Limit. If/when there is room for more interactions to be submitted to
the strategy after submitting the specified segments, Interaction Server
divides the remaining types up equally.

End of procedure

Setting Numerical Limits for Segments

In some cases, instead of having Interaction Server submit equal numbers of
specified interaction segments to a strategy as just described, you might want
to set numerical limits for those segments and save that configuration
information for reuse with another queue. You can do this in Configuration
Manager via the segment-Limits section in an Interaction Queue View object
in the Scripts folder (see Figure 143 on page 159). As described later, to
specify limits for specific segments, you use a combination of values for
segmentation attributes separated by a semicolon.

Assume that you wish to configure limits for attributes entered in the
Segmentation tab of the View Properties dialog box (see Figure 236 on
page 286). After entering the attributes shown in Figure 236, assume the View
section in the Annex tab of the corresponding Interaction Queue View Script
object appears as shown in Figure 237:
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Figure 237: Interaction Queue View Script Object

Warning! To ensure database integrity, you must define the options that are
shown in Figure 237 only in IRD’s Interaction Design window;
do not define them in Configuration Manager. The only exception
is the segment-Limits option described below.

The following procedure describes how to specify limits for different
interaction segments, such as work item interactions for different types of
services for customers of the Gold, Silver, and Bronze revenue potential.

Procedure:
Limiting submission of segments by using
Configuration Manager

Start of procedure

1. Open Configuration Manager (see page 237) and go to the Scripts folder
for the Tenant.

2. Select the Interaction Queue View Script object that you wish to
configure with segment limits.

3. Click the Annex tab.

4. Double-click the View section so it appears under the Annex tab (see
Figure 238).
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Figure 238: View Section in Annex of View Object Properties Dialog Box

5. Click the button to create a New Section/Option.

6. In the resulting Add Section dialog box, enter segment-Llimits as the
Option Name. In the Option Value field, enter the name of another Script
object (to be created) that contains the segment limits configuration.
Genesys suggests creating a Script object of type Data Collection for
this purpose as described ahead. Figure 239 shows an example completed

dialog box.
Edit Option

Option M arme:

L]
ﬁ” Isegment-limits

Option Y alue:

IS egmentLimitsD ataCollectionD bjech

] I Cancel

Figure 239: View Object Edit Option Dialog Box for segment-limits

7. Click OK in the Edit Option dialog box. The option is added to the View
section (see Figure 240).
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Figure 240: View Object, View Section, segment-limits

8.

10.
11.

12.

13.

14.

Still in the Configuration Manager Scripts folder, create a new Script
object of type Data Collection. Continuing with this example, assume that
you name it SegmentLimitsDataCollectionObject, the same asthe Option
Value shown in Figure 239.

Click the Annex tab. There will be no existing sections.
Click the button to create a New Section/Option.

In the Add Section dialog box, enter segment-Limits as the section name
and click 0K.

Double-click segment-Limits so it appears in the drop-down under the
Annex tab.

Click the button to create a New Section/Option. The Edit Option dialog
box opens.

In the Option Name field, enter one or more interaction attributes separated
by semi-colons. Figure 241 shows an example.
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Figure 241: Sample Entry in Edit Option Dialog Box

Note: In the above example, there are two semicolons. The second semicolon
indicates an unspecified attribute (see Figure 242).

15. In the Option Value field, enter a number to specify a limit for this
interaction type and click 0K.

16. Repeat steps 13~15 for the next type of interaction that you wish to limit.
17. Click OK.

End of procedure

Figure 242 shows the example Data Collection Script object for
segment-Llimits.

4% SegmentLimitsDataCollectionObject [172.21.27.97:50...
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‘-:'E SILVER thpedwarkitern V20"

Figure 242: Example Entries for segment-limit option

In this example, the Script object sets limits for submitting three types of
interactions to a strategy:

* For segment customer_segment=G0LD, service_type=typel,
media_type=workitem (see Figure 148 on page 164), the limit is set to 10.

* For segment customer_segment=SILVER, service_type=type2,
media_type=workitem, the limits is set to 20.
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The first segment sets a limit of 50 for interactions (workitems) of BRONZE
customers for which service_type is not set.

Reusing a Configuration

To reuse a segment-Limits configuration for use with another queue, click the
Export to Configuration File button in the Interaction Queue View Script
object (see Figure 242). This opens a Save As dialog box where you can save
the information to a file. You can then import the file for a different
Interaction Queue View Script object by opening that object, clicking the
Import from Configuration File button, and selecting the export file.To
import only the segment-Llimits configuration, click No when the dialog asks
whether you wish to overwrite existing data.

View Configuration Caveats

Do not use attached data for interaction attributes and values.

Define conditions that process all e-mails in the queue. Any interactions
not pulled by a view, remain in the queue.

Expressions vary between underlying databases, but you can use generic
expressions that provide a single interface independent of the underlying
database (Oracle, MS SQL, DB2). They are called Translations.

Figure 223 on page 273 shows the _time_in_queue translation used in the
Condition tab.

Note: Sce the chapter on interaction properties in the eServices
(Multimedia) 8.0 User s Guide for information about translation
functions.

Logic that appears under the Condition tab is incorporated into the where
clause of a SQL select statement and, therefore, has a direct impact on
Interaction Server’s performance. In some cases, you may need to create
additional indexes in the underlying database to improve performance.

The order of the view is incorporated in the order clause of the same SQL
select statement, and also may impact performance. The default order (by

date_received and id) and condition (filter by queue and state) both use an
index on the following fields: queue, state, date_received, and id.

Adding Workbins

For background information about Workbin objects, see page 33. In order for
workbins to be selectable in the IRD Workbin object, they must first be defined
as described in this section.

292
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Procedure:
Adding a Workbin object to a business process

Adding Workbins

Purpose: To hold interactions for later processing by a particular agent (or
Agent Group, Place, Place Group).

Start of procedure

1. Right-click the Workbins folder in the object browser to bring up a menu
and select New Workbin (see Figure 243). Alternative methods:

Select New Workbin from the Business Process menu.

*

+ Right-click in the workflow viewer and select New > Workbin.
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Help

_|0] 3
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I
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el Skep 3.3, Forwarding
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Figure 243: New Workbin Menu Item

The object browser shows a new Workbin object with a temporary name
(see Figure 244).
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Figure 244: New Workbin with Temporary Name

2. Select (slowly double-click) the temporary name and replace it, supplying
your own name. Assume that you name it WorkbinAgentA. The browser now
appears as shown in Figure 245.
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Figure 245: New Workbin Renamed
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3. Drag the Workbin object into the workflow viewer now or after the next
step.

4. Right-click the Workbin object and select Properties from the menu. The
Workbin Properties dialog box opens (see Figure 246).

The "WorkbinAgentA® Interaction YWork Bin Prope k|

General |I:Ir|:|er | Usedin| Queue |

Script Mame IWnrkbin&genL&

Description I
Diwaries
% fgent ™ Agent Group ¥ Enabled
" Flace " Place Group

Figure 246: Workbin Properties Dialog Box

5. Use the information in Table 28 to complete the Workbin Properties
dialog box:

Table 28: Workbin Properties Dialog Box

Place Group

Field Description

Script Name In Figure 246, Script Name reflects the name that is entered in the object browser.
The queue definition will be saved as a Script of type Workbin in the
Configuration Database (see Figure 143 on page 159).

Description Describe the purpose of the Workbin object.

Owner Indicates whether the Workbin is associated with an agent (Person), Agent Group,

Agent Place, or Place Group.

Agent Group If you change the type of workbin.Owner in the'Workbin object proper.tie'ts dialog

Pl box in the Interaction Design window, you will also need to change it in the

ace

Routing Design window in the strategy containing the Workbin routing object.
Otherwise, no message will be generated in the IRD Details tab or in the Log tab
of the Interaction Design window. This is because Check Integrity (see page 354)
was not designed to distinguish the wrong types of existing objects as in the case
of selecting the wrong type of Owner in the General tab of the IRD Workbin
properties dialog box.

Enabled

After activating the strategy as described on page 361, open the Workbin
Properties dialog box and select the Enabled check box to specify the workbin
state as ready to accept interactions. The default is checked (enabled).

* You can also enable/disable Queue objects the same as any other object in
Configuration Manager.
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Table 28: Workbin Properties Dialog Box (Continued)

Field Description

Order In the Order tab, you have the option of defining the order for pulling interactions
from the Workbin (see Figure 247).

The "WorkbinAgentA' Interaction Work Bin Properkie #

General Cirder |L|sed|n| Dueuel

Figure 247: Order Tab

See Figure 224 on page 274 for an example view entry.

Used In If this workbin is eventually used by other business processes, the Used In tab
will list the names of those business processes. Figure 248 shows an example.

The "WorkbinAgentA' Interaction Work Bin Properkie #

Generall Order  Uzedln I Dueuel

Haow to: apply ezcalation procedure

Figure 248: Used In Tab
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Table 28: Workbin Properties Dialog Box (Continued)

Field Description

Queue Use the Queue tab (see Figure 249) to associate the workbin with a base queue or
when associating multiple workbins with the same queue as described in
“Configuring an Escalation Workflow” on page 298.

The “WorkbinAgentA' Interaction Work Bin Prop A

Generall Order I Uszedln EHueus |

— Baze Queus
¢ |lze The Work Bin's Private Queus

" lUze The Faollowing Queue:

[«
Lozate |

Figure 249: Queue Tab

You have two queue association options:
* Use The Work Bin’s Private Queue

* Use The Following Queue (enabled when at least one queue exists in the
business process)

Use The Work Bin’s | When this option is selected, IRD will:
Private Queue + Create (if no such queue already exists) a private queue.

* Link the workbin to it.

* Hide the private queue from view (you cannot view it in the workflow).

When this option is selected, the next option is disabled.

Use The Following | When this option is selected, the drop-down menu allow you to choose an
Queue existing queue. If the workbin was previously linked to a private queue, upon
saving the business process, IRD will delete the private queue from the
Configuration Database. Later, when you click Locate, IRD highlights the queue
within the workflow.

The dropdown menu lists the names of queues that belong to the same business
process where the workbin resides. However, if you then move the queue to
another business process, IRD shows this queue in the form of <business
process>::<queue name>.

6. Select Save from the File menu.

End of procedure
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Later, when creating routing strategies, any workbins you define in the
Interaction Design window will be selectable in the properties dialog box for
the Workbin object in the Routing Design window (see Figure 250).

Workbin properties x|

General I Interaction I]ueuel Target Selectiunl

Owner pe :
‘Warkbin name | [+ 76Techpubs -
El F‘reprncessing
™ Usze logged i Workbindgents —

« L

Figure 250: Workbin Properties Dialog Box

e For information about how to attach a view to a workbin, refer back to
“Adding a View” on page 267.

* For an example of a workbin with an attached view, see “How To: Apply
Escalation Procedure” on page 411.

* For information about connector lines, see page 305.

Configuring an Escalation Workflow

298

Assume that you have a single workbin and want to submit interactions from
the workbin that are over three days old for special processing (escalation). For
a single workbin, you could:

* Define a View object for the workbin (see page 267).

* Inthe Condition tab of the View Properties dialog box, define the
following condition to specify the number of seconds in three days:

* age() » 259200
* Draw a Submitter from the view to the escalation strategy.

Now assume you have five different workbins and want to perform the same
special processing. You could configure five additional View objects with the
same condition and draw five additional Submitters. This “long way” would
not only repeats steps, but also would make the workflow picture more
complex.

A more efficient way is to lay all the workbins on the same queue and then use
the queue in the workflow. This works because a workbin can be associated
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with a queue in the Queue tab of the Workbin object as shown in Figure 249 on
page 297. Although the queue may be hidden in the workflow picture, it does
exist. The steps to implement this shortcut are listed in the following
procedure.

Procedure:
Configuring an escalation workflow

Start of procedure

1. Define the five Workbin objects as described on page 293.

2. Set the same queue for all the workbins with the Use the Following Queue
option described on page 297. The queue will appear in the object browser.

3. Place the Queue object in the workflow.

4. Define a single View object for the queue with the specified escalation
condition.

5. Draw a single Submitter line from the view to an escalation strategy. That’s
it!

End of procedure

Strategy Placeholder Option

So far you have created a Queue, View, and Workbin objects. After
interactions have been extracted by using a view, you submit them to a routing
strategy.

The Independent Objects folder (see Figure 38 on page 63) holds existing
routing strategies that are unconnected to a business process. If the routing
strategies already exist, you can simply drag and drop them into Strategies
folder for the business process.

Note: After a routing strategy has been used in a business process, you can
find it under that business process and reuse it, if necessary.

If the required routing strategies do not exist yet, you have two options:

1. Create a strategy placeholder and postpone the actual routing strategy
configuration (which can be more time-consuming than creating queues
and views) to a later time. If this option is used, you could continue
creating the remaining queues and views that are required by the business
process.

2. The second option is to create the routing strategy immediately, as
described in “Creating Strategies” on page 323.
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The following instructions explain how to create a strategy placeholder in a
business process. See page 323 if you wish to create the routing strategy at this
time.

Note: You must use the Routing Design window to create subroutines; you
cannot create them in the Interaction Design window.

Procedure:
Creating strategy placeholders

Purpose: To create an empty Strategy Script object as a placeholder in a
business process, which can be configured later.

Start of procedure

1. With the applicable business process open and selected (see “Switching to
another business process” on page 252), click the Business Process menu
and select New Strategy. The New dialog box opens in the Routing Design
window (see Figure 251 on page 300).

new x|

MHame :
[

Drezcription :

| 0k, I Cancel

Figure 251: Dialog Box for Creating New Strategy

2. Name and describe the strategy and click 0K. The Routing Design window
opens with the name of the strategy in the title bar (see Figure 252).
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,‘.:.t Routing Design - Inbound preprocessing * ;lglﬂ
il File Edit ‘iew Tools Help

IECEEEEEIE =l

[EEEEE EENEEEN N = N

Figure 252: Routing Design Window

3. Click the File menu and select Save. The Save dialog box opens (see
Figure 253 on page 301).

save x|

— Strategy Mame

IInI:u:uunu:I Preprocezsing

—REBM Filz Path
IE:'&F‘ngram FilezhGCT [\ nteraction Bouting Dezi _I

[T | Store bo databiaze

CHME Script Folder
|V| Scripts

Cancel |

Figure 253: Save Dialog Box

4. Keep the path for the graphical portion (see page 172) of the strategy (RBN
File Path) or click the browse button (...) to select a new path.

5. Optional step. Click in the box under CME Script Folder and double-click
a subfolder under the Scripts folder.

6. Click 0K in the Save dialog box.

Business Process—User’s Guide 301



hapter 10: Creating Business Process Objects

Strategy Placeholder Option

7. Click the x in the upper right corner of the Routing Design window to
close the strategy. A dialog box requesting update confirmation appears

(see Figure 254).

— Warning!
1)

Interaction Routing Designer

The following strategies have been created:
Inbound Preprocessing

Do you wish to update the infarmation?

]

Figure 254: Update Dialog Box

8. Click Yes. The following message box opens (see Figure 255).

Interaction Routing Des

Operation is completed.

x|

Figure 255: Operation Is Completed

9. Click 0K. The strategy name appears under the Strategies folder in the
business process (see Figure 256).
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Figure 256: Strategy Placeholder

10. Drag the strategy from the browser to the viewer (see Figure 257).
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Figure 257: Strategy in Viewer

11. Select Save from the File menu.
End of procedure

Next Steps

* Use the information in the next section to connect the queue to the strategy.

Note: Later on, when you are ready to configure the strategy, right-click the
strategy in the browser and select Edit/View Strategy.

Adding a Submitter

Now that you’ve created queue-processing rules in the form of a view, and a
routing strategy placeholder, the next step is to connect these objects. You do
this by drawing a line called a Submitter object. It represents interactions being
pulled from the queue and pushed (submitted) to a routing strategy.

Figure 258 graphically depicts an interaction submitter in relation to views and
routing strategies.
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Figure 258: Submitter Actions
Procedure:

Creating a Submitter object

Purpose: To connect a view extracting interactions from a queue to a routing
strategy where the interaction can have specialized processing tasks applied.

Start of procedure

1. Draw a submitter (see “Submitters” on page 39) from the View object to
the Strategy object. This tells Interaction Server to submit interactions

extracted from the queue using the view to the strategy (see Figure 259).
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Figure 259: Submitter Object
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2. Click the File menu and select Save.

End of procedure

Next Steps

About Connector Lines

* Later, when you are ready to configure the strategy, right-click it and select
Edit/View Strategy from the menu (see Figure 260).
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Figure 260: Edit/View Strategy

Note: For information about options that affect the submission of interactions

to routing strategies, see the chapter on configuration options in the
eServices (Multimedia) 8.0 Reference Manual.

About Connector Lines

Connector lines show the path for interactions (how interactions must be

processed) by joining one object in a business process to another. Sometimes
IRD draws the lines automatically such as when an interaction path is specified
inside a strategy. You draw the line at other times, and thereby specify the path

for interactions.

* A black line indicates a the path for an existing interaction (the same

interaction that came into the object).

* Arred line indicates a path for an interaction that has been newly created in

the object.
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Depending on the type of object, connectors may be placed automatically, or
you may need to place them manually.

* To add a connector, hover your cursor over the object where the connector
should start. When the cursor becomes a pointing hand, hold down the left
mouse button and move the cursor to the object where the connector
should end.

* To delete a connector, select it, and then press the Delete key; or,
right-click the connector, and then select Disconnect and/or Hide from the
shortcut menu.

Note: You cannot delete a connector that has been automatically placed,
or delete the object to which it connects. Instead, you must edit the
object that generated the automatically placed connector, so that it
no longer contains that particular strategy-linked node. In the
figure above, to remove the Stop interaction node and its
connector, you must edit the Forward e-mail processing strategy.

* To reshape a connector, select it, place the cursor over one of the red x's
that mark the ends of the lines and the control points along the line's Bezier
curve, and drag the x to a new location.

Removing an Object

To remove an object from a business process: in the object browser, drag it
from the business process folder and drop it into the Independent Objects
folder.

Exporting and Importing a Business
Process

Notes: In addition to exporting and importing business processes in the
Interaction Design window as described in this section, you can also
use IRD’s Export solution and Import solution views to:

» Export/import objects between strategies.
» Export strategies using archive, native, open, and text format.
» Export a group of strategies or subroutines.
For more information about these views, see the chapter on routing

strategies, Migrating Strategies and Other Objects section, in the
Universal Routing 8.1 Reference Manual.
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This section describes how to export and import business processes. Having
the ability to export and import business processes allows you to:

* Store the information contained in a business process; for the purpose of
creating a backup copy, for example.

* Easily move business processes located in your Test environment to your
Production environment.

* Share or consult on workflow design with a co-worker.

* Automatically create all the required Configuration Layer objects during
the export process and write them to a Configuration Database during the
import process.

IRD simplifies the operation by letting you export/import multiple business
processes at once. You will most likely use this feature since one business
process may depend on processing that occurs in another business process or
use objects that originate outside of itself.

Procedure:
Exporting a business process

Perform the following steps to export a business process. If the business
process is already open, skip to step 5.

Start of procedure

1. Log in as described in “Opening IRD” on page 57.
2. Click the Interaction Design shortcut bar on the left.

3. Click the Business Processes icon. Existing business processes are listed
for selection as shown in Figure 35 on page 60.

4. Double-click any business process to open the Interaction Design
window.

5. Click the File menu and select Export. The Export dialog box opens (see
Figure 261 on page 308).
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Eport x|

Choose Buzsiness Processes to export
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76T echpubs

ABC Simple BP

ABC Simple Chat BP

Default BF

How to: apply ezcalation procedure | |
Haw ta: attach classification categories and uze attach categaries obie
Haow b attach claszification categones and uge mulki-zoreen object

Haow ta; get credit card number from the e-mail

How to: handle fax interactions

Haw ta: identify contact and create interaction in 1CS

Haow to: place the interaction inta the warkbin _ILI

Shart Camments

Into The Eile:

(] Cancel

Figure 261: Export Dialog Box

6. Inthe Export dialog box, select the business processes that you wish to
export so they are highlighted.

+ To select individual business processes, hold down the Ctrl key while
you select.

+ To group-select, hold down the Shift key while you select.

Note: Media servers (see page 39) are not included in IRD’s
export/import process.

7. Under Short Comments in the Export dialog box, enter any comments
(optional).

8. Click the Browse button. The Choose File Name dialog box opens (see
Figure 262).
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x|
Save in: I i) LaSeql j - £ Eg-
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File name: || Save

Save az type: IWn:-rkfI-:lw Import Export files (7. wig] j Cancel |

4

Figure 262: Choose File Name Dialog Box

9. Ifnot already selected, browse to/create the folder to hold the exported
business process.

10. Enter the file name for the exported business process.

11. Click Save in the Choose File Name dialog box. The Export dialog box
reflects your entries. Figure 263 shows an example completed dialog box.

Export x|

Choose Buzsiness Processes to export

Buzinesz Proceszes il
How to: apply ezcalation procedure

Haw ta: attach claszsification categones and uze attach categaries obie
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Haow to: place the interaction inta the warkbin
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Step 1. Pre-routing
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Figure 263: Export Dialog Box
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12.

Exporting and Importing a Business Process

Note: IRD usesa .wie file name extension when importing/exporting
business processes.

Click 0K in the Export dialog box. Configuration Exporting appears.
After a successful export, Done appears.

End of procedure

Procedure:
Importing a business process

Start of procedure

1.
2.
3.

Log in as described in “Opening IRD” on page 57.
Click the Interaction Design shortcut bar on the left.

Click the Business Processes icon. Existing business processes are listed
for selection as shown in Figure 35 on page 60.

Double-click a business process to open the Interaction Design window.

Click the File menu and select Import. The Configuration Import Wizard
Choose File screen opens (see Figure 264).

Configuration Import Wizard x|

Choose File

Choosze file to import configuration from E'Eg

File

Where to put strategy BBM files

Browsze...

[T Into Databasze  |Msmkatten\Al_KattenhG enesps_SoftwarehGCT M nteractio Brovse. .

Log [only if you need it]

Browsze...

11

Back I Hext I LCancel

Figure 264: Configuration Import Wizard, Choose File
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6. Under File, click the Browse button. The Open dialog box opens.
open 2| x|
Laak i I_;l LaSeql j = =F Ef-

| 72TPTest.wie
ABC wie

File name: | | Open I
Fil=z of bype: IWDrkflnwlmpnrtE:-:pl:urt filez [* wig] j Cancel |

[~ Open az read-only

4

Figure 265: Open Dialog Box

7. Locate the *.wie file you wish to import and double-click it. The Open
dialog box closes. IRD inserts the selected directory path and file name
under File in the Configuration Import Wizard (see Figure 264 on
page 310).

8. Inthe Configuration Import Wizard, under Where to put strategy RBN
files, there are two options.

+  Click the Browse button and locate the folder to contain the graphical
portion of strategies contained in the business process. See “Graphical
Portion of a Strategy” on page 172 if you need to review strategy .rbn
files (which consume more space than the script portion of strategies).

+ Click the Into Database checkbox (if enabled) to save .rbn files in a
database.

Note: In order for the Into Database checkbox to be enabled, a Database
Access Point must appear in the Connections tab of the IRD
Application in Configuration Manager. The database used is the
Configuration Server database. The table name is ird_strategies.
If security is a consideration, you might want to store to a database.
For example, if you are a Service Provider, you might not want
your subscribers to have access to your corporate drives. In this
case, saving to the database in the preferred method.

9. Under Log (only if you need it), you have the option of saving business
process import details in a log file. If you wish to do this, click the Browse
button and locate/name the log file.
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10. Click Next. The Configuration Wizard Confirm Importing screen opens
(see Figure 266 on page 312).

Configuration Import Wizard x|

Confirm Importing

The file containg configuration of the fallowing buziness processes. E'Eg
Confirm wour intent to import the configuration.

&BC Simple BP

Comrments:

Back I Irnport I LCancel |

Figure 266: Configuration Import Wizard, Confirm Importing

11. If satisfied with your entries, click Import; otherwise click Back to return to
the Configuration Import Wizard Choose File screen.

12. Respond to any messages that might appear.

End of procedure

Problems During Importing

If an import request encounters problems, IRD lists the problems and possible
workarounds. You can:

* Choose the workaround for each problem.
* Cancel the import operation.

Figure 267 shows an example dialog box when objects to be imported already
exist in the Configuration Database.
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Exporting and Importing a Business Process

The Following Problems Encountered

Y'ou may choose appropriate action by clicking the Workaround field.

x|

| Problem

| Wiork around

Type | Object Mame
Buszsiness Process ABC Simple BF
Clueus Inbound queus
Wiew Inbound wiew
[ueue Outbound queue
Wiew QOutbound view
Strategy Frocess ABC
Strategy Send ABC

The ohject already exists
The object already exists
The obhject already exists
The ohject already exists
The ohject already exists
The object already exists

The obhject already exists

kerge exizting object with imparti..

Do not import the object
Do ot import the object
D'a ot import the object
D'a ok irpirt the object
Do not import the object
Do ot import the object

Eix The Problems & Continue I

Cancel Impart

Figure 267: The Following Problems Encountered Dialog Box

Note: Choosing particular workaround might trigger another problem. For
example, if a strategy already exists, choosing to overwrite the strategy

might cause a problem if the .rbn file that is associated with the
strategy already exists in the specified location. In such cases, IRD

displays another dialog box.

If you click Cancel Import, the dialog box appears as shown in Figure 268.
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Configuration Import Wizard x|

Configuration import

[t could take a few minutes. E'Eg

|mparting has been cancelled. Mo objects have been imported.
Click Cloze to hide thiz dialog bos.

Cloze |

Figure 268: Canceling an Import Operation
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Problem types and workarounds are listed here.

Problem: Object that is to be imported already exists
in the Configuration Database.

Applicable to objects of the same type (queues, views, strategies, and so on).
IRD offers the following workarounds:

* Do not import the object
*  Overwrite existing object

Exceptions: For business processes, the only allowed workaround is merging.
Since a business process object keeps a list of the objects that belong to it,
merging combines that list of objects with the objects belonging to the business
process being imported.

Problem: The name of the object being imported
conflicts with an existing object.

Applicable to objects of different types (business process, queue, view,

strategy, workbin) that are of the same Configuration Manger object type
(Script). For example, a conflict is created when you attempt to import a
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queue Script object having the same name as an existing strategy Script
object. IRD offers the following workaround:

* Do not import the object.

Exceptions: If importing business process conflicts with an existing object
(Script object of different type), IRD considers the problem to be severe and
the import operation always aborts.

Problem: The .rbn file of the imported strategy already
exists in the specified location.

Applicable to strategies. IRD offers the following workarounds:

* Put the file into alternative location. The alternative location is an
automatically created subfolder in the location you specified on import
startup.

* Overwrite existing file.

Exceptions: None.

Automatic Decisions

IRD’s import utility automatically makes/logs the following decisions:

*  When the attempt to import a submitter (see page 39) conflicts with either
an existing submitter or a Script object of a different type, the imported
submitter takes a new name.

*  When an association between a view (see page 28) and strategy (see
page 30) already exists (i.e., there is a submitter that connects the view and
the strategy), IRD does not import the submitter.

*  When a parent object is not imported (such as a queue with a view child
object or a view with a submitter child object) according to the chosen
workaround), the child object is also not imported.

Distribution of Load Between Multiple
Interactions Servers

Overview

Starting with release 8.1.3, a Business Processes can be assigned to different
Accounts in order to distribute the load between multiple Interactions Serv-
ers within one tenant. By default, a single Interaction Server within a tenant
will run all Business Processes that belong to this tenant. For large custom-
ers with high interaction volume requirements, the ability of multiple Inter-
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action Servers to process interactions within specific tenants can be used to
achieve much better performance.

Creating an Account

316

An Account is a set of Business Processes (with all related sub-objects:
queues, views, workbins, submitters, strategies) that a single Interaction
Server works with.

The Business Process main menu of the Interaction Design window has a
dedicated selection that can be used to create a new Account. See

Figure 269. There is also a corresponding icon on the tool bar of the Interac-
tion Design window that can be used. An existing Accounts can be deleted
using the regular Delete menu selection.

MNew Account

Mew Business Process
Mew Queue

Mew Synthetic Queues
T Wiew

Mew Strategy

Mew Workbin

Add Endpoink

Delete Del

Arrange Objects

Figure 269: New Account
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In the Browser part of the Interaction Design window, each Account is pre-
sented as a folder. See Figure 270.

ih Interaction Design - Default

File Edit Mjew Business Process Tools Help

e @ IOAWE|Z|?
o
jf2ccountl
- A Account2
19| Default
i[7] Queues
(1] Workhins

Ea Skrategies

- (L] Subroutines
[ Useful Yiews
-] Media Servers
-] Independent Objects

Figure 270: Account Folder

The Account object properties dialog box may be viewed by right-clicking
the Account folder, and selecting Properties. See Figure 271.

The 'Accountl01’ Access Group Properties E

General |

Mame I Accountl01

Description I

Iv¥ Enabled

Figure 271: Account Properties

Every new Account created in the Interaction Design window is presented
in the configuration by special Access Group object. These Access Group

objects are created on the Environment level in the Multitenant configura-
tion environment or on the Resources level when working in a Single-Ten-
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ant enterprise solution. This is marked in the Annex tab by two sections, the
BusinessProcesssAccount, and Namespace as Access Group presenting an
Account. See Figure 272.

F_: Conhiguraton Mansger - default defaglt {default], Server petert] v, 5. L100C14 on port BLEL

I 3% DRIXE-D-1E-0

Foiders ol enfiguratosEnvronmentiAccess Groups'

=

oy

g Pt i

1
Adrrelratodd

EVERTOMNE
Super Adminsta...

STETEM
s

A= Account10] [petertl@181] Properties

ool A | Socusty| Dpaciesy |

-] ? 0% 3%

e | Vi

?‘I Ertear

T |

D ] _ow |

Figure 272: Access Group Object
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The Namespace section refers to the name of that particular Account.
SeeFigure 273.

& Account101 [petert1:8181] Properties El

General Annex |Sec1_|nt:.r| Dependencyl

I‘;@ Mamespace j 57 | [] » | = | @

r

Mame Value
Erter tesd hers S| Entertest here i

-

g| ok | Cancsl Anply Help

Figure 273: Namespace Section
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Each Business Process that is assigned a particular Account is marked on
the Annex tab of its configuration object by the section Account, which also
refers to its name. See Figure 274.

4. BP_7.5 [petert1:8181] Properties ﬂ

General Annex ISE-‘G.II'IT)’I Dependenc'_fl

I% Business process j ¥ | [ X | =l | 5

F s

MName Value

Erter tesd hers | Entertest hers o

¥ Account "Account 101"
Eﬂ Default "true”
'-EE Description
b ObjectPath
EﬂStlateg'_.rF‘ath "C:\Program Files (...

g ok | Cancel Annly Help

Figure 274: Business Process Account Section
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The Business Processes view pane in IRD continues to reflect the regular
folder structure of Business Processes script objects—no Accounts will be
displayed here. See Figure 275.

= Interactnon Reuting Designer 1LIDLLE - Server petertlauintgenesyslab.com on port B1E1

e |
& = ([PeterT DI = #

Smememmet | BUSINESS Processes

Ruzsting Deemagn

Monitoring
Evenitlog -

Export/Import EJ
For Fielg, press F | [CS:anm | BC:anw(1Z50) | [ hoa[ [ [ 2

Figure 275: Business Process View Pane

Additional Information

* The Root level in the Browser part of the Interaction Design window
shows all Business Processes in the configuration, along with all Accounts.

* The Business Process can be dragged-and-dropped between different
Accounts, as well as from the root level to the Account folder and vice
versa.

Note: The Business Process cannot be assigned to an Account during the
Business Processes import procedure. It can be added to a
particular Account in a separate step after their import is
completed.

* The same list of Accounts is available for every tenant in the configuration
no matter what tenant is currently selected. But the content (list of
Business Processes) of each Account can be different for different tenants.

¢ In IRD’s Interaction Design window, you can only create Account/Access
Group objects, and correctly set up permissions of Business Process
(including its all related sub-objects) that are assigned to these Account.
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Any other functionality (association of specific Interaction Server with a
particular Account, creation of Person objects for Interaction Server to
work on behalf of, and so on) will need to be done outside of IRD. For
detailed information please refer to the related eServices documentation.
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Chapter

1 1 Creating Strategies

This chapter provides step-by-step instructions for creating a routing strategy.
It covers the following topics:

Preparation, page 323

Sample Strategy, page 324

Summary of Strategy-Creation Process, page 324
Creating a New Strategy, page 326

Segmenting Interactions, page 328

Writing Interaction Data to Variables, page 340
Determining Interaction Status, page 347
Sending interactions to Queues, page 350
Compiling, page 353

Checking Database Integrity, page 354

Adding a Strategy to a Business Process, page 356
Editing/Viewing Strategies, page 357

Deleting Strategies, page 359

Preparation

At this point, this guide assumes you have already:

Started the business process with its queues and views (see “Creating

Business Process Objects” on page 247).

Created Knowledge Manager objects so that Categories, Standard

Responses, and Field Codes will be selectable in the associated IRD object
properties dialog boxes (see “Creating Knowledge Manager Objects” on

page 223).
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* Created Configuration Manager objects so that Persons, Agents, Agent
Groups, Place, Place Groups, and Business Attributes will be selectable

in IRD object properties dialog boxes (see “Creating Configuration
Manager Objects” on page 237).
If this preparation is complete, the process of creating routing strategies will
not be interrupted by the need to create additional configuration objects.

Sample Strategy

This chapter demonstrates how to create the strategy shown in Figure 276.

BusinessData[ InteractionSubtype] = TnboundNDE. I|I ‘Step 2.1. NDR handling E-mails

PF_flag=InteractionData[GEM © © © . 00000000l Tl Z
5 '

Figure 276: Inbound E-mail Preprocessing Strategy

This same strategy is contained in the business process “Step 1. Pre-Routing”
on page 391 as part of the Genesys-supplied Interaction Workflow Samples
component as described in “About the Samples” on page 370.

Summary of Strategy-Creation Process

Table 29 summarizes the process of creating the routing strategy shown in
Figure 276. For complete, step-by-step instructions on creating routing
strategies in general, see the Universal Routing 8.1 Interaction Routing
Designer Help.
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Summary of Strategy-Creation Process

Table 29: Steps for Creating the Inbound Preprocessing Strategy

Objective

Related Procedures

1.

To open the Routing Design
window where you create a new
strategy.

“Creating a new strategy from the IRD main window” on
page 326.

2. To cause incoming interactions | * “Placing the Generic Segmentation object and opening
to take difference paths in the Expression Builder” on page 328.
strategy based on media type, | . «Seomenting Based on an Expression” on page 331.
processing status, and so on. . ) ) ,
» “Sending Segmented Interactions to Queues” on page 337.
3. Writing interaction data to * “Defining Variables” on page 341.
Varl.ables for later use in a + “Assigning a value to a variable from Interaction Data” on
business process. page 342.
+ “Assigning a value to a variable using a function” on page 345.
4. Determining interaction status | * “Using the Generic Segmentation object to determine
(new inbound, already interaction status” on page 347.
processed by Genesys, and so
on)
5. Sending interactions to queues. | * “Sending interactions to queues from the Generic Segmentation
object” on page 350.
6. Compiling a routing strategy. *  “Compiling a routing strategy” on page 353.
7. Checking that objects contained | « “Using Check Integrity” on page 354.
in a strategy are found in the
Configuration Database.
8. Adding a strategy to a folderin | = “Adding a strategy in the Independent Objects folder to a
the Interaction Design window business process” on page 356.
prior to using the strategy in a
business process.
9. Re-using a strategy. * “Re-using a strategy already contained in a business process”

on page 356

10.Viewing and editing strategies.

“Editing/viewing a strategy from the Interaction Design
window” on page 357

“Viewing a strategy from the IRD main window” on page 359

“Deleting strategies from the Interaction Design window” on
page 359

“Deleting strategies from the Strategies List pane” on page 360
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Creating a New Strategy

The very first steps in creating a new strategy depends on your starting location
within IRD and whether a strategy placeholder exists in the business process
(see page 299).

Methods

326

After logging into IRD (see page 58), one of the options below will apply:

If you are in the IRD main window (see Figure 34 on page 59), continue
with step 1 below.

If the business process is already open in the Interaction Design window,
right-click the Strategies folder in the object browser and select New
Strategy.

If the business process is already open in the Interaction Design window,
and you previously created a strategy placeholder, right-click the strategy
and select Edit/View Strategy from the menu (see Figure 260 on

page 305). The strategy appears in the Routing Design window as shown
in Figure 278. To create the sample strategy shown in Figure 276 on

page 324, continue with “Segmenting Interactions” on page 328.

Procedure:
Creating a new strategy from the IRD main window

While this procedure describes how to create an inbound interaction
preprocessing strategy shown in Figure 114 on page 132, the steps apply to
creating a routing strategy in general.

Start of procedure

1.

In the IRD main window (see Figure 34 on page 59), click the Strategies
button.

Note: To enable New from the File menu, a folder or subfolder in the list
pane must already be selected.

If a folder is already selected, from the File menu, click New. You can also
right-click any folder on the list pane and select New. The New dialog box
opens. Figure 277 on page 327 shows an example completed dialog box.
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mew x|

Marme :
IInI:n:nund Preprocessing

Description

Foutes based on interaction subtype

| k. I Cancel

Figure 277: New Dialog Box After Naming and Describing Strategy

3. After clicking 0K, the Routing Design window opens with an Entry object
(see Figure 278).

;.:.t Routing Design - Inbound preprocessing *

| File Edit Wew Tools Help
IEEEEIEE T -]
Bao o@D ||=||Ee ||wadx||ren|=ss]|a

Figure 278: Routing Design Window Before Strategy Configuration
End of procedure

Next Steps
* Placing, configuring, and connecting IRD objects to define strategy

processing.
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Segmenting Interactions

After the Entry object in Figure 276 on page 324, the next object is a Generic
Segmentation object.

Procedure:
Placing the Generic Segmentation object and opening
Expression Builder

Purpose: To open the dialog box where you create an expression to causes
interactions to take different paths in the strategy.

Start of procedure

1. IntheRouting Design window, click the icon for Segmentation objects (see
Figure 279).

;:s Routing Design - Inbound preprocessing * - |EI|E|

| Eile Edit Wew Tools Help |
lemas sme|am 6 [
[raceems || |[Ea |7 a6 |me s =S|

For Help, press F1 [ Jloa[  [um | i

Figure 279: Segmentation Objects Icon
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Note: See “Segmentation Objects” on page 208. For detailed information
about all Segmentation objects, see the section on IRD objects in
Universal Routing 8.1 Reference Manual.

2. Click the button for the Generic Segmentation object. Then click inside the
Routing Design window at the location where you want to place the object.
The Routing Design window now appears as shown in Figure 280.

,‘.‘-s Routing Design - Inbound preprocessing * ;IEIEI
| File Edit Wiew Tools Help |
EEEERE LI |

[Baeesmm ||= |[Ee ||| ek ||mensss)||

Figure 280: Segmentation Object After Entry Object

3. Double-click the Segmentation object to opens its properties dialog box.

4. Click the button for creating a new entry. The properties dialog now
appears as shown in Figure 281.

Generic segmentation properties il
General |
ﬁf{(
Segmém Expression
1

New Entry Button

Figure 281: Generic Segmentation Properties Dialog Box: Starting

5. Click under Expression. A down arrow appears (see Figure 282).
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Generic segmentation properties |

General |

ZF ¥

Segment Expression \
1

Figure 282: Down Arrow Under for Specifying Expression

6. Click the down arrow. Expression Builder opens (see Figure 283).

Expression Builder

¥

General |
— Expression
—Data
Type MName COperator Value
- I
Business Attributes From[VEIATA I= I
Al Functions GEM_Failure b 5
Callinfo language p
Configuration Options <
Data Manipulation £=
Date/Time
List Manipulation LI
rdd |
Vedy |
a0 | or |
Varables |

Figure 283: Expression Builder, Starting

End of procedure
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Procedure:
Segmenting Based on an Expression

Purpose: To define an expression in the Expression Builder dialog box where
the true/false value of the expression will determine each segment (each path)
in the routing strategy.

The first expression will determine whether the interaction has contains the
InboundCollaborationReply Interaction Subtype (see Figure 148 on
page 164). Use the instructions below to create this expression.

Start of procedure

1. InExpression Builder (see Figure 283 on page 330), under Type, click ALL
Functions.

2. Under Name, scroll down and click Business Data. Expression Builder adds
a new panel where you enter parameters and values (see Figure 284).

F
General I
— Expression
-
[
— Data

Type MName COperator Yalue

Interaction Data «| [ACDG ﬂ - |

Business Attributes T | ActiveServerMame

ANI >
Callinfo AnswerCall B
Configuration Options — | BearerCapabili g

Data Manipulation
Date/Time BusinessDatalMNT -
List Manipulation ;I P | »

Parameter / Value Add |
Vedy |
a0 | or |

Key

Wariables

Retum value type: STRING. This function retrieves the User Data information collected
from the incoming call, when the caller responds to either the VR orto an agent. This
user data information is stored on Genesys T-Server throughout the lfetime of the ;I

Figure 284: Expression Builder, Parameter and Value Fields
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3. Leave the equal sign selected.
4. Click in the row under Value to display a down arrow.

5. Click the down arrow to bring up the Key dialog box (see Figure 285).

Key EI

Tupe I Buszinessz Data j

Walle I j

Cancel |

Figure 285: Key Dialog Box, Business Data Type

6. Click the Value down arrow in Figure 285 and select InteractionSubtype

(see Figure 286).
Key El
Type IEusiness Data j
Walue I j
|nteractionSubbype
|nteractionT ype
['VF Application Mame —
A Speech Recognition Usec
I"F Technical Result &
I I L aficeEl

Figure 286: Key Dialog Box, Interaction Subtype Value

7. Close the Key dialog box. The row under the Value area in Expression
Bui Lder now appears as shown in Figure 287.
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Expression Builder

A
General |
— Bxpression
—Data
Type Mame Operator Walue
Imteraction Data A |ACDO ﬂ _
Business Attributes ActiveServertame I=
ANI p
Calllnfo AngwerZall »=
Corfiguration Options Bearer_apahili <

Data Manipulation

Diate/Time BusinessDiatalNT -
List Manipulation j ]I"' | »

L} PP | PR —

Parameter Value Add
Key [nteractionsubtype 7|

|
Viesify |
ao | oR |
|

Varahbles

Retum value type: STRING. This function retieves the User Diata information collected &
from the incoming call, when the caller responds to either the VR orto an agent. This
user data information is stored on Genesys T-Server throughout the lifetime of the j

e | v

Figure 287: Expression Builder Parameter Value Area

8. Under Operator in Expression Builder, select the equal sign (=).

9. Click under Value and enter: Col laborationReply (see Figure 148 on
page 164).

Note: Collaboration Reply is the display name; the internal name in the
Configuration Database is CollaborationReply. You can see this in
Configuration Manager when you right-click an Interaction
Subtype and select Properties.

10. Click the Add button. Expression Builder now appears as shown in Figure
288.
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Segmenting Interactions

x|

General |
— Expression
BusinessData[Interaction Subtype] = CollaborationReply” ;I
—Data
Type MName Operator Walue
Interaction Data «| [ACDG ﬂ = |
Business Attributes ActiveServerMame I=
ANI 5
Calllnfo AnswerCall ==
Configuration Options BearerCapabili £

Data Manipulation
Date/Time BusinessDatalNT -
List Manipulation LI 1| | »

Parameter Value Add

Key

|
Verify |
a0 | or |
|

Wariables

Retum value type: STRING. This function retieves the User Data information collected «
from the incoming call, when the caller responds to either the VR orto an agent. This
user data information is stored on Genesys T-Server throughout the lfetime of the ll

ok | Cancsl | Help

Figure 288: Expression Builder With Expression Created

11.

12.

Click the Verify button.

The expression turns green indicating it is successfully verified. The
following message appears in the lower pane: The expression is
successfully verified.

Click 0K to close Expression Builder. The Generic Segmentation
Properties dialog box appears as shown in Figure 289 (entire expression
not shown).
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Generic segmentation properties ﬂ

General |
i i o
Segment Expression
1 BuzinezzDatalinteractionSubtype] = "Colla

Figure 289: Expression in Generic Segmentation Properties Dialog Box

In Segment 1 in Figure 289, the entire expression reads:
BusinessDatal'InteractionSubtype'] = 'CollaborationReply'

The expression instructs URS to use the BusinessData function
(documented in the Universal Routing 8.1 Reference Manual) with a
Business Data parameter of type InteractionSubtype with a value of
CollaborationReply.

13. Construct the next row in the Generic Segmentation Properties dialog
box (Figure 289) as follows:
+  Click the button to add an item (see Figure 281 on page 329).
+ Repeat the above steps, but substitute NDR for the Value in Step 14.

+  When through in the Generic Segmentation Properties dialog box,
you will have created two expressions (see Figure 290).

Generic segmentation properties il

General |
i P
Segment Expression
1 BuzinezzData[InteractionSubtype’] = "Colla
2 BusinezzData[InteractionSubtype] = "NOR

KN i
ok | cancsl | Hep |

Figure 290: Expressions in Generic Segmentation Properties Dialog Box
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+ URS will use the first expression to determine whether an interaction
has already been processed by Genesys and now contains the
CollaborationReply Interaction Subtype. If true, it is an interaction
resulting from two agents collaborating. The interaction contains the
draft reply being sent back to the original agent from the collaborating
agent.

+ URS will use the second expression to determine whether an
interaction has already been processed by Genesys and now contains
an NDR Interaction Subtype. If true, it is an interaction where no
destination can be reached (NDR). It needs to take a different path in
the strategy than a CollaborationReply interaction.

14. Close the Generic Segmentation Properties dialog box,. The Routing
Design window still appears as shown in Figure 280 on page 329.

15. Connect the Entry object to the Generic Segmentation object as follows:
+ Click and hold on the bottom port of the Entry object.

+ Drag the cursor to the green input port of the Generic Segmentation
object and release. The objects now appear as shown in Figure 291.

,',;s Routing Design - Inbound preprocessing * - |I:I

|l File Edit Wew Tools Help
[EEHE8 & 2R S |
EEEEF EEIEIEEN R ermmu_m“éaal\”m

Figure 291: Entry Object Connected to Generic Segmentation Object

In Figure 291, note that the Generic Segmentation object has two green

side ports.

+ The first port corresponds to the first expression in Figure 290 on
page 335.

+  The second port corresponds to the second expression in Figure 290 on
page 335.

Each port will have different processing associated with it. This means:

+ If an interaction meets the first condition, it goes out the first port for
inbound collaboration replies.
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+ Ifan interaction meets the second condition, it goes out the second port
for interactions where no destination can be reached.

16. Click the File menu and select Save.
End of procedure

Next Steps

* Sending segmented interactions to queues.

The next stage in constructing the routing strategy shown in Figure 276 on
page 324 consists of connecting each of the two side ports (see Figure 291) in
the Generic Segmentation object to different Queue Interaction objects (each
specifying a different queue).

Procedure:
Sending Segmented Interactions to Queues

Purpose: Once segmented interactions are placed in queues, you can send
them to different objects within the strategy for additional processing.
Start of procedure

1. Inthe Routing Design window, click the icon for Routing objects (see
Figure 292).

;:s Routing Design - Inbound preprocessing * - |EI

File Edit Wew Tools Help

:_ﬁﬂ§§|éﬂé|§ﬁs|ﬂ| =
EEErCEEE R P e = e
Elﬁl%mﬁgﬁ@mﬂ%%@@;;;;;;;;;;;;;;;;;;;;;;;;;;;;;

Figure 292: Icon For Multimedia Objects
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2. Click the button for the Queue Interaction object (see Figure 292). Then
click inside the Routing Design window at the location where you want to
place the object. The Routing Design window now appears as shown in
Figure 293.

.'F.t Routing Design - Inbound preprocessing * - |EI

| File Edit Wiew Tools Help
lcEss s 2|38 & i
Eaeommb ||H||@a ||warmH||menjsss|E

Figure 293: Routing Design window, Queue Interaction Object Placed

3. Double-click the Queue Interaction object to opens its properties dialog
box (see Figure 293).

4. Click the down arrow to drop down a menu where you can select an
interaction queue by expanding existing business processes (see
Figure 294).

Queue Interaction properties El

General |

|nteraction queue

H- Step 2.2, Inbound collaboration reply -
-- Step 2.3 MNew inbound e-mails

| B+ ABC Simple Chat BP
=

H..

- Preprocessing

- default-inbound -gueLE
- no-destination-reached
i ecollaboration-reply
[l Indenendent Chisrts

Figure 294: Queue Interaction Properties Dialog Box
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Note: If you followed the “Order of Configuration” on page 217, the
required queue will be available for selection.

5. Double-click a queue and click 0K. The Queue Interaction Properties
dialog box appears as shown in Figure 295.

Queue Interaction properkties 5[

eneral |

|mteraction queue

I Preprocessing .collaboration-rephyicollaborationrephy)

] I Cancel Help

Figure 295: Queue Interaction Object, Queue Selected

Note: The queue could be one used by another business process if creating a
number of smaller, less complex business processes (see page 200). Or
the queue could be one in a different functional area of this business
process if creating a larger, more complex business process.

6. Click 0K in the Queue Interaction Properties dialog box.

7. Draw a connector line from the first side port of the Generic Segmentation
object in Figure 293 on page 338 to the yellow input port of the Queue
Interaction object. This indicates that inbound collaboration reply
interactions should be sent to this queue.
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8. Follow steps 1~6 to create a second Queue Interaction object to handle No
Destination Reached (NDR) interactions, but this time select a different
queue in Figure 294 on page 338.

9. Draw a connector line from the second side port of the Generic
Segmentation object in Figure 293 on page 338 to the yellow input port of
the Queue Interaction object for inbound NDR interactions.

The routing strategy now appears as shown in Figure 296.

BusinessDatalInteraction=Subtype’] = ‘CollaborationReply

BusinessData[lnteractionsubtype] ="NDR’ |

Figure 296: Routing Design Window, Segmenting to Different Queues

Note: If the strategy isn’t commented as shown above, click the Tools menu
in the IRD main window and select Routing Design Options. The
Routing Options dialog box opens (see Figure 127 on page 142). Put
an X in the checkboxes opposite Show Conditions On Graph and Show
Description of Objects On Graph.

10. Save the strategy.
End of procedure

Note: In addition to showing conditions and descriptions, you can also insert
comments. Right-click inside the strategy and select Insert Comment
from the context menu. In the resulting text box, enter your comments.

Writing Interaction Data to Variables

So far we have configured the sample strategy shown in Figure 276 on

page 324 to handle collaboration reply and NDR interactions. The next objects
to be configured determine whether an incoming interaction has an inbound
processing failed status. To do this, the strategy will:
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Write the contents of custom interaction keys (GEM_Fai Lure and

GEM_Fai lureMsg) to variables. The assumption is that these keys were
previously added to the interaction attributes via the custom# fields in the
interactions table as described in the chapter on interaction properties in
the eServices (Multimedia) 8.0 User s Guide.

The strategy then checks those variables and routes based on the true/false
value of an expression.

» Ifthe interaction does have inbound processing failed status, it will be sent
to a queue for these types of interactions.

» If the interaction does not have inbound processing failed status, the
interaction will be sent to a different queue for new inbound interaction
processing.

Procedure:
Defining Variables

Purpose: To define variables to hold the content of the GEM_Fai Lure and
GEM_Fai LureMsg attached data keys.

Start of procedure
1. Inthe Routing Design window, click the button for defining variables (see
Figure 297).
j.v. Routing Design - Inbound preprocessing * - |EI|5|

|| Eile Edit View Tools Help |
ICA R L] = |

BusinessData[Interaction3ubtype] = "CollahorationReply’ | ---------

BusinessData[lnteractionSubtype] = "NOR | -----------------
)

Figure 297: Variables Button

2. Inthe resulting Variable List Properties dialog box, define EPF_f lag

and EPF _value string variables. The dialog box appears as shown in Figure
298.
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X

Variable list
ZF X & B
Variable Type Scope
EFF_flag INTEGER LOCAL
EPF_walue INTEGER LOCAL

Cancel |

Figure 298: Variable List Properties Dialog Box

3. Click 0K in the Variable List Properties dialog box.

End of procedure

Next Steps

* Assigning values to variables.

Now that the variables exist, use the Multi-Assign object to assign values.

Procedure:
Assigning a value to a variable from Interaction Data

Start of procedure

1. Inthe Routing Design window, click the button for Miscellaneous objects

(see Figure 299).

Universal Routing 8.1 @



Chapter 11: Creating Strategies Writing Interaction Data to Variables

A Routing Design - Inbound preprocessing * ;IEIEI

JJ Fle Edit View Toolk Help |

IEEEEEE LY |

Bacogmn = ||HFa ||warm||mauj=zs=s)8:
Eblll:bl?l@ |@|@|P@I||£|I :'r.e;.:rr;:n:.:elaéir;q._;nilaa.b;:ur.at.iu.n;re.pllvl|; ?

coob oo MuliAssign| T TR o
- -Miscellaneous Objects -

Figure 299: Miscellaneous Objects

2. Click the button for the Multi-Assign object (see Figure 106 on page 126).
Then click inside the empty Routing Design window at the location where
you want to place the object.

3. Double-click the Multi-Assign object to opens its properties dialog box.

4. Click the button to add an item in the Multi-Assign Properties dialog box
(see Figure 300).

Multi Assign properties x|

General |

—ﬂssjgry
% * Edit Variables |
Add Item | Name Expression

1| |

Figure 300: Multi-Assign Properties Dialog Box

5. Click in the Name field and select the EPF_f Lag variable.
6. Click under Expression. A down arrow appears (see Figure 301).

Multi Assign properties x|

General |

— Assign

i Edit Wariables |

Hame Expression \
1 |EPF_flag | 3

Figure 301: Expression Down Arrow
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7. Click the down arrow to open the Assign Properties dialog box (see
Figure 301) where you can assign a value to the variable.

8. Under Type, select Interaction Data.
9. Under Name, select GEM_Fai Lure.

Note: The assumption is that this key is contained in the interaction and
was previously defined in IRD as Interaction Data (see

page 119).

10. Click Add followed by Verify. The Assign Properties dialog box appears

as shown in Figure 302.

Assign properties il

General |
— Expression
IEF‘F_ﬂag j F Interaction Data[{3EM_FailureT| :l
rDeta Type Mame
acct_type Add |
Business Attributes From|VRBIATA
All Functions GEM_Failure )
Calllnfao language | Verify I
Configuration Options
Data Manipulation + | = | i | . |
Date/Time
List Manipulation LI Wariables |
The Expression is successfully verfied. :I
oK Cancel |  Hep |

Figure 302: Assign Properties Dialog Box, Expression Verified

The content of the GEM_Fai Lure key in the interaction will be written to the

EPF_f lag variable.
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11. Click 0K in the Assign Properties dialog box.

End of procedure

Procedure:
Assigning a value to a variable using a function

Start of procedure

1. Click the button to add an item in the Multi Assign Properties dialog box
(see Figure 300 on page 343).

2. Click in the Name field and select the EPF_value variable.

3. Click under Expression in the Multi-Assign Properties dialog box. A
down arrow appears similar to Figure 301 on page 343.

4. Click the down arrow to open the Assign Properties dialog box (see
Figure 302 on page 344).

5. Under Type, select ALL Functions.

6. Under Name, select the Update function.

7. Click the down arrow under Value in the Assign Properties dialog box.
The Key dialog box opens.

8. Click the Type arrow and select the EPF_f Lag variable (see Figure 303)

key x|

Tupe |+variable =

s I Cancel |

Figure 303: Key Dialog Box

9.

Click 0K.

10. Back in the Assign Properties dialog box, click Add followed by Verify.

The Assign Properties dialog box appears as shown in Figure 304.
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Assign properties

|5

General |
— Expression
IEF‘F_'u'aIue j F UData[EPF_value]| :l
D=t Type Mame
Interaction Data Time :l Add |
Business Attributes TimeDifference
TimelnZone :
Callinfo TimeStamp | Veerify I
Corfiguration Options Translate
Data Manipulation + | - | / | ) |
Date/Time IIDatalMT
List Manipulation j VO Selected j Variables |
Parameter Value
Key EPF_value 7|

Figure 304: Assign Properties Dialog Box, Assigning to EPF_Flag Variable

11. Click 0K in the Assign Properties dialog box. The Multi-Assign
Properties dialog box now appears as shown in Figure 305.

Multi Assign properties

General |

— Assign

7 X

Hame
EPF_flag

—

InteractionData[GEM_Failure']

Expression

2 |EPF_value

UData[EPF_valug]

Figure 305: Assign Properties Dialog Box

12. Click 0K in the Multi-Assign Properties dialog box.

End of procedure

To continue the strategy:

* Draw a connector line from the bottom red port of the Generic
Segmentation object to the yellow input port of the Multi Assign object.
The routing strategy now appears as shown in Figure 306.
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;l_.. Routing Design - Inbound preprocessing * - ||:||1

—

File Edit View Tools Help

J
|BRE& 2R S H = |
BAS o@D |||k [l |7 e | |me s s))6s

InteractionSubtype’] ="CollaborationReply’ | ---------

InteractionSubtype]="NDR' |- - - - - - - -

............ N T
Figure 306: Routing Design Window, Multi Assign Object Added

If an incoming interaction does not contain an Interaction Subtype of

CollaborationReply or NDR, the interaction goes out the red error port to a
Multi-Assign object.

» Save the strategy as it exists so far.

Determining Interaction Status

Next the strategy will determine whether the interaction has inbound

processing failed status or whether it is a new interaction that has never been
processed by Genesys.

Procedure:

Using the Generic Segmentation object to determine
interaction status

Start of procedure

1. Inthe Routing Design window, click the icon for Segmentation objects
(same as Figure 279 on page 328).
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2. Click the Generic Segmentation object icon (see Figure 103 on page 124).
Then click inside the empty design window at the location where you want
to place the object.

3. Double-click the Generic Segmentation object to opens its properties
dialog box (same as Figure 281 on page 329).

4. In the dialog box, click under Expression. A down arrow appears (same as
Figure 282 on page 330).

5. Click the down arrow. The Expression Builder opens (same as Figure 283
on page 330).

6. InExpression Builder, construct the expression shown in Figure 307;

Expression Builder x

General |

— Expression
EPF_wvalue 1="& EPF_value |="-1" ;I

MName Operator Walue

Bl [
Business Attributes FromVEIATA I= I
Al Functions GEM_Failure b 5
Calllrfao language ==
Corfiguration Options < EE E_ﬂalg
Data Manipulation £= _value
Date/Time
List Manipulation LI
prdd |
Veiy |
a0 | or |
Wariables |

Figure 307: Expression Builder, Verified Expression

7. Click Verify. The lower pane indicates the expression was successfully
verified.
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8. Click 0K in Expression Bui lder. The Generic Segmentation object appears
as shown in Figure 308.

Generic segmentation properties il

General |
s
Segment Expression
1 EPF_value'=" & EPF_walug'="-1

Figure 308: Generic Segmentation Object With One Expression

9. Click 0K in the Generic Segmentation Properties dialog box.

10. Draw a connector line from the output port of the Multi Assign object to
the input port of the Generic Segmentation object.

End of procedure

The strategy now appears as shown in Figure 309.

;'i.w Routing Design - Inbound preprocessing * ;lglﬂ

1 File Edit View Tools Help |
|s@se | mr S8 6 2|
e e EEEN N N =S e

i’

InteractionSubtype] = "CollaborationReply” ¢ - - - - - - - - -

InteractionSubtype] ="MNDR’ | -----------------

Figure 309: Multi Assign Connected to Generic Segmentation
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Sending interactions to Queues

The expression in Figure 308 on page 349 determines whether an interaction
has inbound processing failed status:

If the expression is true for the current interaction (if GEM_Fai Lure contains
a value due to previous processing by Genesys), the interaction has
inbound processing failed status, and goes out the green port.

If the expression is false for the current interaction (if GEM_Fai Lure is
empty), the interaction does not have inbound processing failed status. It is
a new interaction, and goes out the red port.

The next step configures the queue associated with new interactions that have
never been processed by Genesys.

Procedure:
Sending interactions to queues from the Generic
Segmentation object

Purpose: To send interactions to two different queues; one for further inbound
processing and another queue for inbound processing failures.

Start of procedure

1.

350

Click the Queue Interaction object icon (see Figure 292 on page 337).
Then click inside the Routing Design window at the location where you
want to place the object.

Double-click the Queue Interaction object to opens its properties dialog
box (same as Figure 294 on page 338).

Click the down arrow to drop down a menu where you can select an
interaction queue. This example assumes you have followed the “Order of
Configuration” on page 217 so the queue already exists in the
Configuration Database.

Select the inbound postprocessing queue. (see Figure 310).
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Queue Interaction properties 5[

General |

|nteraction queue

-Step 1. Presouting -
-Step 3. 1. Processing by agents

-Step 3.2, QA review

- post-transition

-Step 4. Outbound sending

-Step 3.3, Forwarding

-Step 3.4, Redirecting

- ABC Simple BP

-Step 0. Commmon companents

-Step 2.1, MDR. handling

-Step 2.2, Inbound collabaration reply

-Step 2.3 New inbound e-mails
11, ound e-mail postprocessing
- Preprocessing failure
Preprocessing success

- ABC Simple Chat BP

- Preprocessing

- Indenendent Ohiscts j

k. I Cancel | Help |

Figure 310: Queue Interaction Object, Queue Selected

5. Click 0K in the Queue Interaction Properties dialog box.

6. Follow the above steps to create another Queue Interaction object, but this
time select the queue, inbound preprocessing failures (see Figure 310).

7. Draw a connector line from the side port of the Generic Segmentation
object in Figure 309 on page 349 to input port of the Queue Interaction
object specifying the inbound postprocessing queue.

8. Draw a connector line from the side port of the Generic Segmentation
object to the yellow input port of the Queue Interaction object for inbound
interaction failures.

9. Draw a connector line from the bottom port of the Generic Segmentation
object in Figure 309 on page 349 to the input port of the Queue Interaction
object for inbound preprocessing failures.

The routing strategy now appears as shown in Figure 311.

Business Process—User’s Guide 351



Chapter 11: Creating Strategies Sending interactions to Queues

,'=.~ Routing Design - Inbound preprocessing * - |EI|E|
JJ File Edit View Tools Help |

ErERIEE LI =l

e —e
—

BusinezsData[ InteractionSubtype] = TnboundNDE! I|I Step 2.1 NDR ha.ﬂdlingﬂmaﬂ#

"0 [ EPF_flag=interactionData[GEM | | | |1l e
aeseaatl SR it [TStep 1 Preouting Inbound e,
A =) EPT_value =" & EPT value I="-1 o

For Help, press F1 | [ [LoG | | | v

Figure 311: Queue Objects for Failures and New Inbound Interactions

10. Click the File menu and select Save.
End of procedure

Next Steps

Continuing with the above example, when this routing strategy is placed in a
business process:

* The next step might be to extract interactions out of the queues and submit
them to routing strategies in the same business process.

*  Or the next step might be to use the same queues in different business
processes and continue processing from there. The Interaction Workflow
Samples component takes this latter approach (see “Step 2.1. NDR
Handling” on page 393).
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Compiling

This section describes how to compile a routing strategy in the Routing Design
window:

Procedure:
Compiling a routing strategy

Purpose: To check whether the strategy can be executed and does not contain
errors.

Start of procedure

1. Click the button for compiling (see Figure 312).

;:.n- Routing Design - Inbound preprocessing * ;lglﬁl

—

JEi|E Edit View Tools Help

E"&ss + e |G 6 =
EEEE EEEEE 2N [
""':::::::::::::-:.:::7::::::::::'ﬁ-::::::::::::::::?

Figure 312: Compile Button

2. View the results of the compile. If the strategy compiles successfully, the
following message appears (see Figure 313).

Interaction Routing Designer X|

' "_q,, Result of compilation - 0 error(s), 0 warning(s).
L

Figure 313: Message When Strategy Compiles Successfully

Note: This message also appears in the Errors in Strategy tab, which
appears once you compile, at the bottom of the Routing Design
window (see Figure 314).
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ID

Compiling of strategy
Result of compilation - 0 error(s), 0 warning(s).

1| | i

Find in strategy J Errors in strategy I

Figure 314: Errors in Strategy Tab
3. View the Errors in Strategy tab. If the strategy does not compile
successfully, the Errors in Strategy tab details the error.

4. Correct the error and recompile until no more errors.

End of procedure

You may also wish to use the Check Integrity tool, which highlights invalid
references in the Configuration Database.Using Check Integrity

Checking Database Integrity

You can locate invalid Configuration Database object references within a
saved or compiled strategy using the Check Integrity tool. The tool is located
on the toolbar in the Routing Design window (see Figure 315).

j.v. Routing Design - Inbound preprocessing * - |EI|5|

|| Bile Edit View Tools Help

IECERI R T = |
masegmb||E||Ea ||[ter|Tou|e ===
::::::::::::::/EM*W;QF‘F‘“::::::::::::::::::::::::f:::5!

Figure 315: Check Integrity Tool

Procedure:
Using Check Integrity

Purpose: To check for invalid database references.
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Start of procedure

1.

Open the strategy if not already open. You can open by selecting the
strategy in the Strategies Llist pane (see Figure 34 on page 59) or by
using Edit/View Strategy in the Interaction Design window (see
Figure 260 on page 305).

If you made any changes to the strategy since it was last saved or
compiled, save the strategy again.

Click the icon for checking integrity (see Figure 315 on page 354) in the
toolbar. The objects containing the invalid references are highlighted with
a red border in the Routing Design window, and the Errors in Strategy
output window appears below the Routing Design window listing the
invalid references.

Double-click a highlighted object to open its properties dialog box.

Make corrections to the object as required. The highlight disappears when
you close the properties dialog box for the object.

Use the Search or the Search and replace capabilities (see page 140) to
search for all occurrences of an invalid reference.

End of procedure

Important Information

Keep the following points in mind when using Check Integrity:

When a call should be routed to a Resource under a different Tenant using
the routing rule Switch-to-Strategy, the Check Integrity function will
always return an error.

When Check Integrity is off, IRD allows the opening and editing of a
loaded strategy.

Before checking strategy integrity, save your changes. If you do not save
your changes before using the Check Integrity tool, this error message
appears:

Check Integrity Operation aborted

If the Check Integrity tool is not available select View > Check Integrity
to activate the tool. When the Check Integrity command is activated, all
strategies and objects are checked. While IRD performs the check, you
cannot perform any other operation.

The Progress Bar indicates the progress of the integrity checking.
Use the Compile command to check for strategy syntax errors.

Turn off Check Integrity when updating permissions apply to a large
number of objects. If Check Integrity is turned on, it could take a long time
to update permissions, for example from No Access to Full Control.
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Adding a Strategy to a Business Process

356

Strategies unconnected to a business process can be found in the Independent
Objects folder (see Figure 38 on page 63).

Procedure:
Adding a strategy in the Independent Objects folder to
a business process

Start of procedure

1. Inthe Interaction Design window object browser, Independent Objects
folder, select the strategy.

2. Drag/drop it into the Strategies folder for the applicable business process.

3. Select Save from the File menu.

End of procedure

Procedure:
Re-using a strategy already contained in a business
process

If the strategy is already connected to a business process, you can still use it.

Start of procedure

1. Switch to the business process that contains the strategy by double-clicking
it to make it active (highlighted). You can also select Open the Process
from the shortcut menu.

2. Expand the Strategies folder where you will copy the strategy to.
3. Select the strategy that you wish to re-use so it is highlighted.

4. Drag only (don’t drop yet) to the Strategies folder for the applicable
business process.

5. Place the mouse pointer directly over the Strategies folder.

6. When the mouse pointer becomes a left-pointing arrow, drop the strategy
into the folder.

End of procedure
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Editing/Viewing Strategies

Note: You must deactivate a strategy before you can open it for editing or
viewing. For more information, see page 367.

You can edit or view a strategy that is not loaded on a virtual routing point
from either the Interaction Design window or from the Routing Design

window.

Procedure:

Editing/viewing a strategy from the Interaction Design

window

Start of procedure

1.
menu (see Figure 316).

Right-click the strategy name and select Edit/View Strategy from the

ﬁﬂ Interaction Design - Preprocessing

File Edit Wiew Business Process Tools Help

=10l x|

e BB =8|

o ||
EI@ Preprocessing ;I
=25 Queues
: % ProductB

{4 Workbins Information

" -
Step 0. Common comg 7B_E-Mail>erver

Step 2.3 New ianLTILI
| >

Kl |

il WorkbinAgent
5 ProductB -
-2y Strategies ) roduc @ ,Prodeview?
{2 Inbound Prepr Sales \
(23] Subroutines SUPBOFE | b et e

Configuration Loaded - 0 error(=s),

0 warning(s) .

[4] 4] » [+ ' Log A Configuration Updates A Search Results f

Step 1. Pre-routing .
P ti
Step 2.1, NDR handlin LFDP:EF es
Step 2.2, Inbound coll In oca
Prepr

Edit/View Strategy

Activate Strategy
[Deactivate Strategy
Hename

Disconnect And/Cr Hide Del

v (5rid

Open the strategy in Business Router Designer.

O

1 s

Figure 316: Edit/View Strategy From the Interaction Design Window
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Editing/Viewing Strategies

If you have access to the .rbn file (see “Graphical Portion of a Strategy”

on page 172), the strategy opens for editing in the Routing Design window
(see Figure 317 on page 358).

_inix]
JJ File Edit View Tools Help |
IFEEEIEY e |

[Eacogmb || Ea ||=esm||mon|s=ss||e

BusinessData[ InteractionSubtbype] = TnboundNDE I|I Step 2.1. NDE. hmd]jngﬂmajls{

Cooo ([ Default |

...... | EPF_flag=InteractionData[GEM . . . . . 0.0

o EE

Figure 317: Strategy Available for Editing in Design View
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2. Ifyou have unsaved changes in the currently open business process,
respond to the message that appears (see Figure 318).

Interaction Routing Designer |

The configuration has been changed.

9
\4\-/ In order to view the changes in Interaction Routing Designer, it should be saved.
Do you wish to save the changes?

Mo Cancel

Figure 318: Configuration Changed Prompt

End of procedure
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Procedure:
Viewing a strategy from the IRD main window

To edit/view from the Strategies list pane in the IRD main window (see
Figure 90 on page 115), use one of the methods below.

Start of procedure

1. If working in the Interaction Design window, minimize the window.
2. Open the window that contains the IRD main window.

3. Single-click the strategy to highlight and select Open from the File menu.
+ As an alternative, double-click the strategy to open.

End of procedure

With either method, if you have access to the .rbn file (see “Graphical Portion
of a Strategy” on page 172), the strategy opens for viewing/editing in the
Routing Design window (see Figure 317 on page 358).

Deleting Strategies

You can delete strategy that is not loaded on a virtual routing point in either the
Interaction Design window or the Routing Design window.

Procedure:
Deleting strategies from the Interaction Design
window

Start of procedure

1. In the object browser (see Figure 37 on page 62), right-click the strategy.

2. Select Delete from the shortcut menu. The strategy is not deleted in the
Configuration database, but only disappears from the business process that
uses it. If you want to remove it from the Configuration Database, you
must do so in the Routing Design window.

End of procedure
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Procedure:
Deleting strategies from the Strategies List pane

Start of procedure

1. Inthe Strategies list pane (see Figure 34 on page 59), single-click the
strategy.

2. Press the Delete key. The following message appears (see Figure 319):

Interaction Routing [ |

Do you want to delete object(s)?

Figure 319: Delete Object Confirmation

3. Click Yes. The strategy is deleted. Any re-usable objects (see page 115)
that the strategy uses are not deleted.

End of procedure
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Chapter

1 2 Using a Business Process

This chapter provides step-by-step instructions for using business processes. It
covers the following topics:

« Activating Strategies, page 361

«  Testing the Strategy, page 364

- Verifying the Workflow, page 365

« Deactivating/Unloading Strategies, page 366

Activating Strategies

Before testing a routing strategy, you must load it on a virtual routing point in
your Test environment (do not load it in your Production environment). Use
the Strategy Activation Wizard for this purpose as described below.

Procedure:
Loading a multimedia strategy on a virtual routing
point

Start of procedure

1. As described in the eServices (Multimedia) 8.0 Deployment Guide, make
sure a Multimedia Switch object is configured and available in IRD’s
Monitoring view (see Figure 320 for an example).
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Activating Strategies
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Figure 320: Example Multimedia Switch

2.

it. Or use Open the Process from the shortcut menu.

Wizard:

*

Use one of the following methods to open the Strategy Activation

Open the business process associated with the strategy by double-clicking

Highlight the business process name in the object browser and select

Deactivate Strategy(ies) from the Tools menu. Using this method,
you can activate multiple strategies at once

Right-click the Strategy object in the object browser or workflow

viewer and select Activate Strategy from the shortcut menu (see

Figure 321).

a7

ok )
 handle fax interact - |

» identify contact an
Howe ba: place the interactic
Howe ba: screen multiple rule
Step 0. Commmon componen
Step 1. Pre-routking
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nound e-mails
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Inbound

Locake

)

Inbound e-r
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Propetties
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DFEDFOCE:

Edit/view Strategy
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Strateqgy

Deachivate Strategy.

=]

Figure 321: Activate Strategy from Context Menu

With either method, the Strategy Activation Wizard launches (see Figure

322).

362
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Strategy Activation VWizard El

Choose Interaction Server

Choose an Interaction Server[z), which will submit interactions to the strategy. E'Eg

Interaction Serser | Switch |
|nteractionServer kultimedias

[T Do not show this dialog if there iz only one server available [choose it automatically)

Figure 322: Strategy Activation Wizard, Start

4. Select an Interaction Server and click Next. Choose Universal Routing
Server appears at the top of the wizard (see Figure 323).

Strategy Activation Wizard il

Chooze Univerzal Bouting Server

Chooze Univerzal Bouting Server(z], which will execute the strategy. E'Eg

IJniverzal Bouting. .. | Backup Universal... | Interaction Server | Loaded Strategies |
m InteractionS erver

™ Do not show this dislog if there iz only one server available [choose it automatically]

Back I Activate I LCancel |

Figure 323: Strategy Activation Wizard, Choose Universal Routing Server
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5. Select a Universal Routing Server and click Activate. The next dialog box
indicates the activation is done (see Figure 324).

Strategy Activation Wizard il

The job iz done
Belovw are the activation detail: E'Eg

Iniversal Rou... | Backup Unive. .. | Strateqy name | Result of activation |
UR_Semer_7a0 |nbound e-mai...  Loaded on 'azl_Inbound e-mail preproceszing =t

Cloze

Figure 324: Strategy Activation Wizard, Choose Universal Routing Server

End of procedure

If you do not have a Switch connection to Interaction Server, when you select
Activate Strategy from the menu shown in Figure 321 on page 362, the
Strategy Activation Wizard explains what to do next.

Note: It is possible to manually load strategies in Monitoring view (see
Figure 67 on page 84). The Strategy Activation Wizard is the
preferred method because it creates the virtual routing points for you.
Similarly, when you use the Wizard to deactivate a strategy loaded on a
virtual routing point (see Figure 68 on page 85), the Wizard also
deletes the virtual routing points.

Testing the Strategy

Testing the strategy is accomplished by using a combination of your e-mail
client and Genesys Desktop, which flashes a yellow icon when an e-mail is
received by a ready agent (see Figure 325).
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Verifying the Workflow
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For information about testing business processes, consult the eServices

(Multimedia) 8.0 Deployment Guide.

Verifying the Workflow

A business process must be consistent. This means that:

* All routing strategies are valid.

* All non-dynamic queues have at least one Submitter object.

Business Process—User’s Guide
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* All agent targets and routing strategies must have the appropriate number
of connections.

* All interaction processing must have an end. The end can be specified by
the IRD Stop Processing object or a special target (different from an agent
and/or queue).

To verify a business process:
1. Select Options from the Tools menu.
2. Make sure the following option is selected:
Fix Referential Integrity Errors Automatically (on Load).
3. Select 0K.
4. Close and re-open the business process.

5. Respond to any messages that might appear.

Deactivating/Unloading Strategies

Note: It is possible to unload strategies manually in Monitoring view (see
Figure 67 on page 84). Using Deactivate, as described below, is the
preferred method because it gives you more options.

You must either deactivate or unload a strategy before you can open it for
editing or viewing with Edit/View Strategy.

Procedure:
Deactivating or unloading a strategy in a business
process

Start of procedure

1. Open the Strategy Activation Wizard using one of the following methods:
* Right-click the Strategy object in the object browser or workflow
viewer and select Deactivate Strategy from the shortcut menu.
* Highlight the business process name in the object browser and select
Deactivate Strategy(ies) from the Tools menu. Using this method,
you can deactivate multiple strategies at once

Depending on which method you use, the Deactivate <name> Strategies
dialog box opens listing either one or all of the strategies contained in the
business process that could be deactivated.

In the figure below, the business process contains one strategy (see
Figure 326).
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Deactivate Strategies il
Strategy name | Switch | YRP | I niverzal Bouting Server |
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Deactivate I Unlaad Cancel

Figure 326: Deactivate Strategy Dialog Box

2. Select either Activate or Unload.
* Deactivate deletes the virtual routing point as well as deactivating the
strategy in the business process.
* Unload does not delete the virtual routing point. You must unload a
strategy before you can view or edit it. In a large environment, the
Unload option could save time later when activating multiple strategies
back to existing routing points.

If multiple strategies are listed, select only the strategies you wish to
deactivate or unload.

3. When the strategies are highlighted, click the button for the desired action.
IRD will not display confirmation prompts. After you click the desired
button, the dialog box closes and IRD performs the action.

End of procedure
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Appendix

Business Process Samples

This appendix discusses the Genesys-supplied business process samples. It
builds on the information that is contained in “Using the Samples” on page 197
and covers the following topics:

About the Samples, page 370

Viewing the Samples, page 372

ABC Simple BP, page 374

ABC Simple Chat BP, page 379

ABC Simple MMS, page 381

ABC Simple SMS Paging, page 382

Web Callback, page 382

Default BP, page 387

Step-Numbered Business Processes, page 389

Step 1. Pre-Routing, page 391

Step 2.1. NDR Handling, page 393

Step 2.2. Inbound Collaboration Reply, page 394

Step 2.3. New Inbound E-mails, page 396

Step 3.1. Processing By Agents, page 399

Step 3.2. QA Review, page 401

Step 3.3. Forwarding, page 403

Step 3.4. Redirecting, page 405

Step 4. Outbound Sending, page 407

How To: Business Processes, page 409

How To: Apply Escalation Procedure, page 411

How To: Attach Classification Categories and Use Attach Categories
Object, page 413

How To: Attach Classification Categories and Use Multi-Screen Object,
page 419

How To: Conduct a Survey by Using Email, page 425

How To: Get Credit Card Number From the E-mail, page 430
How To: Handle Fax Interactions, page 434

How To: Identify Contact and Create Interaction in UCS, page 441
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About the Samples

How To: Place the Interaction Into the Workbin, page 445
How To: Screen Multiple Rules and Use Screening Switch, page 449

About the Samples

Because each company has its own environment and different requirements,
supplying business process samples that accurately reflect all real-word
business scenarios is not possible. Therefore, do not consider the
Genesys-supplied Interaction Workflow Samples suitable for a Production
environment, but instead as demonstrations of one way in which to implement
various types of functionality. Use them as a starting point to develop your
own customized business processes adjusted to your company’s specific needs.

370

Through its Interaction Workflow Samples component (shown in Figure 327
on page 373), Genesys provides the following business processes:

ABC Simple BP (page 374), which is a basic business process useful to get a
concept and check the samples installation.

ABC Simple Chat BP (page 379), which offers minimal chat interaction
processing.

ABC Simple MMS (page 381), which offers minimal inbound MMS
(Multimedia Messaging Service) processing.

ABC Simple SMS Paging (page 382), which offers minimal SMS (Short
Messaging Service) processing.

Default BP (page 387), which is a complex business process that has a lot
of functionality. See “Functionality Demonstrated in the Samples”.

The step-numbered samples break down Default BP into
functionally-themed components:

Step
Step
Step
Step
Step
Step
Step
Step
Step
Step

0.

4.

Common Components (see Table 30 on page 389)
. Pre-routing (page 391)

.1. NDR Handling (page 393)

.2. Inbound Collaboration Reply (page 394)
.3. New Inbound E-mails (page 396)

.1 Processing by Agents (page 399)

.2. QA Review (page 401)

.3. Forwarding (page 403)

.4. Redirecting (page 405)

Outbound Sending (page 407)

The how-to business processes:

How to: apply escalation procedure (page 411)

How to: attach classification categories & use attach categories
object (page 413)
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How to: attach classification categories & use multi-screen object
(page 419)

How to: get credit card number from the e-mail (page 430)

How to: handle fax interactions (page 434)

How to: identify contact and create interaction in UCS (page 441)
How to: place the interaction into the workbin (page 445)

How to: screen with multiple rules and use multi-screen object
(page 449)

Web Callback (page 382) offers web callback processing.

Samples Functionality

The Interaction Workflow Samples component supplies the following
functionality:

Pre-routing based on interaction sub-type (see page 391)

Routing interactions to the original agent (see page 393)

Screening of inbound interactions (see page 396)

Attaching classification Categories (see page 419)

Processing of attached data (see page 393)

Redirecting interactions (see page 405)

Forwarding interactions (see page 403)

Collaboration reply sending (see page 394)

Automatic treatment with an acknowledgement e-mail (see page 451)
Autoresponse e-mail when applicable (see page 451)

Placing interactions in workbins (see page 445)

Escalating overdue interactions to supervisor workbins (see page 445)
Routing to agents (see page 399)

Assigning failure codes to interactions (see page 451)

Promoting an interaction that failed pre-routing to the next process (see
page 391)

Routing interactions for QA review (see page 401)
Skill-based review of agent response (see page 401)
Re-processing interactions that failed QA review (see page 401)

Quality control for outbound interactions based on screening (see
page 407)

Re-processing interactions that failed quality control (see page 401)
Sending e-mail responses to customers (see page 407)

Re-processing interactions that failed sending (see page 407)
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* Stopping an interaction with a reason code (see page 378)
* Handling fax interactions (see page 434)
* Identify customer contacts and create interaction records (see page 441)

* Get credit card information from an interaction (see page 430)

Note: In order to understand fully a business process, you must understand its
strategies. Universal Routing 8.1 Strategy Samples details many of the
strategies that are found in the Genesys Multimedia Interaction
Workf low Samples component.

Viewing the Samples

Once the samples are installed (as described in the eServices (Multimedia) 8.0
Deployment Guide) you can view them in the Interaction Design window (see
Figure 327).

372 Universal Routing 8.1 @



Appendix : Business Process Samples

Viewing the Samples
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Figure 327: Interaction Workflow Samples

* For information about printing a business process, see page 76.

* For information about printing the strategies contained in a business

process, see page 109.

* To change to a different business process, double-click the business

process.

Properties Dialog Boxes for Strategy Objects

When you load the samples, as described in the eServices (Multimedia) 8.0
Deployment Guide, part of the installation process involves using Knowledge
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Manager to import the file UCS_impex.kme. This file contains Screening Rules
and other objects found in the Universal Contact Server Database, which must
be synchronized with objects in the Configuration Database. If Screening
Rules or other Knowledge Manager objects do not display in the object
properties dialog boxes for the sample strategies, check whether this step was
performed.

If the file was imported and the properties dialog boxes still do not display the
proper objects, one possible reason may be that the database identifiers (IDs)
of the default Screening Rules and/or other objects have changed. In this case,
use Knowledge Manager to reimport the ucs_impex.kme file. In the Import
dialog box, clear Preserve uniqueness of objects by creation of new UCS
ids.

Warning! Normally, it is very risky to not preserve uniqueness (that is why
the preceding check box is selected by default). However, when
you are importing the ucs_impex.kme file related to the Interaction
Workflow Samples, you do NOT want to change any of the
database IDs that are associated with the default Screening Rules
and other objects. Leaving this box unchecked will ensure that
these rules are not assigned new UCS IDs.

ABC Simple BP

ABC Simple BP in Figure 327 on page 373 is a basic version of a real-life
business process. Figure 328 shows the business process.

-@I =Outbnund wiew - - I}

Outbound Send
queLe SR

@ I '_Inl:unun-:l vk

Inbound
queue

=g -9

E-rrail Stap
distribution

Figure 328: ABC Simple BP
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The business scenario: Deliver inbound interactions to the appropriate agent
and then send out the response created by that agent. The sample has no other
functionality and can correctly process only new inbound customer
interactions.
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Processing Flow

Any e-mail that is received in the contact center is submitted by E-mail Server
to the Inbound queue (see Figure 328 on page 374). Using Inbound view that
has no Conditions or Order By information (see page 273), interactions are
extracted from the queue and passed to the Process ABC routing strategy.

Process ABC Routing Strategy

This routing strategy contains only an Entry object, a Route Interaction object,
and an Exit object (see Figure 329).

Figure 329: Process ABC Routing Strategy

Open the Route Interaction object Properties dialog box (see Figure 330).
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Figure 330: Process ABC Routing Strategy

You will see that the Interaction Queue tab specifies:

* The Genesys predefined queue Stop Processing(_STOP_) for the existing
interaction (the customer’s original e-mail for which processing is now
ending). Stop Processing(_STOP_) is represented by the first Stop object in
Figure 328 on page 374, which is a strategy-linked node (see page 34).

* The queue Outbound queue for the new interaction that will be created,
which will ultimately be sent to the customer. This queue is the Outbound
queuve strategy-linked node in Figure 328 on page 374.

In the Target Selection tab in Figure 330 on page 376, you will see that the
interaction is routed to a member of the Agent Group called E-mai L
distribution. This target is represented as the E-mail distribution person
strategy-linked node (see page 34) in Figure 328 on page 374.

The agent generates a response and places it in the Outbound Queue.
Interactions are extracted using the Outbound view (withno Condition or Order
By information as shown in Figure 222 on page 273) and submitted to the
routing strategy Send ABC.
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Send ABC Routing Strategy

Figure 331 shows the Send ABC routing strategy.

Figure 331: Send ABC Routing Strategy

Send Object
Open the properties dialog box for the Send E-mail object (see Figure 332).

Send Email properties |

General | Format |

Emailserver. | - |

Figure 332: Send Object

* The Send object notifies E-mail Server through Interaction Server to send
the e-mail to the customer. E-mail server is blank in Figure 332 because
Interaction Server uses the E-mail Server that is named in its Connections
list in Configuration Manager.

* The Format tab gives the option to edit the To, From, and Subject areas in
the e-mail that will go to the customer (for details, see Universal Routing
8.1 Reference Manual).

Stop Interaction Object

Note the Stop Interaction object in the strategy in Figure 331. It tells
Interaction Server that processing for this interaction has stopped. Open the
properties dialog box for the Stop Interaction object (see Figure 333).
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Figure 333: Stop Interaction Object

The Stop Interaction object specifies a Reason Code. Genesys predefines the
Sent Reason Code in Configuration Manager. The Stop Interaction object also
specifies that Universal Contact Server (UCS) should be notified that
processing for this interaction (the new interaction) has stopped.

When a Stop Interaction object is used inside a strategy, it generates a Stop
strategy linked node (see page 34). You can see this strategy-linked node as the
second Stop node in Figure 328 on page 374.

Function Object

The Send ABC routing strategy that is shown in Figure 331 on page 377 also
contains a Function object. If there is an error in sending, the interaction goes
out the bottom port of the Send object to a Function object. Open the properties
dialog box for the Function object (see Figure 334).
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Figure 334: Function Object

Strategy execution is delayed for the specified number of milliseconds. After
this number of milliseconds, the interaction is returned to the same queue for
the next send attempt.

ABC Simple Chat BP

ABC Simple Chat BP is very similar to ABC Simple BP. The main difference is
that ABC Simple Chat BP contains a strategy (Chat strategy - create
transcript e-mail) that uses the Chat Transcript object to request E-mail
Server to generate an e-mail that has the customer’s chat transcript attached.
Figure 335 shows the business process.

Business Process—User’s Guide 379



Appendix : Business Process Samples ABC Simple Chat BP

Create chat transcript e-mail wiew

@'Chat inbound wigw .;- Er _________________________ ,...—EJ ..................... - % I

Chat

Chat inbound Chat distribution ate chat transchpt e-rmail
queus inbound Foh quele
strateqy
?@‘———p @ I Send chat transcy
Chat - "
.::'Transcnpl: chat transcript e
- L i queLe
Chat
strateqy
- creata a # l
transcrpk
e-rnail Stop Chat
strateqy ;
- send
chat e #
transcHpt o
a-rail Stop

Figure 335: ABC Simple Chat BP

Note: The objects within this business process have been repositioned so that
all are visible on a page.

The business scenario: Determine whether an interaction should be processed
immediately (such as a chat) or at a later time. If the interaction is the result of
a chat session, request E-mail Server to generate an e-mail that has the chat
transcript attached and send it to the customer.

Note: For more information about this business process, including its queues,
views and strategies, see Universal Routing 8.1 Strategy Samples.
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ABC Simple MMS

ABC Simple MMS provides basic MMS processing functionality. The business
process contains one strategy: MMS Inbound Processing. Figure 336 shows the
business process.
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Figure 336: ABC Simple MMS BP

The business scenario: Deliver inbound MMS interactions to the appropriate
agent. The agent can see the interaction’s content (subject, text and multimedia
elements) and the interaction’s history of a contact (author of the MMS
message). The sample has no other functionality and can correctly process new
inbound customer interactions only.

Note: For more information about this business process, including its
strategies, see the Universal Routing 8.1 Strategy Samples.
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ABC Simple SMS Paging

ABC Simple SMS Paging provides basic SMS processing functionality. The
business process contains two strategies: SMS Inbound and SMS Outbound.
Figure 337 shows the business process.
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Figure 337: ABC Simple SMS Paging BP

The business scenario: Deliver inbound SMS interactions to the appropriate
agent. The agent can see the interaction’s content and the interaction’s history
of a contact (author of the SMS message). The agent can reply to the contact
by using an outbound SMS message. The outbound interaction is placed into
an outbound interaction queue. The SMS Outbound routing strategy fetches the
outbound interaction and sends it to the contact by using SMS Server. The
sample has no other functionality and can correctly process new inbound
customer interactions only.

Note: For more information about this business process, including its
strategies, see Universal Routing 8.1 Strategy Samples.

Web Callback

WebCallback provides basic web callback processing. The business process
contains the following strategies:

* Delivering strategy
* Expired Conference Callbacks strategy

* Expired Transfer Callbacks strategy
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* Qutbound notification email sending strategy
* Preprocessing strategy

* Rescheduled by Agent strategy

* Rescheduled by Customer strategy

* Stop By Agent strategy

e Stop By Customer strategy

The WebCal Lback business process contains the following subroutines:
* Check Customer Session State

* Check Interaction

* Check Maximum Attempts

* Check Maximum Waiting Time

e Increment Number of Attempts

e Schedule Web Callback

* Send Email Notification

e Stop Web Callback

Figure 338 shows the business process.
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Web Callback
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Figure 338: WebCallback Business Process

The business scenario: Process web callback interactions. This includes
delivering web callback interactions to agents, rescheduling web callback
interactions, and stopping web callback interactions.

Configuration

Configuration options used in the WebCal Lback business process are defined in
URS as list objects (see “List Objects” on page 121 for more information).

Figure 339shows the WebCal Lback list object, the options item, and two keys:
UseUCS and MaxAttempts.

UseUCS specifies whether a new web callback interaction will be created in

UCS and updated when the interaction is stopped (true). The default value for
UseUCS is false.
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MaxAttempts specifies the maximum number of attempts that can be made to
deliver the interaction to an agent. The default value is 5. MaxAttempts can be
set to any valid integer.
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Figure 339: WebCallback List Object

Processing Flow

This section outlines the processing flow of the WebCal Lback business process.
It is divided into the following topics:

*  Preprocessing

* Delivering

* Rescheduling by Agent

* Rescheduling by Customer
» Stopping by Strategy

* Stopping by Agent

* Stopping by Customer

Note: For more information about this business process, including its
strategies, see Universal Routing 8.1 Strategy Samples.
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386

Preprocessing

The Preprocessing phase of the business process updates all necessary
interaction business data parameters, sets the correct ScheduledAt key-value
pair, and submits the interaction to the Scheduled queue.

Optional steps include the following:
¢ Create the contact and interaction in UCS.

e Send a confirmation e-mail to the customer.

Delivering

The Delivering phase of the business process finds a target and delivers the
web callback to an agent.

The interaction is redirected to the Stop queue if:
* The end time for the callback has passed.
* A target is not found and the end time for the callback has passed.

The interaction is redirected to the Fai Lover queue if the
WCB_CUSTOMER_SESSION_STATE key-value pair value is set to active. This will
prevent double calls to customers in case of system failover.

Rescheduling by Agent

All of the the necessary interaction business data parameters are updated, and
the correct ScheduledAt key-value pair is set. The interaction is submitted to
the Scheduled queue.

The number of attempts is updated.

The interaction is redirected to the Stop queue if:
* The number of attempts is too high.

* The end time for callback has passed.

Rescheduling by Customer

All of the the necessary interaction business data parameters are updated, and
the correct ScheduledAt key-value pair is set. The interaction is submitted to
the Scheduled queue.

The interaction is redirected to the Stop queue if:
* The number of attempts is too high.
* The end time for callback has passed.
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Stopping by Strategy

All of the necessary interaction business data parameters are updated. The
interaction is stopped.

The status is updated to Comp Leted.
Optional steps include:
* Update the interaction in UCS.

* Send a notification e-mail about the unsuccessful web callback to the
customer.

Stopping by Agent

All of the necessary interaction business data parameters are updated. The
interaction is stopped.

The status is updated to Comp Leted.

Optional steps include:

* Update the interaction in UCS.

Stopping by Customer

All of the necessary interaction business data parameters are updated. The
interaction is stopped.

The status is updated to Comp Leted.
Optional steps include:
* Update the interaction in UCS.

Default BP

Default BP is an example of a complex business process that encompasses the
functional areas that are isolated in the step-numbered business processes (see
Table 30 on page 389). It combines a large number of different tasks into a
single business process. Contrast this with the “Step-Numbered Business
Processes” on page 389 in which the tasks are divided into smaller business
processes that are connected via queues (see page 199).

Figure 340 shows a high-level view of the start of Default BP.
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Figure 340: Default BP
Notes: Select Zoom Out from the context menu to view more of a large
business process.

Figure 340 reflects the default arrangement of the icons in the viewer.
You can always return to the default positioning at any time by
selecting Arrange 0bjects from the business process menu.

Each functional area in Default BP is explained in the step-numbered business
processes.
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Step-Numbered Business Processes

Step-Numbered Business Processes

The step-numbered business processes (connected via queues) isolate the
various functionality found in Default BP (see page 387). Table 30
summarizes the functionality of each step-numbered business process.

Table 30: Step-Numbered Business Processes

BP and functional area(s)

Strategies and objects used

Queue(s)

Step 0: Common Components

These components are shared by the
remaining step-numbered business
processes

Terminate Interaction st uses IRD
objects Call Subroutine, Stop
Interaction, Generic Segmentation,
and Queue Interaction

E-mail service failure analysis uses
IRD objects Multi-Assign, Assign,
Multi-Attach, Function, Generic
Segmentation, and If

Termination failure

Step 1: Pre-Routing
Pre-routing based on interaction
sub-type

Promoting an e-mail that failed
pre-routing to the next process

Inbound e-mail preprocessing str
uses IRD objects Generic
Segmentation, Multi-Assign, and
Queue Interaction

Uses Interaction Subtype Business
Attributes (see page 161 and
page 331)

Inbound e-mails,
Collaboration reply
e-mails, E-mails to route
to original agent, Inbound
e-mail failure, Chat
inbound queue, Inbound
e-mail postprocessing

Step 2.1. NDR Handling

Route Interactions to original agent

Route Interactions to original agent
st uses IRD objects Multi-Assign,
Assign, If, Queue Interaction, and
Route Interaction

E-mails route to original
agent, E-mails for QA
review

Step 2.2. Inbound Collaboration
Reply

Agent collaboration

Collaboration reply sending

Inbound collaboration reply
processing st uses IRD objects
Reply From External Resource,
Stop Interaction, Call Subroutine,
Generic Segmentation, and Queue
Interaction

Terminate Interaction st (see Step 0)
and E-mail service failure analysis
st (see Step 0)

E-mails for QA review,
Termination failure,
Collaboration reply
e-mails, Collaboration
reply failure

Business Process—User’s Guide

389



Appendix : Business Process Samples

Step-Numbered Business Processes

Table 30: Step-Numbered Business Processes (Continued)

BP and functional area(s)

Strategies and objects used

Queue(s)

Step 2.3 New Inbound E-mails
Handling

Screening of inbound e-mails

Automatic treatment with an
acknowledgement e-mail

Autoresponse when applicable

Assigning failure codes

Preliminary e-mail screening st
strategy uses IRD objects Screen,
Call Subroutine, Generic
Segmentation, Function, If, Queue
Interaction, Stop, Autoresponse, and
Acknowledgement

Terminate Interaction st (see Step 0)
and E-mail service failure analysis
st (see Step 0)

Inbound e-mail
postprocessing, Redirect
e-mail, Forward e-mails,
Preprocessing failure,
Termination failure,
E-mails for processing by
agents, Outbound e-mails

Step 3.1. Processing by Agents
Routing to agents

Processing by agents

E-mail distribution for processing st
contains IRD object Queue
Interaction

E-mails for processing by
agents, E-mails for QA
review, Forward e-mails

Step 3.2: Routing E-mails for QA
Review

Processing of attached data
Skill-based review of agent response

Re-processing e-mails that failed
quality control

Re-processing e-mails that failed
sending

Outbound e-mail 65x QA st uses
IRD objects Multi-Assign, Assign,
Generic Segmentation, Route
Interaction, Queue E-mail, If, and
Function

E-mails for QA review,
Quality Control, E-mails
failed QA, Outbound
e-mails

Step 3.3. Forwarding

Stopping an e-mail with a reason
code

Forward e-mail processing st uses
IRD objects Forward E-mail, Stop
Interaction, Call Subroutine,
Generic Segmentation, and
Function

Terminate Interaction st (see Step 0)
and E-mail service failure analysis
st (see Step 0)

Forward e-mails,
Termination failure,
Forward e-mail failure,
Outbound e-mails
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Table 30: Step-Numbered Business Processes (Continued)

Step 1. Pre-Routing

BP and functional area(s)

Strategies and objects used

Queue(s)

Step 3.4. Redirecting

Redirecting an e-mail

Redirect e-mail processing st uses
IRD objects Redirect E-mail, Stop
Interaction, Function, Queue
Interaction, Call Subroutine, and
Generic Segmentation

Terminate Interaction st (see Step 0)
and E-mail service failure analysis
st (see Step 0)

Redirect e-mail,
Termination failure,
Redirect e-mail failure,
Outbound e-mails

Step 4. Outbound Sending

Quality control for outbound e-mails
based on screening

Sending e-mail responses to
customers

Quality Control st uses IRD objects
Screen, If, Queue E-mail, Call
Strategy, and Function

Outbound e-mail sending st uses
IRD objects Send E-mail, Stop
Interaction, Call Subroutine,
Generic Segmentation, Function,
Queue Interaction

Terminate Interaction st (see Step 0)
and E-mail service failure analysis
st (see Step 0)

Quality Control,
Outbound e-mails, E-mail
failure analysis,
Termination failure,
E-mails send error

This appendix now details each step-numbered business process. In addition to
detailing interaction flow, the descriptions show how individual business
processes can be connected via queues.

Note: After each step-numbered business process description, a graphic
depicts the Default BP area that supplies the same functionality.

Step 1. Pre-Routing

The purpose of this business process is to determine if an inbound interaction
is new or has previously been processed by Genesys and process the
interaction accordingly. It does this through the existence (or nonexistence) of
an Interaction Subtype code.

Figure 341 on page 392 shows the Step 1. Pre-Routing business process.
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Figure 341: Step 1. Pre-Routing

Note: Note the up arrows located on the queue nodes in Figure 341. This
indicates a queue that originated in another business process as
described on page 28 and shown in Figure 9 on page 28.

Processing Objects

This section describes the various objects in Figure 341 on page 392.

A view (Inbound e-mai Ls) that has no Conditions (see Figure 222 on
page 273) or Order By information (see Figure 224 on page 274) extracts
e-mails from the Inbound e-mails queue (see Figure 3 on page 23) and
submits them to the Inbound e-mail preprocessing st strategy. Incoming
e-mails may be new ones from customers or they may be e-mails that have
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already gone through Genesys e-mail processing as indicated by the
assignment of an Interaction Subtype (see Figure 148 on page 164).

The flow of an e-mail through the strategy is determined by the existence or
nonexistence of an Interaction Subtype (see page 331).

» Ifthe e-mail has an NDR Interaction Subtype, it is sent to a queue for
delivery to the original agent.

o Ifthe e-mail has an InboundCollaborationReply Interaction Subtype, it is
send to a queue handling collaboration replies from one agent to another.

* Ifthe e-mail does not contain either of these Interaction Subtypes, the
strategy looks for an inbound preprocessing failure flag. If found, the
e-mail is sent to a queue for inbound e-mail failures. If not found, the
e-mail is sent to a queue for new inbound e-mails.

To see the IRD objects that are used in the Inbound e-mail preprocessing
strategy in Figure 341 on page 392, see the Universal Routing 8.1 Strategy
Samples.

Step 2.1.

NDR Handling

The purpose of this business process is to continue the processing started in
Step 1. Pre-Routing. It processes interactions with a Non Delivery Report
(NDR) Interaction Subtype code by sending them to either the original agent
or, if the agent name cannot be found, to a queue for QA review.

Figure 342 shows the Step 2.1. NDR Handling business process.

-8

E-mails

. For Gd

@ l E-mails ko rouke bo original agenk ror A

E-rnails ko rouke to original agent Fouke e-mail .
ko original .h..
agent sk g l @ l
............................... :-'.
Crniarmnic Skop
Targek

Figure 342: Step 2.1: Non-Delivery Report Handling

Processing Objects

This section describes the various objects in Figure 342.
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The E-mails to route to original agent queue is the same queue that is
shown in Step 1. Pre-Routing (see Note on page 392). A view that has no
Conditions (see Figure 222 on page 273) or Order By information (see
Figure 224 on page 274) attached to the queue extracts e-mails. Interactions
are submitted to the Route e-mail to original agent st strategy.

The Route e-mail to original agent st strategy demonstrates how to route a
customer reply e-mail back to the agent that handled the original e-mail. It
checks whether the original agent employee ID or QA reviewer employee ID is
contained in the interaction attached data.

» Ifavariable contains the name of the original agent, the e-mail is routed to
the original agent.

* If'this same variable does not contain the name of the original agent, the
e-mail is routed to a queue for QA review.

Note: To see the IRD objects that are used in the Route Interaction to
original agent st strategy, see the Universal Routing 8.1 Strategy
Samples.

Step 2.2.

394

Inbound Collaboration Reply

The purpose of this business process is to continue the processing started in
Step 1. Pre-Routing. Itprocesses interactions with an Inbound Collaboration
Reply Interaction Subtype code indicating one resulting from two agents
collaborating on a customer reply. Figure 343 shows the Step 2.2 Inbound
Collaboration Reply business process.
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Figure 343: Step 2.2. Inbound Collaboration Reply

Collaboration replies are e-mails from external resources. An external resource

is a name for any object outside the contact center. It may be an external agent
or another contact center.

A collaboration reply inbound e-mail arrives as a result of the following
actions:

* The parent e-mail is forwarded by an agent (via the Forward E-mail object)
requesting collaboration with another agent.

* The collaborating agent constructs a response.
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* The collaborating agent sends the reply back to the requesting agent
creating a collaboration reply inbound e-mail.

Processing Objects

This section describes the various objects in Figure 343 on page 395.

The Collaboration reply e-mails queue is the same queue that is shown in
Figure 341 on page 392 (see Note on page 392). In Default BP, this queue
connects the Step 1. Pre-routing business process with the Step 2.2
Inbound Collaboration Reply business process.

A view that has no Conditions (see Figure 222 on page 273) or Order By
information (see Figure 224 on page 274) extracts e-mails from the queue.

A submitter submits them to the Inbound collaboration reply processing st
strategy.

A Reply From External Resource (see page 204) object in the strategy takes
the collaboration reply as input, extracts the reply text from it, creates a
customer reply outbound e-mail with it, and places the e-mail in an interaction
queue (E-mails for QA review).

A Stop Interaction object notifies Interaction Server that processing is finished.

Error Handling

The following objects in Figure 343 on page 395 are the result of error
handling: Collaboration reply failure queue, E-mail service failure
analysis st strategy, and Terminate Interaction st strategy.

Note: For details on strategy error handling, as well as the IRD objects used
in the Inbound collaboration reply processing strategy, see
Universal Routing 8.1 Strategy Samples.

Step 2.3.

396

New Inbound E-mails

The purpose of this business process is to continue the processing started in
Step 1. Pre-Routing. It processes interactions without an Inbound
Collaboration Reply or NDR Interaction Subtype code (or preprocessing
failure flag) indicating a new inbound interaction from a customer. Figure 344
shows the Step 2.3. New Inbound E-mails business process.
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Step 2.3. New Inbound E-mails
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Figure 344: Step 2.3. New Inbound E-mails

Processing Objects

This section describes the various objects in Figure 344 on page 397.

This business process begins with the Inbound e-mail postprocessing queue,
which is one of four output queues that are shown in Figure 341 on page 392.
In Default BP, this queue connects the Step 1. Pre-routing business process
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398

Step 2.3. New Inbound E-mails

with the Step 2.3. New Inbound E-mails business process (see Note on
page 392).

A view that has no Conditions (see Figure 222 on page 273) or Order By
information (see Figure 224 on page 274) extracts e-mails from the queue.

A submitter submits them to the Preliminary e-mail screening st routing
strategy.

This strategy screens e-mails by using three Screening Rules (see page 185).

1.

If the screening using the first rule (Auto Response Available) produces a
match, an Autoresponse object (Autoresponse strategy-linked node in
Figure 344 on page 397) attaches a Standard Response to the interaction
and places the interaction in the Outbound e-mails queue.

If the first screening does not produce a match, a second screening occurs
using a different rule (Warranty Problem). Results are written to a variable,
which is subsequently used in an If expression. If the expression is true
(Screening Rule match found), the interaction goes to the queue Forward
e-mails. If the expression is false (no match), the interaction goes through
a third screening.

If the second screening does not produce a match, a third screening occurs
using a different Screening Rule (Tech Support). Results are again written
to a variable, which is subsequently used in an If expression.

If the expression is true, the interaction requires a technical support agent
so it goes to the Redirect e-mails queue. A Stop object then notifies
Interaction Server that processing has stopped since the Redirect object is
used for e-mails do not require any further processing (see page 204).

If the expression is false (no match), an Acknowledgement object
(Acknowledge strategy-linked node in Figure 344 on page 397) attaches a
Standard Response to the interaction and places it in the E-mails for
processing by agents queue.

The following objects in Figure 344 on page 397 are the result of error
handling:

E-mail service failure analysis st strategy

Terminate Interaction st strategy

Preprocessing failure queue

Termination failure queue

Note: For details on strategy error handling, see Universal Routing 8.1

Strategy Samples.
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Step 3.1. Processing By Agents

The purpose of this business process is to continue the processing from Step
2.3 New Inbound E-mails. It processes interactions in the E-mails for
processing by agents queue by sending them to members of an agent group.
Once an agent is finished, the interaction is placed in a queue for quality
assurance review.

Figure 345 shows the Step 3.1. Processing By Agents business process.

@ I E-rails for processing by agents R vl (R w 8 I ............................... - al
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for processing
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distribution

Foraard
e-rails

Figure 345: Step 3.1. Processing by Agents

Processing Objects

This section describes the various objects in Figure 345.

The E-mails for processing by agents queue is the same queue that is shown
in Figure 344 on page 397 (see Note on page 392). In Default BP, this queue
connects the Step 2.3. New Inbound E-mails Handling business process with
the Step 3.1. Processing By Agents business process. This queue is used
when a Standard Response cannot be used and the interaction does not require
redirecting as described on page 398.

A view that has no Conditions (see Figure 222 on page 273) or Order By
information (see Figure 224 on page 274) extracts e-mails from the queue.

A submitter submits them to the E-mail distribution for processing st
strategy.

This routing strategy contains only an Entry object, a Route Interaction object,
and Exit object. Figure 346 on page 400 shows the E-mail distribution for
processing st strategy.
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400

Step 3.1. Processing By Agents

Figure 346: E-mail Distribution For Processing

Strategy

The Route Interaction object routes to an Agent Group target type. The name of
the Agent Group is E-mail distribution for processing (see Figure 347).
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Figure 347: Route Interaction Properties Dialog Box

StatAgentsAvai lable is specified under Statisti

cs, Max. URS uses this

statistic to select a routing target if more than one target is available. For more
information about this statistic, see the Universal Routing 8.1 Reference

Manual.

The Route Interaction object also has an Interaction Queue tab (see Figure

348).
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Figure 348: Route Interaction Properties Dialog Box, Interaction Queue Tab

The Interaction Queue tab gives the option of specifying two types of queues.

1. Queue for existing interaction. If the agent can’t handle the e-mail and
determines it should be forwarded to another agent, the Description field
provides a desktop hint for the agent on the Forward e-mails queue. (The
existing interaction is being forwarded, but will eventually come back to
the forwarding agent.) This selection generates the Forward e-mails
strategy-linked queue node (see page 34) in Figure 345 on page 399.

Just as in Figure 330 on page 376, the Genesys predefined queue Stop
Processing (_STOP_) indicates to Interaction Server that processing of the
existing interaction has stopped for now (because the e-mail is being
forwarded). This entry generates the Stop strategy-linked node in

Figure 345 on page 399.

2. Queue for new interaction. Ifthe agent creates a new interaction in the
form of an e-mail response to the customer, the Description field is used
by the desktop to provide a description for the agent on the purpose of the
E-mails for QA review queue. This entry generates E-mails for QA
review strategy-linked node in Figure 345 on page 399.

Step 3.2. QA Review

The purpose of this business process is to continue the processing from Step
3.1 Processing by Agents. It processes interactions in the E-mails for QA
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Step 3.2. QA Review

review queue by determining whether QA review is necessary and then taking

the appropriate action.

Figure 349 on page 402 shows the Step 3.2.

QA Review business process.
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Figure 349: Step 3.2. QA Review

Processing Objects

This section describes the various objects in Figure 349.

The E-mails for QA review queue in Figure 349 is the same queue that is
shown in Figure 345 on page 399 (see Note on page 392). In Default BP, this
queue connects the Step 3.1. Processing by Agents business process with the

Step 3.2. QA Review business process.

A view (E-mails for QA review) that has no Conditions (see Figure 222 on
page 273) or Order By information (see Figure 224 on page 274) extracts

e-mails from the queue.

A submitter submits interactions to the Outbound e-mail 65x QA st strategy.

This strategy determines whether an agent’s e-mail response has undergone
QA review. If the existence of a flag in the interaction indicates that QA has

already reviewed, the response goes to the qu

eue Quality control. If QA has

not reviewed, the strategy determines whether QA review is necessary based

on the skill level of the handling agent.

If the responding agent has the default skill level or higher, QA review is

not necessary so the e-mail goes to a queue for sending to the customer

(Outbound e-mails).

402
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» If the responding agent does not have the default skill level or higher, the
e-mail response is routed to QA for checking (E-mail QA review group). If
QA review does not uncover any errors, the e-mail goes to the queue
Outbound e-mai Ls. If the review uncovers errors, the e-mail goes to the
queue E-mails failed QA.

Note: For details on strategy error handling, as well as the IRD objects used
in the Outbound e-mail 65x QA strategy, see Universal Routing 8.1
Strategy Samples.

Step 3.3. Forwarding

The purpose of this business process is to continue the processing started in
Step 2.3 New Inbound E-mails. It forwards interactions in the Forward
e-mails queue with the expectation of getting a response back. Figure 350
shows Step 3.3. Forwarding business process.
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Figure 350: Step 3.3. Forwarding

Processing Objects

The Forward e-mails queue in Figure 350 is the same queue that is shown in
Figure 345 on page 399 (see Note on page 392). In Default BP, this queue
connects the Step 3.1. Processing by Agents business process with the Step
3.3. Forwarding business process.

A view (Forward e-mai Ls) that has no Conditions (see Figure 222 on

page 273) or Order By information (see Figure 224 on page 274) extracts
e-mails from the queue. A submitter submits interactions to the Forward e-mai l
processing st strategy.
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The Preliminary e-mail screening st strategy in Figure 344 on page 397
previously determined that the e-mail matched the Warranty support
Screening Rule (see page 398) and needs to be forwarded.

The Forward e-mail processing st strategy that is shown in Figure 350 on
page 404 uses the Forward object to request E-mail Server (see page 51) to
create an e-mail using the external address that is associated with the E-mai L
Accounts Business Attribute (see Figure 148 on page 164) that is called
Warranty support. After the e-mail has been generated, it goes into the
Outbound e-mails queue. A Stop object notifies Interaction Server that
processing for this interaction is finished.

Error Handling

The following objects in Figure 350 on page 404 are the result of error
handling:

Forward e-mail failure queue
Termination failure queue
E-mail service failure analysis st strategy

Terminate interaction st strategy

Note: For details on strategy error handling, see Universal Routing 8.1
Strategy Samples.

Step 3.4. Redirecting

The purpose of this business process is to continue the processing started in
Step 2.3 New Inbound E-mails. It forwards interactions in the Redirect
e-mails queue to an outbound queue for sending to other agents/experts
without the expectation of getting a response back. Figure 351 shows the Step
3.4. Redirecting business process.
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Figure 351: Step 3.4. Redirecting Business Process

Processing Objects

406

Step 3.4. Redirecting

The Redirect e-mail queue in Figure 351 is the same queue shown in
Figure 344 on page 397 (see Note on page 392). In Default BP, this queue
connects the Step 2.3. New Inbound E-mails business process with the Step
3.4. Redirecting business process.

A view (Redirect e-mai L) that has no Conditions (see Figure 222 on page 273)
or Order By information (see Figure 224 on page 274) extracts e-mails from
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the queue. A submitter submits interactions to the Redirect e-mail processing
st strategy.

The Preliminary e-mail screening st strategy in Figure 344 on page 397
previously determined that the e-mail matched the Tech support Screening
Rule (see page 398) and must be redirected.

The Redirect e-mail processing st strategy that is shown in Figure 351 uses
the Redirect object to request E-mail Server (see page 51) to create an e-mail
using the external address that is associated with the E-mai L Accounts Business
Attribute (see Figure 148 on page 164) that is called Tech support.

After the e-mail has been generated, it goes into the Outbound e-mails queue.
A Stop object notifies Interaction Server that processing for this interaction is
finished.

Error Handling

The following objects in Figure 350 on page 404 are the result of error
handling: Redirect e-mail failure queue, Termination failure queue,
E-mail service failure analysis strategy, Terminate interaction strategy

Note: For details on strategy error handling, see Universal Routing 8.1
Strategy Samples.

Step 4. Outbound Sending

The purpose of this business process is to perform quality control checking
and, for interactions that pass, place interactions in an outbound queue for
sending. It also performs failure analysis for interactions that cannot be sent. In
Default BP, the Outbound e-mails queue can be found in the following
business processes:

Step 3.2. QA Review

Step 3.3. Forwarding

Step 3.4. Redirecting

Figure 352 shows the Step 4. Outbound Sending business process.
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Figure 352: Step 4. Outbound Sending

Processing Objects

The Quality control queue in Figure 352 is the same one that is shown in
Figure 349 on page 402 (see Note on page 392). This queue connects the Step
3.2. QA Review business process with the Step 4. Outbound sending business
process.

A view (Quality control) that has no Conditions (see Figure 222 on

page 273) or Order By information (see Figure 224 on page 274) extracts
interactions from the queue. A submitter submits interactions to the Quality
control st strategy.

The Quality control strategy uses the Screen object to determine whether an
agent’s response needs failure analysis because the Outbound e-mail 65x QA st
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strategy (see Figure 349 on page 402) placed the interaction in a queue for
quality control checking.

Screening results are written to a variable, which is subsequently used in an If
expression.

* Ifthe expression is true (Screening Rule match found), the interaction goes
to the queue E-mail failure analysis queue.

» Ifthe expression is false, the interaction does not need failure analysis and
goes to the Outbound e-mails queue.

A view (Outbound e-mai Ls) attached to this queue submits the interaction to the
Outbound e-mail sending strategy

The purpose of this strategy is to send interactions that have undergone quality
control to E-mail Server for sending to the customer. If the e-mail cannot be
sent, the strategy performs error processing.

Error Handling

The following objects in Figure 352 on page 408 are the result of error
handling:

E-mail failure analysis queue
Termination failure queue

E-mails send error queue

E-mail service failure analysis strategy

Terminate interaction strategy

Note: For details on strategy error handling, see Universal Routing 8.1
Strategy Samples.

In order to understand fully how Default BP and the step-numbered business
processes implement the preceding functional areas, you must also study the
routing strategies. Universal Routing 8.1 Strategy Samples shows the IRD
objects that are used by many of the strategies in the step-numbered business
processes. It also explains the processing flow.

How To: Business Processes

In addition to the step-numbered business processes that were just described,
the Genesys-supplied samples also supply various “How to” business
processes (see Figure 327 on page 373).

Table 31 lists and describes the “How to” business processes.
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Table 31: How To: Business Process Functionality

How To: Business Processes

Functional area

Strategies and
subroutines used

Output
queues/workbins

Apply escalation procedure (move
interactions overdue for processing from an
agent workbin to a supervisor workbin)

Move overdue interactions

Workbins: Supervisors
workbin, Workbin for
Original Agent

Attach classification Categories and use
Attach Categories object

Classify customer inquiry
strategy att-cc

Subroutines: E-mail service
failure analysis, Terminate
Interaction

Queues: New inbound
interactions, E-mails for QA
Review, Preprocessing
failure

Workbin: E-mail
distribution

Attach classification Categories and use
Multi-Screen object

Classify customer inquiry

Subroutines: E-mail service
failure analysis, Terminate
Interaction

Queues: New inbound
interactions, E-mails for QA
Review, Preprocessing
failure

Workbin: E-mail
distribution

Conduct a survey by using email

Survey for email inbound
strategy

Survey for email outbound
strategy

Survey for email outbound
with a survey link

Submission of surveys from
the web

Queues: Existing
Interactions, New
Interactions, Create New
Interaction

Get credit card numbers

Screen e-mail for credit card
numbers

Inbound e-mail queue,
Non-credit card payment,
Paid with credit card

Handle fax interactions

Preliminary fax screening

Processing by agents,
Forward interaction,
Redirect interaction, Queue
for responses

Identify whether a contact is new or
existing and create an interaction record for
a new contact

Identify contact and create
interaction

Interactions with new
contacts

Interactions with existing
contacts
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Table 31: How To: Business Process Functionality (Continued)

Functional area Strategies and Output
subroutines used queues/workbins
Place an interaction into a workbin Place the interaction into the | E-mails route to original
workbin agent, E-mails for QA
review

Workbin: Workbin for
original agent

Screen multiple rules Preliminary e-mail E-mails for processing by
screening ms agents, Forward e-mails,
Inbound e-mail
postprocessing, Redirect
e-mails, Preprocessing
failure, Outbound e-mails,
Termination failure

Subroutines: E-mail service
failure analysis, Terminate
interaction

The next sections describe each “How to” business process.

How To: Apply Escalation Procedure

This business process, listed in Figure 327 on page 373, demonstrates how to
move interactions that are overdue for processing from an agent workbin to a
supervisor workbin. Figure 353 shows the How to: Apply Escalation
Procedure business process.

& I -5 days overdue R ] R — - dih I
ﬁ

Warkhin For Criginal Agent Move Superyisars
overdue workhin
interactions

Figure 353: Apply Escalation Procedure Business Process

If you need a review of workbins, see “Workbin Object” on page 33.

Processing Objects

This section describes the various objects in Figure 353.

A view (3 days overdue) that has a Condition that specifies interactions with a
time in queue greater than 4,320 seconds (see Figure 223 on page 273) extracts
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interactions from the workbin (Workbin for Original Agent) and submits them
to the Move overdue interactions strategy (see Figure 354).

Warning: Before using this strategy, change the default swatch and VEP values

i the "Service Check Up" schedule m IRD.

For both the "Attach” and "Eeleaze" actions, use a switch and VET that esxist in vour environtnet
(The default value of "asl Meove owerdue mteractions@emal Switch" 15 not environment specific

Figure 354: Move Overdue Interactions Strategy

Figure 355 shows the General and Target Selection tabs in the properties
dialog box for the Supervisors Workbin object (the Interaction Queue tab is
not used).

Workbin properties ﬂl

= = Workbin properties
i Worlkhi rties
General I Interaction Queue I |

General I Interaction Queus  Target Selection |

General Interaction Queue |Target

q for Bxisting Interac — Statistics
0 —= —CQueue for ing Interaction ——
wher type Agent Gro ) r Min
s P r Name I
; Max
Warlhin name IH':""'" to: ar Quenes =
— Targets
™ Use logged in agents o 2% X ¥ Clear Target TiITIEDLI‘tI_
Type Hame Stat
1 |Agent Group Supervisors

—Queue for New Interaction
i P

Queues

Figure 355: Workbin Properties Dialog Box

The Target Selection tab (see Figure 355) indicates that the interaction is
being sent to a workbin that is associated with an Agent Group that is named
Supervisors. You can see this workbin represented as the Supervisors workbin
strategy-linked node in the business process that is shown in Figure 353 on
page 411.
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How To: Attach Classification Categories and Use Attach Categories Object

How To: Attach Classification Categories

and Use Attach Categories Object

This business process, listed in Figure 327 on page 373, demonstrates how to
manually attach classification Categories to new inbound interactions for the
purpose of segmenting those interactions in order to take different paths in the
strategy. If you need to review information about classification Categories, see
“Categories Tab” on page 178.

Figure 356 shows the How to: Attach Classification Categories and use

attach categories object business process.

)

E
Elrnail
l':J,I\-s':ﬂ.l:''-":il:ll'l —J‘é
E-rnails
For
S

_&J review

o+

0 E-rnail
distribution

@ | _Mew inbound interactions

Mew inbound
interactions

- o ol l@ I
Cla“ﬁ Praproceszing
customngr ", Failure
il'lquir!lﬁ:_- -

att-ct

""-t

A |

E-rnail

zehvice
Failure
analysis

*

A |

Tetminate

Figure 356: Attach Classification Categories and Use Attach Categories Business Process
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Processing Objects

This section describes the various objects in Figure 356.

A view (New inbound interactions) that is attached to a queue (New inbound
interactions) that has no Conditions or Order By information, extracts
interactions from the queue and sends them to the Classify customer inquiry
att-ct strategy (see Figure 357).

|T_T11.1dent1ﬂedtrar|saztmn?5|
- % I:l E nmld:stn]:utmn ﬂ:nr pmcessmd

iOl‘]"'Z'Z""ZZE]i

..“,.

.- - Sgreen| - - - |f-Obj
© Obieet by TQbisst

Categorles #2

Route nierac

iz 1ai

‘h‘ h—a M&NUAL recoveny emor u:-ccurred i n:-l.rte t-:- u:-nglnal agent ﬁ't BP.Preprocessing E
a SYSTEM emor u:-ccurred DEL&F[ISDDD] : —| ce an

r-:-ccurre-:l :

o

H-*

e

| Tenm.nate Intera.ctm
0 iz case is |m|:u:-55|b|e since services exrt thr-:-ugh red |:u:-rt u:-nh,r |f an emar occL o -

ice 13il

0—3 FATﬁ-L armar -:-ccurred

[k BP.Preprocessing f -

a SYSTEM emor olzcurred : DEl&YUSDUU]

il =
ru:n:curred- - s s

Sug il gl ¥

eI B

Figure 357: Classify Customer Inquiry ATT-CT Strategy
Screen Object

This strategy starts with a Screen object (#1) that screens for certain words or
word patterns using a single Screening Rule (see “Screening Tab” on page 185
if you need a review) and returns the Category (or Categories) associated with
the Screening Rule.

In the case of the Classify customer inquiry att-ct strategy that is shown in
Figure 357, the object of the strategy is to:

* Screen for interactions that contain wrong transaction amounts and forward
them to agent workbins for processing at a later time.
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* Send unidentified interactions to agents for immediate processing.

You can see the Screening Rule and the instruction to return classification
Categories when you open the properties dialog box for the top-left Screen
object in the strategy that is shown in Figure 357. Figure 358 shows the
properties dialog box.

Screen properties ill
Screen properties El

General  Result I

General | Heguul

Clazszification I_

: £ Do not use output value
Language: I Englizh

" Attach output walue

Screening rule: IWang tranzaction amaont
% ezion output walue bo vanabls |matchBesult j

£ Azsign values of the key-value pairz

— Output values

0k, I Cancel

— ] I Cancel Help

Figure 358: Screen Properties Dialog Box

The Screening Rule used in Screen object #1 is Wrong transaction amount.
Note also that the Result tab in Figure 358 instructs to assign the screening
result output value to a variable named matchResult.

* Ifa Screening Rule match in Screen object #1 occurs, the interaction goes
out the side port to an If object (#1 in Figure 357 on page 414).

* If a match does not occur, the interaction goes out the bottom port to a Call
Subroutine object that performs failure analysis (see Figure 357 on
page 414).
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If Object

Note the If object #1 in Figure 357 on page 414. Figure 359 shows the If object
Properties dialog box.

If expression properties =

General |
— Expression
G etStringk e[S creenFulet atch' matchB esult] = true ;I
[
—Data
Type Hame Operatar Walue
Interaction Data | |GetMinStatData :I _ Imatu:hFl et
Buziness Attnbutes GetMinSubList I=
All Funchions (3 etPricrity * - -
Calllrfa (3 etF outingPoint — = Simple_gsrmor_code
Configuration Ophions GetServicelbjective <
Drata b anipulation et5ServiceT ype 4=
Date/Time
List M anipulati
Lt Manipuation |
Parameter ¥alue Add |
Kew ;
Skring "Werify |
suo | oR |
Wanables |

Feturn value twpe: STRIMG. Parzes out the value for a zpecified key from a keyp-value :I
lizt, If the key searched for does not appear in the lizt, the function returns the empty

ztring. IF the key iz repeated in the list, itz first occurrence is retrieved. LI

| k. I Cancel | Help

Figure 359: If Object Properties Dialog Box

The true/false value of the expression in Figure 359 determines whether the
strategy sends the interaction to Attach Categories object #1 or whether the
interaction is sent for further screening.

If the expression in Figure 359 is true (if the variable matchResult contains
ScreenRuleMatch), the interaction goes out the side port to Attach
Categories object #1 (see Figure 357 on page 414). Continue with “Attach
Categories Object” on page 417.

If the expression in shown Figure 359 is false, the interaction goes out the
bottom port to Screen object #2 that screens using a different Screening
Rule, Unidentified transaction. The result is also written to the
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matchResult variable. The interaction goes out the side port to If object #2,
whose properties dialog box appears the same as in Figure 359. Again, if
the expression in If object #2 is true, the interaction goes out the side port
to the Attach Categories object #2 (see Figure 357 on page 414).

Attach Categories Object

Figure 360 shows the Properties dialog boxes for Attach Categories object #1
and #2 in the Classify customer inquiry att-ct strategy that is shown in

Figure 357 on page 414.

Attach categories properties 5[

Bemesa | Attach categories properties 5[
General |
= Roat Marme: IFinar‘u:iaI service
i Raoot Mame: |Financial service -
Category ’ ' J
1 Errors in tranzactions Category ,
1 Unidertified tranzaction 75
2 Errors in tranzactions 25
Attach Categories #1 Attach Categories #2
(] I Cancel
k. I Cancel Help

Figure 360: Attach Categories Properties Dialog Box

Attach Categories object #1 is used when initial screening indicates that the
transaction contains an error (Wrong transaction amount Screening Rule
match). The Screening Rule identifier is attached to the interaction, which then
goes out the side port to a Workbin object for handling by a member of an
Agent Group (E-mail distribution in Figure 356 on page 413). Figure 361

shows the Workbin Properties dialog box.
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Workbin properties

General I |nteraction E!ueuel Target Selectiunl

hwner type

[T Use logged in agents only

Wwiarkbin name | How to: attach classification cate

x|

Figure 361: Workbin Properties Dialog Box

Attach Categories Properties object #2 in Figure 360 on page 417 is used when
evaluation of the expression in If object #2 indicates that the interaction is an
unidentified one or contains an error. In this case, the interaction goes out the
side port to a Route Interaction object (see Figure 357 on page 414).

Figure 362 shows both tabs in the object properties dialog box for the Route

Interaction object.

Interaction Quewe Target Selection |

Route Interaction properkies Ell
Route Interaction properties El

— Statistics Interaction Cueue | Target Selection |
" Min _ i .
Marme IStaLﬂ.gentaﬂ.vallable — Elueue for E xisting [nteraction
& bdax K
r [atiets ; Queues Description
i v Clear Target Tlmeu:uutl Stop Processingl
Type Mame

—

Agent Group (E-mail diskribution Far

1]

7 K

— Queue for New [nteraction

I Queues

Descriptio

Defaulk BPE-mails For O review

—irtual Queue

[T UseVitual Queue

Figure 362: Route Interaction Properties Dialog Box

418

In the business process that is shown in Figure 356 on page 413, you can see
the following objects: E-mail distribution for processing, Stop, and E-mails

for QA review.

The following objects in Figure 356 on page 413 are the result of error

handling:
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E-mail service failure analysis subroutine

Terminate interaction subroutine

How To: Attach Classification Categories
and Use Multi-Screen Object

This business process, listed in Figure 327 on page 373, demonstrates how to
attach classification Categories to new inbound interactions for the purpose of
segmenting those interactions to take different paths in the strategy. If you need
additional information about classification Categories, “Categories Tab” on
page 178. Figure 363 shows the How to: Attach classification categories
and use multi-screen object business process.

Preprocessing
# Failure

:','_J
7 E-mnail
distribution % I

E-riails

% Mev inbound interactions i .- ............................... o)
J' --_ D{E 3 *a rewiaw
Mews inbiound Classii%,_r l:IisEr-irI:unlilill:-n _

interactions CUSEOMESy Jn.
inguiry 1 @]
Stap
kY
Tarminate
Inkeraction
R}
E-rnail
service
Failure
analysis

Figure 363: Attach Classification Categories and Use Multi-Screen Object Business Process
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Processing Objects

This section describes the various objects in Figure 363 on page 419.

A view (New inbound interactions) that is attached to a queue (New inbound
interactions) that has no Conditions or Order By information, extracts
interactions from the queue and sends them to the Classify customer inquiry
strategy (see Figure 364).

simple error code=2

simple error code=4 | occumed == route to original agent E]

simple error code=1 |

code=3

Delay[15000]

Figure 364: Classify Customer Inquiry Strategy

Multi-Screen Object

This strategy starts with Multi-Screen object that screens for certain words or
word patterns using multiple Screening Rules and returns the Categories
associated with the Screening Rule.

Note: Compare the strategy in Figure 364, which uses the Multi-Screen
object, with the Classify customer inquiry att-ct strategy that is
shown in Figure 357 on page 414, which uses the Screen object.
Complexity and the amount of byte code is reduced with the
Multi-Screen object because Multi-Screen handles multiple rules and
does not require a conditional test after each screening.

You can see the Screening Rules used and instruction to return classification
Categories when you open the Multi-Screen object properties dialog box (see
Figure 365).
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MultiScreen properties ill
MultiScreen properties x
General | R esult | —I

General Result I

Clazzification _

" Do not use output value
Languange: IE”E"'Sh

* fttach output value }

R oot IFinanciaI TEIVICE
" Assign output value to varable

— et zoreened data from
Uzer data key if specified: " Pssign values of the key-value pairs

I — Output values
Otherwize fram the variable if zpecified:
Otherwize fram UCS databaze

— Allnules
FF K

Screening rules
Wrang bransaction amount
2 |Unidentified transaction

—

— Return
™ Flules anly ¥ Categories only

" Matched pairs only Al 0K I Cancel Help

Figure 365: Multi-Screen Properties Dialog Box

The Screening Rules are Wrong transaction amount and Unidentified
transaction. Under Return, note that Categories only is selected. Categories
can be returned because Screening Rules can be associated with Categories in
Knowledge Manager.

Note also that the Result tab in Figure 365 instructs to attach the Categories to
the interaction.

Screen Segmentation Object

Note the Screen Segmentation object in Figure 364 on page 420. Interactions
with Categories attached by the Multi-Screen object go to a Screen
Segmentation object, which causes interactions to take different path in the
strategy based on a Screening Rule match. Figure 366 shows its properties
dialog box.
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Screen segmentation properties il

General |

[T Screen by variable

i Language: IEninsh j
Segment Expression

1 Unidentified tran=action

i Wrong transaction amount

KN i
ok | Cancel | Hep |

Figure 366: Screen Segmentation Properties Dialog Box

Each segment in the Screen Segmentation properties dialog box generates its
own output port in the strategy in Figure 364 on page 420.

* Interactions screened as Unidentified transaction (needing an agent
response instead of a Standard Response) go a Workbin object. This is
represented as the E-mail distribution Workbin strategy-linked node in
Figure 363 on page 419.

Figure 367 on page 423 shows the various tabs in the Workbin properties
dialog box.
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Workbin properties ﬂl
General | Interaction Quews I Workbin properties x|

General Interaction Queue | Target Selection |

Workbin properties

— Queue far Existing Interaction

i General | Interaction Queue Tamget Selection
Werkbin name IHDW to: & Queues Des — Statistics
Skop Processin
™ Use logged in agents ¢ F A . Min: Name I
" Max
— Targets
= ¥ Clear Target Timeout

Type Name 4

— Queue for Mew [nteraction _—
1 [Agent Group E-mail distributi

ZF K

Queues
Defaulk BP.E-mails For Qa4 review(E-ma

Figure 367: Workbin Properties Dialog Box

In the Target Selection tab, an Agent Group workbin named E-mai |
Distribution is selected. This is where the customer’s e-mail will reside
while a response is constructed.

In the Interaction Queue tab, under Queue for New Interaction, the
selection is E-mails for QA review found in the Default BP business
process. This is where the agent will place the new interaction (e-mail
response to customer) so it can be checked by QA prior to sending. This is
represented by the E-mai ls failed QA strategy-linked queue node in
Figure 363 on page 419.

The Genesys predefined Stop Processing(_STOP_) queue is represented by
the Stop strategy-linked node in Figure 363 on page 419. It indicates a
notification to Interaction Server that processing of the existing interaction
has stopped.

* Interactions screened as containing Wrong transaction amount goto a
Route Interaction object.

Figure 368 shows its properties dialog box.

Business Process—User’s Guide 423



Appendix : Business Process Samples

How To: Attach Classification Categories and Use Multi-Screen Object

x|
reracton Guewe | e Solcion| x
—QGueue for Existing Interaction Interaction Queue  Target Selection |
i P 8 — Statistics
Queues Description | M _
Stat Agents Availabl -
Stop Processingl_ = Max I AgentsAvailable J
— Targets
7 3 ¥ Clear Target 'I"lmeoutl vI Sec
Type MName StatServer
1 |Agent Group E-mail distributi
—Queue for New Interaction
i 4
Quenes
Step 3.2, QA review, E-mails failed QA(E-mails
— Virtual Queue
1| | ™ Use Vitual Queue
filias | |
Siiteh | ]
M urnber I j
QK I Cancel
ok | cancsl | o hep |

Figure 368: Route Interaction Properties Dialog Box
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In the Target Selection tab, an Agent Group named E-mail Distribution
is selected. This target is also represented as the E-mail distribution
strategy-linked node in Figure 363 on page 419.

In the Interaction Queue tab, under Queuve for New Interaction, the
selection is E-mai ls failed QA. This is the same queue used by the
Workbin object (see Figure 367 on page 423). This is where the agent will
place a new interaction (e-mail response to customer) so it can be checked
by QA prior to sending. This is also represented by the E-mails failed QA
strategy-linked queue node in Figure 363 on page 419.

The Genesys predefined Stop Processing(_STOP_) queue is represented by
the Stop strategy-linked node in Figure 363 on page 419. It indicates a
notification to Interaction Server that processing of the existing interaction
has stopped.

Universal Routing 8.1 @



Appendix : Business Process Samples How To: Conduct a Survey by Using Email

Error Handling

The following objects in Figure 363 on page 419 are the result of error
handling:

E-mail service failure analysis subroutine

Terminate interaction subroutine

How To: Conduct a Survey by Using Email

This business process demonstrates how a call center offers satisfaction
surveys to their customers through outbound email or after a chat session. The
survey can be sent to customers in a separate window after the chat has ended
or sent by the agent as a link.

The survey results are stored as:

* A transcript under the parent chat interaction.

* Attached data to the parent chat interaction (enables reports to be run).
* A parent interaction to the original email

The email or chat survey implementation consists of the ASP/JSP pages on a
web site and a business process to handle flow control of the survey.

The script on a Java Server Page (JSP) or Active Server Page (ASP) collects
the submitted data and all parameters from the original link, creates the
interaction, and sends it to the Interaction Server. Interaction Server then sends
this interaction to the business process and an interaction is created within
UCS by the business process strategy. Finally, the UCS stores the data in its
database and can viewed in the contact’s historical data by using Genesys
Application Desktop. Figure 369 on page 426 demonstrates the business
process flow.

For more information about Interaction Server, see the eServices
(Multimedia) 8.0 Deployment Guide.
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Figure 369: Email Survey Business Process Strategies

Applicable Strategies

The business process that is used to process the original email and send the
auto-response to the customer consists of three strategies, with a fourth
strategy to handle the submission of surveys after the customer fills out the
form (to Interaction Server from the web). The strategies are described in the
following sections, where the s4e prefix (meaning survey for email) is used in
all of the views, strategies and subroutines.

sd4e_inbound_strategy
This strategy handles incoming email and distributes them among any

available agents. It stops the original interaction (incoming email) and sends
the agent's reply to the outbound queue. See Figure 370 on page 427.
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Figure 370: Route Interaction Properties

sd4e_outbound_strategy

This strategy handles outgoing email, generates the standard response that
contains the hard-coded link to the survey application, and passes the required
parameters by using this link. See Figure 371 on page 428.
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How To: Conduct a Survey by Using Email
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Figure 371: Create Email Out Properties

sd4e_survey_email_strategy

This strategy sends the outbound email with a survey link. See Figure 372.

Figure 372: Strategy to Send Outbound Email

sd4e_survey_strategy

This strategy handles the submission of surveys after customer has completed
the form. The form is submitted to Interaction Server from the web. It is used
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to create the interaction in UCS and associate this interaction with the
customer and parent interaction if one exists. See Figure 373.
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Figure 373: Create Interaction Properties

Deploying the Email Survey Business Process

The following steps are required to deploy the Email survey business process:

1. Send the business process that is used to process the incoming email to the

IRD.

2. Inthe Knowledge Manager application, configure a standard response.

3. In Configuration Server, add a new survey media type to the tenant.

4. InTenant > Business Attributes > E-mail Accounts > Attribute Values,
add a new Survey invitation element. Populate this element as follows:

a. On the Annex tab, create the general section

b. Add the address option with the survey_invitation value.

For more information about Knowledge Manager, see the eServices
(Multimedia) 8.0 Deployment Guide.
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Customizing the Business Process Configuration
Options
Depending on your configuration, you might want to manually change some of

the configuration options inside the strategy according to your business needs.
After the business process is deployed, the options in Table 32 can be changed.

Table 32: Email Survey BP Configuration Options That Can be Changed

Element name Property name Default value
sd4e_inbound_strategy
Route interaction Queue for new Survey For Email
interaction BP.s4e_outbound_emai L (s4e_outbound_email)
Agent Group E-mail distribution for processing
sd4e_inbound_strategy
Create email output Output queue Survey For Email

BP.s4e_survey_email (s4e_survey_email)

From Survey invitation

sde_survey_strategy

Create interaction

User Data Key survey_answer_Text

How To: Get Credit Card Number From the

430

This business process, which is listed in Figure 327 on page 373, demonstrates
how to screen an interaction for credit card information.

* If the customer paid by credit card, the interaction is written to a queue for
those types of interactions.

* Ifthe customer did not pay by credit card, the interaction is written to a
different queue.

Figure 374 shows the How to: Get Credit Card Number From the E-mail
business process.
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Figure 374: Get Credit Card Number From the E-mail Business Process

If you need a review of screening, see “Screening Tab” on page 185.

Processing Objects

This section describes the various objects in Figure 374.

A view (Submit for credit card number for screening) that has no
Conditions or Order By information (see Table 24 on page 273) extracts
interactions from Inbound e-mail queue and sends them to the Screen e-mail
for credit card numbers strategy (see Figure 375).

Please locl at the screemng rule "Credit card number” in Enowledge Manager.
Thiz rule defines matching key natne "Card number”. The actual key in

h P | T 1 1l

S ; . TF )
.. ittl Credit card number Mi How to: getcreditcardnmnberl— :

Figure 375: Screen E-mail for Credit Card Numbers Strategy

This strategy starts with the Multi-Screen object that screens for certain words
or word patterns using multiple Screening Rules. It then returns the Categories
(see page 178) associated with Screening Rules that matched.
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Figure 376 shows the General and Result tab in the properties dialog box for
the Multi-Screen object.

MultiScreen properties ﬂ |
General | Eezult | MultiScreen properties ﬂ

General Result I

Clazzification _

Languange: IE”QHSh

" Do not uze output walue

" Attach output value

— Get screened data from ™ Assign output value to variable

Dthensize from UCS databaze

— 1 Allmles
i o

Ilzer data key if specified: : .
1R " Assign values of the key-value pairs

. . . - — Output values
Othenaize from the vanable if zpecified:

Screening rules
Credit card number

—

Figure 376: Multi-Screen Properties Dialog Box

The name of the Screening Rule is Credit card number. (If the Screening Rule
does not display, see “Properties Dialog Boxes for Strategy Objects” on

page 373.) Under Return, note that Matched pairs only is selected. This
returns pairs consisting of a screening rule identifier and the specific string of
words in the interaction that matches the screening rule. The Result tab in
Figure 376 instructs to attach the Categories to the interaction.

Screen Segmentation Object

The next object in the strategy that is shown in Figure 375 on page 431 is a
Screen Segmentation object. Interactions with Categories attached by the
Multi-Screen object go to a Screen Segmentation object. It causes interactions
to take different path in the strategy based on whether a Screening Rule match
occurred. Figure 377 shows its properties dialog box.
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Screen segmentation properties il

General |

[T Screen by variable

i Language: IEninsh j
Segment Expression
1 Credit card number

KN i
ok | Cancel | Hep |

Figure 377: Screen Segmentation Properties Dialog Box

As shown in Figure 374 on page 431:

* Interactions matching the Credit card number Screening Rule go out the
side port to a Queue Interaction object that specifies an interaction queue
that is called Paid with credit card.

* Interactions that do not match the Credit card number Screening Rule go
to another Queue Interaction object that specifies an interaction queue that
is called Non-credit card payment.

Figure 378 shows the properties dialog box for each Queue Interaction object
after clicking the down arrows to show all queues including the selected
queues.
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Queue Interaction properties 5[
General | Queue Interaction properties il
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Figure 378: Queue Interaction Properties Dialog Boxes

The names of both interaction queues are reflected in the business process that
is shown in Figure 374 on page 431.

How To: Handle Fax Interactions

This business process, listed in Figure 327 on page 373, demonstrates how
screening can work with various medias, such as fax.

* Interactions that match a Screening Rule trigger an automatic response
and/or redirecting or forwarding to other agents.

* Ifan interaction fails the screening, this means the interaction cannot be
processed automatically and requires an agent’s attention. An
acknowledgement e-mail is generated and the interaction goes to a queue
for further processing.

Figure 379 on page 435 shows the How to: Handle Fax Interactions business
process.
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Figure 379: Handle Fax Interactions Business Process

Processing Objects

This section describes the various objects in Figure 379.

A view (Select all interactions) that has no Conditions or Order By
information (see Table 24 on page 273) extracts interactions from the Inbound
fax Interactions queue and sends them to the strategy, Preliminary fax
screening (see Figure 380).
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Figure 380: Preliminary Fax Screening Strategy

Multi-Screen Object
After the Entry object, a Multi-Screen object screens for certain words or word

patterns using multiple Screening Rules. The properties dialog box for the
Multi-Screen object is shown in Figure 381.
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MultiScreen properties ﬂl
General | Fesult | MultiScreen properties ﬂ

General Fesult I

Cossfication |

' Do not use output value

Language: IEI'lEI|i5|'I
% ilttach output value
—Get screened data from " Assign output value to variable
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I il it " Assign values of the key-value pairs
kel
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Ctherwise from UCS database

—1I Al ules
¥ K
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¥ Rules only "~ Categories only
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Figure 381: Multi-Screen Properties Dialog Box

The Screening Rules are Auto Response Available, Warranty problem, and
Tech support.

Under Return, Rules only is selected, which returns only the Screening Rule
identifier when a match is found.

The Result tab instructs to attach the Screening Rule identifier to the
interaction.

Screen Segmentation Object

After the Multi-Screen object, the next object in the strategy that is shown in
Figure 380 on page 436 is a Screen Segmentation object. Interactions take
different paths in the strategy based on the Screening Rule that was matched.
Figure 382 shows its properties dialog box.
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General I

Screen segmentation properties

X

[ Screen by vaniable

i Language: |English j
Segment Expression

1 Auto Reszponse Available

2 Warranty problem

3 Tech zupport

Figure 382: Screen Segmentation Properties Dialog Box

Each segment in the Screen Segmentation properties dialog box generates its
own output port in the strategy (see Figure 380 on page 436).

Autoresponse Object

Interactions matching the Screen Rule Auto Response Available go an
Autoresponse object that uses Customer Support phone text from a Standard
Response Library to create an automatic response (see Figure 383).

Send automated response properties
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Generall Format  Result |
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— Output valuss

Figure 383: Send Automated Response Properties
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Under Operation Mode in Figure 383 on page 438, Open Media is selected.

After the Autoresponse object in the strategy in Figure 380 on page 436, a Stop
Interaction object notifies Interaction Server that processing for this particular
interaction has stopped and supplies a reason code.

Warranty Problem Interactions in Figure 380 on page 436 with a screening result of Warranty
Segment  problem go to an Queue Interaction object that specifies an interaction queue
that is called Forward interaction (see Figure 384).

Queue Interaction properties 5'

General |

Interaction queue

- Default BP =
-~ How to: attach classification categories and use atl

-~ How to: attach classification categories and use mu

-~ How to: get credit card number From the e-mail

- How ko handle Fax inkeractions

o Forvard inkerackion

Figure 384: Queue Interaction Properties Dialog Box

Tech Support Interactions in Figure 380 on page 436 with a screening result of Tech support
Segment g0 to an Queue Interaction object that specifies an interaction queue that is
called Redirect Interaction (see Figure 385).

Queue Interaction properkties ﬂ

General |

|nteraction queue

- Defaulk BP =
- How to: attach classification cateqgories and use atl

- How to: attach classification categories and use mu

- Hows to: get credit card number From the e-mail

- How ko handle Fax inkeractions

i Forward inkeraction
Inbound Fax interactions
Processing by agents
Queue For responses
D - direct inkeraction

Figure 385: Queue Interaction Properties Dialog Boxes

All of the above interactions are faxes, which can be processed automatically.

Processing by  Interactions not matching any of the previous Screening Rules cannot be
Agents  processed automatically. These interactions go out the bottom port of the
Multi-Screen object to an Acknowledgement object (see Figure 386).
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Figure 386: Acknowledgment Receipt Properties Dialog Box

After an acknowledgment e-mail is generated, the interaction is placed in a
queue (Processing by Agents) for processing by agents (see Figure 387).

Queue Interaction properkties El

eneral I

Interaction queLe

Figure 387: Queue Interaction Properties Dialog Box
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How To: Identify Contact and Create
Interaction in UCS

This business process, listed in Figure 327 on page 373, demonstrates how to
process an inbound interactions queue based on whether a customer contact
exists or does not exist in the Universal Contact Server (UCS) Database.

The strategy checks to see if this is an existing contact. If the contact exists, the
strategy creates an interaction for that customer in the UCS Database. If the
contact does not exist, processing continues without the creation of an
interaction in the UCS Database. Figure 388 shows the business process.

-8

Inkeractions
with new

@I all inbound inkeractions . contacks

Inbound Interackions Idenkify

Contack and

create e
interackion @

Interactions
with exisking
conkacks

Figure 388: Identify Contact, Create Interaction in UCS Business Process

Processing Objects

This section describes the various objects in Figure 388.

A view (ALl inbound interactions), that has no Conditions or Order By
information, extracts interactions from an interaction queue that is called
Inbound Interactions and submits them to the Identify Contact and create
interaction strategy (see Figure 389).
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Figure 389: Identify Contact and Create Interaction Strategy

The second object in the strategy is Identify Contact (see page 204).
Figure 390 shows both tabs of its properties dialog box.

Identify Contact properties El
General I Result I Identify Contact properties EI

General HESU“'
Contactsever: |

[T Create Contact

" Do not use output value

™ Retum Unigue ™ Attach output value

™ Update User Data % Azzign output valus to variable |existingContact j

" Assign values of the key-value pairs

|— Cutput values |

Figure 390: Identify Contact Properties Dialog Box

Note: The Contact server field in Figure 380 is blank. If you do not specify a
Contact server, URS finds all available servers and selects based on
load balancing.

The Result tab instructs to write the content of an Interaction Data field,
existingContact, to a variable, also called existingContact.

» Ifthere is no existingContact field or if it is empty, the interaction goes
out the bottom port to the default destination, an option configured in the
URS Application object.

* Ifthe existingContact variable contains a value, the interaction goes out
the side port to an If object (see Figure 391 on page 443), which is the third
object in the strategy in Figure 389.
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Figure 391: If Object Properties Dialog box

Cancel | Help

The If object calls a function called GetStringKey. This function parses out the
value for a specified key. If the searched-for key does not appear in the list, the
function returns an empty string.

The first parameter in the function call is the key, which is
Number0fContactsFound. The second parameter is the variable to contain the
Interaction Data, which is existingContact.

» Ifthe expression is false (existingContact=0), if the interaction is not from
an existing contact, it goes out the bottom port to a Queue Interaction
object specifying a queue for new contacts. Figure 392 shows the Queue
Interaction properties dialog box after clicking the down arrow to show
the selected queue.
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Queue Interaction properties El
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Figure 392: Queue Interaction Properties Dialog Box

» Ifthe expression in Figure 391 on page 443 is true (existingContact=1), if
the interaction is from an existing contact, it goes out the side port to a
Create Interaction object, which is the fourth object in the strategy in
Figure 389 on page 442. Figure 393 shows the properties dialog box.

Create Interaction properties il
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Figure 393: Create Interaction Properties Dialog Box
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Again, the Contact server field in Figure 380 is blank. If you do not specify a
Contact server, URS finds all available servers and selects based on load
balancing.

* Ifrecord creation is successful; the interaction goes out the side port to a
queue for interactions for existing contacts. Figure 394 shows the Queue
Interaction Properties dialog box after clicking the down arrow to show the
selected queue.

Queue Interaction properties ﬂ

General |

Interaction queue

- Default BP =
-How b atkach classification categories and use atl
-How b atkach classification categories and use m.
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Figure 394: Queue Interaction Properties Dialog Box

* Ifrecord creation is unsuccessful, the interaction goes out the bottom port
to the default destination.

How To: Place the Interaction Into the
Workbin

This business process, listed in Figure 327 on page 373, demonstrates how to

route an interaction to the agent that originally handled it. If the original agent
is not immediately available, the strategy places the interaction in the original
agent’s workbin for later handling.
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Note: If you need a review of workbins, see page 33 of this guide.

Figure 395 shows the Place the Interaction Into the Workbin business

process.
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Figure 395: Place Interaction Into Workbin Business Process

Processing Objects

This section describes the various objects in Figure 395.

A view (E-mails to route) that has no Conditions or Order by Information
attached to a queue (E-mails to route to original agent) extracts
interactions and sends them to the strategy Place Interaction into the
workbin (see Figure 396).
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Figure 396: Place Interaction Into The Workbin Strategy

This strategy assumes the original agent employee ID is contained in the
interaction attached data. It is very similar to the Route Interaction to
original agent strategy documented in Universal Routing 8.1 Strategy
Samples.

The general processing flow is as follows:

Note: The numbers in the IRD objects in Figure 396 are keyed to the
numbers below.

1. A Multi-Assign object assigns interaction attributes to three predefined
variables (see Table 33 on page 448).
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448

Table 33: Place Interaction Into the Workbin Predefined Variables

Variable Description

empl_id. The Udata function attempts to get a value from the

attached data key empL_id_f lag and write it to this
variable. If this key contains a value, it indicates that there
is an original agent for routing.

empl_id_flag. | The original agent employee ID number.

GD_OriginalAgentEmpLloyeelID is an attached data key that
may contain the identifier.

num_of_tries is initialized to 0. It functions as a counter used to control

the number of tries the strategy makes to route to the
original agent.

After setting the variables, an If object initializes the empL_id variable so it
does not contain a value.

If the expression in is true (if empL_id does not contain a value indicating
there is no original agent), the e-mail, goes out the bottom port to a Queue
E-mail object specifying the queue E-mails for QA review
(strategy-linked node in Figure 395 on page 446. This is used for a
collaboration reply e-mail from one agent to another.

If the expression is false (if there is an original agent), the e-mail goes out
the side port of the If object to an Assign object, which sets a counter
(variable num_of_try) to zero.

A Route Interaction object attempts to route the interaction to the original
agent contained in the empl_id variable. This target is represented by the
Dynamic target strategy-linked node in Figure 395 on page 446.

If the routing is successful, the strategy has achieved its goal and an Exit
object is connected to the side port of the Route Interaction object.

If the agent cannot accept the interaction for some reason, the e-mail goes
out the bottom port of the Route Interaction object to an Assign object,
which increments the num_of_try counter.

The e-mail goes out the side port of the Assign object to an If object, which
is used to decide whether the number of processing cycles to determine the
original agent is 10 or less.

If the expression is true (number of tries to route to the original agent is
less than 10), the interaction goes out the side port of the If object to a
Function object to delay strategy execution.
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10.

Once the delay is established, the e-mail goes out the side port of the
Function object back to the Route Interaction object to attempt to route to
the original agent.

If the expression is false (number of tries is 10 or greater), the e-mail goes
out the bottom port of the If object to a Workbin object (Workbin for
original agent strategy-linked node in Figure 395 on page 446). This
workbin is associated with the agent contained in the empl_id variable.

How To: Screen Multiple Rules and Use
Screening Switch

This business process, listed in Figure 327 on page 373, demonstrates how to
screen incoming interactions using multiple Screening Rules by using the
Multi-Screen object.

Note: Multi-Screen differs from Screen in that it supplies additional return

options: Screening Rules only, classification Categories only, matched
pairs only, or all three. It also does not require a conditional test to
determine whether a match occurred.

The strategy also demonstrates how to segment interactions to take different
paths based on Screening Rules.

Figure 397 shows the Screen Multiple Rules and Use Screening Switch
business process.
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Figure 397: Screen Multiple Rules and Use Screening Switch BP
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Processing Objects

This section describes the various objects in Figure 397.

A view (Inbound e-mail postprocessing) that has no Conditions or Order by
information attached to a queue (Inbound e-mail postprocessing) extracts
interactions and sends them to the strategy Preliminary e-mail screening ms.
Figure 398 shows the top part of the strategy.

3. Autoresponse l — 3
= L {9
2. Screen
Segmentatlo ! This case is impossible sinoe services exit through red pf
Object

a FATAL emor occcumed

a MANUAL recovery emor cccumed == route to original

a SYSTEM emor occumed

a RETRY emor cccumed

1. Multi-Screen
Object

4. Acknowledgement

Objact@= l:%%— \IE>)

Figure 398: Preliminary E-mail Screening MS Strategy

Note: “MS” at the end of the strategy name stands for “Multi-Screen.”

1. This strategy uses the Multi-Screen object and three different Screening
Rules (Auto Response Available, Warranty Problem, and Tech Support) to
screen inbound interactions for words or word patterns.
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2. A Screen Segmentation object connected to the green output port of the
Multi-Screen object causes different screening results to take different
paths in the strategy.

The purpose of the initial screening is determine whether the e-mail can be
responded to with a Standard Response.

3. Ifyes, an Autoresponse object generates a Standard Response (see the
Autoresponse strategy-linked node in Figure 397 on page 450). A Stop
object (see Figure 333 on page 378) notifies Interaction Server that
processing of this interaction is finished (see Stop strategy-linked node in
Figure 397 on page 450).

If a Standard Response cannot be used, a second screening determines
whether the e-mail contains text that indicating it is from a customer with a
warranty problem and therefore should be placed in a queue for
forwarding. If yes, the e-mail is placed in that queue (see the Forward
e-mails queue in Figure 397 on page 450). A Stop object (see Figure 333
on page 378) notifies Interaction Server that processing of this interaction
is finished (see Stop strategy-linked node in Figure 397 on page 450).

If the second screening indicates a warranty problem is not involved, the
e-mail goes through a third screening to determine if it contains text
indicating it is from a customer with a technical support problem and
therefore should be placed in a queue for redirecting. If yes, the e-mail is
placed in a queue for redirecting (see the Redirect e-mails queue in
Figure 397 on page 450). A Stop object notifies Interaction Server that
processing of this interaction is finished (see Stop strategy-linked node in
Figure 397 on page 450).

4. If the third screening does not produce results, an Acknowledgement
object generates an acknowledgement Standard Response. The e-mail then
goes to a queue for processing by agents (see the E-mails for processing
by agents queue in Figure 397 on page 450).

Error Handling

The following objects in Figure 397 on page 450 are the result of error
handling:

Preprocessing failure queue
E-mail service failure analysis subroutine
Terminate interaction subroutine

Termination failure queue

Multi-Screen Versus Screen

This strategy is the functional equivalent of the Preliminary e-mail screening
strategy that is discussed in Universal Routing 8.1 Strategy Samples.
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The difference between the two is as follows:

* Preliminary e-mail screening uses three separate Screen objects. After
each screen object, the strategy uses an If object and performs a
conditional test to determine whether a screening rule match occurred. This
adds a level of complexity and generates additional code.

Figure 399 shows the three Screen objects and If objects in the strategy.
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Figure 399: Multi-Screen Object Properties Dialog Box

*  Compare the strategy in Figure 399 with the strategy Preliminary e-mail
screening ms, shown in Figure 398 on page 451, which uses the
Multi-Screen object. Complexity and the amount of byte code is reduced
because a single object handles multiple rules and does not require a
conditional test after each screening. Figure 400 on page 454 shows the
properties dialog box for the Multi-Screen object in Preliminary e-mail
screening ms.

Business Process—User’s Guide 453



Appendix : Business Process Samples How To: Screen Multiple Rules and Use Screening Switch

MultiScreen propetties El
General I Heguﬂl MultiScreen properties il

General Result |
Claz=ification _

Language: IEninsh ™ Do not use output value
% Mtach output valus |
— [Eet zoreened data from " Assign output valus to variable

I1zer data key if specified:
™ Assign values of the key-value pairs

Othenmize fram UCS database

—I Allndes
s o

. . . - —Output values
Othensize fram the vanable if zpecified:

Screening rules
Aukn Response Available
Warranty problem
Tech support

—

I

L]

—Returk
£+ Fules only " Categories only

i M atched pairz only i Al

k. I Cancel | Help

Figure 400: Screen Object Properties Dialog Box (Accepts One Rule)

QK I Cancel Help

Figure 401 shows the properties dialog box for the Screen Segmentation object
attached to the Multi-Screen object.
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Screen segmentation properties il

General |

[T Screen by variable

i Language: IEninsh j
Segment Expression

1 Auto Response Available

2 Warranty problem

3 Tech =upport

KN i
ok | Cancel | Hep |

Figure 401: Screen Segmentation Properties Dialog Box

Each segment in Figure 401 generates its own output port (see the Screen
Segmentation object in Figure 398 on page 451).
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S Genesys

Supplements

Related Documentation
Resources

The following resources provide additional information that is relevant to this
software. Consult these additional resources as necessary.

Universal Routing

Interaction Routing Designer 8.1 Help, comprised of Routing Design Help
and Interaction Workflow Design Help. The information contained in this
help file duplicates some of the information contained in this guide, but
presents it in a shorter, online format.

Universal Routing 8.1 Reference Manual, which describes and defines
routing strategies, IRD objects used in strategies, functions that can be
called from strategies, Universal Routing Server and other server options,
number translations, pegs, statistics used for routing decisions, and
reporting on routing. You will want to consult this guide to get additional
information about the IRD objects discussed in “Planning a Business
Process” on page 195 of this book.

Universal Routing 8.1 Deployment Guide. The first part of the guide
provides information you will need to get started: A high-level overview of
Universal Routing features and functions, including product architecture,
system availability, redundancy information and deployment-planning.
The second part of the guide provides instructions for deploying Universal
Routing components, and describes how to start and stop these components
once you have configured and installed them.

Universal Routing 8.1 Strategy Samples, which simplifies strategy
configuration for first-time users of the strategy development tool,
Interaction Routing Designer. To achieve this goal, this document supplies
examples of routing strategies that can be used as general guides during the
design stage.

Universal Routing 8.0 Routing Application Configuration Guide
(previously Universal Routing 7.6 Routing Solutions Guide), which
contains information about the various types of routing solutions that can
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Related Documentation Resources

458

be implemented, including skills-based routing, business-priority routing,
share agent by service level agreement routing, and proactive routing. It
also discusses Universal Routing support for a Genesys Instant Messaging
Solution.

Universal Routing 7.6 Cost-Based Routing Configuration Guide, which
documents a solution where Universal Routing Server considers the cost of
routing to a target, comprised of Infrastructure cost and/or Resource cost,
as addition selection criteria when choosing the right target.

Genesys 7.6 Proactive Routing Solution Guide, which documents a
solution that enables you to proactively route outbound preview
interactions to Genesys Agent Desktop, as well as to completely process
Calling List and Do Not Call List records solely from the logic of a routing
strategy without agent intervention.

eServices

eServices (Multimedia) 8.0 Deployment Guide, which provides a
high-level overview of features and functions of Genesys Multimedia with
architecture information and deployment-planning materials. It also
introduces you to some of the basic concepts and terminology used in this
product.

eServices (Multimedia) 8.0 User’s Guide, which provides overall
information and recommendations on the use and operation of the Genesys
Multimedia components.

eServices (Multimedia) 8.0Reference Manual, which provides a reference
listing of all configuration options and of Field Codes used in Standard
Responses.

eServices (Multimedia) 8.0 Knowledge Manager Help, which is an online
guide to Knowledge Manager, the user interface for Genesys Knowledge
Base. You use Knowledge Manager to create and manage the Category
structure for Standard Responses, create and validate Field Codes, and to
create and edit Screening Rules.

“Multimedia Log Events” in Framework 8.0 Combined Log Events Help,
which is a comprehensive list and description of all events that may be
recorded in logs.

Genesys

Genesys Technical Publications Glossary, which ships on the Genesys
Documentation Library DVD and which provides a comprehensive list of
the Genesys and computer-telephony integration (CTI) terminology and
acronyms used in this document.
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Related Documentation Resources

*  Genesys Migration Guide, which ships on the Genesys Documentation
Library DVD, and which provides documented migration strategies for
Genesys product releases. Contact Genesys Technical Support for more
information.

* Release Notes and Product Advisories for this product, which are available
on the Genesys Technical Support website at
http://qenesyslab.com/support.

Information about supported hardware and third-party software is available on
the Genesys Technical Support website in the following documents:

*  Genesys Supported Operating Environment Reference Manual
*  Genesys Supported Media Interfaces Reference Manual
Consult these additional resources as necessary:

*  Genesys Hardware Sizing Guide, which provides information about
Genesys hardware sizing guidelines.

*  Genesys Interoperability Guide, which provides information about the
compatibility of Genesys products with various Configuration Layer
Environments; Interoperability of Reporting Templates and Solutions; and
Gplus Adapters Interoperability.

* Genesys Licensing Guide, which introduces you to the concepts,
terminology, and procedures relevant to the Genesys licensing system.

*  Genesys Database Sizing Estimator 8.0 Worksheets, which provides a
range of expected database sizes for various Genesys products.

For additional system-wide planning tools and information, see the
release-specific listings of System Level Documents on the Genesys Technical
Support website, accessible from the system level documents by release tab
in the Knowledge Base Browse Documents Section.

Genesys product documentation is available on the:

* Genesys Technical Support website at http://genesyslab.com/support.

* Genesys Documentation Library DVD, which you can order by e-mail
from Genesys Order Management at ordermanegenesyslab.com.
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Document Conventions

Document Conventions

This document uses certain stylistic and typographical conventions—
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this
document. Version numbers change as new information is added to this
document. Here is a sample version number:

80fr_ref_06-2008_v8.0.001.00

You will need this number when you are talking with Genesys Technical
Support about this product.

Screen Captures Used in This Document

Screen captures from the product graphical user interface (GUI), as used in this
document, may sometimes contain minor spelling, capitalization, or
grammatical errors. The text accompanying and explaining the screen captures
corrects such errors except when such a correction would prevent you from
installing, configuring, or successfully using the product. For example, if the
name of an option contains a usage error, the name would be presented exactly
as it appears in the product GUI; the error would not be corrected in any
accompanying text.

Type Styles

Table 34 describes and illustrates the type conventions that are used in this
document.

Table 34: Type Styles

Type Style | Used For Examples
Italic * Document titles Please consult the Genesys Migration
«  Emphasis Guide for more information.
« Definitions of (or first references to) Do not use this value for this option.
unfamiliar terms A customary and usual practice is one
o Mathematical variables that is widely accepted and used within a
Also used to indicate placeholder text within particular industry or profession.
code samples or commands, in the special case | The formula, x +1 =7
where angle brackets are a required part of the | where x stands for . . .
syntax (see the note about angle brackets on
page 461).
460 Universal Routing 8.1 @




Document Conventions

Table 34: Type Styles (Continued)

Note: In some cases, angle brackets are
required characters in code syntax (for
example, in XML schemas). In these cases,
italic text is used for placeholder values.

Type Style | Used For Examples
Monospace | All programming identifiers and GUI Select the Show variables on screen
font elements. This convention includes: check box.
(Looks like | * The names of directories, files, folders, In the Operand text box, enter your
teletype or configuration objects, paths, scripts, dialog | formula.
typewriter boxes, options, fields, text and list boxes, Click 0K to exit the Properties dialog
text) operational modes, all buttons (including box.
radio buttons), check boxes, commands,
tabs, CTI events, and error messages. T-Server distributes the error messages in
. EventError events.
* The values of options.
. Logical ts and d svnt If you select true for the
gical arguments and command syntax. ) )
inbound-bsns-calls option, all

* Code samples. established inbound calls on a local agent

Also used for any text that users must are considered business calls.

manually enter during a configuration or . Enter exit on the command line.

installation procedure, or on a command line.
Square A particular parameter or value that is optional | smcp_server -host [/flags]
brackets ([ ])| within a logical argument, a command, or

some programming syntax. That is, the

presence of the parameter or value is not

required to resolve the argument, command, or

block of code. The user decides whether to

include this optional information.
Angle A placeholder for a value that the user must smcp_server -host <confighost)
brackets specify. This might be a DN or a port number
(<>) specific to your enterprise.
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S Genesys

Index

Symbols
[l (square brackets). . . . . . ... ... .. 461
<> (angle brackets) . . . .. ... ... .. 461
A
ABC SimpleBP . . . .. .. ... ... .. 374
ABC Simple ChatBP. . . . ... ... ... 379
access permissions . . . . ... ... ... 153
Accounting forLabels . . . ... ... ... 91
accurateprinting . . . . .. ... 90
Acknowledgement button . . . . . . .. .. 127
Acknowledgement object. . . 125,176, 185, 201
Activate Strategy . . . . . . . ..o 83
active strategy loading . . . . . . ... ... 84
Add Recordobject . . . . . ... ... ... 211
Add Record object button . . . . . ... .. 128
add strategy to Business Process . . . . . . 356
agent
capacity rule assignment . . . . . . . .. 164
configuration. . . . .. ... ... .. 156, 161
group . . ... 133, 156, 207
routingtarget . . . . ... ... ... .. 133
strategy linkednode. . . . . ... ... .. 36
workbin . . . ..o 208
Allow Docking . . . . . . . . ... .. 95, 96, 97
anglebrackets . . . . ... ... ... 461
AngleSnap. . . ... ... ... ... ... 113
ANlobject . . . .. ... ... ... .... 125
Annex tab in Configuration Manager. . . . . 172
Application
Configuration Manager login . . . . . .. 238
IRD login dialogbox. . . . . . ... .. .. 59
Knowledge Manager login. . . . . . . .. 224
Apply escalation procedure . . . . . . . .. 410
Arrange Objects
Interaction Designview . . . . . . ... .. 83
arrange objects. . . . . .. ... ... L. 71
Arranging Optionstab . . . . ... ... .. 91
arrow

Business Process—User’s Guide

Queueobject . . . . .. ... 28

Strategy object . . . . .. ..o 30

Workbinnode . . . . ... ... ... ... 37
asl . . . ... 84
Assignobject . . . . .. .. 126, 133, 209, 343
Attach Categories button . . . . . . . . .. 127
Attach Categories object. . . . . . .. 180, 202
Attach classification Categories sample . . . 410
attacheddata . . . .. .. .. .. .. 126, 292
Attributes

definiton . . . ... .. ... ... ... 118

interactions . . . ... ... ... .... 216

View. ... 112,273
audience, fordocument . . . . . ... ... 16
Autoresponse button. . . . . ... .. L. 127
Autoresponse object. . . . . 125, 176, 185, 202
B
backup strategy . . . . . . ... ... ... 140

black connector line in workflow viewer . 38, 305
brackets

angle . . . ... ... L. 461
square. . . . ... 461
Business Attributes . . . . . .. . .. 208, 209
definiton . . . .. ... ... ... ... 161
origin . . ... ..o 244
Business Process
addstrategy. . . . . . .. ... ... 356
Attach Classification Categories . . .413,419
cannotcopy. . . . . . . .. ... 78
connecting with queues. . . . . . .. .. 199
creating . . . . . . .. ... 247
definiton . . . . .. ... ... 21
exporting . . . . ... .. ... ... .. 307
flow diagram . . ... ... ... 42
GUI . . ... . 57
importing . . . . .. ... ... ... .. 310
Listview. . . . . . ... ... .. .. .. 104
Locatecommand . . . . . . . . ... ... 38
menu . . . . . .. .. ... ... ... 82

463



Index

nodes . . .. ... ... ... . 34
object definitions. . . . . . . ... ... L. 27
originating . . . . . . ... ... L. 28
overview. . . . . ... 21
planning . . . . ... ... ... ... 195
printing. . . . . .. .. ... .. 90
printinglarge. . . . . . ... ... ... 77
samples . . . . ... ... ... .. 25,369
Scriptfile. . . . . ... ... L. 159
shortcutmenu. . . . . . .. ... ... .. 94
strategy comparison. . . . . ... ... .. 44
switching to another. . . . . . . . . . .. 252
Business Rules
definition. . . . . .. ... ..o 119
VIEW . .o 112
Business segmentation object . . . . . . . . 125
buttons for reusable objects . . . . . . . .. 116
C
call flow
printing. . . . . ... ... 76,108
Call subroutine button . . . . . ... .. .. 126
Call Subroutine object . . . . . . . 126, 209, 415
Campaign . . ... ... ....... 203,211
Capacity Planning Wizard . . . . . . . . .. 165
Capacity Rule assignment . . . . . . .. .. 164
Categories . . . . . . . ... 176, 202, 203, 208
ChangePassword . . . . ... ... .... 110
ChangeTenant. . . . . ... ........ 114
Chat Transcriptbutton . . . . . . . ... .. 127
Chat Transcript object . . . . . . . .. 125,202
Check Integrity . . . . . . ... .. .. 112,354
Check Interval (sec) . . . . . . .. .. 272,287
CIM (Customer Interaction Management)
Platform . . . . . . . . . ... .. 14,15
classification categories . . . 176,178,413,419
Classification Segmentation object. . . . . . 176
Classification Server . . . . . . 50, 202, 203, 205
Classifybutton . . . . . . . ... ... ... 127
Classifyobject . . . . . ... .. ... ... 203
Classify Segmentation object . . . . . 125, 208
CollaborationReply. . . . . . ... ... .. 333
colorofconnector . . . . ... ... . ... 38
Commentobject . . . . . ... . ... 139, 340
commenting on this document . . . . . . .. 17
communication protocol . . . . . . ... .. 53
compilestrategy . . . . . .. ... ... .. 353
conceptual diagram . . . . ... ... ... 24
Condition tab forview . . . . . . . .. 216,273
conditions for extracting interactions. . . . . 29
conduct an email survey using email. . . . . 425
Configuration Database . . . . . . . .. .. 176
Configuration Manager
login. . . ... ... 237
using. . . . ..o 155
464

configurationorder. . . . . . .. ... ... 217
Configuration Server

portforCME . . . . . ... ....... 238

portforIRD . . . . ... ... ... .... 59
Configuration Updatestab. . . . . . . . . .. 72
Contact Attributes . . . . . ... ... ... 246
ContactServer. . . . . . ... ... ... .. 22

empty in IRD properties. . . . . . . . 442,445
Content Analyzer . . . . ... ... ..... 50
conventions

indocument. . . . . ... ... ... .. 460

typestyles. . . . .. ... ... 460
copy

BusinessProcess. . . . . . .. ... ... 78

Routing Designview . . . . . ... ... 111
Create E-mail Out button . . . . . . . . .. 127
Create E-mail Outobject. . . . . . . .. .. 203
Create Interaction button . . . . . . .. .. 127
Create Interaction object. . . . . . . .. .. 203
Create Notification button . . . . . . . . .. 127
Create Notification object . . . . . . . . .. 203
Create SMSbutton . . . . ... ... ... 127
Create SMSobject. . . . . . .. ... ... 203
Create SMS Qutbutton . . . . . . . .. .. 129
Create SMS Outobject . . . . . . ... .. 207
curvedlines . . . . . ... .. ... ..... 27
Custom Variables . . . . . . 175,176, 218, 233
Customer Segment . . . . . . . ... ... 163
Customize IRDtoolbars . . . . . .. .. .. 114
cut copy paste instrategy . . . . . . .. 111,140
D
Data & Services objects . . . . . . 206, 207, 209
database

Configuration . . . . . ... ... .. 176,179

expressions. . . . ... ... ... 292

index . ... ... ... ..., 292

integrity . . . ... ... ... .. 87,354

Universal Contact Server . . . . . . . 50,179
DatabaseHints . . . . . ... ... .... 284
Database Wizard . . . . .. .. ... 124,147
Dateobject. . . . . . . .. ... ... ... 125
Day of the Week object . . . . . . ... .. 125
DB2 . .. .. ... . 292
deactivate routing strategy. . . . . . . . 85, 366
defaultcondition. . . . . . ... ... ... 292
default destination . . . . . ... ... ... 442
Default Font tab in Routing Design . . . . . 146
defaultinbound queue . . . . . . . . ... .. 22
defaultorder. . . . . . . ... ... 292
default skilllevel . . . . . . . ... ... .. 402
Default strategy-building object . . . . . . . 125
definition of Business Process. . . . . . . .. 21
Delete

Interaction Designview . . . . . . .. . .. 83
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Describe
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document
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VIEW . ..o 272
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Enterprise in Configuration Manager. . . . . 157
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Export
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